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1 Introduction

1.1 Introducing wMobile

Introduction

wMobile™ is an application that is installed on one of your organization's servers to

provide remote access to GoldMine™. wMobile provides this functionality through any

mobile phone device with an internet connection and an internet browser application.

Examples of such devices are any  iPhone®, iPad®, Android phone or tablet, or Windows

Mobile® devices.

wMobile uses the internet browser application of the device to navigate to your

organization's wMobile server so that you can work with your organization's GoldMine

CRM information.

To get started with wMobile you will need to add a web site link to your device's internet

browser. Your organization will have a unique web address (URL) for your wMobile server.

A typical address would be http://www.organization.com/wmobile or

https://wmobile.organization.com. Please contact your wMobile administrator to obtain

the web address you will need to use.

Overview of Features

Contact Management
wMobile provides your users with secure access to all contact information stored in

GoldMine. It is quick and easy to find, edit and add contacts and related information.

Phone and Email Integration
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wMobile interacts with your device allowing you to quickly phone and email contacts

using the capabilities of the device. A complete email center allows all email to be linked

to GoldMine CRM.

Sales Forecast Management
wMobile allows you to easily review, update and add sales forecasts for any contact and

for any time period.

Activity Management
wMobile allows you to quickly review, update, add and complete activities with immediate

update of your GoldMine database. You can schedule and review activities for other

GoldMine team members.

Dashboard Reporting

Quickly review key statistics from the GoldMine system. A dashboard displays information

such as the number of completed and pending activities. For history, new contacts added

to the database are shown. You can quickly jump to underlying detail information.

Easy Configuration

wMobile automatically inherits configuration from your GoldMine system. A designer

application is included to allow additional changes to the wMobile user interface.

Security

wMobile supports all GoldMine security concepts as well as standard internet security

protocols such as SSL data encryption, Firewall DMZ installation and BlackBerry

Enterprise server integration. Data resides on the server and never on the device itself.

Real Time Data

Information updated on a wMobile device is immediately applied to your GoldMine system

without the need for data replication.

Cross Platform Support

wMobile supports all phone devices such as BlackBerry® , Palm Treo®, Windows Mobile®

and iPhone®. wMobile supports all worldwide mobile phone carriers and systems with

internet data service.

Ease of Administration

The wMobile server is installed in less than an hour and users are deployed in minutes.



IntroductionwMobile User Guide 12

Copyright © 2021 SugarCRM All Rights Reserved.

1.2 Document Conventions

wMobile provides this functionality through mobile phone devices with an internet

connection and an internet browser application. Therefore, the term "page" will be used

throughout this document to refer to the current page (i.e., web page, screen, form, etc.)

being displayed on your device.

The word "click" is used at times throughout this document as a metaphor to describe an

action that you, the wMobile user, will perform on a button, a link (also referred to as:

hyperlink), a drop-down list or any other object on a screen that requires user intervention.

The actual "action" that you need to perform for a "click" will depend on the device you are

using to access wMobile. For example, these actions may include the "click" of the

trackwheel on a BlackBerry device, the "tap" of a finger or stylus on a smartphone, a

"mouse click" if you are using a desktop computer or even a "tap" on a laptop's touchpad,

etc.

The term "link" is used interchangeably with hyperlink. A link is typically displayed on a

web page as blue underlined text (e.g., Home).

The documentation you are reading also uses these following conventions:

CONVEN

TION

DESCRIPTION

boldface Menus and menu options, command buttons, tabs, and service or process

names.

italics References to other documentation.

monospace Web site addresses, email addresses, file names, folder names, user input /

user entered information, command lines and other information to be

entered by users using keys pressed on the keyboard.

KEY

PRESS

Keyboard Key Press Combinations - Keys that you are to press will be in

boldface. Keyboard key press combinations and singular key presses will be

shown differently depending on how the user is required to perform the key

press.
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For key press combinations joined with a plus sign (e.g., Alt+F) the user

would press and hold the first key while simultaneously pressing the

second key.

Single key presses are simply shown as the key to be pressed (e.g., Enter,

Shift, F1, Esc, Page Up, Tab, etc.).

For combinations joined with a comma (e.g., <Alt, F>) the user would press

and release the first key, then press and release the second key.

> This symbol indicates a menu item. For example, "Select Tools > Options"

means choose the Options item from the Tools menu.

KEYWOR

D

Keywords for SQL and other programming languages will appear in boldface

and uppercase text.

General notes

Important information

Tips, ideas and recommendations

Configuration notes

1.3 Searching the Users' Guide

Getting answers to questions fast is a key to productivity. This online wMobile Users'

Guide supports full-text search.

To start searching, use the SEARCH tab.

How to search for an exact phrase in the wMobile Users' Guide

Enclosing one or more words inside of double-quotes will allow you to search for an exact

phrase. For example, entering work will find work, working and framework, but entering

"work" with double-quotes will only find work. This also works for a group of words.

Entering "Working with the Calendar" will only find the exact occurrences of all four words.

This functionality (using double-quotes) can be combined with wildcard characters. For

example, "work*" will find working but not framework.



IntroductionwMobile User Guide 14

Copyright © 2021 SugarCRM All Rights Reserved.

  TIP: Using the * and ? Wildcard Characters in Full Text Searches

There are two wildcard characters you can use when searching: the asterisk (*) and the

question mark (?) which are almost the same in use.

? is used to represent any single character and * represents any number of characters.

Examples:

Search using (?): "s?t"

Results: sat, sit, set, ...etc.

"s?t" will find any combination of three characters beginning with "s" and ending with

"t". 

Search using (*): "s*t"

Results: sail boat, soft, signed document, ...etc.

"s*t" will find any combination of characters beginning with "s" and ending with "t".
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1.4 Documentation Feedback

wMobile Support always seeks to improve its documentation. Please send your questions,

comments, or suggestions about this or any wMobile Support documentation to

goldminesupport@sugarcrm.com.

Your feedback is always welcome and appreciated. Thank you!

1.5 Version History

What's New in these versions...

· wMobile 5.1

· wMobile 5.0

· wMobile 4.0

· wMobile 3.1

· wMobile 3.0

· wMobile 2.1

· wMobile 2.0

· wMobile 1.9

· wMobile 1.8

1.5.1 What's New in wMobile 5.1?

NEW

wMobile (Infrastructure Changes)

· Windows Server 2008/R2 end of support

· Internet Explorer 11 end of support

wMobile Phone

· The Phone version includes a clean and modern UI:

1. Layout

o wMobile Phone has a new look. All the pages and controls in the application have a

modern and cleaner style.

o The new UI also has new features to customize the display.

o 'Font Size' and 'Display Density' settings can be used to adapt the display to your screen

size.

2. Menu

mailto:goldminesupport@sugarcrm.com
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o A new user menu (side menu) was added where you can view your preferences, save

bookmarks and navigate to the recently viewed contacts.

o The style of this menu as well as the style of the 'Home Menu' can be customized in

User Preferences.

3. Contact View

o The Contact view is separated into 2 tabs to show Details, such as a user typically sees

on the top of the wMobile Desktop or Goldmine contact view and Linked information,

such as we see on the Contact tabs.

o The same style is used in Opportunity, Case and Project views.

4. Calendar

o Month: You can view activities on a specific day directly in this view and you can

navigate very easily to a specific day.

o Today button was added in the calendar top bar.

o A new setting was added: 'default activity duration' - used to preset the duration when

creating a new activity.

5. Email

o The Email Center will offer Email navigation and Email view improvements as well as

menu reorganization.

NOTE: The wMobile Phone documentation has been updated for our new wMobile 5.1 User

Interface. 

wMobile (General)

· The email messages can be seen in Calendar (Calendar Preferences -> History Activities

list)

wMobile Desktop

· Metric Dashboards for Projects

· New darker theme

· Added support for larger email attachments

wMobile Manager Console

· Error 'wMobile.Managerconsoel.exe has stopped working' error on closing the wMobile

Manager Console has been resolved.

 

wMobile Email Fetcher Service
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· Fix for Local Trash Deletion Service

1.5.2 What's New in wMobile 5.0?

NEW

wMobile (Infrastructure Changes)

· .NET Framework 4.7.2 (or higher) will now be a prerequisite

· wMobile 5.0 includes a Telerik upgrade. Telerik is the tool our developers use to build

wMobile. The new provides new programming functionality, including the basis for the

new Desktop User Interface.

· Windows Server 2019 is added as a supported environment for wMobile 

· SAP Crystal Reports Runtime Engine update

wMobile Desktop

· New User Interface with bigger buttons and easy to read menus

· Customizable navigation menu

· Recent navigation menu to return to previously visited pages

· New Themes to work with the new user interface

· Metric Dashboards for Activities, Opportunities, and Cases (a metric dashboards for

Projects is coming!)

1.5.3 What's New in wMobile 4.1?

Infrastructure Changes

· The wMobile 4.1 upgrade will update all references back to the wMobile corporate

domain, including installers, license activation, and the wDiagnostic. 

· New icons for wMobile Phone and Desktop one-click logins. 

· New icons on the server for the wMobile Manager Console, wDiagnostic, and wMobile

Update shortcuts.

· Local Email Rules functionality has been added for processing incoming emails in

wMobile Desktop and wMobile Phone. This functionality can emulate GoldMine's auto-

retrieve and auto-delete settings for online email (on your email server or ISP).

· Support added for WebEx meeting requests in wMobile's email client.

NEW

wMobile (General)

· Improvements to installers so they are not detected by anti-virus applications.

· Option added to bypass GoldMine 2018.2 password complexity rules if these rules were

not adopted in existing GoldMine implementations.
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· Support for email rules, such as copying email from the Online Inbox to the GoldMine

Inbox

· Delete functionality added on Opportunities

· User Access filter will be taken into account when checking for duplicate contacts.

· Support for WebEx Meeting requests in wMobile's email client

wMobile Phone

· Option added to show primary email and website on Pending Activity List

· Ability to 'Hide' wMobile Phone fields instead of removing them in the Manager console

Contact Screen Configuration

· More options added to filter builder operators for improved searching

wMobile Desktop

· Fixes in filter bar use

· Improvements to Opportunity fields set to not allow blank input and force valid input

1.5.4 What's New in wMobile 4.0?

Infrastructure Changes

· wMobile 4.0 included updated branding to reflect our UpCurve Cloud company name. All

references such as installers, license activation, and diagnostics have been re-pointed to

our new domain. The wMobile product name remains the same. The same staff are here

to develop and support wMobile!

NEW

wMobile (General)

· Support for most security features in GoldMine 2018.2 (password complexity and SQL

Read-Only user configuration)

· Ability to add custom company logos for One Click logins for wMobile Phone and

Desktop

wMobile Phone

· Calendar display and navigation enhancements

· Referrals

· Relationships

· Projects

wMobile Desktop

· Calendar display enhancements
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· Email Drag and Drop functionality in the Email Center

· Referrals

FIXED

· Opportunity issues in wMobile Phone and Desktop related to filtering options and

sorting

1.5.5 What's New in wMobile 3.1?

Infrastructure Changes

· wMobile 3.1 has been updated to support the latest Microsoft standards and platforms.

· wMobile now supports the latest .NET 4.5 framework to provide compatibility with

Internet Explorer 11.

· wMobile continues to support BlackBerry, iPhone, Android, and Windows Phone devices

NEW

wMobile Phone

· Record Alerts

wMobile Desktop

· Knowledge Base

· wMobile now has support for iPad and Android tablets

· Record Alerts

· Document merge functionality

· Added Agenda View and Multi-Day View support

· Added support for PDF export for Activities, Contacts, Documents

ENHANCED

wMobile Phone

· Save Draft support in wMobilePhone on composing email

· Navigation enhancements for Phone Edition

wMobile Desktop

· Print calendar support in wMobile Desktop

· iCal export support in wMobile Desktop

· Added Agenda View and Multi-Day View support in wMobile Desktop
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· Support to save all email attachments at once in wMobile Desktop

· Added new touch skin in Desktop Edition for tablet operating systems: MetroTouch

· Added ability to change activity type to Email on completion

wMobile (General)

· Moved wMobile updates and Mgr Console out of Phone Edition folder on Start menu

· Add support for dbase COLOR and COUNTER functions

FIXED

· On tablets, add support to manage the zoom level

· Show the grids hyperlink columns with a different style in wMobileDesktop

· Notes editor does not display a border in some screens

· Change lookup stylus such that it will be easier to touch it on tablets

· On Tablets: Wider toolbars are not scrollable or they are hard to scroll

· Desktop: The Clone functionality should not automatically create a contact, but it should

open the AddContact screen

· MultiCalendar - left click should open the context menu

· Contact Screen: When we enter the first email address it should be set as primary

· Change Documents Module/AddIn to Document Templates or Templates

· Telerik Update

· In wMobilePhone, added a button to navigate to the bottom of the page, to quickly

access the menu

[This is only a partial listing of highlights.]

1.5.6 What's New in wMobile 3.0?

Infrastructure Changes

· wMobile 3.0 has been updated to support the latest Microsoft standards and platforms. 

· wMobile now supports the latest .NET 4.0 framework.

· wMobile installers have been updated to be more intelligent about the Web server

environment the application is going into.

· wMobile continues to support all BlackBerry, iPhone, Android, Windows Mobile and Palm

devices.

· Windows 8 Phone support.

NEW

wMobile Phone
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Service Cases

· Support for service cases to mimic GoldMine functionality. 

wMobile Desktop
Service Cases

· Support for service cases to mimic GoldMine functionality.

Field Tabs Security Support

Record Type Support

wMobile (General)
Calendar

· Support for using color codes in graphical calendar.

ENHANCED

wMobile Phone

· Ability to customize most of the wMobile Phone screens : change labels or show/hide

fields

· Quick Search fields are configurable per user.

· Opportunity Screens improvements: added real time calculation for amount, added

product list in opportunity list, etc.

· Email Improvements: changed email account page.

wMobile Desktop

· All screens use new Lookup control with suggestion as you type.

· Support for Clone Contact .

· Opportunities improvements: opportunity list filter and record ownership adjustments.

· Email Improvements: better theme integration with Email Center. Reviewed the email list

and adjusted the columns.

Manager Console

· Support for settings editing in Manager Console (System and Default User Options,

Ability to view, edit and read system settings documentation).

· Change wMobile/GoldMine database used by wMobile.

Installer

· Signed wMobile Installers
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FIXED

wMobile Phone
BlackBerry OS 5 Lookup Contact Issues

· The lookup contact screen buttons and generally any link button were not working on BB

OS 5.

Contact List View: Issues with Clicking Email Address

· If the 'Email Client' setting was set to 'Device', then wMobile would have taken you to

your device email client - but instead it was redirecting to its internal email client.

Zoom Level: not working on iPads and iPhones

wMobile Desktop
Alarm Screen

· An invalid time in 'ONTIME' column caused a crash in wMobile.

Manager Console
Fetcher Activity Timer Issues

· Email Fetcher Activity screen used to increase CPU and memory usage while running;

especially on slower computers.

Common Fixes
Detail Type Fixes

· There was a problem with the dollar character ($) in Detail Type key.

Email Filing with Body Larger than 8000 characters

· If RFC822 was larger than 8000 characters, there was a problem inserting the data into

the MAILBOX table.

1.5.7 What's New in wMobile 2.1?

· A brand new desktop browser user interface for those of you who want a full web based

version of GoldMine for you Internet Explorer, Firefox, Chrome or Apple Safari browsers. 

NOTE: This user interface is built on GoldMine Premium and requires customers to have

GoldMine Premium (any version) as their current GoldMine system.

· Automated Email Filing to Contacts so you can use any email client to send and receive

mail.

· Enhancements to wMobile interface
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o Support for multiple contact sets

o Filter based security

o iPhone and iPad enhancements

· Improved installer and New Diagnostic Tool

wMobile Desktop Browser User Interface

· Users see the same contact record as they see in the full GoldMine application.

· All custom fields are automatically displayed in the browser user interface.

· Contact detail tabs behave as in the full GoldMine application.

· All field drop-down options are supported.

· Scheduling and completing activities is done in the same screen layout as the full

GoldMine application.

· Daily, weekly, and Monthly calendars are available.

· Users can drag and drop to reschedule activities.

· Users can view others’ calendars and schedule according to security permissions.

New: Email Archiving 

· wMobile will optionally cache and automatically file any user’s sent and received email

directly to contact History.

· Supports Microsoft Exchange, Google and any IMAP compliant mail server.

· Users can use any mail client including native mobile phone email client and web mail

such as Outlook web access and Gmail.

· wMobile matches “sent from” or “sent to” email addresses to GoldMine contact records.

1.5.8 What's New in wMobile 2.0?

Infrastructure Changes

· wMobile 2.0 has been updated to support the latest Microsoft standards and platforms. 

· wMobile is now fully 64 bit compliant and supports the latest .NET 3.5 framework and

Windows 2008 64 bit servers.

· wMobile installers have been updated to be more intelligent about the Web server

environment the application is going into.

· wMobile continues to support all BlackBerry, iPhone, Android, Windows Mobile and Palm

devices.

Customizable Contact Screen
The wMobile system can be further customized to include any user defined or standard

CRM field in the main wMobile contact record view and contact related page header. This

makes key information visible at a glance.
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Customizable Quick Search
Instantly search for any combination GoldMine fields such as Company, contact names,

customer numbers and more.

Opportunity Management

wMobile support full opportunity management with complete view and edit ability of all

Opportunity information elements including influencers, linked documents, issues, multiple

item forecasts, pending and history activities.

Support for alarmed activities

When a user has alarmed activities an alarm flag is shown within the wMobile user

interface directing the user to the alarmed activities.

SSL Mail and Gmail Support
wMobile now supports encrypted email SSL protocols for more secure email management

and support for Gmail accounts. Gmail in increasingly popular as a business email host

performing email services for GoldMine and Outlook clients. wMobile now fully supports

this platform.

Email Attachments

wMobile users can now email any document that has been linked to a CRM contact. If a

contact wants an emailed quotation or copy of a contract, this is now possible from your

mobile device.

Dashboards

· Review Activities

· Review Sales

· Review New Contacts Created 

· Drill down to view details 

Clone current contact to new record
When entering a new contact record a previously viewed contact record can be cloned to

save time and keystrokes.

Duplicate check on new contact entry
wMobile performs a duplicate contact check on new contact entry. Duplicates are shown

and users can chose to proceed with entry or to start using the pre-existing contact

record.
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File email to other contact without re-linking email address
wMobile users can now file an email to a related contact without re linking the email

address to the new contact.

Improved One Click Login Setup
It is now simpler to create one click login URL’s for new users.

HTML Email Support

· For devices that can display rich HTML, wMobile emails can optionally be shown as

HTML instead of the standard text based messages.

Email templates and email merge

· wMobile email client supports email templates and email merge to groups and filters.

Ability to Add Contacts to local device
Contact is copied locally with one click.

Function can be disabled to prevent local data.

Integration to Yahoo Maps for Pocket Devices
Use the Local Are Map function to display the contact location.

Contact Routing
Turn by turn directions to contact from and back to the office or from any of last viewed

contacts

Review of GoldMine Groups
Maintain Key Account groups, New Lead Groups for fast account management 

Manage forecast sales right from the main menu

·  Review and edit existing forecasts

·  Add new forecasts

·  Review forecasts for other team members (as defined by security settings)

1.5.9 What's New in wMobile 1.9?

Details
Full GoldMine Detail Support has been added to wMobile.

· View, Edit, Add or Delete Details to records.

· View, Edit, Add or Delete Detail types (MASTER users only)
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Linked Documents
wMobile now includes a list of all the files on the 'Links' tab in GoldMine. Download and

open files* linked to records.

Scheduling Activities for Multiple GoldMine Users
wMobile adds a new 'Users' tab to the 'Schedule Activity screen.

· When Scheduling an Activity, click the 'Users' tab to select multiple users.

Support for Duplicate Record Search when Creating Contacts

Sending E-mail to GoldMine Users without an E-mail Address
By popular demand, wMobile will now send 'Internal' GoldMine messages to GoldMine

users without an e-mail address.

· When creating a new message, all the GoldMine user's will appear in the list of

recipients. Select a GoldMine user and click Add.

Forwarding E-mail Attachments
Also by popular demand, wMobile now has the ability to forward e-mail attachments. 

· When forwarding a message, a new section below the recipient provides to ability to

optionally include the attachments of the forwarded message.

Navigation Enhancements
We've added several navigation and viewing enhancements to the following pages:

Contact Details

· The overall layout has been cleaned up so that viewing and editing Pending, History, etc.

is grouped together. 

· Additional Contacts, Details, Links and Fields screens have been converted into drop

down boxes to make the screen shorter.

· wMobile counts the total number of items in each list and also counts the number of

each type in the each list. This makes it easier for wMobile users to filter their selection

based on the available items. For example, users can filter the Detail list to display only

the selected Detail type.

· When Scheduling an Activity, click the 'Users' tab to select multiple users.

· When navigating to a list of Activities, Details, etc. a new link to the primary contact

record at the top of the page has been added in addition to the link that already exists at

the bottom of the page.

Pending/History
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· The layout of the viewing page as been reformatted for better viewing.

· The contact name on the activity is hyperlinked to allow faster navigation.

· When viewing a list of multiple activities, users will have previous and next buttons that

prevent users from having to return to the list and select the next activity. 

Administrative Password Lockout
Administrators can now have wMobile automatically lockout a wMobile Login if a

configurable number of failed logins.

Many Minor Updates

· Various Device Support Improvements

· Various Speed Improvements

· Installer and Update Enhancements

*In order to download and view linked files or e-mail attachments, the device must opening

the file type.

1.5.10 What's New in wMobile 1.8?

Monthly, Weekly and Daily Graphical Calendars for any user
wMobile adds three new main menu options for various calendar formats to the main

application menu:

Monthly Calendar View, Weekly Calendar View and the Daily Calendar View

· Daily and weekly graphical calendar for any GoldMine user (default current logged in

user)

· New appointments can be scheduled directly on the calendar for any user by clicking a

time hyperlink

· Existing activities can be viewed, edited and deleted

Detailed Calendar Display User Preferences
User can adjust detailed preferences on calendar function:

· Colors of activities and labels

· Day start and end

· Time section size (15, 30, 60 minutes)

· Alarm on new activities by default

· Working days

· View scheduled activity types

· View completed activity types

Activity Scheduling from Calendar Views
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· Press Schedule New Activity menu option or press hyperlinked time label on daily and

weekly calendars

· Search for contact to schedule

· Enter activity details

Event Activity Type Scheduling Support

· New support for single or multi-day Event activity type

· Events display as days with designated color background on monthly calendar and

before start of day on weekly and daily calendar

International Regional User Settings

· New support for user preferences for date, time, currency type, currency formatting and

distance units

· Date formats support day-month or month-day

· Time formats support AM-PM or 24 hour clock format

· Currency supports USD, EUR, GBP, CAD, AUD, YEN, etc.

· Distance units support Miles or Kilometers

Time Zone Translation Support

· New support for converting scheduled activity time for users local time zones

· Activities are entered into GoldMine as local server time but displayed in wMobile

converted to each users specified local time zone

Many Minor Updates

· Carry over notes in scheduled follow-up

· Ability to delete scheduled activities

· Ability to copy additional contacts to local address book

· Add File Email to GoldMine Inbox

· Various Speed Improvements

· Installer and Update Enhancements



Instal l ing and Configuring wMobilewMobile User Guide 29

Copyright © 2021 SugarCRM All Rights Reserved.

2 Installing and Configuring wMobile

This section and its sub-sections discuss: pre-installation requirements, installation, how-

to's, and post installation:

1. How to check that the server(s) you are installing on meet all the prerequisites.

2. How to install or upgrade wMobile.

3. How to configure wMobile using the wMobile Manager Console.

2.1 Pre-Installation Checklist (System Requirements)

  IMPORTANT: Before starting a new wMobile installation or upgrading an existing

previous version of wMobile to the latest version, please be sure that your system's

environment meets the minimum hardware and software requirements.

By verifying all the items on the list, you are ensuring that your installation of wMobile will

be successful. If you are unsure about anything on the list, the 'How do I...' and

'Discussion...' links in the 'See Also' section for each item will help you check, complete

or understand any requirement on the list.

 NOTE: Unless specifically stated, restarting the server will NOT BE required when

installing any of the prerequisites.

q Operating System Requirements:

· Verify that the server(s) on which you are installing wMobile on have the following

minimum operating system requirements: 

§  Windows Small Business Server 2011 [64-bit (x64) processor]

§ Windows Server 2012 (All Editions) [64-bit (x64) processor]

§ Windows Server 2016 (All Editions) [64-bit (x64) processor]

§ Windows Server 2019 (All Editions) [64-bit (x64) processor]

· See Also:

o How do I check if my server meets the Operating System requirements?

q GoldMine Version Requirements:
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· Verify that the GoldMine version meets the minimum requirements:

o GoldMine Corporate

§ GoldMine Corporate Edition, Version 7.0 or higher.

o GoldMine Premium

§ GoldMine Premium Edition, Version 8.0 or higher.

§ GoldMine Premium Edition, Version 9.0 or higher. 

§ GoldMine 2013.x, 2014.x, 2015.x, 2016.x, 2018.x, 2019.x

· See Also:

o How do I check my GoldMine version?

q GM.INI Settings:

· Verify that the 'SysDir' setting in the GM.INI file does not point to a mapped driver letter.

· See Also:

o How do I check my GM.INI file for a Mapped Drive Letter?

o How do I determine if the SYSDIR path in the GM.INI file is a mapped drive letter?

o What is a Mapped Driver Letter?

o Discussion: GM.INI Settings

q .NET Framework:

  IMPORTANT: Installing .NET Framework

If .NET Framework v4.7.2 or higher is not detected, the wMobile 5.0 installer will

provide options to download it from the wMobile or Microsoft server. 

.NET Framework 4.7.2 can be installed on the following operating systems:

§ Windows Small Business Server 2011 [64-bit (x64) processor]

§ Windows Server 2012 (All Editions) [64-bit (x64) processor]

§ Windows Server 2016 (All Editions) [64-bit (x64) processor]

§ Windows Server 2019 (All Editions) [64-bit (x64) processor]

https://docs.microsoft.com/en-us/dotnet/framework/get-started/system-requirements


Instal l ing and Configuring wMobilewMobile User Guide 31

Copyright © 2021 SugarCRM All Rights Reserved.

The .NET Framework install often requires a server reboot. The .NET Framework

installations should be performed on the server "prior" to running the wMobile

installer. 

o How to Install .NET Framework

 NOTE: When the wMobile installer is started, it will determine if the required .NET

Framework version is missing and if so, prompt the user to install it. After the user is

prompted the installer will close.

· See Also:

o How do I check if I have .NET Framework installed?

q Internet Information Services (IIS):

· Verify that you have Internet Information Services (IIS) installed on the Web Server.

Please check the screenshots for your server version to confirm that you have all the

prerequisite roles and features installed.

· See Also:

o How do I verify that IIS and required Roles and Features are installed?

q ASP.NET 4.0:

· Verify that ASP.NET 4.0 is installed on the Web Server.

· See Also:

o How do I verify that ASP.NET is installed?

q SQL Server Login Credentials:

· Verify or create a SQL username and password that is mapped to the GoldMine database

and has 'db_owner' role membership.
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NOTE: wMobile will create objects in the GoldMine database. The 'db_owner' role is

required to create these objects and for wMobile to work properly.

· See Also:

o How do I check for database mapping and role membership?

o How do I create a SQL user?

o How do I set Permissions?

q Open Port(s) In The Firewall:

· Verify that ports have been opened from the firewall to the Web Server.

· See Also:

o Discussion: Opening ports in the firewall for wMobile

2.1.1 Checking Operating System Requirements

Determining an Operating System's Version

· On Any Version of Windows if "My Computer" is on the desktop

1. Right-click on My Computer and click Properties.

2. The Windows Edition should be displayed in the first section.

· On Any Version of Windows if "My Computer" is not on the desktop

1. Click on Start or use the Windows Logo Key   on the keyboard. 

2. Right-click on Computer in Windows Explorer and click Properties.

3. For Windows Server 2012 the version of Windows will be displayed under the
Windows edition (the first section) and System sections (the second section) of
System window. The System window will be the first window that is displayed.

4. For Windows Server 2016 and Windows Server 2019, open the Start menu. Right
click on This PC and select Properties.

  TIP: Alternate Method

To determine the version of:
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· Windows Server 2012, 2016, 2019: Use Search, type in winver, and then click winver

where the search results are displayed.

 NOTE: The <Windows Logo Key  + R> keyboard combination will open the Run

dialog on all versions of Windows.

Return to the Pre-Installation Checklist

2.1.2 How To Check GoldMine Version

· For Any Edition of GoldMine

1. Open GoldMine and login.

2. On the main menu, click Help and select About or About GoldMine...

3. The GoldMine edition and version information will be displayed on the About
GoldMine window. 

Return to the Pre-Installation Checklist

2.1.3 Checking GoldMine Database

· In Any Edition of GoldMine

1. Open GoldMine and login.

2. Click on Help and select About or About GoldMine...

3. Click System.

4. Look for GoldMine Files and Contact Files under the Description column.

5. Note the values for GoldMine Files and Contact Files as this information will be
needed during the wMobile installation.

Return to the Pre-Installation Checklist

2.1.4 How Do I Check My GM.INI

· In Any Edition of GoldMine

1. Open GoldMine and login.

2. Click on Help and select About or About GoldMine...
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3. Click System.

4. Look for System Files under the Description column and make a note of the path
designated in the value column.

5. In My Computer/Computer, browse to the path of the System Files.

6. Once you have navigated to the path, open the file named GM.INI.

7. In GM.INI, look for a setting called SysDir.

8. Make a note of the value following SysDir=.

9. If the value begins with "\\", then the GM.INI is using a UNC path to find the
GoldMine system files.
NOTE: wMobile will be able to find the GoldMine system files using a UNC path.
No changes are needed to achieve a successful wMobile installation.

10. If the value begins with a letter, then there is a possibility that the GM.INI is using a
mapped drive letter to find the GoldMine System Files. Refer to the topic on
determining if a Drive letter is a mapped drive. 

NOTE: In the case of a mapped drive, it must be configured in the wMobile
Manage Console Virtual File System (VFS) Settings after installation to ensure
access to GoldMine files (such as the license, executable and dll files) as well as
documents. 

Return to the Pre-Installation Checklist

2.1.4.1 What is a Mapped Drive Letter

A mapped drive letter is the way of associating a letter assignment with either a shared a

shared folder on another computer (its most common usage) or even on the local

machine. When a drive is mapped, GoldMine or the user can read and write files by

accessing that drive letter, just as if that drive represented a local physical hard disk drive

on the workstation or server.

Consider the following:

A server named GMSERVER has a folder called Apps on the C:\ drive. It is shared as Apps.

Therefore, to access the folder from the network, a user would type \\GMSERVER\Apps in

the address bar of a window. Since the Apps folder is shared, it can be mapped as a drive

letter. For this example, we will assume that \\GMSERVER\Apps is mapped to the G:\ drive

letter on a user's computer.

Any folder under \\GMSERVER\Apps (Quickbooks, GoldMine, or any other application) is

seen from the workstation on the G:\ drive instead of on the Apps folder on \\GMSERVER.

However, the locations are the same. So if a user types either \
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\GMSERVER\Apps\GoldMine or G:\GoldMine in the address bar of a window, they will be

taken to the same location.

The important thing to remember with mapped drive letters is that they are specific to a

given user and are often assigned through a login script or manually assigned in Windows. 

Service accounts or the Local System account cannot access mapped drive letters. Any

service using the Local System account should use the local path (in this example, C:

\Apps) in place of the mapped drive letter, if possible. Any service using a Service Account

can use either the local path (in this example, C:\Apps) or the UNC path (in this example,\

\GMSERVER\Apps) in place of the mapped drive letter. In wMobile 3.0 or above, the Virtual

File System (VFS) Settings in the wMobile Manager Console can be used to configure a

translation for drive mapped paths that are not normally accessible by the Local System

account. 

Return to the Pre-Installation Checklist

2.1.4.2 Discussion: GM.INI Settings

· The Use of GM.INI settings in the Remote GoldMine Service

The GM.INI is a global settings file that helps GoldMine determine (among many other

things) where data is located. When the GoldMine API is loaded, it reads the GM.INI and

feeds several important pieces of information to the Remote GoldMine Service (RGMS):

What database alias contains the GoldMine contact set. This is the COMMONDIR setting

in the GM.INI.

What database alias contains the common GoldMine database tables. This is the

GOLDDIR setting in the GM.INI.

Where the GoldMine System Files (such as the license file and the GoldMine's program

files) are located. This is the SYSDIR setting in the GM.INI.

The Remote GoldMine Service takes these values and attempts to log into GoldMine using

whatever username and password is supplied by the user from either the wMobile

Manager Console or from the wMobile Login Page.

· The Use of SYSDIR in GoldMine Corporate Edition 7.x and GoldMine Premium Edition
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Generally speaking, the SYSDIR setting can cause the most difficulty with a wMobile

installation. This setting is often used to enforce where a workstation will find GoldMine's

program files, where it can find the default locations of Reports and Templates as well as

the default locations for linked documents and e-mail attachments. If this setting is not

present, then GoldMine will use the path it was started from to determine the SYSDIR

location.

Consider the following: Scenario 1:

GoldMine is installed on a server called GMSERVER.

The GoldMine folder is shared on the \\GMSERVER\Apps\ UNC path in the GoldMine

folder.

The G: Drive is mapped to \\GMSERVER\APPS

The GM.INI has NO SYSDIR setting.

If the shortcut to GoldMine on my desktop points to \

\GMSERVER\APPS\GoldMine\gmw.exe, since there is NO SYSDIR in the GM.INI, then

GoldMine will assume that my SYSDIR is: \\GMSERVER\APPS\GoldMine.

If the shortcut to GoldMine on my desktop points to G:\GoldMine\gmw.exe, since there is

NO SYSDIR in the GM.INI, then GoldMine will assume that my SYSDIR is G:\GoldMine.

Consider the following: Scenario 2:

GoldMine is installed on a server called GMSERVER.

The GoldMine folder is shared on the \\GMSERVER\Apps\ UNC path in the GoldMine

folder.

The G: Drive is mapped to \\GMSERVER\APPS

The GM.INI has SYSDIR set to G:\GoldMine.

If the shortcut to GoldMine on my desktop points to \

\GMSERVER\APPS\GoldMine\gmw.exe and the SYSDIR in the GM.INI points to G:

\GoldMine, then my SYSDIR will be G:\GoldMine.

If the shortcut to GoldMine on my desktop points to G:\GoldMine\gmw.exe which matches

the SYSDIR in the GM.INI, then GoldMine make my SYSDIR G:\GoldMine.

In Scenario 1, since there is no SYSDIR, GoldMine will assume that the SYSDIR is the path

from where I am starting GoldMine. If its a UNC path, then my SYSDIR becomes a UNC

path. If its a mapped drive letter, then my SYSDIR becomes a mapped drive letter. In
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Scenario 2 the GM.INI contains a SYSDIR, so no matter where I start GoldMine from, the

setting ensures that the SYSDIR will be G:\GoldMine.

Since the SYSDIR setting can be either a mapped drive letter OR a UNC path, we

recommend that the setting be removed from the GM.INI and that all workstations use the

method for determining the SYSDIR outlined in Scenario 1. In this case, all users should

start GoldMine from the same path to ensure that GoldMine uses to the correct SYSDIR

for all users.

· Final Notes on Changing Paths in the GM.INI

If there is a requirement that the GM.INI SYSDIR value must be set as a UNC path, this may

cause a problem for remote users running the GoldMine spell checking (e.g., remote Citrix

users).

To correct this add/edit the following in the GM.INI file's [GoldMine] section to use

mapped drive path to avoid problems with GoldMine's speller:

[GoldMine]

SSCE_PATH=speller

SSCE_PATH=(GOLDMINE_ROOT_FOLDER)\speller\ssce_lex\ssceam.tlx

SSCE_PATH=(GOLDMINE_ROOT_FOLDER)\speller\ssce_lex\ssceam2.clx

Example:

SSCE_PATH=D:\Apps\GoldMine\speller\ssce_lex\ssceam.tlx

SSCE_PATH=D:\Apps\GoldMine\speller\ssce_lex\ssceam2.clx

Return to the Pre-Installation Checklist

2.1.4.3 How Do I Determine if a Drive Letter is a Mapped Drive

· In Any Version of Windows

1. Double-click on My Computer.

2. Find the drive letter from the value in SYSDIR referenced in the GM.INI file.
Example: If SYSDIR=W:\GoldMine, then you will need to right-click on the drive
letter W:.

3. Right-click on the drive and select Properties.

4. Check the Type on the General tab.

5. If the Type is Network Drive, then the drive letter is a mapped drive.
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6. If the Type is Local Disk, then the drive letter is NOT a mapped drive.

Return to the Pre-Installation Checklist

2.1.5 Checking if .NET Framework is Installed

The wMobile installer determines if the required .NET Framework is installed on your

server(s): GoldMine and Web. Please see .NET Framework requirements for details.

Determine Which .NET Framework Version(s) Are Installed 

To find .NET Framework versions by viewing the registry:

1.  Click on the Start menu or use the Windows Logo Key   on the keyboard. 

2.   Enter regedit.exe.Select regedit from the resulting list.

You must have administrative credentials to run regedit.exe.

3.  In the Registry Editor, open the following subkey:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Framework Setup\NDP\v4\Full

  NOTE: The "NET Framework Setup" folder in the registry does not begin with a

period.

Check for a DWORD value named Version.

  NOTE: If the Full subkey is not present, then you do not have a the .NET Framework

installed.
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See Also:

§ How To Download and Install .NET Framework 

Return to the Pre-Installation Checklist

2.1.5.1 How To Instal l  .NET Framework

Downloading and Installing .NET Framework

.NET Framework 4.7.2 can be installed on the following operating systems:

§ Windows Small Business Server 2011 [64-bit (x64) processor]

§ Windows Server 2012 (All Editions) [64-bit (x64) processor]

§ Windows Server 2016 (All Editions) [64-bit (x64) processor]

§ Windows Server 2019 (All Editions) [64-bit (x64) processor]

wMobile 5.x has a prerequisite for .NET Framework v4.7.2 (or higher). If the installer

detects that this is not installed, it will present options to download from the wMobile or

Microsoft Server:

Once the installer is downloaded, select the option to Run the install.
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Accept the license agreement:
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The installation wizard will proceed.
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It is likely that a server reboot will be required. In this case, the restart can be done

immediately or at a later time. The wMobile installer will not recognize the installation

until a reboot is completed. 

After restarting the server, run the previously downloaded wSetup.exe file again. 

Return to the Pre-Installation Checklist
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2.1.6 How To Verify IIS and Required Roles and Features are Installed

To determine if IIS is installed, do the following on the Web Server:

· For All Versions of Windows

1. Click Start > Run (or <Windows Logo Key  + R>). 

2. In the Open box, type regedit and then click OK.

3. Navigate to the following key in the registry:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\InetStp

4. There should be an entry named: VersionString containing a value.

5. If the registry key and VersionString entry is present, then IIS is installed.

· See the link below for screenshots of the required roles and features on your server

operating system:

§ How To Install IIS on Windows Server 2019 (All Editions)

§ How To Install IIS on Windows Server 2016 (All Editions)

§ How To Install IIS on Windows Server 2012 (All Editions)

Return to the Pre-Installation Checklist

2.1.6.1 How To Instal l  IIS On Windows Server 2019 (All Editions)

Installing IIS on Windows Server 2019

1. Open Server Manager by clicking the Server Manager icon on the desktop.

2. In the Server Manager window, with the Dashboard and Quick Start selected, click Add
roles and features, or click the Manage menu, and then click Add Roles and Features.
The Add Roles and Features Wizard will start with a Before You Begin page. The wizard
asks for verification of the following:

· The administrator account has a strong password.

· The network settings, such as IP addresses, are configured.

· The most current security updates from Windows® Update are installed.

3. On the Before You Begin page, click Next.

4. On the Installation Type page, select Role-based or feature-based installation to
configure a single server. Click Next.
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5. On the Server Selection page, select Select a server from the server pool, and then
select a server; or select Select a virtual hard disk server, select a server to mount the
VHD on, and then select a VHD file. Click Next.

6. On the Server Roles page, select Web Server (IIS).
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7. Select Add Features  when prompted. 

8. Clck Next to proceed.

9. On the Features page, select the .NET Framework 4.7 and ASP.NET features below if
they are not already installed, and any others you'd like to install. Click Next to
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continue. 

10.On the Web Server Role (IIS) page, click Next.

11.On the Role Services page, be sure these specific roles (designated below in red) are
"checked."
If you select a role service that requires other role services or features to be installed, a
page will be opened indicating the role services or features to be installed. Leave
Include management tools (if applicable) selected to select the install management
tools associated with the server role. You may not need the management tools on the
destination server if you plan to manage the role remotely. Click Add Features to add
the required role services or features. Click Next when all desired selections have been
checked.
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12.On the Confirmation page, verify the role services and features that are selected. Select
Restart the destination server automatically if required to restart the destination server
if the settings need to take immediate effect. To save the configuration information to
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an XML-based file that you can use for unattended installations with Windows
PowerShell, select Export configuration settings, move to the appropriate path in the
Save As dialog box, enter a file name, and then click Save.
When you are ready to start the installation process on the Confirmation page, click
Install.

13.The Installation Progress page is displayed. You can close the wizard without
interrupting running tasks. You can view task progress or open the page again by
clicking Notifications in the notification area, and then clicking Task Details.

14.On the Results page, verify that the installation succeeds, and then click Close.

15.Confirm that the Web server works by opening a web browser, and verifying that the
default web page is displayed when you use the http://localhost address.

Return to the Pre-Installation Checklist

2.1.6.2 How To Instal l  IIS On Windows Server 2016 (All Editions)

Installing IIS on Windows Server 2016

1. Open Server Manager by clicking the Server Manager icon on the desktop.

2. In the Server Manager window, with the Dashboard and Quick Start selected, click Add
roles and features, or click the Manage menu, and then click Add Roles and Features.
The Add Roles and Features Wizard will start with a Before You Begin page. The wizard
asks for verification of the following:

· The administrator account has a strong password.

· The network settings, such as IP addresses, are configured.

· The most current security updates from Windows® Update are installed.

3. On the Before You Begin page, click Next.

4. On the Installation Type page, select Role-based or feature-based installation to
configure a single server. Click Next.

5. On the Server Selection page, select Select a server from the server pool, and then
select a server; or select Select a virtual hard disk server, select a server to mount the
VHD on, and then select a VHD file. Click Next.

6. On the Server Roles page, select Web Server (IIS).

7. In the Add Roles and Features wizard, click Add Features to install the IIS Management
Console, and then click Continue.

8. On the Server Roles page, be sure these specific roles (designated below in red) are
"checked" and then click Next.
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9. On the Features page, select any features that you would like to install, and then click
Next. Note that you do not need to select any features on this page to install IIS. IIS
setup will select the features that are required.

10.On the Web Server Role (IIS) page, click Next.
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11.On the Role Services page, select any additional role services that you want to install.

12.If you selected a role service that requires other role services or features to be
installed, a page will be opened indicating the role services or features to be installed.
Leave Include management tools (if applicable) selected to select the install
management tools associated with the server role. You may not need the management
tools on the destination server if you plan to manage the role remotely. Click Add
Features to add the required role services or features.

13.After you have added the role services that you need on the Role Services page, click
Next.

14.On the Confirmation page, verify the role services and features that are selected. Select
Restart the destination server automatically if required to restart the destination server
if the settings need to take immediate effect. To save the configuration information to
an XML-based file that you can use for unattended installations with Windows
PowerShell, select Export configuration settings, move to the appropriate path in the
Save As dialog box, enter a file name, and then click Save.
When you are ready to start the installation process on the Confirmation page, click
Install.

15.The Installation Progress page is displayed. You can close the wizard without
interrupting running tasks. You can view task progress or open the page again by
clicking Notifications in the notification area, and then clicking Task Details.

16.On the Results page, verify that the installation succeeds, and then click Close.

17.Confirm that the Web server works by opening a web browser, and verifying that the
default web page is displayed when you use the http://localhost address.

Return to the Pre-Installation Checklist

2.1.6.3 How To Instal l  IIS On Windows Server 2012 (All Editions)

Installing IIS on Windows Server 2012

1. Open Server Manager by clicking the Server Manager icon on the desktop.

2. In the Server Manager window, with the Dashboard and Quick Start selected, click Add
roles and features, or click the Manage menu, and then click Add Roles and Features.
The Add Roles and Features Wizard will start with a Before You Begin page. The wizard
asks for verification of the following:

· The administrator account has a strong password.

· The network settings, such as IP addresses, are configured.

· The most current security updates from Windows® Update are installed.

3. On the Before You Begin page, click Next.
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4. On the Installation Type page, select Role-based or feature-based installation to
configure a single server. Click Next.

5. On the Server Selection page, select Select a server from the server pool, and then
select a server; or select Select a virtual hard disk server, select a server to mount the
VHD on, and then select a VHD file. Click Next.

6. On the Server Roles page, select Web Server (IIS).

7. In the Add Roles and Features wizard, click Add Features to install the IIS Management
Console, and then click Continue.

8. On the Server Roles page, be sure these specific roles (designated below in red) are
"checked" and then click Next.

Common HTTP Features:

Health and Diagnostics:

Performance
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Security

Application Development

Management Tools
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9. On the Features page, select any features that you would like to install, and then click
Next. Note that you do not need to select any features on this page to install IIS. IIS
setup will select the features that are required.

10.On the Web Server Role (IIS) page, click Next.

11.On the Role Services page, select any additional role services that you want to install.

12.If you selected a role service that requires other role services or features to be
installed, a page will be opened indicating the role services or features to be installed.
Leave Include management tools (if applicable) selected to select the install
management tools associated with the server role. You may not need the management
tools on the destination server if you plan to manage the role remotely. Click Add
Features to add the required role services or features.

13.After you have added the role services that you need on the Role Services page, click
Next.

14.On the Confirmation page, verify the role services and features that are selected. Select
Restart the destination server automatically if required to restart the destination server
if the settings need to take immediate effect. To save the configuration information to
an XML-based file that you can use for unattended installations with Windows
PowerShell, select Export configuration settings, move to the appropriate path in the
Save As dialog box, enter a file name, and then click Save.
When you are ready to start the installation process on the Confirmation page, click
Install.

15.The Installation Progress page is displayed. You can close the wizard without
interrupting running tasks. You can view task progress or open the page again by
clicking Notifications in the notification area, and then clicking Task Details.

16.On the Results page, verify that the installation succeeds, and then click Close.

17.Confirm that the Web server works by opening a web browser, and verifying that the
default web page is displayed when you use the http://localhost address.

Return to the Pre-Installation Checklist

2.1.7 SQL Server - Creating a New SQL User

This action is performed on the SQL Server that hosts GoldMine's database.

To create a new SQL User, do the following:

1.  Open SQL Server Management Studio.

2.  Login as either sa or Administrator (or a user with equivalent privileges).

3.  Expand the Security folder.

4.  Expand the Logins folder.
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5.  Right-click on the Logins folder and select New Login.

6.  Provide a Login name in the Login name field.

7.  Select SQL Server authentication.

8.  Provide a password in the Password and Confirm password fields. The password
complexity requirements include that the password is at least 8 characters long and
contains upper case letters, lower case letters, a number (0-9), and/or a non-alpha
character such as an exclamation point (!), dollar sign ($), number sign (#) etc. The
password cannot contain the account name of the user. 

9.  Uncheck the following: Enforce password expiration, and User must change password
at next login.

10.  Click User Mapping.

11.  Click Map next to the GoldMine database in the Users mapped to this login section.

12.  Type dbo in the Default Schema field.

13.  Click db_owner in the Database role membership section.

14.  Click OK.

Return to the Pre-Installation Checklist

2.1.8 SQL Server - Checking For Database Mapping and Role Membership

This check is performed on the SQL Server that host's GoldMine's database.

To check to see what database mappings and roles a username has, do the following:

1. Open SQL Server Management Studio.

2. Login as either sa or Administrator (or a user with equivalent privileges).

3. Expand the Security folder.

4. Expand the Logins folder.

5. Right-click on the SQL User and select Properties.

6. Click on the User Mapping page in the left column.

7. Verify that the Map column checkbox is checked next to the GoldMine database under
the Users mapped to this login list.
NOTE: Your database name might be different than the database alias name in
GoldMine.

8. Verify that the db_owner checkbox is checked in the Database role membership
section.
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Return to the Pre-Installation Checklist

2.1.9 Creating a Service Account

This action is performed on the GoldMine Server.

To create a Service Account for wMobile, do the following:

· For Servers or Computers that *ARE NOT* part of an Active Directory:

1. Right-click on My Computer.

2. Select Manage.

3. Expand Configuration.

4. Expand Local Users and Groups.

5. Click on Users.

6. Right-click on the Users folder and select New User. 

7. Provide a logon name in the User name field.

8. Provide a full name in the Full name field. 

9. Provide a password in the Password and Confirm password fields.

10. Tick the Password never expires check box.

11. Click Create.

· For Servers or Computers that *ARE* part of an Active Directory:

1. Log into Domain Controller as a Domain Administrator.

2. Click on  Start > Settings > Control Panel.

3. Double-click on Administrative Tools.

4. Double-click on Active Directory Users and Computers.

5. Expand the Domain object.

6. Right-click the Users folder. 

7. Select New User. 

8. Provide a first name in the First name field.
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9. Provide a last name in the Last name field.

10. Provide a logon name in the User name field.

11. Click Next. 

12. Provide a password in the Password and Confirm password fields.

13. Tick the Password never expires check box.

14. Click Next. 

15. Click Finish. 

Return to the Pre-Installation Checklist

2.1.10 How To Set File Permissions

This action is performed on the GoldMine Server.

To Set Permissions on the GoldMine folder for the Service Account, do the following:

· For Servers or Computers that ARE NOT part in an Active Directory

1. Browse to your GoldMine folder.

2. Right-click on the GoldMine folder and select Properties.

3. Click the Security tab.

4. Click Add.

5. Click Advanced.

6. Click Find Now.

7. Locate and double-click on the Service Account. 

8. Click OK.

9. Check the boxes for Modify, Read & Execute, List folder contents, Read and Write under
the Allow column.

10. Click OK.

· For Servers or Computers that ARE part in an Active Directory

1. Browse to your GoldMine folder.

2. Right-click on the GoldMine folder and select Properties.
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3. Click the Security tab.

4. Click Add.
  NOTE: Check to see that the Active Directory Domain is listed in the From this
location box. If it is not, follow steps 4.1 through 4.4:  4.1. Click the Locations button.
  4.2. Expand Entire Directory.
  4.3. Select the Active Directory Domain that contains the Service Account. NOTE: DO
NOT EXPAND the Domain, you simply need to select it.
  4.4. Click OK.

5. Click Advanced.

6. Click Find Now.

7. Locate and double-click on the Service Account. 

8. Click OK.

9. Click the boxes for Modify, Read & Execute, List folder contents, Read and Write under
the Allow column.

10. Click OK.

Return to the Pre-Installation Checklist

2.1.11 Discussion: Service Account vs. Local System Account

Local System Account

By default, the local system account and the local administrator account have the same

file privileges, but they have different functions. Services starting as the local system

account will be given the computers privileges on the network (accessing other computers

AS the computer, instead of as a specific user). The local system account can be

assigned Permissions to files on the local server and, by default, is granted full control

over all the files on the server. It cannot be added to domain user groups. This account

does not recognize mapped drive letters and cannot access most UNC paths (even if the

UNC path is on the local machine). When the Remote GoldMine Service is installed, this is

the default user. If this user is selected as the account to run the Remote GoldMine

Service, any files (including the GoldMine folder or any linked documents) that are on a

UNC path will not be accessible in wMobile.

Service Account

A service account is a user account that is created with the sole purpose of providing a

specific security context to a service when the service is running. As opposed to the local
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system account, which acts as the server itself, a service account can be given access

and permissions on UNC paths on a different computer and can be assigned to user

groups on a Windows Domain. A service account does not recognize mapped drive letters.

A service account can be specified when installing the Remote GoldMine Service. The

Remote GoldMine Service can also be reconfigured with a service account at a later time

in the Services panel if an account is not available at install time.

For creating a service account, see: Creating a Service Account

Return to the Pre-Installation Checklist

2.1.12 Discussion: Opening Ports in the Firewall

Generally speaking, the following ports need to be opened for wMobile to be accessed

from the Internet:

· Scenario 1: GoldMine Server, SQL Server and Web Server are behind the same firewall.

· With No SSL Certificate (Provides basic Non-Encrypted Communication between the

Mobile Device and the Web Server)

oTCP Port 80 from the Internet to the Web Server.

oWith an SSL Certificate (Provides Encrypted Communication between the Mobile

Device and the Web Server)

§ TCP Port 443 from the Internet to the Web Server.

· Scenario 2: GoldMine Server and SQL Server are behind a firewall, the Web Server is in a

DMZ

oFrom the Web Server in the DMZ to the GoldMine Server

§ TCP Ports 8085 and 2121

oFrom the Web Server in the DMZ to the SQL Server

§ TCP Port 1433

oWeb Server to the Internet

§ With No SSL Certificate (Provides basic Non-Encrypted Communication between the

Mobile Device and the Web Server)
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vTCP Port 80 from the Internet to the Web Server.

§ With an SSL Certificate (Provides Encrypted Communication between the Mobile

Device and the Web Server)

vTCP Port 443 from the Internet to the Web Server.

· Scenario 3: GoldMine Server, SQL Server and Web Server are behind the same firewall.

Customer has Blackberry Enterprise Server

oNo open ports required. wMobile will be shared automatically through BES.

· Scenario 4: GoldMine Server, SQL Server and Web Server are behind the same firewall

with Port Redirection.

oWith No SSL Certificate (Provides basic Non-Encrypted Communication between the

Mobile Device and the Web Server)

§ Any TCP port from the Internet to TCP Port 80 on the Web Server (Assuming IIS is

configured to use TCP Port 80 for non-SSL requests).

oWith an SSL Certificate (Provides Encrypted Communication between the Mobile

Device and the Web Server)

§ Any TCP Port from the Internet to TCP Port 443 on the Web Server (Assuming IIS is

configured to use TCP Port 443 for SSL requests).

  IMPORTANT: For Blackberry Owners Only: The standard browser that comes

installed on the Blackberry does not support accessing websites on TCP ports other

than 80 or 443. If you own a Blackberry and do not own a Blackberry Enterprise Server,

then you must configure your firewall to allow access to wMobile on TCP Port 80 for

Non-SSL traffic or TCP Port 443 for SSL traffic.

Return to the Pre-Installation Checklist

2.1.13 Use of SSL Certificate

Using an SSL certificate with the HTTPS (Hypertext Transfer Protocol Secure) protocol

provides encrypted communication between the mobile device and the Web Server. If a

customer wishes to use the HTTPS (Hypertext Transfer Protocol Secure) protocol, they must

obtain and install an SSL certificate in IIS. SSL certificates can be obtained from certificate
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authorities such as Go Daddy, DigiCert, Global Sign, etc. (Note: wMobile does not endorse

any particular certificate authority.)

A customer can also create a self-signed (free) certificate. These certificates are easy to

generate, but do not provide the security of a certificate signed by a certificate authority. Since

anyone can generate a self-signed certificate, there's no real guarantee you're connecting to

the intended server. Another downside of self signed certificates is that people (your wMobile

end users) who visit a website using a self-signed certificate will see a warning in their

browser that the certificate was not issued by a certificate authority. There are many websites

that provide information on creating self-signed certificates, including this Microsoft reference:

https://support.microsoft.com/en-us/help/228991/how-to-create-and-install-an-ssl-certificate-

in-internet-information-s

wMobile Phone and Desktop components can be installed using the Advanced Installation

method in order to select the HTTPS protocol.

If wMobile is already installed, and a change to HTTPS is needed, please contact

goldminesupport@sugarcrm.com for assistance. The steps will vary depending upon existing

installation configuration.

2.1.14 How To Verify ASP.NET Is Installed and Enabled

This check is performed on the Web Server. 

To check to see if ASP.NET 4.0 is installed and registered with IIS, do the following:

· For All Versions of Windows

1. Click Start and then click Run. 

2. In the Open box, type Regedit and then click OK. 

3. Look for the following key in the registry:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\ASP.NET\4.0.30319.0

4. With the 4.0.30319 key selected in the left-hand window, look for the DllFullPath entry
in the right-hand window.

5. If the DllFullPath entry is present and has a path value in the Data column, then
ASP.NET is installed and registered with IIS.

https://support.microsoft.com/en-us/help/228991/how-to-create-and-install-an-ssl-certificate-in-internet-information-s
https://support.microsoft.com/en-us/help/228991/how-to-create-and-install-an-ssl-certificate-in-internet-information-s
mailto:goldminesupport@sugarcrm.com
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· ASP.NET is a component of the .NET Framework. If ASP.NET is not installed, see the

section on How to Install .NET Framework.

In IIS 6, check to verify that ASP.NET 4.0 is enabled. (In IIS 7/8, the ASP.NET version is set

per application pool, so this check is not applicable.)

1. Click Start and then click Run. 

2. In the Open box, type inetmgr and then click OK. This will open IIS.

3. Click on the + sign to expand the server to display the Application Pools, Web Sites
and Web Service Extensions folders. 

4. Select Web Service Extensions. 

5. Verify that ASP.NET v4.0.30319 listed on the right has a status of Allowed. If not,
right click on it and set it to Allow as shown below.

Return to the Pre-Installation Checklist

2.2 Installation

Verify the Installation Requirements

Please review the Pre-Installation Checklist before starting a new wMobile installation or

upgrading an existing previous version of wMobile to the latest version to be sure that

your environment meets the minimum hardware and software requirements.



Instal l ing and Configuring wMobilewMobile User Guide 62

Copyright © 2021 SugarCRM All Rights Reserved.

2.2.1 Preparing for Installation

wMobile Components
There are eight (8) main components to wMobile:

.NET Framework 4.7.2 (or higher)
The .NET Framework is a prerequisite for wMobile 5.x. It will need to be installed on

the server prior to installing wMobile. If you will be implementing a split install (with

the Remote GoldMine Service on one server and the other components on a web

server) the .NET Framework will be required on both servers.

Remote GoldMine Service (RGMS)

The Remote GoldMine Service provides communication between wMobile and

GoldMine. The Remote GoldMine Service can be installed on the GoldMine server or on

the IIS server (Web server), provided GoldMine can be accessed by a network share if it

is not installed on the same server. This service is used for logins.

wMobile Phone Edition 

This component is the web application you view when you connect to wMobile from a

web browser on your PDA such as Blackberry, iPhone, Droid, etc. The wMobile Phone

Edition component is installed on the server running IIS.

wMobile Desktop Edition 

This component is the web application you view when you connect to wMobile from a

web browser on a workstation, laptop, iPad, or tablet. The wMobile Desktop

component is installed on the server running IIS.

wMobile Email Fetcher Service
This component fetches email for wMobile and handles email processing.

wMobile Manager Console
The wMobile Manager Console is a tool that provides administrators with the ability to

customize wMobile's menus, security, user email accounts, and application settings.

This is a Windows application and is always installed on the same server as wMobile.

Crystal Report Runtime Engine
This a required component for wMobile Desktop Edition. It is installed on the IIS server

along with the wMobile Desktop component. 

wMobile Diagnostics Installer
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The wMobile Diagnostics tool is used to diagnose problems if wMobile is not working

correctly and optionally send diagnostics logs to wMobile Support as required. If you

will be implementing a split install  (with the Remote GoldMine Service on one server

and the other components on a web server) we recommend that you install the

wDiagnostic component on BOTH servers.

PLEASE READ BEFORE STARTING INSTALLATION

1.  Verify your system meets the all of the system requirements by referring to the Pre-

Installation Checklist.

2.  Check the GM.INI file in the GoldMine root directory and ensure that, if present, the
SYSDIR setting is set to a Mapped Drive, Universal Naming Convention (UNC) path
using the server name, or a local path. 

3.  In the case of a mapped drive, it must be configured in the wMobile Manage
Console Virtual File System (VFS) Settings after installation to ensure access to
GoldMine files (such as the license, executable and dll files) as well as documents. 

4.  In the case of a UNC path, you might need to change the service user for the
Remote Login Service following the installation of the Remote GoldMine Service.
This service user must have read/write access to GoldMine's network share (for
more information on service accounts see: Service Account vs. Local System
Account). 

5.  If required, the wMobile Download Manager will install all of the prerequisites first
and then install the application components. Save time by downloading and
installing the prerequisites before installing wMobile.

6.  Ensure that TCP Port 80 or TCP Port 443 has been redirected in your firewall to your

Web server to allow access to wMobile from outside of your network.

7.  If you wish to use the HTTPS protocol, a certificate should be obtained and

installed in IIS on the web server hosting wMobile.

2.2.2 Installation Scenarios for wMobile

Installing wMobile on the GoldMine Server (Single Server Installation)

Scenario: You have a single server that hosts GoldMine and IIS.
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NOTE: Ensure that your server meets both the GoldMine and Web Server Requirements.

On the Server

Installed by an admin user on server:

Prerequisites (Installed only if needed):

· .NET Framework 4.7.2 (or higher) (This installation may require a server restart

depending on components installed.)

Required:

· IIS (Please confirm that the required roles and services are installed for your server

version.)

· ASP.NET

Installed by wMobile Setup:

wMobile Components:

· Remote GoldMine Service

· wMobile Phone Edition

· wMobile Desktop Edition

· wMobile E-mail Fetcher

· wMobile Manager Console

· Crystal Reports Runtime files

· wMobile Diagnostics Installer

Installing wMobile on a Separate Web Server (Split Server Installation)

Scenario: You have a GoldMine server, but you want to host IIS on a different server.

On the GoldMine Server

Installed by an admin user on server:

Prerequisites (Installed only if needed):

· .NET Framework 4.7.2 or higher (This installation may require a server restart

depending on components installed.)



Instal l ing and Configuring wMobilewMobile User Guide 65

Copyright © 2021 SugarCRM All Rights Reserved.

Installed by wMobile Setup:

wMobile Components:

· Remote GoldMine Service

· wDiagnostics

On the Web Server

Installed by an admin user on server:

Prerequisites (Installed only if needed):

· .NET Framework 4.7.2 or higher (This installation may require a server restart

depending on components installed.)

· Required:

· IIS (Please confirm that the required roles and services are installed for your server

version.)

· ASP.NET

Installed by wMobile Setup:

wMobile Components:

· wMobile Phone Edition

· wMobile Desktop Edition

· wMobile E-mail Fetcher

· wMobile Manager Console

· Crystal Reports Runtime files

· wMobile Diagnostics

2.2.3 Installing wMobile for the First Time

The wMobile Download Manager will determine if you need to install the various

prerequisites, components and services required for wMobile. In addition, it can also

determine if you are upgrading from a previous version or updating an existing version of

wMobile.
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1. Download the Installer from this link:

http://download.w-systems.com/wmobile/setup/5.1/wsetup.exe. 

Once you click on the link, you'll be prompted to Run or Save. Select Run.

2. Your server will be checked for prerequisites. If any required components are missing,

the installer will inform you. These missing components will need to be installed

separately prior to continuing the wMobile installation. To see a list of prerequisites, see:

Pre-Installation Checklist (System Requirements). Be sure to check the required IIS roles

and features for your server operating system.

3. The wMobile Download Manager application will start. Using the previous section as a

guide, you can determine which component will need to be installed on your server. You

can select or deselect components by clicking the checkbox next the component name.

The Remote GoldMine Service can be installed on the GoldMine server or on the IIS server,

provided GoldMine can be accessed by a network share if it is not installed on the same

server. 

For Single Server Installs:

· Install "all" of the wMobile components.

For Split Server Installs:

· On the GoldMine Server:

o Remote GoldMine Service Installer

o wMobile Diagnostics Installer

http://download.w-systems.com/wmobile/setup/5.1/wsetup.exe
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· On the Web Server:

o wMobile Phone Edition Installer

o wMobile Desktop Edition Installer

o wEmailFetcher Installer

o wMobile Manager Console Installer

o wMobile Diagnostics Installer

o Crystal Reports Runtime Engine

4. When you have selected the appropriate components for your installation type, click

Run.  See related topics for installing each component.

2.2.3.1 Instal l ing the Remote GoldMine Service

How to Install the Remote GoldMine Service

Welcome to the Remote GoldMine Service Setup Wizard.

Click Next to proceed.
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Review the wMobile License Agreement and click I Agree to accept the terms and

continue installing the Remote GoldMine Service.
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Select the installation type Basic or Advanced. 

The Basic option will attempt to auto-detect GoldMine settings. You will still have an

opportunity to select the installation path etc.

The Advanced option shows the same screens, but does not auto-detect any values. All

entries must be made manually. 

The Basic option is recommended. Once you have selected your option, click Next.



Instal l ing and Configuring wMobilewMobile User Guide 70

Copyright © 2021 SugarCRM All Rights Reserved.

The installer will attempt to auto-detect the SQL server information. If it is detected, the

server name and SQL username will be filled in for you. Otherwise, select the server from

the drop-down list or type in the name of the server. (local) may also be used if SQL is

installed on the same server.

Enter the SQL username and password credentials.

 NOTE: The SQL Username must be 'dbo' on the GoldMine database you plan use with

wMobile.

If you don't know the SQL password, another SQL login can be created. See the topic:

Creating a New SQL User.

After the SQL credentials are entered successfully, the SQL databases will be available

from the SQL Database drop-down list. Select the appropriate database and click Next.

 TIP: If the SQL Database drop-down list does not contain the list of available

databases, please re-enter the SQL credentials. The SQL Database drop-down list only
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populates after entering valid SQL credentials.

If the installer detects any SQL table names beginning with "WT_", a warning will be

displayed onscreen. If a copy of wMobile was previously installed to the database being

currently installed to, such as from a trial/evaluation, these existing tables will cause a

conflict with the new installation. Any old installations should be uninstalled, or the tables

should be manually removed. wMobile tables that were created as backups (i.e., having

different table names) may exist allowed for the purpose of backing up user settings, and

later restoring into a new/clean installation. In this case, proceed with the new install.
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If you had an old wMobile install or trial from version 1.x or 2.x, remove these files. If you

are migrating wMobile from one server to another, and had wMobile 3.0 or higher installed

on the old server, it's ok to install without deleting these tables to preserve existing

settings. 

A local user account will be created to provide file access. Click Next.

The Remote GoldMine Service installer will attempt to detect the GoldMine version, where

GoldMine is installed, and the database alias(es). Verify or change the settings to match

your environment. This path should be a local or UNC path. 

It is possible that the database alias for the Contact Set and GMBase tables is different

from the SQL database name. Check Help > About GoldMine > System in your GoldMine to

verify the alias(es).

Enter a valid GoldMine username and password. This will be used to check authentication

with the GoldMine API.

You can click Test Settings to verify all the settings. However, the settings will be tested

when you click Next in any case.
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The GoldMine path used for wMobile is added to the server's Environment Variable path.

If the settings tested successfully, click Continue. Otherwise, go back to check the

settings and try again. 
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The default location is in C:\Program Files\W-Systems (or C:\Program Files (x86)\W-

Systems). Click Change to specify a different installation path. 

Click Next to continue.
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Click Install.

Installation may take several minutes to complete. After the product has install, the

Remote GoldMine Service will be started automatically.
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Optionally click the checkbox to Create Start Menu Entries.

Click Finish to complete the installation process.
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2.2.3.2 Instal l ing wMobile Phone Edition

How to Install wMobile

1. Welcome to the wMobile Phone Edition Installer Wizard.

Click Next to continue.
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2. Select the Installation Type:

Select the installation type Basic or Advanced. 

The Basic option will attempt to auto-detect GoldMine settings. You will still have an

opportunity to select the installation path etc.

The Advanced option shows the same screens, but does not auto-detect any values. All

entries must be made manually.

The Basic option is recommended unless you'll need to select the https protocol. 

2.2.3.2.1  Basic

Select the Installation Type: Basic

Basic (Recommended): The Basic installation method attempts to auto-detect settings for

the installer. This installation type provides the option to review installation options and
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make configuration changes.  Used the Advanced method if you need to create a new

website or wish to use the HTTPS protocol. 

 

Review the auto-detected settings. 
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  TIP: Once the GoldMine Server has been filled in, the Get Settings button can be

used to pull SQL Server configuration information from the Remote GoldMine Service

into the wMobile Installer.

Otherwise, enter or adjust the settings manually.The default is to install into the Default

Web Site, but another web site could be created and/or selected. The default port is 80, but

another could be selected if you've created another website with a different port. 

Click Test Settings to verify your settings.

Click Next.

  IMPORTANT: A SQL User with 'dbo' rights to the database used by GoldMine must

be supplied in the SQL User field.
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The default location is in C:\Program Files\W-Systems. Click Change to specify a different

installation path. 

Click Next to continue.

 

On the screen, select the appropriate option for registration status. 

· If this an evaluation license, fill in the number of users you'd like to have evaluating

wMobile.

· If you have an evaluation serial number, select this option and enter the serial number.

· If you have purchased wMobile then enter the wMobile serial number. 

NOTE: If this a re-installation, you would need a new wMobile license. It is not possible to

activate an old wMobile license on a new machine. Email

goldminesupport@sugarcrm.com for a new license. 

mailto:goldminesupport@sugarcrm.com
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Once your selection is made, click Next to proceed.

 

Click Install to complete the installation.
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Optionally check to Create a Desktop shortcut and Create Start Menu Entries.

Click Finish. 
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2.2.3.2.2  Advanced

Select the Installation Type: Advanced

Advanced: This installation mode provides the option to configure installation location

and advanced web settings. This should be used if the application (wMobile) will need to

use its own port, application pool, and/or custom settings. This method also provides the

option to use the HTTPS protocol.

This installation method also provides the option to skip any web configuration. In this

event the web settings would need to be added manually in IIS after the installation. No

web site, virtual directory, or app pool would be defined during the installation.
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The installer will attempt to auto-detect the SQL server.

  TIP: Once the GoldMine Server has been filled in, the Get Settings button can be

used to pull SQL Server configuration information from the Remote GoldMine Service

into the wMobile Installer.

Otherwise, enter the appropriate server values for the SQL server where the GoldMine

database is hosted.

Click Test Settings to verify your settings.

Click Next.

  IMPORTANT: A SQL User with 'dbo' rights to the database used by GoldMine must

be supplied in the SQL User field.
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Select Existing Web Site to use the default web site.
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- or -

Select Create New Web Site and enter the values if you are defining a new web site. The

default port is 8081 but can be changed. 

Note: Using the Advanced install method for both wMobile Phone and wMobile Desktop

would result in two separate websites, requiring separate open ports.  It is possible to

create the website in advance, to be selected for both wMobile Phone and wMobile

Desktop. Another option is to use the Advanced install method for for installing wMobile

Phone into a new website, such as wMobile, then use the basic install method for wMobile

Desktop to install into the same web site. All web apps within the website will inherit the

properties of the web site including the protocol and port.

IP Address/Name - This can be any machine name or IP address. 

Web Site Name -This can be any name; wMobilePhone is a logical name.

Host Header - The Host Header is a name for the web site node. wMobile is a logical

name. It is not a mandatory field.
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Protocol - HTTP is the default setting. HTTPS can be selected as well. If HTTPS is used, it

is recommended to configure a security certificate in IIS after the wMobile installation.

After configuring a certificate to use in IIS, a binding needs to be configured at the root

level (Web Site level), to allow HTTPS protocol usage.

Port - The default port is 8081 but it can be set to use any port above 1024 and below

56000. Be sure that the selected port is available.

 

- or -

Select Skip Web Configuration if you would like to do this in IIS at a later time. No website,

virtual directory, or app pool will be defined.

Click Next to continue.

Select Change to modify the wMobile installation location. Otherwise, click Next to

continue.
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The installation may take several minutes to complete.

 

As with the Basic installation, select the appropriate registration status. 

· If this an evaluation license, fill in the number of users you'd like to have evaluating

wMobile.

· If you have an evaluation serial number, select this option and enter the serial number.

· If you have purchased wMobile then enter the wMobile serial number. 

NOTE: If this a re-installation, you would need a new wMobile license. It is not possible to

activate an old wMobile license on a new machine. Email

goldminesupport@sugarcrm.com for a new license. 

Once your selection is made, click Next to proceed.

mailto:goldminesupport@sugarcrm.com
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Click Install to complete the installation.
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Optionally check to Create a Desktop shortcut and Create Start Menu Entries.

Click Finish. 

 

2.2.3.3 Instal l ing wMobile Desktop Edition

How to Install wMobile Desktop Edition

1. Welcome to the wMobile Desktop Edition Installer Wizard.

Click Next to continue.



Instal l ing and Configuring wMobilewMobile User Guide 92

Copyright © 2021 SugarCRM All Rights Reserved.

2. Select the Installation Type:

Select the installation type Basic or Advanced. 

The Basic option will attempt to auto-detect GoldMine settings. You will still have an

opportunity to select the installation path etc.

The Advanced option shows the same screens, but does not auto-detect any values. All

entries must be made manually.

The Basic option is recommended. Once you have selected your option, click Next.

See the sections below based on the installation type you selected.
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2.2.3.3.1  Basic

Select the Installation Type: Basic

Basic (Recommended): The Basic installation method attempts to auto-detect settings for

the installer. This installation type provides the option to review installation options and

make configuration changes.  Used the Advanced method if you need to create a new

website or wish to use the HTTPS protocol. 
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The installer will attempt to auto-detect the setting from the Remote GoldMine Service

settings if installed on the same server. 

  TIP: Once the GoldMine Server has been filled in, the Get Settings button can be

used to pull SQL Server configuration information from the Remote GoldMine Service

into the wMobile Installer.

Otherwise, enter or adjust the settings manually.

Click Test Settings to verify your settings.

Click Next.

  IMPORTANT: A SQL User with 'dbo' rights to the database used by GoldMine must

be supplied in the SQL User field.
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Select the location where you would like wMobileDesktop installed or leave the default

path. Click Next to continue.
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Setup now has enough information to install wMobile. 

Click Install to begin installation.

The installation may take several minutes to complete.



Instal l ing and Configuring wMobilewMobile User Guide 97

Copyright © 2021 SugarCRM All Rights Reserved.

 

Optionally click the checkboxes to Create Desktop Shortcuts and Create Start Menu

Entries.

Click Finish to complete the installation process. 
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2.2.3.3.2  Advanced

Select the Installation Type: Advanced

Advanced: This installation mode provides the option to configure installation location

and advanced web settings. This should be used if the application (wMobile) will need to

use its own port, application pool, and/or custom settings. This method also provides the

option to use the HTTPS protocol.

This installation method also provides the option to skip any web configuration. In this

event the web settings would need to be added manually in IIS after the installation. No

web site, virtual directory, or app pool would be defined during the installation.
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The installer will attempt to auto-detect the SQL server.

  TIP: Once the GoldMine Server has been filled in, the Get button can be used to pull

SQL Server configuration information from the Remote GoldMine Service into the

wMobile Installer.

Otherwise, enter the appropriate server values for the SQL server where the GoldMine

database is hosted.

Click Test Settings to verify your settings.

Click Next.

  IMPORTANT: A SQL User with 'dbo' rights to the database used by GoldMine must

be supplied in the SQL User field.
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Select Existing Web Site to use the default web site.
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- or - Select Create New Web Site and enter the values if you are defining a new web site.

The default port is 8081 but can be changed.

Note: Using this method for both wMobile Phone and wMobile Desktop will result in two

separate websites.  It is possible to create the website in advance, to be selected for both

wMobile Phone and wMobile Desktop. 

IP Address/Name - This can be any machine name or IP address. 

Web Site Name -This can be any name; wMobileDesktop is a logical name.

Host Header - The Host Header is a name for the web site node. wMobileDesktop is a

logical name. It is not a mandatory field.

Protocol - HTTP is the default setting. HTTPS can be selected as well. If HTTPS is used, it

is recommended to configure a security certificate in IIS after the wMobile installation.

After configuring a certificate to use in IIS, a binding needs to be configured at the root

level (Web Site level), to allow HTTPS protocol usage.
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Port - The default port is 8081 but it can be set to use any port above 1024 and below

56000. Be sure that the selected port is available.

 

- or - click Skip Web Configuration if you would like to do this in IIS at a later time. No

website, virtual directory, or app pool will be defined.

Click Next to continue.

Select Change to modify the wMobile installation location. Otherwise, click Next to

continue.
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Click Install to proceed.

The installation may take several minutes to complete.
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Optionally click the checkboxes to Create Desktop Shortcuts and Create Start Menu

Entries.

Click Finish to complete the installation process.  
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2.2.3.4 Instal l ing the wMobile wEmail Fetcher Service

How to Install the wEmailFetcher

Welcome to the wEmailFetcher Installer Wizard. 

The wMobile E-mail Fetcher service will scan for and download email headers from your

POP3 or IMAP server.



Instal l ing and Configuring wMobilewMobile User Guide 106

Copyright © 2021 SugarCRM All Rights Reserved.

Select the account that will be used to run the Email Fetcher Service. The service can run

using the Local System Account. Optionally, a specific account may be used instead of the

Local System Account by selecting This Account and specifying a Windows username and

password. 

See Also:

  How do I create a Service Account?

  Configuring Access to Linked Documents
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Select the location where you would like the wEmailFetcher installed or leave the default

path. Click Next to continue.
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Click Install to proceed.

The installation may take several minutes to complete.
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Click Finish to complete the installation process.
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2.2.3.5 Instal l ing the wMobile Manager Console

How to Install the wMobile Manager Console

Welcome to the wMobile Manager Console Installer.

Click Next to continue.

Select the location where you would like the wMobile Manager Console installed.

Click Next to continue.
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Setup now has enough information to install the wMobile Manager Console.

Click Install to begin installation.

The installation may take several minutes to complete.
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Optionally, click the checkboxes to Launch wMobile Manager Console, Add Desktop Icon,

and the Add Start Menu Shortcuts.

Click Finish to complete the installation process. 
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2.2.3.6 Instal l ing the wMobile Diagnostics Tool

How to Install the wMobile Diagnostics Tool

Welcome to the Remote GoldMine Service Setup Wizard.

Click Next to proceed.
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The default location is in C:\Program Files\W-Systems. Click Change to specify a different

installation path.

Click Next to continue.
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Click Install to proceed.
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Optionally click the checkboxes to Create Desktop Shortcuts, Create Start Menu Entries,

and Run wMobile Diagnostics.

Click Finish to complete the installation process. 

The wMobile Diagnostics Tool is designed to assist wMobile administrators in identifying

configuration problems with an installation or after a problem has occurred. For more

information about this tool, please see the wMobile Diagnostics Tool topic for details.
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2.2.3.7 Instal l ing the Crystal Reports Runtime Engine

How to Install the Crystal Reports Runtime files

Welcome to the Crystal Reports runtime engine installation Wizard. 

(Note: This component only needs to be installed if users will be running Crystal Reports

from wMobile.)

Click Next to proceed.

NOTE: The installer will download either the 32-bit or 64-bit runtimes as required.
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Review the License Agreement and click I Accept the License Agreement and click Next to

proceed.
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Click Next to install.
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The installation may take several minutes to complete.
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Click Finish to complete the installation process.
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2.2.4 Creating a New Web Site in IIS

Sometimes there are existing websites or restrictions on the Default Web Site (such as on
SBS) when it will be necessary or desired to create a separate web site.

In IIS, right click on Sites and select Add Website. 
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Add the site name such as wMobile. The physical path should be C:\inetpub\wwwroot
because the aspnet_client and other resources are here that need to be accessed. Leave
the host name blank.  A specific port can be assigned, such as 8081.

The binding type could be changed to https. In this case, an additional field will become
available to select an SSL certificate. An SSL certificate is required for using the https
protocol. The certificate should be installed in IIS prior to installing wMobile so that it is
available for selection. 
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A host name can be added if wMobile will be accessed using a domain name. If wMobile

will be accessed using an IP address in the web address, leave the Host Name blank. 

Once a website is created, it can be used in the wMobile installation process. The Basic

installation method can be used.
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In the web page settings, select the website created previously.  The installer will
automatically create the Web Directory, and used the port specified when the web site was
created.

There will be 2 virtual directories for Phone and Desktop, that will use the same port. 
(Using the Advanced installer to create a website is also an option. However, using that
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method, two websites would be created, one for wMobile Phone and another for wMobile
Desktop.  Each site would require a separate port.)

The internal addresses will look like the following, specifying the port, using the port
defined when the website was created. The external addresses would be the same, but
substituting the external static IP address or domain name and the proper port.

http://localhost:8081/wMobilePhone
http://localhost:8081/wMobileDesktop

2.3 Post-Installation Checklist

The following post-installation checklist is designed to help you configure wMobile. If you

are unsure about anything on the list, the links under the "See Also" section for each item

will help you check, complete, or understand any requirement on the list.

q Activate Your License

If you have purchased the software or were supplied with a serial number to demo

wMobile, Product Activation will unlock the time and user limits that come pre-installed

with wMobile.

See Also:

· Activating Your License

q Test wMobile using the wMobile Diagnostics Tool

http://localhost:8081/wMobilePhone
http://localhost:8081/wMobileDesktop
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If you did not run this tool during the wMobile installation/upgrade/update, it is highly

recommended.For instructions and details, see the wMobile Diagnostics Tool topic.

See Also:

· wMobile Diagnostics Tool

q Configure User Access

Configure which GoldMine users will have access to wMobile.

See Also:

· Configuring Users and Configuring User Profiles

q Configure wMobile Drive Mapping for Email Attachments and Linked Documents

Configure wMobile to find attachments and linked documents that are linked to a mapped

drive letter.

See Also:

· Virtual File System Settings

· Virtual File System Commands

q Customizing the Main Menu

Alter the layout and content of the Home Menu to streamline the user experience.

q Configure Global wMobile Settings

Enable additional functionality or customize wMobile for your region or specific

requirements.

See Also:

· Learn about: Global (System Settings) versus Default User Options

· Setting the Default Time and Date Formats

2.3.1 Activating Your License

How to Activate Your wMobile License
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The wMobile installer provides the opportunity to use an evaluation license for 30 days for

new customers. After purchase, a new license will be provided by SugarCRM and can be

activated using the steps below. These same steps can be used any time a new license is

provided (such as for server migrations or changes in license count).

 NOTE: This activation process requires an Internet connection.

To activate wMobile follow these steps:

1.  From the Web server where wMobile is installed, start the wMobile Manager Console.

2. From the main menu select Help > Activate Product to display the wMobile Licensing

Wizard.
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Click Next.

NOTE: If this is an evaluation license, the first screen in the wMobile Licensing Wizard will

display the number of days remaining before a production wMobile license will need to be

activated. You can cancel activation at any time by clicking Activate Later.

3. Enter your Contact/Company information into the various fields.

Click Next.

NOTE: Required fields are designated with asterisks (*).
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4. Enter the Serial Number provided.

Click Next.
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5. The system will validate the Serial Number you've entered and activate your copy of

wMobile.
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6. You will see a message stating that the product has been validated after completion.

Click Finish.
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3 Upgrading wMobile

Customers with current wMobile maintenance may upgrade wMobile during their

maintenance period. There will usually be a desktop shortcut on the server which can be

used to start the wMobile update. If this is not immediately apparent, the current wMobile

installer/updater can be accessed from this link. 

  PLEASE READ BEFORE UPGRADING:

You will need to execute the wMobile Download Manager on any server(s) that already

have wMobile components installed on them.

For example, if you have a split-server installation, you must first upgrade the Remote

GoldMine Service on the GoldMine server before upgrading wMobile on the wMobile

server. If you are unsure what type of installation you have, see the Installation

Scenarios for wMobile topic for information.

wMobile Upgrade Wizard

Which wMobile Versions Can I Upgrade

3.1 wMobile Upgrade Wizard

The wMobile installer checks the registry for installed wMobile components. Based on

what is detected, wMobile will use the appropriate installer/upgrader/updater for each

component.

· The installer will be launched if a component is not currently installed.

· The updater will be launched if a previous build of the current version is installed.

· The upgrader will be launched if a previous wMobile version is installed.

The wSetup.exe file can be run directly or downloaded to the server, as desired.

http://download.w-systems.com/wmobile/setup/5.1/wsetup.exe
http://download.w-systems.com/wmobile/setup/5.1/wsetup.exe
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wMobile 5.1 has a prerequisite for .NET Framework v4.7.2 (or higher). If the installer

detects that this is not installed, it will present options to download from the wMobile or

Microsoft Server:

A .NET Framework update will not be required for every wMobile update. Please refer to

the topic on installing .NET Framework and return to this topic when that component is

installed. 

All the components installed on the server should be listed. (When updating from a

previous version of wMobile 5.x, only the wMobile component updates will be listed for

installation. .NET Framework and Crystal Report Runtime Engine updates are not required

on regular updates.)
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  NOTE: If you have a split-install, you will need to execute the wMobile Download

Manager on each server. Install only the Remote GoldMine Service on the server where

it is currently installed. Install all other components on the IIS server.  The Remote

GoldMine Service should only be installed ONCE. If you are unsure what type of

installation you have, see the Installation Scenarios for wMobile topic for information.

The Remote GoldMine Service should be the first component to be updated.

Click Run to begin updating the components. The installer will begin downloading the

component installers:

Click Next through the update wizard.

The Remote GoldMine Service will stop and start during the update, which would cause

any logged in users to be kicked back to the login page. Updates should be done outside

of business hours, or warn users of scheduled maintenance in advance.
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Click Finish to complete the component install and move on to the next component

install.
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Proceed through each component, following the wizard updaters.

The wMobile Email Fetcher Service will also stop and start during that component update.
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wMobile Diagnostic will run after that component is updated. Review the diagnostic

summary for any items marked in red.

If you encounter any problems, please email goldminesupport@sugarcrm.com for

assistance.

3.2 Which wMobile Versions Can I Upgrade

The wMobile 5.1 Download Manager will upgrade from wMobile 3.0, 3.1, 4.0, 4.1, 5.0

installations only.  Older version upgrades are no longer available. 

  IMPORTANT:

· If you are upgrading wMobile 1.8, 1.9, 2.0 or 2.1 please contact your reseller or

goldminesupport@sugarcrm.com for assistance.

mailto:goldminesupport@sugarcrm.com
mailto:goldminesupport@sugarcrm.com
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4 wMobile Administration

Different levels of administration exist in wMobile. System wide settings for wMobile are

available to administrators having access to the wMobile server while the more "personal"

user settings are accessible by the users themselves directly within the Phone and

Desktop edition interfaces.

System Level Administration

For System Administrators:

Administration for wMobile is performed using the wMobile Manager Console. This tool is

designed for system administrators needing to make system wide changes to wMobile

affecting all users. This includes setting up and maintaining user access, creating and

editing email accounts, license management, setting various global settings, and much

more. Please see the other related topics starting with the wMobile Manager Console

itself.

User Level Administration

For End Users:

Users have the ability to make changes to their personal wMobile experience by using My

Preferences in the Phone Edition or by configuring the User Options in the Desktop

Edition.

4.1 wMobile Manager Console

Administration and configuration of wMobile is done using the wMobile Manager Console.

This application is installed on the wMobile server and can be accessed from the server's

Start menu. To run the wMobile Manager Console, select Start > All Programs > W-

Systems > wMobile Manager Console > wMobile Manager Console.

Logging into wMobile Manager Console:

By default, login credentials are not required for access to wMobile Manager Console.

However, if a login requirement is desired, a GoldMine user's credentials may be used. To

configure wMobile Manager Console to require a login, please see: Configure wMobile

Manager Console Login Requirement

The wMobile Manager Console application interface window is divided into separate tool

windows:
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· wMobile Explorer: A hierarchical user interface used to view and manage the objects in

wMobile.

· Properties: The properties of the object selected (may be editable or read-only at times

based on context).

· Main: This is the center window/work area. Based on context, this area may display

grids, logs, configuration screens, or other interfaces.

· Actions: This window displays the "action" commands available for the object being

configured.

· Messages: In some contexts, messages may appear in this area (tabbed window at

bottom and may be pinned open if desired).

The wMobile Manager Console allows administrators to (this is a partial list; please see

table of contents):

· Configure: wMobile System Setting (Global/System Wide Settings)

· Configure: Email Accounts

· Configure: Maximum login failures allowed before an account is locked

· Configure: Change the default automatic logoff time (default timeout)
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· Configure: Configure Access to Email Attachments and Linked Documents

· Configure: Enable / Disable wMobile Manager Console Login Requirement

· Configure: Customizing Contact Screens

· Configure: Logging in wMobile Manager Console

· Customizing wMobile Desktop Edition

4.2 Configuring wMobile System Settings

Configuring wMobile System Settings

System wide settings are configured from within the wMobile Manager Console.

For information regarding default user options, please see: Configuring wMobile User

Options

The System Settings are accessed by selecting the wMobile node in the wMobile Explorer

window and then double-clicking the System Settings icon.

To the right of the wMobile Explorer window is a tree list containing nodes. Selecting a

node in the tree list will allow you to edit its associated properties in the Properties

window on the right.

  CONFIGURATION NOTE:
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There are many configuration settings available that are not described here in detail. To

get descriptions for a specific settings, click on a property name and its description will

appear at the bottom of the dialog.

Configuration

The Configuration node is at the top of the tree list and has the following sub-nodes:

§ Common: Contains settings that are common throughout wMobile.

§ Desktop: Contains settings that are specific to the wMobile Desktop edition.

§ Phone: Contains settings that are specific to the wMobile Phone edition.

Example of System Settings in wMobile Manager Console.
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Here are some common settings that can be updated in System Settings.

Configuration > Common > Contacts > 

AllowContactDeletion – This setting controls whether contacts can be deleted in wMobile.

This is dependent upon GoldMine user settings as well.
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ContactRecordTypeField – This should indicate which field in GoldMine is used to store

the Record Type. Typically, this is the Key1 field, unless it’s been changed or customized.

Configuration > Common > Contacts > Duplication

AllowDuplicateEmailAddresses – This setting controls whether duplicate email addresses

can be entered into wMobile. This is not recommended because email messages are

linked based on a matching email address.

CheckCriteria – This setting is used to determine which field(s) will be used to detect

potential duplicate records. Click on the 3 dots (ellipsis) at the end of the line to launch

the Duplication criteria editor. 
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Options here are greater than in GoldMine itself (which includes Company and Contact

name, Phone number and Email address). In wMobile, you can select any field, including

custom fields, as potential duplicate detection criteria. If selecting more than one field,

use And if both (or all) fields should be used to identify potential duplicates. Use Or if only

one of the selected fields needs to match to be considered a duplicate. 

The desired setting will be dependent on how your GoldMine is used. Some companies

have a “company-centric” database where each company they work with has a record in

GoldMine, and all the contacts they work with are entered as additional contacts on this

one record. Some companies have a “contact-centric” database where they have a

separate GoldMine record for each contact they work with. In the latter case, you would

not want to be detecting duplicates based on Company, because you’d expect to have

multiple records with the same company name. Another consideration is whether you

have individual people as customers, where there’s no company name. Detecting

duplicates based on Company wouldn’t be very helpful in that case. You’d want to match

on Contact, or perhaps Company AND contact, so both would have to match for the new

contact to be detected as a potential duplicate.

ConsiderBlankValues – This can be set as True or False. The desired setting will be

dependent on how contacts are added in GoldMine. As in the example above, if you have

many records where there’s no company name, then you’d want to set this as True to

ignore the blank company field.
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ConsiderRecordOwnership – This can be set as True or False. If set to True it will not take

record ownership/curtaining into account on evaluating potential duplicates. So if a

duplicate exists in the database, a user would be notified of a potential duplicate, even if

he or she doesn’t have access to see it. If set to False, then record ownership/curtaining

will not be ignored. If a user adds a record that already exists, he or she will not get any

warning of a potential duplicate.

ConsiderUserAccessContactFilter – This can be set as True or False. If set to True it will

NOT take record a User's record access filter into account on evaluating potential

duplicates. So if a duplicate exists in the database, a user would be notified of a potential

duplicate, even if he or she doesn’t have access to see it. If set to False, then record

ownership/curtaining will not be ignored. If a user adds a record that already exists, he or

she will not get any warning of a potential duplicate.

Configuration > Common > Contacts > LinkedDocuments

LinkedDocPath: This value represents a mapped drive or network UNC path that the

Remote GoldMine Service can access. This path is where the linked documents will be

saved.

Configuration > Common > Email
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AccountConnectionMaxRetries: This is the maximum number of times the wMobile Email

Fetcher Service will try to connect to an email account. The default is 3, but can be

increased. After this number of attempts, the account will be disabled for auto-checking to

preserve resources on the server.

AutoFilingSupressionFilter: This can be manually entered values, such as specific email

addresses. Email from an email address(es) would not be linked and auto-filed in History..

This option allows you to exclude email from auto-filing. For example, a specific email

address or domain could be excluded. Add entries to this field to be excluded. Separate

each of the filter values with a semi-colon (;) or a comma (,) character. An asterisk (*)

character may be used as a wildcard in order to exclude all email from a specific domain.

Filter examples: 

user1@baddomain.com; user2@baddomain.com (these two email addresses will not be

auto-filed). 

*.baddomain.com (all email addresses from "baddomain.com" will not be auto-filed).
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CountLimit: The count of emails that will be downloaded from the user’s server or ISP

mailbox. The default is 1,000. The most recent emails are downloaded.

DaysLimit: This setting determines how many days back the fetcher service will go back

to download email from the user’s server or ISP mailbox. In cases where an administrator

is trying to auto-file older email, this number can be increased.

DDCheckInterval: This setting is used if DDEnabled is set to True, and determines how

often (in hours) the fetcher will check and de-duplicate filed email.

DDEnabled: This setting determines whether the de-duplication service is enabled. Some

customers have the email accounts set to auto-file certain email folders (such as the

Inbox and Sent items folders). Auto-filing is mainly used by customers that don't use

GoldMine or wMobile as their email client. They might use Outlook, Zimbra, Lotus Notes,

MacMail, etc. However, sometimes, a customer will use multiple email clients and doesn't

want to miss linking important emails. In this case, the de-duplication service would

review emails for duplicates and remove them.

DDTargetPeriod: if DDEnabled is set to True, this setting determines how many days back

will be checked for duplicates. The default is 30 days.

DisableFilingForUnlinkedEmails: This setting controls whether the menu options “File” and

“Copy to GoldMine Inbox” are visible for unlinked emails.

EmailFetcherMinCheckInterval: This setting determines how often the email fetcher

service will go out to the users' server or ISP mailbox to check for new messages. The

default is 30 minutes, but can be decreased. It's not recommended to set this lower than 5

minutes to ensure a fetch is completed before the next attempt.

NOTE:

When  auto checking is enabled, wMobile will make a specified number of attempts to

connect to the email server to perform a sync. If the number of attempts exceeds the

value set in the AccountConnectionMaxRetries property, wMobile will disable the auto

checking by add a "tick" to the Disable Auto Checking checkbox for the email account

trying to sync.

Example: Using default settings, the email Fetcher will attempt to connect to an email

account 3 times, every 30 minutes. If it fails to connect those 3 times, over a total of 90
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minutes, the auto-retrieval will be disabled. This is to avoid using up expensive system

resources for failed connections.

For information on re-enabling auto-retrieval, see the topic on Troubleshooting Email

Accounts.

EmailFetcherScanInterval: The default value is 1, so every minute the fetcher service will

check the email accounts table and check if it's time to check each email account.

EmailFetcherTaskQueueConcurrentLimit: this determines the number of tasks that the

fetcher will perform concurrently. The default is 25. Each request to check an email

account is counted as a task. (by a user within the wMobile application or automatically

by the fetcher service). If there are many email accounts, some tasks will be queued.

When the number of open tasks drops below 25, queued tasks would then be processed

accordingly.

EnableFilingOnSentItems: The default is False. This setting controls whether “File” option

is available on Sent email. In most cases where email is sent from wMobile or GoldMine,

the email is already filed. This option would pertain to customers using another email

client to send email.

Configuration > Common > GoldMine

EnableMgrConsoleGMLogin: Use to disable the GoldMine user login requirement for the

wMobile Management Console. When there is no GoldMine login requirement, it won't use

a GoldMine license when opened.  

UseGoldMineCurtaining: This controls whether wMobile will use GoldMine's record

curtaining rules.

Configuration > Common > PDI

DisableAddToLocal: Use to disable/enable users from being able to add data into their

device's local address book/calendar. Settings: False = enabled (allows users to use

feature); True = disabled.
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Configuration > Common > Security > Login

Max Failed Logins: The maximum number of failed login attempts before an account is

locked.

Tree Navigation: Configuration > Common > Security > Rights

AdditionalContactRights: Global System Rights for Additional Contacts.

HistoryActivityRights: Global System Rights for History Activities.

PendingActivityRights: Global System Rights for Pending Activities.

PrimaryContactRights: Global System Rights for Primary Contacts.

Configuration > Phone > Contacts
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EnableRecordTypes: [True | False] Enables the use of Record Types in wMobile Phone

Edition.

NOTES: 

In new installations, this is set by default. Older installations might have this set as False

to allow use of custom field view XML files.

Record Typing is automatically enabled in Desktop Edition, there is no configuration

setting.

Configuration > Phone > Contacts > Related Actions

Many of these items have settings to control whether they appear in wMobile. The Visible

status can be changed to False to remove them from view.
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Configuration > Phone > Contacts > Related Views

Many of these items have settings to control whether they appear in wMobile. The Visible

status can be changed to False to remove them from view. For example, f your company

does not use GoldMine Cases, that option can be removed from view in wMobile so the

menus will be shorter and will require less scrolling.

Configuration > Phone > Contacts > Opportunities

Although less commonly used, items can be removed from view in the Opportunities

screens by changing the Visible setting from True to False.
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Configuration > Phone > UI

· DefaultListPageSize: Defines the default number of items for lists.

4.3 Configuring wMobile Default User Options

Configuring wMobile User Options

User Options are configured from within the wMobile Manager Console and can be used to

apply user settings to all users at the same time.

For information regarding System Settings, please see: Configuring wMobile System

Settings
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The User Options are accessed by selecting the wMobile node in the wMobile Explorer

window and then double-clicking the Default User Options icon.

To the right of the wMobile Explorer window is a tree list containing nodes. Selecting a

node in the tree list will allow you to edit its associated properties in the Properties

window on the right.

  CONFIGURATION NOTE:

There are many configuration settings available that are not described here in detail. To

get descriptions for a specific settings, click on a property name and its description will

appear at the bottom of the dialog.
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Options

The Options node is at the top of the tree list and has the following sub-nodes:

§ Common: Contains settings that are common throughout wMobile.

§ Desktop: Contains settings that are specific to the wMobile Desktop edition.

§ Phone: Contains settings that are specific to the wMobile Phone edition.

Example of User Options in wMobile Manager Console.



wMobile AdministrationwMobile User Guide 158

Copyright © 2021 SugarCRM All Rights Reserved.

When settings have been configured that should be globally applied, use the Apply to All

Users option in the Actions pane on the right. 

4.3.1 Default User Options - Common

Common settings are common to both wMobile Phone and Desktop Editions. The most

commonly used and edited settings are below. Users can override the default settings by

changing their individual settings in User Options in Desktop Edition or My Preferences in

Phone Edition.

Activities

Activities Settings control activity and calendar settings. 

Options > Common > Activities
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· CarryOverCompletionNotes: A True value will copy over notes into followup activities.

· CheckFollowupDefault: A True value means wMobile will automatically schedule a

follow up activity by default.

· DefaultHistorySort Order: a DESC value will sort History activities in Descending order

with the most recent activities at the top.

· DefaultPendingSortOrder: An ASC value will sort Pending activities in Ascending order

with the soonest activities at the top.

· HideAuditRecords: A True value will mean that Audit records will not be displayed in the

History activity list. 

· SetAlarmOnNewActivity: A True value will automatically set an alarm on new activiites.

Contacts

The only option currently in this list is AddContactFaxLabel which will show the Fax field in

secondary contacts with a different label such as Mobile or Cell. This provides matching

functionality to a GoldMine gm.ini setting to adjust the secondary contact fax label.

Options > Common > Contacts

Regional Settings

Regional Settings control the default date, time, currency and distance unit used by

wMobile. 

Options > Common > RegionalSettings
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· Currency: The Currency used by the current user.

· CurrencyFormat: The Currency Format used by the current user.

· DistanceUnit: The Distance Unit changes whether distance will be given in either miles

or kilometers when either of wMobile's Closest Contacts or Get Directions features are

used.

· LongDateFormat: Long Date Format controls how wMobile will display date fields where

the date is expressed using the Month and Day as words and/or numbers and Year.

· ShortDateFormat: Short Date Format controls how wMobile will display date fields

where the date is expressed using the Month, Day, and Year as numbers.

· TimeFormat: The Time Format used by the current user.

· TimeZone: The Time Zone used by the current user.

4.3.2 Default User Options - Desktop

The Desktop section contains user options specific to wMobile Desktop edition. The

most commonly used and edited settings are below. Users can override the default

settings by changing their individual settings in User Options.

Email

The email section contains various email preferences. 

Options > Desktop > Email
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· DefaultForwardEmailTemplate: A default email template can be selected if there's a

standard template used by all users. 

· DefaultNewEmailTemplate: A default email template can be selected if there's a

standard template used by all users.  

· DefaultReplyEmailTemplate:A default email template can be selected if there's a

standard template used by all users.  

· IncludeOriginalReplyMsg: This setting will include the original email message in reply

messages.

· OpenComposeMethod: A NewBrowserWindow value will open new email messages in a

new browser window. This is the default value. A New Child Window will open a new

Child Window in which to compose the new email. A Same Window option will display

the new email message in the same window. 

· OpenViewMethod: A NewBrowserWindow value will open new email messages in a new

browser window. This is the default value. A New Child Window will open a new Child

Window in which to compose the new email. A Same Window option will display the new

email message in the same window. 

· ShowGoldMineFolder: A True value will display the GoldMine Inbox in the Email Center to

display emails previously downloaded into GoldMine.

MainMenu

wMobile 5.0 introduced a new User Interface (UI) with the option to customize the main

menu.

Options > Desktop > Main Menu
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Use the ellipse button to access the Main Menu options and set the order. 

Personal

The Personal setting currently only contains the EmailClient setting. A BuiltIn value will

use the email client built into wMobile. An External value will mean that wMobile will

prompt to open the default email client on the computer to compose a new email

message.

Options > Desktop > Personal
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4.3.3 Default User Options - Phone

The Phone section contains user options specific to wMobile Phone edition. The most

commonly used and edited settings are below. Users can override the default settings by

changing their individual settings in 'My Preferences' in Phone Edition.

Contacts - Quick Search Fields

These settings can be used to set the Quick Search fields for all users. 

Options > Phone > Contacts > Quick Search Fields
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PDI

The PDI (Personal Device Interface) settings control calendar and contact download

settings.

Options > Phone > PDI

· AddLocalCalendarMethod: This defines the procedure used to add a wMobile activity to

the local device Calendar. There are two options for this setting: D - Download, E - Email.

· AddLocalMethod: This defines the procedure used to add a wMobile contact to the local

device Address Book. There are two options for this setting: D - Download, E - Email.

UI

Options > Phone > UI

The UI (User Interface) section controls settings on hand held devices. 
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· List Page Size: The default number of items in lists is 10. This can be increased, but it

would be across the whole application and could mean users wait a bit longer to display

list views.

· ShowContactExpressionFields: If GoldMine primary or field views contain dBase

Expression fields that need to be seen in wMobile, then this field should be set as True.

· ShowEmptyFields: Shows/Hide empty fields in detail views like contact detail view,

activity detail view, opportunity detail view etc. By default, this setting is False in order to

optimize the space used on mobile devices. [The default is "False" meaning that the

empty fields will not be displayed, limiting scrolling through empty fields.] Empty fields

are shown in Edit mode regardless of this setting. 

4.4 Configuring Logo for Phone/Desktop

It is possible to add a custom company logo for the Phone and Desktop editions of

wMobile. The logos need to be configured separately, and each edition has its own size

requirements. The logos are set using the wMobile Manager Console. The acceptable

image formats for the logo images are: png, gif, or jpg.

Phone Edition Logo Configuration

In the wMobile Explorer window, navigate to: wMobile > Phone > UI > Logo.

Click on the [Change] link and browse for a different logo using the Open file dialog.

NOTES:

· The logo should not be larger than 90 x 30 pixels.

· It is recommended to save the logo in the following folder: W-

Systems\wMobilePhone\res\img

After selecting the image file, it will display in the center window. Click the Save link in the

Actions window to have wMobile use the newly assigned logo.
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Desktop Edition Logo Configuration

In the wMobile Explorer window, navigate to: wMobile > Desktop > UI > Logo.

Click on the [Change] link and browse for a different logo using the Open file dialog (do

this for each size logo image being changed).

NOTES:

· Desktop uses two logos: a small and a large size image. The large (full) image should

not be larger than 300 x 69. The small image should not be larger than 65 x 15 pixels.

· It is recommended to save the logos in the following folder: W-

Systems\wMobileDesktop\res\img

After selecting the image files, they will display in the center window. Click the Save link in

the Actions window to have wMobile use the newly assigned logos.
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4.5 Change Default Timeout Setting

Setting in wMobile Desktop/Phone

Default Timeout Setting

To change the default timeout setting, you need to edit the KeepAliveDuration property

value. 

To change this setting:

Open the wMobile Manager Console.

In the wMobile Explorer window, select wMobile and then double-click Default User

Options in the main window.
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Tree Navigation:

Options > Desktop > Session -or- Options > Phone > Session

· KeepAliveDuration: The timeout for the current user session. The default value is 30

minutes.

Setting in wMobile Using Web.config (NOTE: Using wMobile Manager Console is

recommended)

Default Timeout Setting

To change the default timeout setting, you need to edit the timeout setting in the

Web.config file.

To change this setting:
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Click Start and then Run...

Type notepad and click OK.

Click File > Open and navigate to the C:\Program Files\W-Systems\wMobilePhone folder.

Find the Web.config file and open it.

Once you have the file opened in Notepad, go to Edit > Find and type timeout in the Find

what field, then click Find Next. You're looking for the following:

Now edit the timeout="60" setting to the value you prefer:

Example: timeout="45"

After making the appropriate change, click File > Save.

Click File > Exit to close Notepad.

4.6 Configuring wMobile AddIns

wMobile Phone and Desktop both have AddIn components. Some AddIns are for GoldMine

functionality, but we are also able to extend GoldMine and wMobile functionality with

customized AddIns. Some customers have requested and purchased custom AddIns for

specific functionality.

An AddIn can:

- Add or change User interface elements(screens, menu items, toolbar items, pads,

contact tabs)
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- Add User Options and System Settings. Some options will appear in User Options only if

an Addin is enabled

- Extend functionality or override existing functionality (this has been done for specific

customer AddIns) 

Some examples of the AddIns for GoldMine functionality would be Service Cases,

Opportunities, and the KnowledgeBase. These AddIns can be turned on and off in the

wMobile Manager Console. No customer uses ALL the features of GoldMine or wMobile,

and it’s easier for end-users if unused items aren’t displayed. All of the built-in AddIns are

enabled by default. 

Open the wMobile Manager Console to make adjustments to AddIns for wMobile Phone

and Desktop. Select the component in the wMobile Explorer Pane and select AddIns

Configuration. We’ll start with Phone.

 

There are only 2 built-in AddIns for Phone Edition: Cases and Reporting. (If you have a

custom AddIn provided by W-Systems, you’ll see it in this list as well.)  If you don’t use the

GoldMine Service Cases component, you might want to disable the Cases AddIn by

unchecking it as shown below in yellow. Click Save to preserve this change.
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You’ll be prompted to restart Phone. Click OK to proceed.  

 

When your end users next log into wMobile, items related to Cases in Phone Edition, such

as Cases on the contact record as shown below, and the option to create a New Case, will

no longer be displayed. 
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wMobile Desktop has more AddIns than Phone Edition. To view these, select Desktop in

the wMobile Explorer Pane and select AddIns Configuration.

If any of these features are not used, the AddIns can be disabled by unchecking the item.

(If you have a custom AddIn provided by W-Systems, you’ll see it in this list as well.) 

Following the previous example, let’s say your company doesn’t use Service Cases.  We’ll

want to disable this functionality and remove the Cases item from the toolbar. Uncheck it

in the list of AddIns. When you have made your changes click Save.
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As before, you’ll be prompted to restart Desktop.

 

Note: Restarts of Phone or Desktop will cause users to be forced back to the login page.

When users log back into Desktop, the AddIns that were removed will no longer be visible

in wMobile Desktop.

The menu item will be gone from the toolbar.
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The option to display the tab will be gone from User settings.

 

The tab will be removed, if it was previously displayed.
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4.7 Configure wMobile Manager Console Login Requirement

Setting the option to enable/disable the requirement for a wMobile Manager Console login

To change this setting:

Open the wMobile Manager Console.

In the wMobile Explorer window, select wMobile and then double-click System Settings in

the main window.

Tree Navigation:

Configuration > Common > GoldMine

With GoldMine selected, use the drop-down for the EnableMgrConsoleGMLogin setting as

follows:

· EnableMgrConsoleGMLogin: Defines whether or not an administrator is required use a

GM user to login into wMobile Manager Console.

o False = Disables the login requirement

o True = Enables the login requirement
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  IMPORTANT: The next step requires that wMobile components are restarted which

will cause logged in users to lose their connections. Please be careful when this is

used.

After making the selection, click Save in the Actions window and allow the components to

be restarted.

4.8 Configuring Screen Templates

Screen templates can be used to force default values to be entered automatically for

users when adding new activities.

In the Desktop Edition example below, a template is created so that all new pending

appointments will default to a specific time, color, and activity code. 

The Screen Templates are accessed by selecting the wMobile node in the wMobile

Explorer window and then double-clicking the Screen Templates icon.

In the main window, select the Define Templates tab. There are templates for both Phone

and Desktop editions.
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Select AddPendingActivity_Desktop from the Define Templates list. 

Select New in the Actions window.
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In this example, we want set a predefined behavior for Appointments:

· Place a tick in the Selected Predefined Fields column for Type.

· Enter A in the Predefined Values for column (for "Appointment"; other values that can be

used are listed below).

· Enter a Name for the Screen Template Type.

· Click Save in the Actions window.
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Activity Type Values (used for Type):

A = Appointment 

C = Phone call 

D = To-do 

E = Event 

O = Other Action 

S = Forecasted Sale

Select the Screen Template Type created (named SchedAppt in this example) and select

New from the Actions window.
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In the example below, we’ll set the Activity Code as "SLS" (do not include quotes), the

Duration to 20 minutes, and set the Color as red (see list of available colors below). Next,

give the Screen Template a name, and then click Save in the Actions window.
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Color Options (used for Color):

Blue (default) = space or null

Magenta = !

Red = " (double quote)

Cyan = #

Green = $

Yellow = %

Dark cyan = &

White = ' (single quote)

Light gray = (

Maroon = )

Dark green = *

Dark yellow = +

Dark blue = , (comma)

Purple = -

Dark gray = . (period)

Black = /
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Click on the Select Templates tab. The screen template types and templates that have

been created will appear in the Screen Template Type and Screen Template drop-down

lists.

Once you have made selections from the drop-downs, click the Add to List button. Your

selection will be added to the list in the main window.

The screen template will be applied for all users when scheduling new appointments.
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4.9 Configure Logging in wMobile Manager Console

wMobile generates logs that can be used for troubleshooting purposes. The logs created

by wMobile record various types of information used to determine the causes of issues

and aid in resolving them. Each component of wMobile has its own logs that can be

reviewed when a customer reports a problem. In the wMobile Explorer window, you can

access the logs for any of the installed components on the server. Each component has a

Logs node with child nodes: Application Logs (application operation specific), Sql Logs

(SQL data specific), and for certain components, Access Logs (access data). If needed,

logs can be cleared.
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  NOTE: If you have a split installation (see: Installation Scenarios) of wMobile, and

the Remote GoldMine Service (RGMS) is installed on another server, you will not see

the Remote GoldMine Service in the wMobile Manager Console at this time. (We hope

to add that functionality in the future.)

When viewing a log, the results can be filtered by using the drop-down to select a specific

filter level. In this example, "Error" is being selected so we review those problems more

easily.
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Logs can also be searched by using a text search if we are looking for an error on a

specific task or contact. Click on Search and then enter the text to identify. In the Find

dialog, use the Previous and Next buttons to navigate through the results.

If the current logging level does not contain sufficient information, we can increase the

logging level to "Debug" causing wMobile to log more information. In the Actions window,

select Change Logging Level and select Debug from the drop-down list. After your

selection is made, click Save.
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There is also an option to enable SQL logging. Select the SQL Logs node for the

component in the wMobile Explorer window as highlighted in green below. Next, select

Enable SQL Logging in the Actions window. Now set the value to On and click Save.

After the logging levels have been changed, an attempt should be made to reproduce the

problem so the logs will be populated with more information. This extra level of logging

helps to troubleshoot the cause of the problem.
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  NOTE: Both Application Logs and SQL Logs are included along with the

wDiagnostics Tool report when its Send option is used.

The logging levels should be set back to less aggressive settings after troubleshooting

has been completed. The reason for this is so that the logs do not take up unnecessary

disk space on the server. The Application Logs should be set back to Info and the SQL

Logs can be disabled (i.e., set to Off).

  IMPORTANT: Starting with build 3.1.3.977, making changes to the logging levels in

wMobile Manager Console will not require components to be re-started. However, if

changes are made directly to the configuration file(s) or the Windows Registry

pertaining to these logging settings, then the Application Pools will need to be re-

started manually. In this case, any logged in wMobile users should be warned that if

they do not log out that they will be forced out when the Application Pools are re-

started. 

Clearing Logs

Logs grow over time and can be cleared as required. The links to clear logs are available

when logging is enabled for a specific logging type (Application Logs, Sql Logs, and

Access Logs). Each component (Phone, Desktop, etc.) stores its own sets of logs and are

cleared independently. 

To clear logs, navigate to a specific component in the wMobile Explorer window (this

example uses Phone). For this example we've navigated to wMobile > Phone > Logs. After
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selecting one of the logging types, the Actions window will display the links to clear the

logs:

Clear Current Log - Clears the logs of the selected log type only.

Clear All Logs - Clears the Application Logs and the Sql Logs simultaneously (NOTE:

Access logs are not cleared using this command. Use the clear command on the "Access

Logs" node).

4.9.1 wMobile Access Logging

A useful feature for developers and administrators is “Access Logging”. This is used to have an

overview map for wMobileDesktop and wMobilePhone by retrieving information for all actions which

users are performing:  all pages that are visited, used browsers, timing on server side and client side (in

milliseconds), all requests that are sent to the server. 

Access Logging is accessible from the wMobile ManagerConsole and it’s available for both web sites:

wMobilePhone and wMobileDesktop.



wMobile AdministrationwMobile User Guide 189

Copyright © 2021 SugarCRM All Rights Reserved.

Access Logging is disabled, by default, and it can be enabled from the Actions panel on the right side: 
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After this step, each user move will be captured and stored in WT_AccessLog SQL table. 

(Note: In older versions of wMobile, a prompt would appear after enabling the feature, to restart the

application pool in order to take effect.)

The example below shows information for user MASTER while using wMobileDesktop: 

 

In this table we have captured 6 moves for user MASTER. As you can see, he accessed the Contact List,

then navigated to a contact page and changed the tab from Additional Contacts to Pending Activities,

then moved to email list and composed an email. In all this time only one user was connected

(MASTER) and this can be seen in the 6
th

 column – LoggedIn User Count. This table is also displaying

the timing (in milliseconds) registered on server and client side. 

Here’s some data information as a result for user MASTER while using wMobilePhone:

A singled logged in user (MASTER) navigated from the Home page to the Contact List and scheduled

an activity. All these steps were performed using the Google Chrome browser.
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wMobile logins are also recorded in the GoldMine UserLog table. If the login was via wMobile Phone,

this will be indicated by WP in the CRC column. wMobile Desktop login is indicated by WD in the CRC

column.

4.10 Configuring Notification Services

wMobile uses Notification Services to support activity notifications such as activity

alarms, notifying users when a new activity has been created for them, and RSVP

notifications. By default the Notification Services are not enabled and require

configuration before they can be used.

The configuration is done using wMobile Manager Console. Access the settings by

double-clicking the Notification Services icon in the center window.
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Notification Rules

wMobile comes with a set of built-in notification rules that define the actions that will be

executed under certain conditions, when a specific event is fired. Each notification rule

has a description that explains its behavior.

Notification Monitors

As we mentioned earlier, wMobile uses some background tasks to fire time flow related

events like alarm expiration. These tasks are called Event Monitors and they are running
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inside wMobile Email Fetcher. Currently, wMobile deploys an Alarm Monitor that is used to

fire alarm expiration events. This monitor is not enabled by default when you install

wMobile. If you want alarm notifications in your system, you will need to open Notification

Services configuration, then select Notifications > Monitors and put a check in the event

monitor list for Alarm Expired Monitor to enable it. To complete the configuration, click

the Save in the Actions window.

After clicking Save, click OK when prompted to restart wMobile Email Fetcher Service. The

Email Fetcher restart is mandatory in order for Alarm Monitor to run.

4.10.1 Configuring Email Settings for Notifications

Notification Services requires configuring an SMTP server account that will be used to

send the email notifications asynchronously. Here is an example of the Notifications >

Settings > Email Settings filled in (please note that your settings will be different than in

this example).
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After entering the Email Settings, click the Test Settings... command link in the Actions

window on the right. If the test is successful, click Save (also in the Actions window).

  NOTE: All email notifications are sent asynchronously via Email Fetcher service.

wMobile users will not have to wait for emails to be sent, this process is transparent

for them.

4.10.2 Configuring SMS Settings for Notifications

The wMobile Notification Service originally supported only email notifications, but Short Message

Service (SMS) notification support was added shortly thereafter. In order for wMobile to able to send

texts, SMS settings must be configured in the wMobile Manager Console.

The example below uses Twilio. Please contact wMobile support if you'd like to integrate another SMS

service.

Twilio SMS Client Configuration
The default SMS client we are using is Twillio, because it provides powerful messaging

features. To configure the Twilio in the wMobile Notification Service you must first go on

the Twilio website and receive an Account SID and Authentication Token. 

To be specific, after creating the Twilio account, the Account SID and Authentication

Token can be found under Home / Dashboard / Console Dashboard (see Figure 1: Twilio

Credentials).

mailto:goldminesupport@sugarcrm.com
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Figure 1: Twilio Credentials

 After getting the credentials, for the Twilio account to work you need caller phone number and some

verified caller ids.

Eg: phone x sends messages to phones y and z

 

The caller phone number can be found under Home / Dashboard / Phone Numbers / (see Figure 2:

View caller phone numbers). 

 On the account creation, no numbers should be assigned. (See Figure 3: Get a caller phone number)

Figure 2: View caller phone numbers
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Figure 3: Get a caller phone number

Now that we have the caller phone number (phone x in the example above) we need the verified

caller ids. Those numbers can be found under  Phone Numbers / Verified Caller IDS (see Figure 3:

Verified Caller IDS). This might be your own corporate cell phone number for testing. When you’re

ready to go live, each user that will be sent SMS texts from wMobile must be added here. 

Figure 3: Verified Caller IDS

 In the Figure 3 it is shown how a Twilio user can modify or add an existing receiver phone number.

     

After this step, proceed to the wMobile Manager Console with your wMobile user account and under

the Notifications Services, locate the SMS Settings (see Figure 4: Notifications SMS Settings).

Enter the data as follows:

     Test phone (text field) - enter a verified caller ID phone that will be used for testing purposes

 (see Figure 3)

     Sender phone (text field) - enter the caller phone number (see Figure 2)

     Account SID and Authentication Token (text fields) - enter the Twilio credentials (see Figure 1)
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Figure 4:  Notifications SMS Settings

After the data is inserted you can test the data or save it. Now the wMobile Twilio SMS Service is

running and the users can receive notifications SMS.

SMS Notification Rules
 

The wMobile Notification Service has a built-in SMS rule that must be active in order for SMS sending

to work. This rule can be found in the Rules section under the Notification Services in wMobile

Manager Console (Figure 5: SMS Notification Rules). Individual rules can be enabled or disabled.

Figure 5:  SMS Notification Rules
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In Figure 5 we highlight the “SMS on alarm expiration” rule. This rule sends an SMS when an activity

alarm in wMobile occurs. In order to work, this rule needs the “Alarm Expired Monitor” to be activated

(see Notification Monitors section in the related blog post). 

Setting wMobile user phone number

 

In order to receive an SMS, the phone number must be placed in both Twilio and wMobile.

     

First, the phone number must be registered into Twilio under Manage Caller IDs (see Figure 3: Verified

Caller IDs). 

     

After that the wMobile user with that phone number must be included in his or her wMobile settings.

The location of the setting in wMobile Desktop is in Tools / Options / Personal (Figure 6: wMobile User

Phone Number).

Figure 6:  wMobile User Phone Number

An administrator can add the number from the wMobile Manager Console User Options.
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Figure 7: User Options

Select the user from the drop down list.

Figure 8: User list in User Options

The number can be added in the Mobile listing as shown below.
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Figure 9: Mobile number in User Options

4.10.3 Notification Services Failure Mgt

Failure Management

There will be occasions when the system will not be able to send email or SMS

notifications. This may be due to the email server being down, the server is not accessible,

or the server settings have been changed, and your notifications will not be sent.

By default, the system will try to send a notification for a specified number of times. Once

that number is reached and the notification cannot be sent, it will be moved into a list of

Email Failures or SMS Failures, as appropriate. The default retry count is 3, but can be

adjusted in the System Settings under Configuration > Common > Notifications.
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This list is accessible from wMobile Manager Console and the notifications can be further

managed as follows:

· One or more can be removed from Email Failures  or SMS Failures list using the Remove

(remove a specific email by selecting the one to remove) or Remove All command in the

Actions window.

· They can be re-posted into the notification queue for retry using the Retry (retry a

specific email by selecting the one to retry) or Retry All command in the Actions

window.

4.10.4 Using Notification Services to Update Email Passwords

The wMobile Notification Services can be used to notify users when their email passwords have

changed and provide a link to update the password. This was developed for customers whose email

passwords change periodically.

The wMobile email fetcher service checks for new emails in user email accounts on the

server or Internet Service Provider and copies them to wMobile. Using default settings,

this happens every 30 minutes but can be adjusted. So when users log into wMobile Phone

or Desktop, they see new email. If the password has changed, eventually this check by the
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wMobile email fetcher service gets disabled to save resources on the server. In this event,

the user will not see new email and will not be able to use wMobile to send or receive

email until the password is updated.  The user does have some visual cues that there’s a

problem. 

In wMobile phone, the email account will be listed in red with a note regarding the

suspended status.

In wMobile Desktop, the account appears in red with a Stop sign.

However, now we can proactively notify a user before they even log into wMobile using the

Notification Services.

In the wMobile Manager Console, select Notification Services as shown below.
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Enable the rule ‘Email when wrong email account credentials detected’ by placing a

checkmark in the Enabled column. Select Save when the change is made.

The Email Settings must be configured so an email notification can be sent. 

In order to send a message with a page to update the credentials, the wMobile web address must be

provided for wMobile Desktop and Phone. Select System Settings.
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Navigate to Configuration > Desktop > Application Info. Enter the web address of wMobile

Desktop. Your company web address might use an IP address or a domain name.

Next, navigate to Configuration > Phone > Application Info. Enter the web address of

wMobile Phone. Your company web address might use an IP address or a domain name.
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When both changes have been made, select Save in the Actions pane. If you are prompted

to restart services, click OK to do so.

Now in the future, if a user’s email password changes and they haven’t updated it in

wMobile, they’ll get a message like the one shown below with a link to change the

password.
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The ‘click here’ link will open a browser and direct the user to a page to update the

password. Otherwise, a web link is also provided. The user must know the old password

and the correct new password. On clicking OK, the credentials will be tested as shown

below in blue. 
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On a successful test, the user will receive a confirmation of the updated password, and

will have links to go to the wMobile Phone or Desktop login page.
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If the user enters either the old password or the new password incorrectly, they will get an

error message and have the opportunity to try again.

We hope that you will find this functionality useful!

Note: Applicable to wMobile 3.1.3.268 and above

4.11 Managing Duplicate Detection (Contacts)

This topic refers to a handful of settings in wMobile Manager Console allowing for some

control over handling contact duplication up front, that is, before contacts are duplicated

in your database. When creating new contact records or editing existing contact ones,

wMobile provides control over duplication, allowing duplicates in without warning, or

informing the user before the duplication is made in your database.

Accessing the wMobile Manager Console System Settings
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wMobile system wide settings are configured from within the wMobile Manager Console.

On the wMobile server, this tool can be started from the Windows Start menu. The System

Settings are accessed by selecting the wMobile node in the wMobile Explorer window and

then double-clicking the System Settings icon.

The settings discussed here are in the "Common" section and will affect both wMobile

Phone and wMobile Desktop. To access these specific settings, navigate the tree list as

follows:

Configuration > Common > Contacts

These four (4) settings are covered below:

· AllowDuplicateEmailAddresses

· CheckDuplicateContactCriteria

· DuplicateCriteriaIgnoreBlankValues

· DuplicateCriteriaIgnoreRecordOwnership

AllowDuplicateEmailAddresses
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This setting controls whether duplicate email addresses can be entered into wMobile for

separate contacts. This is normally not recommended because email messages are linked

based on a matching email address.

Settings are: True or False

False = (Recommended) Avoids users from saving duplicate email addresses within the

database. With this setting, the user will be warned the email address already exists.

True = Allows duplicate email addresses within the database. With this setting, the user

will not be warned they're duplicating an email address when the record is saved.

In wMobile Phone, the user will see this message appear:

CheckDuplicateContactCriteria

The desired setting will depend on how the information in your GoldMine database is used.

Some companies have a “company-centric” database where each company they work with

has a record in GoldMine, and all the contacts they work with are entered as "additional

contacts" linked to a company record. Some companies have a “contact-centric” database

where they have a separate GoldMine record for each contact they work with. In the latter

case, you would not want to be detecting duplicates based on Company, because you’d

expect to have multiple records with the same company name. Another consideration is

whether you have individual people as customers, where there’s no company name.

Detecting duplicates based on Company wouldn’t be very helpful in that case. You’d want

to match on Contact, or perhaps Company AND contact, so both would have to match for

the new contact to be detected as a potential duplicate. Based on your specific need here

is a description of the settings:

Settings are: None, Company, Contact, Company AND Contact, and Company OR Contact.

None – wMobile will not consider records to be duplicated and allow them to be created.

Company – wMobile will check only the Company field for duplications.

Contact - wMobile will check only Contact field for duplications.
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Company AND Contact – wMobile will check both the Company field and the Contact field.

If "both" of these fields match an existing record, the new one will not be inserted.

Company OR Contact – wMobile will check both the Company field and the Contact field.

If "either one" of these fields match an existing record, the new one will not be inserted.

In wMobile Desktop the user will see this message when a duplication warning is

presented:

DuplicateCriteriaIgnoreBlankValues

This setting specifies if the contact duplication criteria will take blank values into

consideration. The desired setting will depend on how contacts are added in GoldMine.

For example, if you have many records where there’s no company name, then you’d want to

set this as True to ignore the blank company field. 

Settings are: True or False

True = wMobile will check for duplication using criteria from

"CheckDuplicateContactCriteria" and "will ignore" records with Company/Contact fields

that are empty: 

· CheckDuplicateContactCriteria = Company and DuplicateCriteriaIgnoreBlankValues =

True, if user is trying to insert a new record with the Company field empty and the

database has an existing record with the Company field empty, wMobile will not detect

this as a duplicate.

· CheckDuplicateContactCriteria = Company OR Contact and

DuplicateCriteriaIgnoreBlankValues = True, if the user trying to insert a new record with

the Contact field or the Company field empty and the database has an existing record

with the Contact field or the Company field empty, wMobile will not detect this as a

duplicate.
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False = wMobile will check for duplication using criteria from

"CheckDuplicateContactCriteria"and "will not ignore" records with Company/Contact fields

that are empty:

· CheckDuplicateContactCriteria = Company and DuplicateCriteriaIgnoreBlankValues =

False, if user trying to insert a new record with Company field empty and the database

has an existing record with Company field empty, wMobile will detect this as duplicate.

· CheckDuplicateContactCriteria = Company OR Contact and

DuplicateCriteriaIgnoreBlankValues = False, if the user trying to insert new record with

the Contact field or the Company field empty and the database has an existing record

with the Contact field or the Company field empty, wMobile will detect this as duplicate.

In wMobile Phone, the user will see this message appear:

DuplicateCriteriaIgnoreRecordOwnership

This setting controls whether record ownership is honored or ignored when checking for

possible duplication.

Settings are: True or False

True = wMobile will not take record ownership/curtaining into account for evaluating

potential duplicates. This means that if a duplicate exists in the database, a user would be

notified of a potential duplicate, even if he or she doesn’t have access to see it.

False = This forces wMobile to honor (i.e., not ignore) record ownership/curtaining. If a

user adds a record that already exists, he or she will not get any warning of a potential

duplicate.

wMobile will take record ownership/curtaining into account for evaluating potential

duplicates. This means that if a duplicate exists in the database, a user would not be

notified of a potential duplicate because they do not have rights to access that record.
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In wMobile Desktop the user will see this message when a duplication warning is

presented:

4.12 Change Database (for re-hosting)

On occasion, you might need to change the SQL database used for GoldMine and wMobile.

If a backup of the SQL database has been used, then the wMobile SQL tables will be

present. These table names begin with WT_.  

If the new SQL database is not a restoration of an existing database, there's an option in

the wMobile Manager Console to copy the wMobile tables to the new SQL database.

Select Change Database as shown below.

Checkmark ‘Copy Table Data to New Database.’
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You’ll see a progress bar as the task proceeds.

You’ll be prompted to restart services when the task is completed.
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The wMobile registry key will also need to be updated with the appropriate GoldMineCommonDir

and GoldMineGoldMineDir and values.



wMobile AdministrationwMobile User Guide 216

Copyright © 2021 SugarCRM All Rights Reserved.

4.13 Configuring Users

When a user attempts to log into wMobile, wMobile first determines if that user is

permitted to log in via wMobile. If the user is permitted to log in, then the credentials

supplied by the user are passed to the Remote GoldMine Service. The Remote GoldMine

Service checks the username and password against GoldMine. If the username/password

combination matches GoldMine, then the user is logged into wMobile. To simplify, ask

yourself these questions:

1.  Is the user allowed to log into wMobile?

2.  Is the user's account unlocked in wMobile?

3.  Does the supplied username and password match GoldMine?

If all three of these questions are answered "Yes", then the user is logged into wMobile.

From a technical perspective, its important to note that 1 and 2 in the example above

occur at the wMobile server. wMobile will attempt to pass the credentials to the Remote

GoldMine Service only after these 2 factors have been satisfied with a 'True' result,

regardless of the credentials passed by the user on the login page are correct or incorrect.
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If the username supplied on the login page is not permitted to log into wMobile, the

user will get the error: Login Failed. The specified user has no rights to log into

wMobile.

If a user fails to login by supplying an invalid password, the user will get the error:

Login Failed. Account is locked after repeated login failures. Please contact your

wMobile administrator to release the lock.

This three-factor authentication allows administrators to prevent unauthorized or

malicious usage of wMobile by non-mobile users, users who attempt guess a valid users

password or attempts to use wMobile from a lost or stolen device.

In this section, we will discuss how to configure users and security in wMobile to ensure

the security of your GoldMine information.

This section has been structured to provide a guided approach to adding and configuring
user accounts and account security. By following the 'See Also' section at the bottom of
each page, you will be able to move through the steps of adding and configuring a user for
wMobile access.

See Also:

  Adding or Updating Users to wMobile

  Configuring User Profiles

  Configuring Email Accounts in wMobile

  Logged In Users: Viewing / Logging Out

4.13.1 Adding or Updating Users in wMobile

wMobile automatically maintains an internal list of GoldMine users and User Group

membership. This is done to provide additional layers of security, permit administrators to

configure users with different settings when accessing wMobile from a mobile device or

web browser and to improve performance.

Because wMobile maintains its own list of users, the list updates itself when:

               1. Users are added or removed from GoldMine.

               2. Users are added or removed from User Groups.

               3. User groups are added added or removed from GoldMine.
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To access the Users icon, click on the wMobile node from within the wMobile Explorer

window.

The GoldMine users list is cached and periodically refreshed. If you have just added a user

to GoldMine, click on the Refresh option in the Actions pane to refresh the list.

See Also:

  Configuring User Profiles

  Configuring Email Accounts in wMobile
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4.13.2 Configuring User Profiles

Users (GoldMine User List)

Users determines which users can log into wMobile in addition to displaying the default

Ownership, Curtaining, Record Set, and feature access that the user will have when logging

into wMobile.

This section will describe the options for users and explain what the options control.

To access the Users (GoldMine User List), click on the wMobile node from within the

wMobile Explorer window and then double-click the Users icon.

  IMPORTANT:

Configuration of Record Ownership, Record Curtaining, and Master Rights are read

from GoldMine. Adjusting the Contact Filter within the Manager Console will apply to

wMobile ONLY (i.e., this is a wMobile- specific setting). 

The User Name and User's Full Name columns contain the same information from the

GoldMine user list. Both of these columns are READ-ONLY. They cannot be changed in the

Manager Console.
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The Record Ownership column is READ-ONLY and displays the owner of new records

created by the user in wMobile.

The Record Curtaining column (READ-ONLY) determines the curtaining level of of new
records created by the user in wMobile.
The possible values for this column are:

· No curtaining(public): All the users can view the entire Contact Record.

· Partial: Users who are not record owners can view only the contact name, and phone
number areas.

· Semi-partial (hide tabs): Users who are not record owners can view the upper four
panes, but cannot view the Tabs.

· Complete: Users who are not owners cannot access any of the contact information.

The Contact Filter column uses Filters from GoldMine to determine which records the user

will have access to in wMobile.

The Master Rights (READ-ONLY) column sets the user with advanced settings:

· Ability to Create and Edit Detail Types
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· Ability to see all records, regardless of curtaining.

· Ability to see all Users Activities, regardless of User Access settings.

The Allow Login column enables wMobile access for the user.

  NOTE: The number of users with "Allow Login" checked can never exceed the
number of wMobile licenses you have purchased. For example, if you have a 5-user
license of wMobile, then you can only check "Allow Login" for up to 5 GoldMine users.

The Is Locked column displays if the user account has been locked because of multiple

failed login attempts.

If a user account is locked, this checkbox will be checked and must be cleared before the
user can log into wMobile again. To unlock a user account, remove the check mark from
the checkbox column and the number of logins for that user account is set to 0.

The number of login attempts allowed before an account is locked is controlled by the
MaxFailedLogins property of the System Settings.

  NOTE: This checkbox setting is controlled by wMobile (i.e., set to "checked") when
the number of failed logins has been exceeded by the user. This column can be set
manually. To manually restrict access to wMobile for a particular user check the
column for the user you desire to restrict access or un-check "Allow Login" instead. If
you check the Is Locked column the number of logins.
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The Actions window will contain these tools: 

Save: Save the configuration for user account.

Refresh: Restore the configuration to the last save action. Any modification done to a user
account , from the last save action will be lost.

  NOTE: Any modification done for a user account must be saved by pressing Save in
the Actions window. 

  IMPORTANT: The MASTER username's default password is well-known in the

GoldMine community. If you wish to set MASTER to log into wMobile, be sure to

change the password before enabling the username for login.

  CONFIGURATION NOTE: When updating User Profile settings, the user must log out

of wMobile and then log back in for the changes to take effect.

See Also:

  Adding or Updating Users in wMobile

  Configuring Email Accounts in wMobile

4.13.3 Clear Cache

There is an option to Clear Cache in the wMobile Manager Console. Examples when Clear Cache

might be used are:

· When a user is added to GoldMine and doesn’t yet appear on the wMobile user list to

grant login access 

· When a GoldMine user is added or removed from a GoldMine user group for updating

record access 
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· When user ownership settings are changed in GoldMine.

If 'Clear cache' is clicked from wMobile root, cache is reset for all components.

If 'Clear cache' is clicked from one of the components, only cache from that component is

reset.

When ‘Clear cache’ action is executed, a request is sent to each component or to only one

component for resetting cache.

Data cleared from cache includes:

· GoldMine Users’ Security 

· GoldMine User Groups 

· Users 

· GoldMine DbAliases 
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· GoldMine DbOwner 

· Email Accounts 

· Custom Screen Tabs (wMobileDesktop) 

· GoldMine View Tabs (wMobileDesktop) 

· Contact Details Tabs (wMobileDesktop)

Normally, wMobile caches these settings for 4 hours before refreshing them

automatically. This feature will be helpful for administrators when they are changing user

permissions in GoldMine and wish to force a clearing of cache for the changes to take

effect in wMobile. 

wMobile users will still also need to logout of wMobile and back in for changes to take

effect.

4.13.4 Logged In Users: Viewing / Logging Out

Using the wMobile Manager Console, it is possible to view which users are currently

logged into Phone and Desktop respectively. To access this information, start by selecting

either the Phone or Desktop node in the wMobile Explorer window. In the following

example, the logged in users for Phone will be displayed.

After selecting the Phone node, double-click the Logged in Users icon (shown above) to

display a list of users currently logged into wMobile Phone. 
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To get a complete number of users logged in (i.e., an aggregate of Phone + Desktop),

Desktop would need to be checked for logged in users as well.

After selecting the Desktop node in the wMobile Explorer window, double-click the Logged

in Users icon (shown above) to display a list of users currently logged into wMobile

Desktop. 

Logging a User Out of wMobile

To log a specific user out of wMobile, place a tick in the checkbox for that user and then

click the Logout command in the Actions window.
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4.14 Configuring Email Accounts in wMobile

Configuring Email Accounts in wMobile

The wMobile Manager Console allows an administrator to configure and maintain email

accounts for all users from one convenient place. 

In the wMobile Explorer window, click on the Email Accounts node to display the email

accounts in the main window.

In the grid, you can view all of the defined email accounts and see specific configuration

settings, account status, etc.

  NOTE: All the columns are READ-ONLY. To change settings for an email account,

you must use the action links available in the Actions window. 
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If the text in a grid cell is not fully visible, hover your cursor over the cell and a screen tip

will appear with the entire text contents.

The Account Name column contains the name of the email account (this is typically a

"friendly" name for the email account).

The Last Checked Date column contains the last date the Email Fetcher Service tried to

retrieve the emails for the email account on that row. If the wMobile Email Fetcher Service

did not attempt to retrieve email messages for the chosen folders, the displayed value will

read: Never.

The Type Name column contains the type of protocol used by the email server. This will

be chosen when creating a new email account and cannot be changed afterword in edit

mode.

NOTE: If the account has the wrong protocol set, the account needs to be deleted and a

new one created.
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The User Name column contains the username for the email account used by the login

process.

The Owner column contains the wMobile user for which the email account was created. 

The Last Connection Status column displays the message resulting from when an email

account is tested. If the account is setup correctly, the background color of the column

will be green and the status will read: "Success!"

If there was a problem with the email account this column will explain why the test failed

(a common problem is that the email account is not configured correctly) and the

background color of the column will be red.

The Is Default column contains a tick for the email account set as the default account

when more than one email account is configured for any given user (details below).

The AutoCheck Enabled column displays the status for the email account being set to

automatically retrieve new emails from the email server.
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The Incoming Server column contains the incoming email server specified to be used for

inbound email.

The Actions window contains these tools: 

New: Create a new email account.

Copy: Duplicate an existing email account.
Edit: Edit an existing email account.
Delete: Delete the selected email account.
Make Default: Sets the selected email account as the default (see details below).
Check Emails: Checks for email messages.

Create New Email Account
1.  In the Actions window, click New. This will open the Account Type Selection dialog

requesting the Reply Address and the type of account being configured (POP3 or IMAP).

2.  Click the Continue button and the Add Email Account dialog will display.

3.  Enter the appropriate credentials for the email account and click the Save button.

Copy Email Account
1.  Select the email account you want to duplicate by clicking on it.

2.  In the Actions window, click Copy. This will open the Duplicate Email Account dialog.
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3.  Make the appropriate changes to the existing data for the new email account and click
the Save button.

Edit Email Account
1.  Select the email account you want to edit by clicking on it.

2.  In the Actions window, click Edit. This will open the Edit Email Account dialog.

3.  Make the appropriate changes and click the Save button.

Delete Email Account
1.  Select the email account you want to delete by clicking on it.

2.  In the Actions window, click Delete. This will open a prompt asking you if you are sure
you want to delete the selected account.

3.  Choose Yes or No.

Make an Email Account the Default
A user may have multiple email accounts within wMobile. Each account saved in wMobile
is designated as "owned" by a specific user. When a user has more than one email
account, one of these accounts must be set as the "default" account. For outgoing email,
wMobile will use the email address from the default account as the "From" address for the
user sending the email.
1.  Select the email account you want to make the default by clicking on it.

2.  In the Actions window, click Make Default. This will cause the checkbox in the Default
column of the Email Accounts table to be set for the selected account.

Check Emails
For the selected email account, this function is the same as the "Refresh" on wMobile
Phone's email list page and "Check Mail" in wMobile Desktop's Email Center. 
1.  Select the email account you want to check for online email by clicking on it.

2.  In the Actions window, click Check Emails.

See Also:

  Adding or Updating Users to wMobile

  Configuring User Profiles

4.14.1 Create Email Account in wMobile

Creating Email Accounts in wMobile Manager Console
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wMobile's Manager Console allows an administrator to create new email accounts for all

users. This topic provides step-by-step instructions on how to configure your email

account using wMobile Manager Console so that you access it using wMobile. You can

add and configure email accounts for other users as well. All the settings for an email

account and it's email folders can be changed by the user for which you are creating the

email account.

In the Actions window, click New.

The first step in creating a new email account is defining the Type of the email account

and specifying the reply email address.

Setting a reply-to address:

With wMobile, you can set a reply-to address that's different from your email account

username. Responses to messages you send with an alternate reply-to address are

delivered to that address.
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Setting a server type:

POP and IMAP are protocols that enable you to download messages using the wMobile

Email Fetcher Service. These downloaded messages come from email servers into your

wMobile system so you can access your mail with the wMobile email client program.

Chose the protocol from the provided options.

Press Continue button.

Press the Continue button to specify the rest of the settings for the email account.

Press the Cancel button to stop the creation of the email account and exit the dialog.

Specify Email Account Settings

  NOTE: All the fields that have an asterisk (*) at the end of the description are

mandatory fields. The email account information will not be saved until these field are

completed.

The Owner drop-down contains a list of all the users from wMobile and Goldmine. The

default value set for this field is the first value within the drop-down. The email account

will be available only for the chosen user.

The Reply Address is automatically filled with the email address specified at step 1, the

value can be changed.
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· Incoming Server: The address of the incoming email server. 

· Type: Incoming mail protocol. This is set when the account is first created and cannot

be modified.

· Port: Represents the server port for incoming email server.

· User Name: The user name used for logging into the incoming email server.

· Password: The password of the user logging into the incoming email server.

· Authentication Method: The method of authentication used by the the incoming email

server. Chose an appropriate method from the drop-down.

· This Server requires a secure connection (TLS/SSL): If your incoming mail server

requires a secure connection, this checkbox needs to be checked. The wMobile email

client will try to use TLS first, but if it's not detected on the server, it will then default to

SSL.

· Check Interval (Minutes): This value is a time period in which the Email Fetcher Service

will scan the email account server for new emails. 

· Disable automatic retrieving of new e-mails: This option tells the Email Fetcher Service

to check for new emails and automatically download them if found in the set interval

time. Tick this option ti disable if you do not wish to download new emails

automatically. 

· Automatic delete e-mails from e-mail Server after being processed by wMobile: This

option allows Email Fetcher Service to delete the emails from the email server after

downloading them.

· Has Cases: This option specifies that the email has a case. The Email Fetcher Service

will scan every email for cases and if a case id is found within the email "Subject", it will

extract the case from the email content. The cases will not be processed for sent folder.

Case processing is needed before Filing, because if there is no new case, the email will

be filed as history linked to existing case, even if auto filing was disabled.
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· Email signature: This field is used to enter your signature that will be used when sending

email.

· Outgoing Server: The address of the outgoing email server.

· Port: Represents the server port for outgoing email server 

· User Name: The user name used to login into the outgoing email server.

· Password: The password of the user logging into the outgoing email server.

· Authentication Method: The method of authentication used by the the incoming email

server. Chose an appropriate method from the drop-down.

· This Server requires a secure connection (SSL): If your incoming mail server requires a

secure connection, this checkbox needs to be checked.

Automatic Filling Options
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Auto File Start Date: This option by default is set to the current date and time. Email

Fetcher Service will scan emails with the email date more recent than the chosen date and

process them in order to link them to a contact or file them is necessary.

After setting the Incoming Server Information and Outgoing Server Information you can

test the email account by clicking Test Account. 

Save: Pressing the Save button will save the email account and its folders.

Before saving the email account, the settings are tested and the result will be displayed in

a window. The email settings will be saved regardless of the testing result. 

If the email account uses the POP3 protocol, the email folders that will be saved are Inbox

and Sent. If the email account uses IMAP protocol the email folders will be downloaded

based on the Incoming Server Information. If the settings specified for Incoming Server

Information are not correct the email folders are not downloaded from the server and

therefore will not saved.

Save and Close: This button will execute the steps specified for the Save action and will

close the window. 

Cancel: The Cancel button will discard any change made in the form and those changes

will not be saved.
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Specify Email Account Folder Settings

If the selected email account protocol is POP3, the email folders will be automatically

generated by wMobile Manager Console. The email folders will be visible in the same page

as the email account settings and they will be READ-ONLY.

If the selected email account protocol is IMAP, the email folder settings will be displayed

in a separate tab. The email folders will be downloaded from the email server and

displayed in a grid. The folders are downloaded when the Email Folder Settings tab is

clicked. In order to download the email folders for an email account that uses the IMAP

protocol, it is necessary to provide the Incoming Server Information.
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The special email folders: Inbox and Sent are detected by the wMobile Manager Console.

The email folder Inbox is marked as Visible by default and this property cannot be

changed.

The Sent folder is automatically detected by the folder flag set on the email server and the

folder name. You can change this setting by selecting a different option from the drop-

down.

The available options in the drop-down from which you can choose a sent folder from are

the email folders detected on the server excluding the Inbox folder.

The option Sync with server will download new folders defined on the server and delete

the local folders that no longer exist on the email server.
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All the folders detected and downloaded from the email server are displayed in the grid.

For each folder, you choose to make it Visible and/or set it to use Auto File. If an email

folder is made Visible, the user can view its content in the wMobile email client.

If an email folder is set to Auto File, the Email Fetcher Service will automatically file email

found for that folder.

See also De-Duplication Service.

4.14.2 Configure Email Account Settings

Configure Email Accounts with wMobile Manager Console for wMobile users

Every email account already configured for wMobile users can be maintained using the

wMobile Manager Console.

Open wMobile Manager Console. In the wMobile Explorer window, click on the Email

Accounts node to display the email accounts in the main window.

Example of the email account grid:
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To open an email account for editing, select an email account by clicking on it within the

grid and then click Edit in the Actions window (or double-click on an email account to

within the grid). This opens the Edit Email Account dialog.

All of the email account settings can be edited within this dialog with the exception of the

Type value (i.e., the mail server protocol: POP3 or IMAP).

See also Email Archiving Service.

4.14.3 Sample Email Account Setup

Example of Creating an Email Account
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In this topic we will show the steps to add a new email account.

Using wMobile Manager Console, in the wMobile Explorer window, click on the Email

Accounts node.

In the Actions window, click New.

Type the Reply Address (an email address) and choose the appropriate protocol for Type.

For this example, we will choose "IMAP". Click the Continue button.
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Add the Incoming Server Information in order to download the email server folders.

These example settings apply to a Gmail email account type.
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The email folders are downloaded and displayed on the Email Folder Settings tab.

Multiple "email sent" folders are detected and the last one is chosen by default. You can

change this with any of the presented options in the drop-down.
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Add the Outgoing Server Information.

These example settings apply to a Gmail email account type.
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Click the Test Account button to test your account settings. A message with the test

results will be displayed.

Click the Save and Close button and email the account configuration will be saved.

The user for which the email account was created may login to wMobile Desktop and

access the Email center. This user was specified in the Owner field. In this case it is

MASTER.

The email account will appear in the email accounts list. (NOTE: The email account is

accessible for the user MASTER in the wMobile Phone edition as well.)

4.14.4 Email Archiving

We all know how much business is conducted via email these days. It’s a benefit to be

able to archive email in your GoldMine CRM system, so that it’s available for later

reference. Many of our customers use GoldMine and/or wMobile to send and receive

email, so this email is automatically stored in GoldMine History. However, sometimes we

find customers that use other email clients such as Lotus Notes, Thunderbird, Zimbra,

MacMail or even Outlook without using GoldMine’s Outlook integration. Sometimes sales

staff will use a native email application on their mobile devices instead of emailing from

GoldMine or wMobile. In these cases, the email can be archived automatically by the

wMobile Email Fetcher Service. In order to archive both incoming and outgoing mail, the

email server must support IMAP connections (not POP3).
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Email archiving can be set up by an administrator or an end-user. We’ll review both

options. In cases where end-users are using a mix of email clients, including GoldMine

and/or wMobile, a de-duplication service can be used to avoid archiving duplicate copies

of the same messages. 

Email archiving can be set up by an administrator in the wMobile Manager Console on the

server where wMobile is installed. These settings would be under the Email Fetcher

component in the wMobile Explorer pane on the left. On selecting Email Accounts, you’ll

see the list of user email accounts configured in wMobile.  Highlight an email account and

double-click on it or use the Edit option in the Actions menu on the right.

 NOTE: Email settings are not carried over from GoldMine, so if these aren’t

configured already, check out the topic on Creating Email Accounts in the wMobile

Manager Console. 

On the Email Account Settings tab, the Auto File Start Date would be selected as

highlighted below. The account cannot have automatic retrieving of emails disabled for

auto filing (archiving) to take place.
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To select individual folders for Auto Filing (archiving), select the Email Folder Settings tab

as highlighted below. A list of email folders will appear. Folders such as the Inbox and

Sent Items folders can be check-marked in the Auto File column. Your own email folders

might be named slightly differently based on your mail server, but should be named

recognizably as the inbox and sent mail folders.

If you have a long list of folders, you can filter the Folder Type to only show Inbox and Sent

folder types. Click on the filter icon in the upper corner of the Folder Type header. Then

uncheck any folder types you don’t need to see on the list and click OK. 
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When all configurations are completed, select Save and Close at the bottom of the

window.

Email archiving can also be set up by a wMobile user in the wMobile Desktop or Phone

email preferences. 

See also De-Duplication Service.

4.14.4.1 De-Duplication Service

If email is sent and received in multiple email clients and email auto filing is in use, there

could be duplicate emails archived in GoldMine’s History. The wMobile Fetcher Service

includes a de-duplication service which remove duplicates based on the MailID.

The email de-duplication service is configured in the wMobile Manager Console System

Settings. Select wMobile at the top of the wMobile Explorer Pane to include all settings.

Double click on System Settings.
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Navigate to Configuration > Common > Email and locate the DDEnabled setting as shown

below. This should be set to True to enable the DeDuplication service

In System Settings there are some other settings related to Auto Filing such as CountLimit

and DaysLimit. The default settings are 1,000 and 30, by default, but these can be adjusted

temporarily if you’re trying to archive a larger amount of email. For example, sometimes

new wMobile customers will want to archive past email. Be advised that there’s no

specific limits on these values, but the system will consume higher resources during the

period when they’ve been increased.
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4.15 Configure Access to Email Attachments and Linked Documents

In order to access to email attachments and linked documents via wMobile, some

configuration is required. 

1) If the document paths reference a drive mapping such as G:\GoldMine\TmpLinks or G:

\GoldMine\Mailbox\Attach, then the drive mapping must be added in the wMobile Manager

Console, see: Virtual File System Settings.

  NOTE: In wMobile versions prior to 3.0.2.x this was controlled by using a domain

account for the Remote GoldMine Service Account. This is now done in the wMobile

Manager Console using the Virtual File System.

4.16 Configuring Security

Security Concepts in wMobile

In this section outline and discuss methods for securing wMobile in the following ways:

· Restricting access to records with Contact Filters for users

o Ideal for customers who have never used record curtaining

o Ideal for customers who are accustomed to restricting access to remote laptops

4.16.1 Restricting Accesss to Records with Contact Filters

Restricting Access to Records with Filters

wMobile features the ability to use filters, rather than Ownership, to restrict access to

records. This method of record security is ideal for customers who are migrating users

who have traditionally used a laptop and have synchronized to get records or for

customers that want to limit the records a user or group of users can see without having

to implement Record Ownership and Record Curtaining.

Any filter in GoldMine can be selected; wMobile will recognize public filters and filters

owned by any user. Public filters will be listed first followed by the filters of all users,

sorted alphabetically by Username, then by filter name.

Configure a User with a Contact Filter to Restrict Access to Records

In the wMobile Manager Console, locate the user in the Users grid.
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In the Contact Filter column, select the filter that you would like to use to define which

records the user will see.

After making the changes to the user's profile click the Save button in the Actions window.

  CONFIGURATION NOTE: When updating User Profile settings, the user must log out

and log back in for the changes to take effect.

  IMPORTANT: Contact Filters will restrict the access of records regardless of the

'MASTER' setting. For example, if the user is set as a MASTER in wMobile and has a

Contact Filter on their profile, they will still only be able to see the records in the

Contact Filter.

See Also:

  Adding or Updating Users in wMobile

  Configuring User Profiles
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4.16.2 One Click Login Security

One Click Login Security for Phone and Desktop Editions

wMobile offers administrators the ability to control whether users can use the One Click

Login feature or not in the Phone and/or Desktop editions separately. For more

information on configuring and using the One Click Login feature, please refer to the

topics:

One Click Login for Phone

One Click Login for Desktop

Setup One Click Login for Desktop

Enable / Disable One Click Login for Phone and Desktop Editions

Users can be forced to enter their login credentials each time they want to use wMobile as

an added security measure. If your business rule requires this, here is how an

administrator can change the setting to enable or disable the usage of One Click Login

feature.

Open wMobile Manager Console and then go into the System Settings.

The AllowOneClickLogin setting value controls the use of the One Click Login feature. 

To edit the Phone edition setting, navigate the tree list to get to the following node:

Configuration > Phone > Security > Login

To edit the Desktop edition setting, navigate the tree list to get to the following node:

Configuration > Desktop > Security > Login

Example of configuring AllowOneClickLogin for the Desktop users:
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With Login selected for either edition, you will see AllowOneClickLogin in the main

window. This value defines whether or not users can setup One Click Login. Set this to

True to allow this feature or set to False to disable this feature.

After making the changes to these settings, click  Save in the Actions window (restarting

components will be required; a prompt will appear after clicking "Save").

4.17 Customizing wMobile Phone Edition

wMobile Phone Edition can be customized in a variety of ways:

  Customizing the Home Menu

  Customizing Lookup Options

  wMobile Phone AddIn Configuration

This documentation assumes you have some familiarity with GoldMine database structure

and the ability to identify GoldMine field names. If assistance is needed for customization,

please contact your wMobile reseller or wMobile support.

4.17.1 Configuring Option to Add to Local Address Book

Steps for setting the method (Download or Email) used by wMobile to add a contact to

your device:

1. From the Home page, open the Side Menu,  click on My Preferences > Contact Options.

Select Email or Download from the Add Contact to Local Address Book Method drop-down.
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2. If your device requires using the Email method, you will need to configure the

Notification Service Settings.

· Open the wMobile Manager Console.

· Select the wMobile node in the wMobile Explorer window and then double-click the

Notification Service Settings icon in the main window to display the SMTP Server

settings.

· Enter your SMTP Server information to be used for sending the contact information via

email.

· Click Save in the Actions window to save the settings.

  NOTE: You may optionally use Test Settings in the Actions window to test that your

settings were configured successfully.
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4.17.2 Customizing the Home Menu

wMobile Phone edition's Home menu can be customized to suit the needs of your end

users. These customizations are made using the wMobile Manager Console. By hiding

and/or showing items on the Home menu, users may experience less scrolling in order to

access specific items on the menu. Further, the most useful items needed can be

available with minimal clicks. New items can be added onto the Home menu as shortcuts

to common tasks.

See Also:

  Hide/Show Home Menu items

  Delete Menu item

  Add New Home Menu Shortcut

  Setting Sort Order on Home Menu

4.17.2.1 Hide/Show Home Menu Items

Menu items can be configured to be displayed or hidden on the Home menu using the

Mobile Menu Designer. 

Accessing the Mobile Menu Designer

In the wMobile Explorer window, navigate to: wMobile > Phone > UI > Menus, and then

select HomeMenu.

In the main window you will find the Mobile Menu Designer containing the menu layout.

Within the layout:

· Items that appear in blue will be displayed on the wMobile Home menu.
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· Items that appear italicized and gray will not be displayed on the wMobile Home menu.

Hiding / Showing Items in the Menu
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· To hide a menu item, select it from the list in the Mobile Menu Designer.

· In the Properties window, change the Visible status from True to False using the drop-

down list.

· Likewise, to show an item that is currently hidden, select it in the Mobile Menu Designer

and then change the Visible property to True.

Click Save in the Actions window to save any changes that were made.

The changes will appear in wMobile after a page refresh or after a user logs out and then

logs back into wMobile.

For changing the order of Home menu items, please see the topic: Sort Order on the Home

menu.

4.17.2.2 Delete Menu Item

Menu items can be stopped from displaying on the Home menu using two methods: (1)

hiding the item; or (2) removing the item.

Remove an item by highlighting it and then clicking Remove Menu Item in the Actions

window. 

  IMPORTANT: 
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· Unless you are sure the menu item will not be needed again, it is highly recommended

that the item is hidden rather than deleting it completely.

· There is no option to restore deleted menu items, they would need to be recreated

manually or a Restore Default command may be executed causing all customizations

to be lost.

NOTE: There is no option to restore deleted menu items, they would need to be recreated

manually.

4.17.2.3 Add New Home Menu Shortcut

New items can be added to the Home menu using the Mobile Menu Designer.

In the wMobile Explorer window, navigate to: wMobile > Phone > UI > Menus, and then

select HomeMenu.

At the bottom of the phone's screen, in the main window, click _new item (Edit Me).

For this example, we'll add a menu option to show "This Week's Appointments".

You can use the splitter bar to adjust the tool window sizes so you can see the Properties

window more easily. Put your cursor over the splitter bar, and then click-and-drag it to a

usable width.
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Select "item" as the Type from the drop-down list in the Properties box.

Enter Text as you would like the option to appear on the Home menu. In this example, the

Text will be entered as:

<% $Resources:Phone.Menus,LBL_WEEKLY_APPTS %>

The LBL_WEEKLY_APPTS is the Resource Id and the value will be "This Week's

Appointments". This information needs to be inserted in the database for Localization and

is discussed below.
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Click in the ImageURL field and then click the browse button to display the Select

ImageUrl dialog. Use this dialog to select an image icon to be used for the menu item.

  NOTE: A number of icons are provided in the wMobilePhone\res\img folder.

It is possible to add and use custom icons, but note that the icons provided are formatted

consistently so they download quickly. If you use your own, they must be formatted with

the same size and type as the existing collection icons.

Set the Visible status to True.

Add the Value text as:

ViewPendingActivityListPage.aspx?DateRangeType=KnownDateRange&KnownDateRange=ThisWeek&ActivityType=A

You can copy the Value from another menu item and edit it accordingly. The following

time-frame and activity types cam be used:
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Time-frame values:

LastMonth

LastWeek

Yesterday

Today

Tomorrow

ThisWeek

ThisMonth

ThisQuarter

NextMonth

NextWeek

NextQuarter

Next30Days

Next14Days

Next31_60Days

Next61_90Days

PastDue

PastDueAndToday

GoldMine activity types:

A - Appointments

C - Calls

S - Sales

T - Next Actions

O - Other Actions

Click Save in the Actions window to save any changes that were made.

wMobile must be restarted for this type of change to take effect. 

Click the wMobile > Phone node in wMobile Explorer window.
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In the Actions window, click Restart.

A translation needs to be added for the newly added menu item. This is done through the

wMobile Manager Console Localization feature.

To access the Localization icon, click on the wMobile node found in the wMobile Explorer

window.

Double-click the Localization icon to open the editor in the center window.

All the resources are loaded into the grid. Search for the Resource Id:

LBL_WEEKLY_APPTS. The Resource Id is not loaded yet.
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Click Update Dynamic Resources in the Actions window. The phone menu item you added

will be extracted and merged with the current resources.

The Resource Id will appear in the center window. The Resource Id and Resource Set fields

are READ-ONLY. 

The Invariant Value field contains text that is automatically generated based on the

specified Resource Id.

You can modify the Invariant Value (i.e., the text that is displayed in wMobile) and also

translate the menu item in Spanish by adding the appropriate translation text in the Value

field.

These values are saved automatically when you click away from the field you edited.

The new item will appear at the bottom of the Home menu:
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For changing the order of Home menu items, please see the topic: Sort Order on the Home

menu.

4.17.2.4 Sort Order on Home Menu

Items on the Home menu can be sorted to meet your needs.

Highlight the menu item to be moved in the Mobile Menu Designer.

Use the Move Down Menu Item command in the Actions window to move the menu item

lower on the list.

Highlight the menu item to be moved in the Mobile Menu Designer. 

Use the Move Up Menu Item command in the Actions window to move the menu item

higher on the list.
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Click Save in the Actions window to save any changes that were made.

The changes will appear in wMobile after a page refresh or after a user logs out and then

logs back into wMobile.

4.17.3 Customizing Contact Screens

wMobile allows simple customizations of your Contact Screens that were initially created

and configured in GoldMine. Of all the fields displayed within a specific Contact Screen

while working in GoldMine, not all of them are needed by users working remotely with

wMobile. These instructions explain how to modify the Contact Screens to fit the specific

needs of your users, enabling them to see only what is necessary. On small devices this is

a great benefit as fields can be removed from the screen and the order of existing fields

can be changed.

In order to be able to see and use custom Contacts Screens in wMobile, Record Types

must be enabled. To enable Record Types, please see the EnableRecordTypes setting in

the topic: Configuring wMobile System Settings.

Once you have enabled Record Types for the Phone Edition, check the contact view. If the

field you are looking for is already on the Contact Screen in GoldMine, then it should

automatically appear in the contact screen in the Phone edition as well. You only need to

add a field in GoldMine if that field is not on the contact screen in wMobile and you wish



wMobile AdministrationwMobile User Guide 265

Copyright © 2021 SugarCRM All Rights Reserved.

to see it there. wMobile reads the GoldMine database for this information (fields cannot

be added to contact screens from within wMobile Manager Console).

With EnableRecordTypes set to False, wMobile will use the company, contact, address

fields, phone fields, email address, website, and key fields.

Open the wMobile Manager Console. In the wMobile Explorer window, navigate to: wMobile

> Phone > UI > Contact Screens. Under this node are the screens you can customize. In

this example, you see: Main View, Wide View, Car, and Service Customer.

Click on a screen name to select it and have it display in the center window.

In the center window, select the screen field you would like to perform an action on by

clicking on it. Your choices are: Remove Screen Field, Move Up Screen Field, or Move

Down Screen Field. 
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It is also possible to 'hide' a field from view. Select the field in the list. Set the Visible

settings as shown below to 'False.'
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The Actions window contains the commands to perform on the selected screen field.

After making your edits to a screen, click Save.

Actions
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Save: Save changes made to the screen.
Refresh: Refresh the screen.
Remove Screen Field: Remove the field from the screen. [NOTE: This does not affect the
screen in GoldMine; only the display in wMobile. If you remove a screen field and need it to
display again, you will need to use the Restore Default action (see below). It is
recommended to set the Visible setting to False, rather than removing the field.]
Move Up Screen Field: This action moves the selected field "up" within the list.
Move Down Screen Field: This action moves the selected field "down" within the list.
Restore Default: Restores the screen to its original configuration (as it is in GoldMine). All
customizations done in wMobile for the currently selected screen will be lost. Use this
action if you need to re-do a screen customization from the beginning.
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4.17.4 Customizing Lookup Options

wMobile has two options to help users search for contacts.

The first option is Quick Search which is located at the top of the wMobile Home Menu.

Using the default search fields, a wMobile user can enter part of a company name, contact

name, or city. By default, wMobile already has a three search fields configured but allows

its users to modify their searching capability by adding and/or removing Quick Search

fields. For instructions on customizing these search options, see the topic: Customizing

Quick Search Fields.

The second option is the Lookup Contact item on the Home Menu.
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By default, the Lookup Contact option includes five search fields. To get the list of these

fields and to add or remove fields to be searched, see the topic: Customizing Lookup

Contact Fields.

The fields displayed in the "results" received after a search is performed using Quick

Search or Lookup Contact may also be customized to meet your needs. To learn about

customizing the results, see the topic: Customizing List View Results.

  NOTE: It is possible to edit these scripts while users are logged into wMobile.

However, be aware that if you make a mistake, it could cause the users to get errors

and not be able to view the respective pages. wMobile does not need to be restarted to

display these customizations. Saving the script and doing a screen refresh in wMobile

is all that is needed.
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4.17.4.1 Customizing Quick Search Fields

By default, the Quick Search includes the Company, Contact and City fields. Users can edit

their own Quick Search fields in the wMobile Phone My Preferences. These modifications

are saved on a per user basis meaning that users will have their own individual search

fields selected to be used when searching for contacts. One user may prefer using a

specific phone number field while another may prefer the company or contact's name. The

Quick Search fields can also include GoldMine user-defined fields which help to provide

many searching choices.

Select My Preferences from the Home Menu. Then select Contact Options as highlighted

on the left.

Select a Primary Search Configuration field from the drop-down list. In this example,

postal code (Contact1.ZIP) will be added. After selecting the item in the drop-down, click

the Add button to include this field in the Quick Search. There is no limit to the number of

fields you can add but please be aware: the more fields you add, the more that need to be

searched, and the longer the results will take to be displayed.

Click Save to save your changes.
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To test the results in wMobile, enter search criteria into the Quick Search field:
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The matching contacts will be displayed. If additional fields would be helpful in the results

list, see the topic: Customizing List View Results.
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If additional fields would be helpful in the results list, see the section on Customizing List

View Results.

Administrators can also set Quick Search fields for all users in Default Users Options. 

4.17.4.2 Customizing Lookup Contact Fields

By default, the Lookup Contact option includes the Contact name, Company name,
Country, Zip, and Address. The field choices to be selected for searching can be
customized by editing the LookupContact.xml located in the following folder (typical
location):

C:\Program Files\W-Systems\wMobilePhone\conf\UI\CustomForms

Drop-down containing search fields:

Adding a Lookup Contact Field:
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Perhaps you'd like to add the ability to search for the "Department". In this example, the

GoldMine Department field has been added as a search criteria.

For this example, Notepad has been used to open the XML (you may use a different editor;

see: TIP (Editing XML Files) for more information). Changes made to the file appear in

bold blue text.

The easiest way to add a field is to copy a line and edit it accordingly. Copy an existing

line and then edit the LookupField Name and Title values as shown in blue. Add this new

line into the file:

<LookupField Name="Dept:" Title="&lt;% $Resources:Common,LBL_DEPARTMENT %&gt;" />

Example showing new line added after "Address1":

<MobileForm.Configuration>

<LookupFields>

<LookupField Name="Contact"  Title="&lt;% $Resources:Common,LBL_CONTACT %&gt;"/>

<LookupField Name="Company" Title="&lt;% $Resources:Common,LBL_COMPANY %&gt;"/>

<LookupField Name="Country" Title="&lt;% $Resources:Common,LBL_COUNTRY %&gt;" />

<LookupField Name="Zip" Title="&lt;% $Resources:Common,LBL_ZIP %&gt;" />

<LookupField Name="Address1" Title="&lt;% $Resources:Common,LBL_ADDRESS %&gt;" />

<LookupField Name="Dept:" Title="&lt;% $Resources:Common,LBL_DEPARTMENT %&gt;" />

<!-- Use GoldMine label 

<LookupField Name="Country" -->

</LookupFields>

<LookupOperators>

<LookupOperator Name="BeginsWith" Title="&lt;% $Resources:Common,LBL_BEGINS_WITH %&gt;"  />

<LookupOperator Name="EndsWith" Title="&lt;% $Resources:Common,LBL_ENDS_WITH %&gt;"  />

<LookupOperator Name="Contains" Title="&lt;% $Resources:Common,LBL_CONTAINS %&gt;" />

<LookupOperator Name="EqualTo" Title="&lt;% $Resources:Common,LBL_EQUAL_TO %&gt;" />

<LookupOperator Name="NotEqualTo" Title="&lt;% $Resources:Common,LBL_NOT_EQUAL_TO %&gt;" />

<LookupOperator Name="GreaterThan" Title="&lt;% $Resources:Common,LBL_GREATER_THAN %&gt;" />

<LookupOperator Name="LessThan" Title="&lt;% $Resources:Common,LBL_LESS_THAN %&gt;" />

<LookupOperator Name="GreaterThanOrEqualTo" Title="&lt;% $Resources:Common,LBL_GREATER_THAN_OR_EQUAL_TO %&gt;" />

<LookupOperator Name="LessThanOrEqualTo" Title="&lt;% $Resources:Common,LBL_LESS_THAN_OR_EQUAL_TO %&gt;" />

</LookupOperators>

</MobileForm.Configuration>

Once editing is complete, save the changes made to the LookupContact.xml file and test in

wMobile to see that the field displays.

Example showing the "Department" field in the drop-down:
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If additional fields would be helpful in the results list, see the section on Customizing List

View Results.

4.17.4.3 Customizing List View Results

When searching for records in wMobile using the Quick Search or Lookup Contact options,

the results will be displayed in a List View. There is a default group of fields that will

contain the data returned by a search: Contact, Company, Address1, CityState,

EmailAddress, Phone1, Ext1, and Key1. The order of the search result fields displayed in

the List View is configurable, see details below.

Results in the List View shown with the default fields:
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Based on your specific needs, it may be helpful to include additional fields in the List View

results.

An administrator can add additional fields by editing the ContactListStyle.xml file  located

in the following folder on the wMobile server (typical location):

C:\Program Files\W-Systems\wMobilePhone\conf\UI\ListViewStyles

  NOTE: The ContactListStyle.xml file is copied to the server during the initial

wMobile installation but not during wMobile updates. This prevents customizations

made to this file from being overwritten with subsequent wMobile updates.
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  IMPORTANT: It is recommended that a backup copy of the ContactListSyle.xml file

is made before editing the original. The backup copy may be used for reference or as a

restore point if needed.

In the following customization example, the Industry (i.e., KEY2) and Source (i.e., SOURCE)

fields will be added to the List View results.

Open the ContactListSyle.xml file. You can use Notepad to open XML files (you may use a

different editor.

  TIP (Editing XML Files): To edit XML files you can use the Notepad application that

ships with Windows but most text editors could be used such as Microsoft Visual

Studio or Notepad++. Please note that some text editors directly support editing XML

files. This support is beneficial because the editors can color code the text aiding in the

editing of XML files.

The modifications to the original file are shown in the following listing in blue. Two

sections of this file need to be edited. One section is between the <Columns> and

</Columns> tags and the other section is between the <ItemLayout> and </ItemLayout>

tags (shown in red).

<?xml version="1.0" encoding="utf-8"?>

<ListView>

  <Columns>

    <ImageColumn Name="ContactImage" ImageUrl="res/img/Contact.png" />

    <LinkButtonColumn Name="Contact" Title="Contact" DataField="Contact" CommandName="Select" />

    <TextColumn Name="Company" Title="Company" DataField="Company" EmptyText="N/A" />    

    <TextColumn Name="Address1" Title="Address1" DataField="Address1" EmptyText="N/A" />

    <TextColumn Name="CityState" Title="CityState" DataField="CityState" EmptyText="N/A" />

    <LinkButtonColumn Name="EmailAddress" Title="Email" DataField="EmailAddress" CommandName="SendEmail" />

    <PhoneLinkColumn Name="Phone1" Title="Phone" DataField="Phone1" />

    <TextColumn Name="Ext1" Title="Ext1" DataField="Ext1" />

    <LinkButtonColumn Name="Pending" Text="&lt;% $Resources:Phone.ListViews,LBL_PENDING %&gt;" Title="Pending" CommandName="Pending" />

    <LinkButtonColumn Name="History" Text="&lt;% $Resources:Phone.ListViews,LBL_HISTORY %&gt;" Title="History" CommandName="History" />

    <TextColumn Name="Key1" Title="Key1" DataField="Key1" EmptyText="N/A" />

    <TextColumn Name="Key2" Title="Key2" DataField="Key2" EmptyText="N/A" />

    <TextColumn Name="source" Title="source" DataField="source" EmptyText="N/A" />

  

  </Columns>

  <ItemLayout>

    <RowLayout BackColor="SkyBlue">

      <CellLayout HorizontalAlign="Left" ColumnLayout="0" />

      <CellLayout HorizontalAlign="Left" ColumnLayout="1" />
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    </RowLayout>

    <RowLayout>

      <CellLayout HorizontalAlign="Left" ColumnLayout="" />

      <CellLayout HorizontalAlign="Left" ColumnLayout="2" />

    </RowLayout>

  <RowLayout>

  <CellLayout HorizontalAlign="Left" ColumnLayout="" />

  <CellLayout HorizontalAlign="Left" ColumnLayout="3" />

  </RowLayout>

  <RowLayout>

      <CellLayout HorizontalAlign="Left" ColumnLayout="" />

      <CellLayout HorizontalAlign="Left" ColumnLayout="4" />

    </RowLayout>

    <RowLayout>

      <CellLayout HorizontalAlign="Left" ColumnLayout="" />

      <CellLayout HorizontalAlign="Left" ColumnLayout="5" />

    </RowLayout>

      <RowLayout>

  <CellLayout HorizontalAlign="Left" ColumnLayout="" />

  <CellLayout HorizontalAlign="Left" ColumnLayout="10" />

      </RowLayout>

      <RowLayout>

  <CellLayout HorizontalAlign="Left" ColumnLayout="" />

  <CellLayout HorizontalAlign="Left" ColumnLayout="11" />

      </RowLayout>

      <RowLayout>

  <CellLayout HorizontalAlign="Left" ColumnLayout="" />

  <CellLayout HorizontalAlign="Left" ColumnLayout="12" />

      </RowLayout>

  <RowLayout>

      <CellLayout HorizontalAlign="Left" ColumnLayout="" />

      <CellLayout HorizontalAlign="Left" ColumnLayout="6; ;7" />

    </RowLayout>

    <RowLayout>

      <CellLayout ColumnSpan="2" HorizontalAlign="Right" ColumnLayout="8; ;9;&lt;hr size=&quot;1&quot; color=&quot;black&quot;&gt;" />

    </RowLayout>

  </ItemLayout>

</ListView>

Add the columns to the <Columns></Columns> section:

The easiest way to add an item is to make a copy of an existing line and customize the

copied line accordingly. After inserting the two new lines for this example, update the

TextColumn Name, Title, and DataField values (shown in blue) to be the field names to be

displayed:

 <TextColumn Name="Key2" Title="Key2" DataField="Key2" EmptyText="N/A" />

 <TextColumn Name="source" Title="source" DataField="source" EmptyText="N/A" />
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Now these items must also be added to the <ItemLayout></ItemLayout> section for them

to be displayed. 

Before customizing the ItemLayout section, it's worth noting that there are two methods

of setting the column order in the List View that displays search results: (1) using "index

numbers" and (2) using "column names". Each item to be displayed must be included in the

list of columns found between the <Columns> and </Columns> tags in the

ContactListSyle.xml file. 

1. Using Index Numbers:

In the following listing, the column numbers shown in red were added for reference only

and are not in the actual file. They are here to show that the items are depicted as

numbered sequentially from top to bottom starting with index "0". These index numbers

can be used to set the position of the items in the List View. While this is a viable option,

you may find using "column names" easier and more "readable".

  <Columns>

0   <ImageColumn Name="ContactImage" ImageUrl="res/img/Contact.png" />

1   <LinkButtonColumn Name="Contact" Title="Contact" DataField="Contact" CommandName="Select" />

2   <TextColumn Name="Company" Title="Company" DataField="Company" EmptyText="N/A" />    

3   <TextColumn Name="Address1" Title="Address1" DataField="Address1" EmptyText="N/A" />

4   <TextColumn Name="CityState" Title="CityState" DataField="CityState" EmptyText="N/A" />

5   <LinkButtonColumn Name="EmailAddress" Title="Email" DataField="EmailAddress" CommandName="SendEmail" />

6   <PhoneLinkColumn Name="Phone1" Title="Phone" DataField="Phone1" />

7   <TextColumn Name="Ext1" Title="Ext1" DataField="Ext1" />

8   <LinkButtonColumn Name="Pending" Text="&lt;% $Resources:Phone.ListViews,LBL_PENDING %&gt;" Title="Pending" CommandName="Pending" />

9   <LinkButtonColumn Name="History" Text="&lt;% $Resources:Phone.ListViews,LBL_HISTORY %&gt;" Title="History" CommandName="History" />

10  <TextColumn Name="Key1" Title="Key1" DataField="Key1" EmptyText="N/A" />

11  <TextColumn Name="Key2" Title="Key2" DataField="Key2" EmptyText="N/A" />

12  <TextColumn Name="source" Title="source" DataField="source" EmptyText="N/A" />

  </Columns>

2. Using Column Names:

The following listing is the same column list as the prior one but without the index

numbers being shown. In this listing, the red text is highlighting the column "Name" values

needed for setting the column order in the List View (i.e., the "Name" value):

<Columns>

   <ImageColumn Name="ContactImage" ImageUrl="res/img/contact.gif" />

   <LinkButtonColumn Name="Contact" Title="Contact" DataField="Contact" CommandName="Select" />

   <TextColumn Name="Company" Title="Company" DataField="Company" EmptyText="N/A" />    



wMobile AdministrationwMobile User Guide 281

Copyright © 2021 SugarCRM All Rights Reserved.

   <TextColumn Name="Address1" Title="Address1" DataField="Address1" EmptyText="N/A" />

   <TextColumn Name="CityState" Title="CityState" DataField="CityState" EmptyText="N/A" />

   <LinkButtonColumn Name="EmailAddress" Title="Email" DataField="EmailAddress" CommandName="SendEmail" />

   <PhoneLinkColumn Name="Phone1" Title="Phone" DataField="Phone1" />

   <TextColumn Name="Ext1" Title="Ext1" DataField="Ext1" />

   <LinkButtonColumn Name="Pending" Text="Pending" Title="Pending" CommandName="Pending" />

   <LinkButtonColumn Name="History" Text="History" Title="History" CommandName="History" />

   <TextColumn Name="Key1" Title="Contact Type" DataField="Key1" EmptyText="N/A" />

   <TextColumn Name="Key2" Title="Key2" DataField="Key2" EmptyText="N/A" />

   <TextColumn Name="Source" Title="Source" DataField="Source" EmptyText="N/A" />

</Columns>

Again, copy another set of lines beginning with <RowLayout> and </RowLayout> tags and

paste them where they should appear in the resulting List View, in this example, after the

KEY1 (having ColumnLayout = 10). 

1. Using Index Numbers:

<RowLayout>

    <CellLayout HorizontalAlign="Left" ColumnLayout="" />

    <CellLayout HorizontalAlign="Left" ColumnLayout="11" />

</RowLayout>

<RowLayout>

    <CellLayout HorizontalAlign="Left" ColumnLayout="" />

    <CellLayout HorizontalAlign="Left" ColumnLayout="12" />

</RowLayout>

2. Using Column Names:

As you'll see here, using the "names" instead of the "index numbers" allows you to easily

identify the positioning of the items you are placing in the layout without having to know

which index number is related to the column you are working with.

<RowLayout>

    <CellLayout HorizontalAlign="Left" ColumnLayout="" />

    <CellLayout HorizontalAlign="Left" ColumnLayout="Key2" />

</RowLayout>

<RowLayout>

    <CellLayout HorizontalAlign="Left" ColumnLayout="" />

    <CellLayout HorizontalAlign="Left" ColumnLayout="source" />

</RowLayout>

When all editing is complete, save the changes made to the ContactListView.xml file. Now

test your the updated List View by running a Quick Search or Lookup Contact search in

wMobile Phone to see the new fields in the results list. 
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  NOTE: Fields in the List View results that do not contain data are not displayed.

wMobile Phone Edition is designed for use on a handheld devices and does not display

empty fields to minimize scrolling.

Example of updated List View layout:

See Also:

· Customizing Quick Search Fields
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· Customizing Lookup Contact Fields

4.17.5 wMobile Phone AddIn Configuration

 To make adjustments to AddIns for wMobile Phone, open the wMobile Manager Console.

In the wMobile Explorer window, select the Phone node and then double-click the AddIns

Configuration icon in the center window. 

There are only two built-in AddIns for the wMobile Phone edition: Cases and Reporting.

(NOTE: If you have a custom AddIn provided by W-Systems, you will see it in this list as

well.)

Following is an example of disabling the Cases Addin. If you don't use GoldMine's Service

Center for cases, you might want to disable the Cases AddIn by unchecking it as shown

below in yellow. Click Save (shown highlighted in green) in the Actions window to preserve

this change.

A prompt will appear requesting to restart the Phone component; click OK to proceed. 



wMobile AdministrationwMobile User Guide 284

Copyright © 2021 SugarCRM All Rights Reserved.

NOTE: Restarting the Phone application will cause users to be forced back to the wMobile

login page.

When a user logs into wMobile after these steps are taken, the items related to Cases in

the Phone Edition, such as the option to create a "New Case" will no longer be displayed.
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4.18 Customizing wMobile Desktop Edition

  Managing Contact Tabs in wMobile Desktop

4.18.1 Managing Contact Tabs in wMobile Desktop

Following are examples and the steps to take in order to configure the contact tabs that will be

displayed for users.  The contact tabs configuration can be done for all users (globally) using the

Default User Options or for specific users (individually) by using User Options. The process is similar

for both but when setting the Default User Options, there is no availability to select a specific user.

Setting the Contact Tabs

Typical for setting both types: "Default User Options" and "User Options"

Start by opening the wMobile Manager Console. Select Start > All Programs > W-Systems >

wMobile Manager Console > wMobile Manager Console.

Select the Desktop node in the wMobile Explorer window.

To perform a global modification to the displayed tabs for "all" users:
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In the center window double-click on the Default User Options icon.

The center window will now display the options available. In the center window, navigate to

Options > Desktop > Contacts and click on the SelectedTabs setting as shown and then click on the

ellipses button.

After clicking the ellipses button the Contact Tabs Editor dialog will appear. Tick the checkboxes for

the tabs that need to be seen by the users. As a checkbox is ticked, its tab name will appear in the

Checked Tabs window on the right (see below in red). Sorting the order of the tabs is done by

selecting a tab name by clicking on it, and then using the up/down arrows to position the tab in the

order preferred (see below in blue). The top-most tab in this list will display on the left and the

bottom-most on the right in wMobile Desktop. After completing these steps, click OK.
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Next, click the Save command in the Actions window at the right side of wMobile Manager Console.

When performing this global change to all users, some wMobile components will need to be restarted.

The following dialog will appear and clicking OK will start the processing. NOTE: Users that are logged

into wMobile at this time will be dropped and will need to log back in after the processing completes

so it may be best to warn users ahead of time.
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Now the tabs should be set the same for all users.

To perform a modification to the displayed tabs for a "specific" user:

In the center window double-click on the User Options icon.

The center window will now display the options available. In the center window, use the drop-down

list to select the user you are configuring the tabs for (see below in blue). After picking the user,

navigate to Options > Desktop > Contacts and click on the SelectedTabs setting as shown and then

click on the ellipses button.
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The remaining steps are the same as above for configuring the Default User Options with these

exceptions: 

· After clicking the Save command in the Actions window, you will not need to restart any

components; that is only required when a global change is made to all users.

· The user will need to manually log out of wMobile and log back in to see the changes made if

they were logged into wMobile during the configuration changes.

· User specific settings override those set using the Default User Options.

4.19 Password Complexity Requirements in GoldMine 2018.2

Starting with GoldMine 2018.2, GoldMine will now be storing passwords in proper case.

Previously these were stored in all upper case, so as to be case-insensitive. After the

GoldMine upgrade, all users will need to log into GoldMine using their existing passwords

ALL IN CAPS, and then change their passwords. Password complexity settings can be

configured, but going forward will likely include 1 upper case letter, 1 lower case letter, 1

digit/number, one special character, and a length requirement.

wMobile has adopted the password complexity requirements.  Once wMobile detects

GoldMine 2018.2 version, it will verify the user's password complexity at login. If it doesn’t

respect the password complexity requirements, the user will be prompted to update their

password.
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wMobile will no longer allow blank passwords, regardless of GoldMine version, beginning

with wMobile 4.0.0.732.

Note that any One Click Logins that users had prior to the GoldMine 2018.2 update will no

longer work. The One Click Logins contain the username and password in an encrypted

form. If a user's GoldMine password changes, the One Click Login will need to be

recreated.

Please see related topics on creating One Click Logins in wMobile Phone and wMobile

Desktop.

4.20 Performance Monitors

From the Manager Console you can see some performance indicators for three wMobile components

(wMobile Desktop, wMobile Phone and Email Fetcher). You can access Performance Monitors from

the wMobile Explorer pane on the left. There’s a Performance Monitor for each of these component as

shown below.
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For the Performance Monitor to work, application pools (wMobileDesktop, wMobilePhone) and the

Email Fetcher Service need to be started.

After clicking on Performance Monitor, you need to enable performance monitoring.

After you click on ‘Enable Performance Monitor’ you will be asked to restart the component for which

you want to see performance indicators. Click OK to restart the component. 
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Once enabled, the Performance Monitor registers information about CPU usage, Memory used, and

the number of active Threads for that wMobile component. You will see a chart with all data

collected.

After you end with checking performance counters you can disable Performance Monitor from the

Actions pane on the right. The monitoring does take up some resources, so you might not want to

leave it running indefinitely.
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You will be prompted to restart the component again for the change to take effect.

You can adjust Performance Monitor settings for every component from System Settings:

- CountersSnapshotSize : This setting represents the number of values stored for every

performance counter. After this number is reached the oldest value is removed and the new

value collected is inserted.
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- CountersUpdateIntervals: This setting represents the interval in seconds used to update

the performance counters collected data. 

- PerformanceChartRefreshInterval: This setting represents the interval in seconds used

to refresh the performance chart view. 

Example:

So, with the above settings, the Performance Monitor will keep the last 60

values(CountersSnapshotSize) for every performance indicator (CPU, Memory, Threads) collected

every one second (CountersUpdateIntervals). In other words, the Performance Monitor keeps data

from the last minute.

You will see data collected in a chart with a refresh rate of 5 seconds (PerformanceChartRefreshInterval).

4.21 SQL Read-Only User for GoldMine 2018.2 Compatibility

In GoldMine 2018.2, administrators will need to configure a new SQL user with read-only

permission for use with SQL queries, including filters creating using SQL syntax.

wMobile’s SQL Desktop Manager has always only allowed SQL SELECT statements.

However, for consistency we have added the same requirement of a read-only SQL user

(regardless of GoldMine version).

The SQL User  will be configured in the wMobile Manager Console. 

Navigate to Desktop > SQL Queries Manager in the wMobile Explorer pane on the left.
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If you choose to use an existing SQL user (configured in SQL Server or GoldMine prior to

use in wManager Console), the application will detect its existence and will test the

connection. Click Check user to test the credentials. The screenshot below shows the

confirmation when the password and connection are correct.

If any information is incorrect, an error will indicate the issue:



wMobile AdministrationwMobile User Guide 296

Copyright © 2021 SugarCRM All Rights Reserved.

If a SQL Read-Only user does not exist, the application will detect when querying the

database and will create the user with read-Only permission.

In the case of a failed check, the administrator will not be able to save the settings. 

A failed check can occurs in one of the following cases:

· Using an existing user and an incorrect password

· Using a reserved SQL keyword as user name

· Using a blank user name or password
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Note: wManager Console will reject any user name which is a reserved SQL keyword. The

full list of SQL reserved keywords can be found at: 

https://docs.microsoft.com/en-us/sql/t-sql/language-elements/reserved-keywords-

transact-sql?view=sql-server-2017

4.22 Virtual File System Settings

wMobile Manager Console has the option of creating a Virtual File System to manage

paths used to access network resources. The network paths specified using UNC

(Uniform Naming Convention) describe the location of a network resource, such as a

shared file or folder. 

The UNC syntax used by Microsoft Windows has this generic form:

\\ComputerName\SharedFolder\Resource

The Virtual File System settings are accessed by selecting the wMobile node in the

wMobile Explorer window and then double-clicking the Virtual File System icon.

https://docs.microsoft.com/en-us/sql/t-sql/language-elements/reserved-keywords-transact-sql?view=sql-server-2017
https://docs.microsoft.com/en-us/sql/t-sql/language-elements/reserved-keywords-transact-sql?view=sql-server-2017
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At the top of the center window, the menu bar offers options for adding a New Server, a

New Share, New Folder, or a New Path to the Virtual File System. Below the menu bar you

will find a drop-down containing a list of all the users for which you can add network paths

for in the Virtual File System.

The Actions window on the right contains commands for working with the virtual file

system configuration. Because there are no network paths present in the file system view,

the only available actions are Refresh and Select Linked Document Folder Paths. For detail

on all available actions, please see: Virtual File System Actions.

See Also:

  Virtual File System Commands

4.22.1 Configure Server

Steps to add a new server in the file system view.

Select the user for which the server will be added (or use (All) to make it available to all

users).
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Click on the New Server command from the menu bar.

A window will appear prompting for the server name. Please note that some characters

are not allowed in the Name field. When you hover the mouse over the Name field, a

message will appear warning you about the characters that are not permitted in the server

name.

Type the name of the server in the Name field and then click Continue. 

If you type a name that does not conform to the specified rules or a name that already

exists in the file system, an error icon will be displayed and you cannot continue with this

action. Hover your mouse over the error icon to view the error message.
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The server is added to the file system view. When you click on the server node, its

properties will be loaded in the property grid (located in center window). The fields that

can be edited are Name, RemoteUserName, and RemoteUserPassword.

 CONFIGURATION NOTE: The RemoteUserName and RemoteUserPassword

credentials are only required when the documents are not on the same server as: 

· the Remote GoldMine Service

· the path that is being shared (UNC or local path)

To change the name of a server already existing in the file system view, click on the

server's Name row in the file system property grid to enable editing. 

Type a new name for the server and click on any other row to save the change.

The same server naming rules mentioned earlier apply here. If you type a wrong character

and try to save your change, an error message will display and the action is canceled. The

previous name will remain as the server name.
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When the server name is edited successfully, the path is automatically updated with the

new Name entered for server.

  CONFIGURATION NOTE: When updating a server, the changes will be saved

automatically.

  IMPORTANT:

1. The Path field is not editable. The Path field is automatically created when you insert

a server name.

2. The server does not have a mapped drive designation available.

4.22.2 Configure Share

Adding a new share is available through the menu bar by clicking the New Share

command.



wMobile AdministrationwMobile User Guide 302

Copyright © 2021 SugarCRM All Rights Reserved.

Steps to add a new share in the file system view.

Select a user from the drop-down. The paths previously created for selected user will be

loaded into the file system view.

When adding a Share, you must first select the server node to which you want to add the

Share, and then click the New Share button on the menu bar.

A window will appear prompting for the share Name. Type the share Name. Please see:

naming rules for details.

Click on the newly created share node in the file system view to load its properties in the

property grid (located in center window). You can configure a share Folder through the

editable fields: Name, RemoteUserName, RemoteUserPassword, and MappedDrive.

Multiple MappedDrive Letters 

Multiple drive letters can be assigned to the same path if needed by separating the drive

letters with semi-colon (;) characters. 

Example: D;G;H
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 NOTE: The RemoteUserName and RemoteUserPassword credentials are only

required when the documents are not on the same server as:

· the Remote GoldMine Service

· the path that is being shared (UNC or local path)

To change the name of the Share you can follow the steps used for Configure Server.

4.22.3 Configure Folders

Adding a new Folder is available through the menu bar by clicking the New Folder button. A

folder can be added to a share or another folder.

Steps to add a new Folder in the file system view.

Select a user from the drop-down. The paths previously created for the selected user will

be loaded in the file system view.

From the file system view, select a share node or a folder node for which you would like to

add a new folder and then click the New Folder button.
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A window will appear prompting for the folder Name. Type the folder Name. Please see:

naming rules for details.

The newly added Folder is visible in the file system view.

See Also:

  The steps performed to edit a folder name are the same steps used to change the name

of a share or server. For mode details please view the steps described in Configure Server.

4.22.4 Virtual File System Commands

Configuring Virtual File System 

wMobile Manager Console allows an administrator to add, import, remove, and test paths

in the Virtual File System. 
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The Actions window will contain these tools: 

Delete: Deletes the selected node and all its children from the Virtual File System view.

Refresh: Refreshes the Virtual File System view.

Test Path: Tests the path of a selected node in the Virtual File System view.

Test All Paths: Tests all of the paths within the Virtual File System view.

Select Linked Document Folder Paths: Import the UNC paths, server, and share, needed to

open a linked document.

Delete 

1.  Select a node you want to delete from the Virtual File System view.

2.  In the Actions window, click Delete. 

3.  The node is deleted. If the node has children, they will be deleted as well.

Refresh

1.  Refresh the Virtual File System view.

Test path

1.  Select a node from the Virtual File System view to be tested.

2.  In the Actions window, click Test Path. This action will cause the interface to be

disabled temporarily during the test:
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A path may have explicit credentials. However, if the current path does not have explicit

credentials and does not inherit credentials from its parent folders or share, we will

assume the path does not have credentials and it will be tested as such. 

If the path that does not have explicit credentials and its parent folders or share has

credentials, those credentials will be inherited.

3.  When the testing action is complete, the interface will be enabled so you can edit the

properties of a file system node.

4.  If the test does not "pass", the node tested will be displayed in red.

5.  Hover over the "red marked" node and a tool-tip with the error message will appear:

Test All Paths

1.  In the Actions window, click Test All Paths. All the nodes present in the file system

view will be tested.

2.  The interface will be disabled temporarily during the path tests.

3.  When the testing action is done, the nodes that did not pass the test will be displayed in

red.

4.  Hover your pointing device over a "red marked" node to view the error message.

Select Linked Document Folder Paths

1.  In the Actions window, click Select Linked Document Folder Paths. This will open a

window with the UNC network paths used to open linked documents.
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2.  Chose the paths you would like to import into Virtual File System by clicking the

checkbox in front of the UNC paths and then clicking the Import button. To cancel the

operation click the Cancel button.

See Also:

  Virtual File System Settings

4.22.5 VFS Sample

This is a sample of a Virtual File System drive mapping configuration. In this example we

set the server and path as: \\Server\GoldMine using the drive letter: G, and the credentials

RemoteuserName: administrator and RemoteUserPassword: test (NOTE: test appears as

**** in the field).
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5 Phone Edition

wMobile Phone Edition allows you to access your GoldMine information on mobile

devices such as iPhone, Android, Blackberry, etc. All you need is an Internet connection

and the web address which should be provided by your GoldMine or wMobile

administrator.
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5.1 General Editing

This topic covers general editing features that are important to know as they're used

throughout wMobile Phone's user-interface.

When editing certain field values like "Reference" or "Code" when scheduling an activity or

when adding or editing new or existing contacts, wMobile will allow you to either choose a

pre-defined selection entry from a drop-down list or type your own entry into a textbox. The

pre-defined selections that are available in the drop-down lists are typically maintained

within GoldMine by an administrator (i.e., GoldMine's F2 Lookups). 

Switch Between a Drop-down List and a Text Box

Using the button to the right of the field will change the entry method between a drop-down

list and a text box.

This is a drop-down list:

Please take note of the arrow button designating this as a drop-down list. Tap the arrow

button to change from using a drop-down list to use a textbox.

This is an example of a typical drop-down list. Based on the mobile device you are using,

select the appropriate method to open the list of choices to select from. As an example,

for the iPhone devices, tap the drop-down to display list of choices.

Drop-down list contents:

Tapping the black arrow  will open the list to allow a selection to be made.

This is an example of a list that will be displayed when using a drop-down for entering data

into a field. 

NOTE: The data in your drop-down lists will vary based on your specific business model.
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This is a textbox:

To place data into a textbox, simply type in your data entry.

Tap the [>] arrow button to change from using a textbox to use a drop-down list.

Entering Data into a Drop-down List or a Text Box

Whether you decide to use the drop-down list or the textbox for data entry will depend on if

wish to pick your selection from a list of choices (use drop-down) or type an entry

manually (use the textbox). 

Editing Notes (Pending and History Records)

Pending activity notes and history record notes play a key role in keeping solid

relationships with your contacts. Within the notes field for these record types, you can

add, edit or simply review notes for the current activity.

Notes textbox:
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The notes field is a multi-line free-form text box. Enter helpful information here to aid in

upcoming activities (Pending) or meaningful information describing what occurred for an

activity (History). Text is edited in the same way for both pending and history notes.

5.2 Connecting to wMobile

Getting started requires connecting to wMobile using your specific mobile device. Your

devices Internet browser is used to access wMobile. These sections cover these topics to

get your device configured.

  Open Your Internet Browser

  Adding a Browser Shortcut to wMobile

  Logging into wMobile

  Special Browser Configuration

  Setup One Click Login

  TIP: Since there are so many devices capable of being used to access wMobile, we

cannot list them all in great detail within this User's Guide. Please use the instructions

found here as a starting point for performing certain device specific functions and refer

to your device's documentation for full details if further help is needed.

5.2.1 Open Your Device's Internet Browser

Each device being used to connect to wMobile has its own method for accessing the web

browser. Below are examples of methods from popular devices/operating systems. 

*** Please note that your specific device might not be mentioned here. ***

Using an iPhone or iPad

· On the Home Screen, tap on the Safari icon (Safari is the default browser in the Apple

iOS).
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Using an Android Phone or and Tablet

· On the Home Screen, tap on the Browser icon (some Android devices might be using

Chrome as the default browser).

Using a Windows Phone
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· On the Home Screen, tap on the Internet Explorer icon.

5.2.2 Adding a Browser Shortcut to wMobile

To avoid having to type the web address into your browser for each wMobile session, save

the web address to your browser's favorites.

For each of the instruction examples below, start by opening your browser and then

navigating to the wMobile login page using the web address (i.e., URL) of your wMobile

sever provided by your wMobile administrator.

Once you have the wMobile login screen displayed in your browser, continue to add a

shortcut/bookmark. 

*** Please note that your specific device might not be mentioned here. ***

Using an iPhone or iPad

With the wMobile login page in the browser, tap on Share ( ) icon:
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· Tap "Add Bookmark" from the selections provided.

· Add the bookmark details (name and location) and tap Done.

Using an Android Device

Using Default Browser:

· Tap the Menu icon.

· Tap Add Bookmark.

· Tap and hold bookmark in My Device - then tap Add shortcut.

Using Chrome:

· Tap Menu.

· Tap Add to Homescreen.

· Change the title and tap Add.

Using a Windows Phone

· On Start, tap Internet Explorer and open the wMobile login page.

· Tap More ... > Add to favorites

· Internet Explorer automatically fills in the name and web address (URL) of the site. If you

don't need to make any changes, tap Done.

o Otherwise, tap inside a text box to edit an entry. When you've finished, tap Done.

See further information in Preferences on creating a One-Click Login that will store the

user name and password along with the web address.

5.2.3 Logging into wMobile

Your wMobile administrator will provide the web address (i.e., URL) needed for accessing
wMobile using your device's Internet browser. In the following URL examples, you will need
to replace "External_IP_Address" and "Internal_IP_Address" with your specific IP addresses
as required:

http://External_IP_Address/wMobilePhone

http://External_IP_Address/wMobileDesktop

or

http://Internal_IP_Address/wMobilePhone

http://Internal_IP_Address/wMobileDesktop
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If you are using DNS (Domain Name System), a domain name can be used instead of the

external (or internal) IP address if you have the required DNS entries. Here are examples

for URLs using DNS:

http://yourdomain.com/wMobilePhone

http://yourdomain.com/wMobileDesktop

or

http://wmobile.yourdomain.com

http://wmobiledesktop.yourdomain.com

  NOTE: The HTTPS protocol is supported.

Hyper Text Transfer Protocol Secure (HTTPS) is HTTP through a secured connection.

Communications through an HTTPS server are encrypted by a secure certificate known

as an SSL. The encryption prevents third-parties from eavesdropping on

communications to and from the server.

The HTTPS protocol can be configured using the wMobile Phone Advanced Installation

and the wMobile Desktop Advanced Installation types. If wMobile was initially

configured to use the HTTP protocol, it can later be changed to use HTTPS.

  TIP: If you are having trouble with a wMobile URL, please try this troubleshooting

topic: Internet Service Provider (ISP) Has Changed

Once your browser connects to your wMobile Internet site, you will be presented with a

wMobile login page.

· Use your GoldMine username and password credentials for logging into wMobile (users

must have already been granted access to login).

· Tap Login.



Phone EditionwMobile User Guide 316

Copyright © 2021 SugarCRM All Rights Reserved.

Login Notes

· wMobile will only accept one login per user name at any time. If you login a second time

your initial session will be automatically logged out.

· When logged into wMobile and you have been inactive for a predetermined number of

minutes (as defined by your wMobile administrator), your session will time out and you

will be logged out of wMobile automatically. At that point, you will need to log back in

using your username and password again.

· If you need to change your login password, this must be done in GoldMine.

Login Failure Codes

Wrong username or password

There is a mismatch between your GoldMine username and password. You may have

mistyped one of these credentials.

Not a wMobile User

The username has not been registered on the wMobile server. Check with your

administrator to ensure you are using your correct GoldMine user name.

Access denied

You have entered a valid username and password combination but your wMobile

administrator has disabled your use of wMobile.
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Access is locked

The wMobile user account has been locked after too many failed login attempts. Contact

your GoldMine/wMobile administrator to unlock the user account. 

  TIP: If you are having trouble logging into wMobile, please try this troubleshooting

topic: User Cannot Log into wMobile

5.2.4 Special Browser Configuration

Some browsers need to be configured to support advanced web applications such as

wMobile.

*** Please note that your specific device might not be mentioned here. ***

iPhone and iPad Configuration

In Apple's iOS, JavaScript needs to be enabled. This is done within the Safari browser

settings.

· Select the Settings application/icon on the iPhone/iPad Home Screen.

· Select Safari on the following screen.

· Select Advanced, located near the bottom of the following screen.

· Move the JavaScript toggle to the right so that it highlights green.
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Android Configuration

Follow these instructions to activate and enable JavaScript on your Android.

· Select Browser or Internet to open the web browser.

· Select Menu.

· Select More then Settings.

· Finally select Turn on JavaScript.

BlackBerry Configuration
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We have found that some BlackBerry browsers need to be configured to turn on support

for HTML tables, Java scripts and CSS style sheets. Here is how to perform these

configurations on a BlackBerry:

The BlackBerry browser application starts you in a bookmarks page. To add a bookmark:

· Click the scroll wheel

· Scroll down to and tap on Add Bookmark

· Type the name of the bookmark 'wMobile'

· Type the web address given to you by your wMobile administrator

· Click Add

Scroll and tap on the selections for:

· Support HTML Tables

· Use Foreground and Background colors

· Support Java Script

· Support Style Sheets

· Emulation Mode
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  CONFIGURATION NOTE: BlackBerry users may need to change the Emulation Mode

to Microsoft IE for the best display quality.

5.3 Navigation in wMobilePhone

A navigation bar appears at the top of each page, for use in navigating no matter what

page of wMobile you're working on. It  contains navigation links (back and home), the title

of the current page, search contact button, and user profile menu button.

Quick Search 

Click on the magnifying glass from the header menu.
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Click here for more info on Quick Search.

User Profile Menu

The user profile menu is accessed from the right most icon on the navigation bar.

The user profile menu button will open a new menu specific to each user.
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At the top of this menu you will see information like: the logged in user name, the selected

contact set, and the current application build number.

Then, you will see the following menu items:

· Home page link

· My preferences link. Click here for further information on configuring user preferences. 

· Bookmark Settings

· You can save your favorite pages and access them directly from this menu

· Recent Contacts

·

· Logout option

· About page link - this link will display information on the current wMobile version and

specific build. 

Admins can edit this menu in the Manager Console. They are able to add new items, hide

items, or change the item order in the same way it can be done for the Home Menu .
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5.3.1 Bookmarks

It’s very easy to save a frequently used page. Just navigate to the desired page within

wMobilePhone, open the side menu and use the ‘New Bookmark’ (+) button.

You will have the option to choose the name of your new bookmark.
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 NOTE: You can change the URL with an external link if you want to access an

external web page directly from wMobilePhone.

After the link is saved, it will appear in the Bookmark list..
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If you click the pencil icon (Edit) you will be redirected to the ‘Side menu options’, where

you can edit your bookmarks.
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You have the option to edit the bookmark name, to delete bookmarks or to move up/down

bookmarks.
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5.3.2 Recent Contacts

wMobile offers the option to navigate back to recently viewed contacts from the User

profile menu. 
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· You can personalize how many recent contacts to see (from 0 to 10) and in which

format. This option is available in “Side menu options”.

·  Available formats:

· Contact

· Company

· Contact, Company

· Company, Contact
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5.4 Home Menu

After a successful login to wMobile you will be presented with the Home Menu page. This

page contains links to many of the features you will be using in one easily accessible

location.

While logged into wMobile Phone, tapping the Home icon ( ) at any time will bring

you back to this Home Menu.

Directly below the wMobile logo is the Quick Contact Search feature followed by a list of

links used for accessing different features available in wMobile.

Menu Link Details:

  Quick Search (contacts)

  Alarms

  Go To Last Contact

  New Contact

  Lookup Contact

  Contact Filters

  Contact Groups

  User Email Inbox

  GoldMine Inbox

  Email Center

  Calendar Month

  Calendar Week

  Calendar Day

  Schedule Pending Activity

  Lookup Pending Activity

  Lookup History Activity

  Today's Calls

  Today's Appointments

  Today's Other Actions

  This Week Other Actions

  Forecasted Sales

  Opportunities

  Cases

  Dashboard

  Reports
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  My Preferences

  Logout

  About

  CONFIGURATION NOTE: Menus may vary from what you see in this document to

what you see displayed when you log into wMobile. Your administrator might have

customized this Home Menu to suit the needs of your business. Email account

configurations will also affect what is displayed on this menu.
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5.4.1 Quick Search (Contacts)

Quick Search Usage

Under the wMobile application logo you will find the Quick Search feature. This allows you

to type in any portion of a contact name, company name, or city value to quickly find a

contact in your database. By default, wMobile is set to search for Primary contacts (see

selected radio button in example image below). Alternately, you may choose to select the

Additional radio button causing the scope of your search to be narrowed down to

additional contacts only. When using the Additional radio button, you may still use text for

all or part of the company name if known along with the contact name.

Example Search:

In this example, you need to search for a person named: "Susan Smith" and you also know
that Susan works for a company named: "ABC Company". In wMobile, simply type "susan

abc" (without quotes) into the Quick Contact Search box and tap the Search button.

wMobile will search for both contact names and company names for any combination of
the words you have entered into the Quick Contact Search box.

To open the Quick Contact Search box first tap on the magnify glass from the header.

Type your search text in the field as shown here:

Example Results:

The Quick Contact Search results will display in a list similar to the one shown here.

In the results listing you will see a portion of the details available for each of the contacts
that were found based on your search criteria. To see the details for one of these
contacts, tap on the contact's name link (e.g., Susan Smith). 
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NOTE: When the contacts result list is displayed, for any contacts that do not have a
"contact name", wMobile will display (No Contact Name). Tap on the (No Contact Name)
link to see that contact's details.

For each contact listed there will be two links: Pending  History. These links open the
following:

The Pending link opens the Contact Pending Activities page (displays: all activity types)

The History link opens the Contact History Activities page (displays: all activity types) 

Get information on the Contact Detail screen.

The Quick Search Configuration settings allows you to add or remove fields that are used

by Quick Contact Search.

  NOTES:

1.  In wMobile, email addresses and phone numbers are available as hyperlinks for

quick access to your email client and to dial the viewed phone number.

2.  In the contact results listing there may be shortcuts to common contact commands

such as Pending and History that are displayed and are links that may be used to

view the pending activities (those that are scheduled) or activity history (those that

have been completed) for the listed contact.
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5.4.1.1 Quick Search Configuration

Quick Search Configuration settings allow you to add or remove fields that are used by

Quick Contact Search.

The default Primary Contact Search Fields are: Company, Contact, and City

(Contact1.U_Company, Contact1.U_Contact, and Contact1.U_City).

Available fields for searching are from within the CONTACT1 and CONTACT2 (user-

defined) GoldMine tables.

The default Additional Contact Search Fields are Company, Contact, and Ref

(Contact1.U_Company, Contsupp.U_Contact, and Contsupp.U_Contsupref).

Available fields for searching are from within the CONTACT1 and CONTSUPP GoldMine

tables.

See the following details for editing your configuration for the fields you use most.

Accessing QuickSearch Configuration:

From the Home page, tap My Preferences then Contact Options.

On the Contact Options page, scroll down to Quick Search Configuration. 

Example Configuration (adding contact1.PHONE1):

To add a field to a Quick Contact Search, select it from the drop-down. For this example of

adding the PHONE1 field, you would select Contact1.PHONE1 in the drop-down, and then

tap the Add button.

To remove a field that is already configured as a search field, simply tap the Remove link

associated with the field.

The Additional Contact Search Fields are configured in the same manner as the Primary

fields.

To complete the configuration, tap Save:
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  NOTE: PHONE1, PHONE2, and PHONE3 are column names in GoldMine's

CONTACT1 table. The "labels" associated with these phone fields may be different.
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5.4.2 Alarms

wMobile shows any Alarms for activities immediately after logging into wMobile. The

Alarms link is displayed in red at the top of the Home Menu and the number of alarms

appears in parentheses. The Alarms link will only display when there are current alarms for

the logged in user.
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Tap on Alarms to see a list of alarmed activities. Only activities with alarms due today or

past due will be displayed. From this list, a user can select to Turn Off the alarm or

Complete the activity. Tapping on the reference line of an alarmed activity (highlighted blue

line) will open the details of that activity in another page and allow the user to: turn off the

alarm, complete, edit, or delete the activity, and go back to this list or the Home Menu.
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5.4.3 Go To Last Contact

Tap the Go To Last Contact link to view the contact detail page of the last contact you

viewed in this or your last session in wMobile. The last contact you view before logging

out of wMobile is saved from that session. When you log back into wMobile and tap the

Go To Last Contact link, the last contact you viewed is displayed whether your prior

session was ten (10) minutes ago or ten (10) weeks ago.

5.4.4 New Contact

To create a new contact, tap the New Contact link. This will open the Add Contact page in

wMobile.

A contact entered into wMobile will be immediately available to all other wMobile users as

well as all GoldMine users on the network. All field customizations and field values

available in the drop-down lists in GoldMine will likewise be available in wMobile. 

See Also:

 Add New Contact (Additional)
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5.4.5 Lookup Contact

The Lookup Contact link on the Home Menu allows you to search for contacts or

companies using more criteria than the Quick Contact Search feature that is at the top of

the Home Menu page. You can search on one of several fields and also filter using city

and state values.

On the Lookup Contact page, the selectable search field has an associated drop-down to

allow the selection of: Begins With, Ends With, Contains, Equal To, Not Equal To, Greater

than, Less than, Greater than or Equal to, Less than or Equal to. Default Search fields

include Contact, City, and State.  

Any or all of these fields can be used for a search.
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This type of Lookup Contact page appears when searching for email recipients when

sending email.

See Also:

  Customizing Lookup Options
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5.4.6 Contact Filters

If you have filters defined in GoldMine, they will be displayed on the Contact Filters page in

wMobile. By default, the filters of the logged in user are displayed. However, using the

drop-down to select another user will cause that user's filters to be displayed.

Tap on a filter to see only the accounts that meet the filter criteria.

The filtered contacts will be listed in groups of ten (10) if there are more than ten that

meet the criteria. A count will be displayed. Use the << and >> symbols to scroll through

the records. From this list, a user can tap on a contact to view more detail, tap on the

email address if one is listed to draft an email message, tap on the phone number to make

a call, or tap on Pending or History to view related activities.
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At the bottom of the list are options to Schedule, Edit Filter, go Back to Contact Filters, or

return to the Home menu.
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At the bottom of the list of filters, there is a button for creating a new Filter (+) and the

other options for deleting, Delete Selected Filters, Add Filter Contacts to Group, and return

to the Home menu.

If New Filter is selected, the user will have the opportunity to name the filter and enter

criteria in a manner very similar to GoldMine.
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5.4.7 Contact Groups

If you maintain groups of contacts in GoldMine, these same groups will be available in

wMobile. It is convenient to maintain these as they can provide quick lists of your top

customers, groups created for marketing campaigns, etc.

The Contact Groups page lists the names of the contact groups and the number of

members within each contact group. 
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When a specific contact group's name is tapped, the contacts that are members of that

selected group are displayed in a list. The name of the Group will be displayed at the top of

the list.

From the list of Contact Groups, the user may create a New Group (the " + " button), Delete

Selected Groups, or return to the Home menu.

The contacts will be listed in sets of ten (10) if there are more than ten contacts in the

group. A count will be displayed. Use the < and > symbols to scroll through the records.

From this list, a user can tap on a contact to view more detail, tap on the email address if

one is listed to draft an email message, tap on the phone number to make a call, or tap on

Pending or History to view activities.
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At the bottom of group list page, the user may choose to Edit Group Properties, Add

Contacts from Filter, Remove Contact(s) From Group, go Back to Contact Groups or return

to the Home menu.



Phone EditionwMobile User Guide 347

Copyright © 2021 SugarCRM All Rights Reserved.

If a new contact group is created, the user may select the group name and a code. The

user defaults to the logged in user, but a different user may be selected. Tap Save to save

the new Contact Group and it will be added with zero (0) members.
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After the new group is created, members can be added to it. Tap on the group's name link

and then use Add Contacts from Filter.
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5.4.8 User Email Inbox

This link will allow you to view new email messages in your email server mailbox or

Internet service provider mailbox. If you use GoldMine for email, this is the equivalent of

the "Online" mailbox in the GoldMine Email Center.

On the Home Menu, a number in parenthesis after the Email Account Inbox link indicates

the total number of "unread" email messages. 

The User Email Box link displays for users individually on their Home Menu depending

upon the selection in My Preferences. For further information on configuring this in email

settings, see the section on how to Add an Email Account. 

For details on working with the Email Inbox see:

  Email Account Inbox

  NOTE: The actual email account name for the Inbox that is displayed on the Home

Menu will be the Account Name that was configured when the email account was

created. For information on adding an email account, see: Add Email Account.
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5.4.9 GoldMine Inbox

This link will allow you to see email messages you have stored in your GoldMine Inbox. If

you use GoldMine for email, this is the equivalent of the "Inbox" in the GoldMine Email

Center. 

On the Home Menu, a number in parenthesis after the GoldMine Inbox link indicates the

total number of "unread" email messages.

For details on working with the GoldMine Inbox see:

  GoldMine Email Inbox
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The GoldMine Inbox link is displayed on the user Home Menu depending upon the

selection in My Preferences. For further information on configuring this in email settings,

see the section on how to Add an Email Account. 
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5.4.10 Email Center

From the Home Menu, tap the Email Center link to take you to the Email Center page.
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From the Email Center, the user can select which mailbox to view. If multiple email

accounts are configured, these can be toggled in the first line using the down arrow.  The

Inbox link will display newly received email on your email server or Internet service

provider mailbox. The GoldMine Inbox link will display email retrieved and stored in the

GoldMine Inbox. The E-mail Setup link can be used to navigate to email settings. 

Use these links for further information on working with inboxes: Inbox and GoldMine

Inbox.



Phone EditionwMobile User Guide 354

Copyright © 2021 SugarCRM All Rights Reserved.

The Email Center link is displayed the user's Home Menu depending upon the selection in

My Preferences. For further information on configuring this in email settings, see the

section on how to Add an Email Account. 
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5.4.11 Calendar Month

The Calendar Month option on the Home Menu will allow you to view all activities for the

month. Tap on Calendar Month to view the calendar. The number in parentheses is the

total number of activities on the user's calendar within this time-frame.

Any day which has activities scheduled will be highlighted in bold. Tap on that date for the

Calendar Day view.

The date highlighted in green (as shown below) is the current date. This color can be

changed on a per user basis in the Calendar Options settings.

Tap on the arrows [<] and [>] buttons to go back or advance a month for the calendar

display. 
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See Also: 

 Working with the Calendar: Calendar Month

5.4.12 Calendar Week

The Calendar Week option on the Home Menu will allow you to view all activities for the

month. Tap on Calendar Week to view the calendar. The number in parentheses is the total

number of activities on the user's calendar within this time-frame.
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Scroll down to see the activities for the week. Tap on the arrows buttons [<] and [>] to go

back or advance a week for the calendar display.
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See Also: 

 Working with the Calendar: Calendar Week

5.4.13 Calendar Day

The Calendar Day option on the Home Menu will allow you to view all activities for the

month. Tap on Calendar Day to view the calendar. The number in parentheses is the total

number of activities on the user's calendar within this time-frame.
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Scroll down to see the activities for the day. 

Tap on the letters to see activities for specific days of the week (e.g., M = Monday, T =

Tuesday, etc.).

Tap on  the arrows buttons [<] and [>]  to go back or advance a month for the calendar

display. 
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See Also: 

 Working with the Calendar: Calendar Day

5.4.14 Schedule Pending Activity

The Schedule Pending Activity link allows the user quick access for scheduling an activity

directly from the Home Menu.
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Select the appropriate user for whom the activity will be scheduled. Tap on the magnifying

glass icon to search for a contact.
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Enter part of the company or contact name to search for the contact.
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Select the appropriate contact.
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Select the activity type such as Call, Appointment, Next Action. 

Enter the reference, codes, and notes as needed. Any field that has a lookup list in

GoldMine, will have the same lookup list in wMobile.

Activities can be linked to opportunities or cases. 

Select the date, time and duration as needed. 

Activities can be alarmed using the Alarm checkbox. 

Tap Schedule when save the new activity.
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5.4.15 Lookup Pending Activity

This feature gives users the ability to search for and view a list of pending activities for a

specific user, date range and type of pending activity. Using combinations of the search

criteria will allow a user to see only the desired activities.
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The Lookup Pending Activity link allows you to search for pending activities that are

scheduled for you or for any GoldMine users on your security team. After selecting a

single user (or (All) for all users), select the Period or Date Range and Activity Type.

The Period drop-down list consists of the selections: Past Due, Today, Tomorrow, This

Week, This Month, Next Week, 0-14 Days, Next 30 Days and Next Month. If a specific

date range is desired, tap the Date Range radio button and set the date value using the

From and To drop-down lists.

The Activity Type drop-down list consists of the selections: All, Calls, Others,

Appointments, Sales, Events, Messages, Queued E-Mails and Literature Requests.

Tap Search to run the search and display a list of activities.
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The Pending Activities page displays the resulting list of a pending activity search along

with the GoldMine user and the date range used for the search. The pending activities are
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listed and a pair of links ([Edit][Complete]) is available for each activity that can be used to

Edit or Complete the selected activity.

See Also:

  Editing Pending Activities

  Completing Pending Activities
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5.4.16 Lookup History Activity

This feature gives users the ability to search for and view a list of history records for

completed activities for a specific user, date range and type of history activity. Using

combinations of the search criteria will allow a user to see only the desired activities.

The Lookup History Activity link allows a search for history activities that were scheduled

for you or for any GoldMine users on your security team. 

After selecting a single user (or (All) for all users), select the Period or Date Range and

Activity Type.

The Period drop-down list consists of the selections: Last Month, Last Week, Yesterday,

Today, This Week and This Month. If a specific date range is desired, tap the Date Range

radio button and set the From and To date drop-down values.

The Activity Type drop-down list consists of the selections: All, Calls, Appointments, Sent

E-mails, Received E-Mails, Others, Sales, Events, Forms and Literature Requests.

Tap the Search button to run the search and display a list of activities.
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The resulting list of a history activity search displays the user and the date range used by

the search. The history activities are listed and an [Edit] link is available for each activity

that can be used to Edit the selected activity.
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See Also:

  Editing History Activities

5.4.17 Today's Calls

This link displays a list of pending calls that are scheduled for the logged in user today. On

the Home Menu, a number in parenthesis after the Today's Calls link indicates how many

calls are scheduled. For example: "Today's Calls (2)" would indicate there are two calls

scheduled for today.
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To the right of each scheduled activity in the list are the [Edit][Complete] commands.

At the bottom of the list is the "+" button to create a new activity.

See Also:

  Editing Pending Activities

  Completing Pending Activities

5.4.18 Today's Appointments

This link displays a list of pending appointments that are scheduled for the logged in user

today. On the Home Menu, a number in parenthesis after the Today's Appointments link

indicates how many appointments are scheduled. For example: "Today's Appointments (1)"

would indicate there is one appointment scheduled for today.
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To the right of each scheduled activity in the list are the [Edit][Complete] commands.

The "+" button to create a new activity is located at the bottom of the list.

See Also:

  Editing Pending Activities

  Completing Pending Activities
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5.4.19 Today's Other Actions

This link displays a list of pending other actions that are scheduled for the logged in user

today. On the Home Menu, a number in parenthesis after the Today's Other Actions link

indicates how many calls are scheduled. For example: "Today's Other Actions (2)" would

indicate there are two other actions scheduled for today.

To the right of each scheduled activity in the list are the [Edit][Complete] commands.

The "+" button to create a new activity is located at the bottom of the list.
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See Also:

  Editing Pending Activities

  Completing Pending Activities

5.4.20 This Week's Other Actions

This link displays a list of pending other actions that are scheduled for the logged in user

this week. On the Home Menu, a number in parenthesis after the This Week's Other

Actions link indicates how many other actions are scheduled. For example: "This Week's

Other Actions (3)" would indicate there are three other actions scheduled for this week.
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To the right of each scheduled activity in the list are the [Edit][Complete] commands.

The "+" button to create a new activity is located at the bottom of the list.
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See Also:

  Editing Pending Activities

  Completing Pending Activities

5.4.21 Forecasted Sales

The Forecasted Sales link allows a user to search for forecasted sale activities that were

scheduled for the logged in user or for any other GoldMine users on your security team.
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After selecting a single user (or (All) for all users), select the Period or Date Range and

Activity Type.

The Period drop-down list consists of the selections: This Month, Next Month, This

Quarter, Next Quarter, Next 30 days, 31-60 Days, 61-90 Days, and Past Due. If a specific

date range is desired, tap the Date Range radio button and set the date drop-down's value.

Tap the Search button to run the search and return a list of activities.
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The resulting list of a forecasted sales search displays the user and the date range used

by the search. The forecasted sales are listed and a pair of links ([Edit][Complete]) is

available for each activity that can be used to Edit or Complete the selected activity.

See Also:

  Editing Pending Activities

  Completing Pending Activities

5.4.22 Opportunities

Select Opportunities from the Home Menu menu to view Opportunities. The number in

parentheses represents the number of Opportunities. 
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Filter the Opportunities by User, Status, Stage, Sort By (Close Date, Name, Company,

Contact, Value, Probability) and select ASC (Ascending) or DESC (Descending) order. 
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The opportunities that match the criteria will be listed. 
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Tap on an Opportunity name to view further details of the opportunity or to edit the

opportunity.
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If the opportunity is opened, additional opportunity data will be displayed in the LINKED

tab. Tap on the down arrow in the relevant section to see additional details such as

Influencers, Team members, Issues, Pending/History activities related to the Opportunity,

etc.  New details can also be added by tapping on the " + " button.
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In the DETAILS tab, on the bottom menu are the options to add Notes, Edit the Opportunity,

change the status to Win or Lose the opportunity, go Back to Opportunity List, or back to

the Home Menu.
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See Also:

  Creating a New Opportunity

5.4.22.1 New Opportunity

At the bottom of the list of Opportunities is the " + " button to create a New Opportunity.
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After selecting New Opportunity, the user is presented with the Search Contact page.

Search for the contact to be linked to the opportunity and a list of results will be displayed.

From the results list, tap the Select button of the contact to link to the opportunity being

created.
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Fill in the Opportunity fields as you would in GoldMine. Any field that has a lookup list in

GoldMine will have the same lookup list in wMobile. When all data is entered, tap the Save

link at the bottom of the page. Note custom Opportunity fields added in GoldMine are also

available.
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The new opportunity will be displayed in the list of Opportunities. Tap on the name of the

opportunity, in this case "Mapview", to add further details.

From here, information can be updated and added. Add Influencers, Products/Services,

Team members, schedule activities linked to the opportunity from Pending, and more from

LINKED tab.
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5.4.23 Cases

Select My Open Cases from the Home Menu menu to view Cases. The number in

parentheses represents the number of Cases. 



Phone EditionwMobile User Guide 392

Copyright © 2021 SugarCRM All Rights Reserved.

Tap on the arrow to open the filter zone.

 Select the appropriate user and any other desired criteria to view specific cases. From

this page, the New Case (available at the bottom of the page) the " + " button can be used

to create a new case.
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The cases that match the criteria will be listed. Tap on a Case name to view further details

of the case or tap Edit to update the case.
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If the case is opened, additional case data will be displayed. 
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Select LINKED tab to see Additional Contacts, Team members, Pending/History,

Attachments, etc. related to the Case. Tap on the down arrow in the relevant section to

expand the list. New details can also be added by tapping on the " + " button next to the

relevant section.

In the DETAILS tab, on the bottom menu are the options to add Notes, Resolution Notes,

Edit the case, Reassign, Escalate, Resolve, Abandon, Delete, go Back to Cases, or back to

the Home Menu.
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5.4.23.1 New Case

At the bottom of the list of Cases is the " + " button  that allows the user to create a New

Case.
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After selecting New Case, the user is presented with the Search Contact page. Search for

the contact to be linked to the case and a list of results will be displayed. From the results

list, tap the Select button of the contact to link to the case being created.
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The New Case page will open. On this page, make edits as required which can include

setting the Subject, Category, Type, Origin, Priority, Offering, Deadline, and Description (all

displayed as drop-downs).

On the bottom of the page are commands to Save, Cancel, or go back to the Home Menu.
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See Also:

  Creating a New Case

5.4.24 Projects

The Projects can be selected from the Home Menu. 

Tap on the arrow to select the desired filter criteria to view specific projects.

The projects that match the criteria will be listed. 
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To Create a New Project, use the " + " button at the bottom of the project list. At this step

you can choose to create an Empty Project or Search Template.

See Also:

  Creating a New Project

Tap on a Project name to view further details of the project or tap Edit to update the

project or to Complete it.

If the project is opened, additional case data will be displayed. 
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Select LINKED tab to see additional Contacts, Pending, History, Links, etc. New details can

also be added by tapping on the " + " button next to the relevant section.
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In the DETAILS tab, on the bottom menu are the options to add Notes, Edit the Project,

Complete Project, Relink to another contact, Save as template, Delete (if the user has

permission to use this action), go Back to Project List, or back to the Home Menu.
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See Also:

  Creating a New Project Template

5.4.24.1 New Project

At the bottom of the list of Projects is the " + " button  that allows the user to create a

New Project.
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After selecting New Project ("+" button), tap on Empty Project. 

The user is presented with the Search Contact page. Search for the contact to be linked to

the opportunity and a list of results will be displayed. From the results list, tap the Select

button of the contact to link to the opportunity being created.
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Fill in the Project fields as you would in GoldMine. Any field that has a lookup list in

GoldMine will have the same lookup list in wMobile.

On the bottom of the page are commands to Save, Cancel, or go back to the Home Menu.
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5.4.24.2 Project Templates

Project templates are created and used to save time. If the same fields and related details

are always added for a type of project, using Project templates to pre-fill that information

can make creating new projects faster.

The project templates list can be accessed from the Projects page by selecting Go to

Templates.

The project templates can be filtered by tapping on the arrow button.
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Enter filter criteria and select Search. The project templates that match the criteria will be

listed.
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Tap on a Project Template name to view further details. Tap on Edit to update the project

template fields or Use the project template.
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If the project templates is opened, additional project template data will be displayed. 
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Select LINKED tab to see additional Contacts, Team, etc. New details can also be added

by tapping on the " + " button next to the relevant section.
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In the DETAILS tab, on the bottom menu are the options to add Notes, Edit the Project

Template, Use it, Delete (if the user has permission to use this action), go Back to

Templates, or back to the Home Menu.
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A project template can be used when a new project is created. From the project list select

the " + " button and then select Search template. 

The Project Templates page will be opened and from there the user can choose a specific

project templates. The values of the project template will be applied to the new Project.

See Also:

  Creating a New Project Template

5.4.24.2.1  New  Project Template

To create a new template, use Go to Templates.
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The " + " button allows the user to create a new project template, available at the bottom

of the page.

To create a new project template tap on the " + " button.

The New Template page will be open.

Fill in the appropriate fields to be pre-filled in the template and then select Save. 
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After the template is saved, additional steps can be added to the template such as Team

members, Tasks etc. Tap on the " + " button next to the relevant section on the LINKED

tab.
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If you have a project that you think would make a good template for future use, this is

easily done from the DETAILS tab. Tap on Save as template, found at the bottom of the

DETAILS tab.
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5.4.25 Dashboard

The Dashboard link in wMobile offers a quick view of history and pending metrics from

GoldMine.

You may view your own or any team member's key GoldMine productivity numbers. You

can drill down on the metrics numbers to review the details behind the numbers.

After tapping one of the numbers (which is a count of an activity type's records), another

screen will appear displaying a list of items based on the type of activity for the number

you selected. The activities are listed and an [Edit] link is available for each activity that

can be used to edit the selected activity. Select either tab to display the metrics desired:

History Activities or Pending Activities.
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See Also:

  Editing History Activities

  Editing Pending Activities

5.4.26 Reports

wMobile Phone supports running Crystal Reports. The Crystal Reports Runtime engine

must be installed for the Reports functionality to work.
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The reports themselves must be written using Crystal Reports tools and then

stored/maintained in GoldMine. Once the reports are accessible for use in GoldMine, they

can then be accessed using Reports from the wMobile Home Menu.

To access a specific report, select the appropriate user library and category the report was

filed to.

Only Crystal Reports will appear on this list.

To run a report, tap the report name link (for the following example, "Account List with

Account Mgr Prompt" was used).
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If the report requires any parameters to be selected (State in this example) the user will be

prompted. After the parameters are set, tap OK:

The report will be generated and then displayed. The Crystal Reports Runtime provides the

report navigation tools like paging through the report, zoom level, find, and more:
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5.4.27 My Preferences

The My Preferences link can be selected from the user menu (side menu) on the wMobile

Home page. This will give the logged in user access to the My Preferences page where

that user can make adjustments to their own settings. The settings made here are only for

the logged in user and will not affect other users.



Phone EditionwMobile User Guide 424

Copyright © 2021 SugarCRM All Rights Reserved.

Tapping My Preferences opens the following page (see below for links to the individual

options and settings):
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Use the following links to access more detailed information on each set of preferences

listed:

  Personal Information

  Regional Settings

  Calendar Options

  Contact Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

  Contact Set

5.4.27.1 Personal Information

The Personal Information settings are used in document and email templates.

If your phone requires a dialing prefix, set it here in the Prefix Dial field.

After editing the settings on this page, tap Save to preserve them. 
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Use the following links to access information on each of the other My Preferences topics:

  Regional Settings
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  Calendar Options

  Contact Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

  Contact Set

5.4.27.2 Regional Settings

The Regional Settings include your time zone as well as formatting options for date, time,

currency, and distance unit. These settings are used to determine the way data will appear

in wMobile. The example shown here is typical for a user in the United States.

There are different Short Date Format and Long Date Format settings, and choices for

Time Format, Currency Type, Currency and Distance Unit.

After editing the settings on this page, tap Save to preserve them.
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Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Calendar Options

  Contact Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

  Contact Set
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5.4.27.3 Calendar Options

The Calendar Options page is where a user sets their personal preferences for how the

calendar will display.

Today BackColor, Scheduled Time BackColor, Event BackColor and History Activity

BackColor: These are settings that control the colors you see for specific calendar areas.

Experiment with these to get the most pleasing and useful combination of colors.

The Dots Indicator Size controls the dimensions of the dot, which indicates the types of

activities.

The Day Start Hour and Day End Hour values are in 24 time format. This determines the

span of time displayed on the calendar.

The Minute Interval controls the time increments displayed on the Week and Day pages.

Set Alarm on New Activities enables alarms on new activities by default.

Open 'Lookup Contact' on new activities opens the 'Lookup Contact' when a new activity is

created.

Carry over completion notes to follow-up will carry over activity notes on follow up

activities.
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Pending Activity Types allows selection of the activity types for "pending" activities that
will be displayed on the calendar.

History Activity Types allows selection of the activity types for "history" activities that will
be displayed on the calendar.

Show History Activities when checked, will cause wMobile to display history records (i.e.,
completed activities) on the calendar.
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Work Days checkboxes control the days that are viewable and accessible on the Week
page. If a checkbox for a specific day is not checked, the hyperlinks are not available to
take you to that day.

Show on Calendar will display activities on the calendar with the Contact name and/or
Company name.

Save: After editing the settings on this page, tap Save to preserve them.
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Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Contact Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

  Contact Set

5.4.27.4 Contact Options

Show Additional Contact Drop-down: This option controls how Additional Contacts will be

displayed on the full contact window. The options are Contact Only, Contact title and

Contact reference.

Add Contacts to Local Address Book: The options are Download or Email. If your mobile

device browser does not support opening downloaded vCard files, then use the Email

method. The contact's vCard file will be emailed to your device (see note).

Add Activity to Local Calendar Method: The options are Download or Email. If your mobile

device browser does not support opening iCal, then use the Email method. An activity iCal

file will be emailed instead (see note).

  NOTE: For adding to Add to Local Address Book/Calendar: Android, Windows

Phones, and Blackberry devices will work with Download method; iPhone requires the

Email method.

Additional Contact : Fax Label: The value entered here will be displayed as the label for the

"Fax" field.

Quick Search Configuration

Use the Quick Search Configuration page to configure the Primary/Additional Quick

Contact Search fields used to find your contacts fast. 

After editing the settings on this page, tap Save to preserve them.

Tap Back to My Preferences to make other changes to the user settings.
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Home: Returns you to the Home Menu.
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Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Calendar Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

  Contact Set

5.4.27.5 E-mail Setup

The Email Accounts Page will list any email accounts already configured and will give you

the ability to add New Account.
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· Accounts: Email account(s) that have been configured are displayed first. Tapping on an

email account's link will open that account's detail page to allow maintenance to be

done to that email account such as editing the signature or updating configuration. For

details on all the field settings, see Add Email Account.

· Test: Use Test to test the email account settings. 

· Default: Tap this link to set an account as the default account if you have more than one

email account. When sending email from within wMobile, the "from" address will be used

from the email account chosen as the default if a user has multiple email accounts

configured. 

   NOTE: All email accounts for a specific user will have email received regardless of

this "Default" setting (and if the account(s) are set to receive email).

· New Account: Tap this link to open the Add Email Account screen. Enter all of the

appropriate information to create an email account. The Account Name field will store a

"friendly" name for each email account you create and these names will display in the

Email Center drop-down to select from (i.e., if you use more than one email account).

· Delete: Tick an email account's checkbox and then tap on Delete to remove the account.

General Email Settings:

· Email Client: The email client selection options are Builtin or External. This setting

controls wMobile's behavior when you tap on an email address hyperlink. Depending on

the setting here, the email will be created using wMobile as the email client (Builtin) or

your device's email client (External).

· Enabled Server Settings: Selections include Incoming Only, Outgoing only, Incoming and

outgoing. Most customers select Incoming and outgoing (the default value), which will

enable settings for both incoming and outgoing email connections.

· Users Count in Recipient List: Select the number of GoldMine users to be displayed by

default in the email recipient list when composing email.

· Default E-mail view: Plain Text or Full Html. By default, this is set to Plain Text so that

email will be displayed quickly (no text formatting). The Full Html option can be used to

display graphics and special text formatting like bold, underline, font colors, font sizes,

different fonts, etc.

· Default 'New' Template: Select an email template to be used as the default when

creating new email messages.

· Default 'Reply' Template: Select an email template to be used as the default when

replying to email messages.

· Default 'Forward' Template: Select an email template to be used as the default when

forwarding email messages.
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· Show GoldMine Inbox in Home Page: Displays the GoldMine Inbox link on the Home

Menu.

· Show E-mail Center in Home Page: Displays the Email Center link on the Home Menu.

· Complete original message on Reply/ReplyToAll: Add the original message when you

reply to an email.  

· Tap Save to preserve any changes. 

· Back to My Preferences: Returns you to the My Preferences page.

· Home: Returns you to the Home Menu.

  TIP: Using the wMobile Manager Console, an administrator can manage the email

accounts used in wMobile without having to log into the wMobile Phone/Desktop

editions as a specific users to mange their accounts.  Please see the Configuring Email

Accounts in wMobile topic for details.

Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Calendar Options

  Contact Options

  Side Menu Options

  Setup One Click Login

  Contact Set

5.4.27.5.1  Add Email Account

To setup a new email account:

From the Home page, select user menu (side menu) and then tap on My Preferences > E-

mail Setup > New Account. This will open the Add Email Account page. Enter the email

address and tap Continue.
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 NOTE: After tapping Continue, on the Add Email Account page there will be three tabs

used for the account setup: Basic, Advanced, and Folders. Fields with an asterisk (*) are

required fields and must be filled in.

Basic Settings

Account Name*: This is a required field. This is the "friendly" name of the email account

that will appear in Email Center drop-down and optionally on the main menu.

Reply Address: Your full email address.

Incoming Server*: The name of the "incoming" email server. Enter your email server name

or IP address.

Type*: Select either POP3 or IMAP.

NOTE: Once the account is configured with a specific protocol and the protocol needs to

be changes, the accounts must be deleted and recreated in wMobile (simply changing the

protocol is not supported).

User Name*: Your email account login name.

Password: Enter your email login password. (NOTE: After an email account has been

configured and saved, there will be an Edit Password link to allow editing of the password).
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Outgoing Server(SMTP)*: The name of the "outgoing" email server. Enter your email server

name or IP address.

Signature: Attaches a signature (information about you, your organization, telephone

number, etc.) to each message sent.

 Show in Main Menu: When checked, this email account will be displayed on the Home

menu.

 Test settings when saving: When checked, an email message will be sent to your email

address as a test.

Save: This will "save" any changes made to the email account that is currently being

accessed.

Cancel: This will take you back to the Email Accounts Page without saving any changes.
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Home: Returns you to the Home menu.

Advanced Settings

Reply Name: This is the sender's full email address.

Incoming Server Port*: Specifies the port address to be used for incoming email.

 Use encrypted connection (TLS/SSL): Check this if your email server requires

encryption for incoming email. 

Authentication: Select the authentication method required by your mail server. The

methods currently supported are:

· Auto, Regular, Ntlm, Cram-Md5, and Kerberos. 

Check Interval(Min) >=30: This setting is the frequency that will be used to check for new

email messages. Enter a value using 30 minutes increments such as 30 minutes or more.
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Outgoing Server Port*: Specifies the port address to be used for outgoing email.

 Use encrypted connection (TLS/SSL): Check this if your email server requires

encryption for outgoing email.

Authentication: Select the authentication method required by your mail server. The

methods currently supported are:

· None, Auto, Login, Plain, Ntlm, Cram-Md5, and Kerberos. 

User Name: Specifies the user account name used to access your outgoing mail server.

Password: Specifies the password used to access your outgoing mail server. (NOTE: After

an email account has been configured and saved, there will be an Edit Password link to

allow editing of the password).

 Test settings when saving: When checked, an email message will be sent to your email

address as a test.

Save: This will save any changes made to the email account that is currently being

accessed.

Cancel: This will return you to the Email Accounts Page without saving any changes.

Home: Returns you to the Home Menu.
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Folders Settings
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The email fetcher service can Auto File emails sent from another email system such as

Outlook or Gmail. This feature is particularly useful for Outlook users that do not process

their email in GoldMine. 

Inbox: The wMobile email process downloads emails in the background for each account.

If the email address of the sender is linked to a contact record in GoldMine, the email is

linked and filed automatically. The email will appear in the Inbox with annotations as

"Linked" and "Filed". 

Show All: Displays all folders available for auto-filing.

Configure Sent Folder: See below for details.

 Auto File: When checked, will automatically link and file emails in this folder based on a

matching email address.

NOTE: For Auto File to function, "Disable Auto Checking" must NOT be enabled. 

After tapping on "Show All", place a check mark in the Auto File checkbox for the specific

folder(s) you would like to have auto-filing enabled for.
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Configure Sent Folder: Select the mail folder that contains your Sent mail from the list of

folders in the drop-down. Typically the folder selection is set to link emails in the Outlook

Sent Items folder. 
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 Disable Auto Checking: This option will stop the Email Fetcher service from

automatically checking for new mail on this email account. Any Auto File folders selected

for automatic filing will not be honored when Auto Checking is disabled.

 Delete from Server when Processed: With this option checked, wMobile will delete

email from the server when it is processed. If email is deleted from the server using

another email client (e.g., GoldMine) wMobile will remove it from your wMobile Account

Inbox. If email is deleted from wMobile it will be deleted from server as well.

Auto File Start Date: Set the start date for auto-filing email messages based on your auto-

file settings.

 Test settings when saving: When checked, an email message will be sent to your email

address as a test.
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Save: This will save any changes made to the email account that is currently being

accessed.

Cancel: This will return you to the Email Accounts Page without saving any changes.

Home: Returns you to the Home Menu.

If you had Test settings when saving ticked when saving the email account, and the

account creation was successful, you will get a message stating wMobile sent you a

message and to check your Inbox for it.
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5.4.27.5.2  Edit Email Account

When an existing email account needs to be edited or deleted, select My Preferences from

the user menu (side menu ) on the Home page and then select E-mail Setup. Tap the

appropriate link for the E-mail Account to be edited and a screen similar to the following

example will display containing a view of the current settings for that email account. For

details on each field, see Add Email Account. There are three tabs of information for email

settings. Be sure to fill in all necessary configuration details.
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5.4.27.6 Side Menu Options

Side Menu Options includes the menu style, Bookmarks and the contacts list displayed in

user side menu.

Side menu style: You can choose the classic or modern style. The modern style includes

predefined colors to each category. You can change the brightness and generate random

colors.
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Bookmarks: You can change the order of bookmarks or you can delete them.

Recent Contacts (Number of recent contacts displayed in side menu):

The list of recent contacts displayed in user side menu can be configured to show from 0

to 10 contacts. The contacts format can also be edited.
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Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Calendar Options

  Contact Options

  E-mail Setup

  Setup One Click Login

  Contact Set

5.4.27.7 Setup One Click Login

The One Click Login is an encrypted web address (URL) that contains your organization's

wMobile server address combined with the user's username and password in encrypted

form. If your administrator has enabled this feature, wMobile will allow you to copy this

URL and save it as your wMobile "Favorite" or "Bookmark" shortcut for easy access

logging into wMobile without having to type your user name and password each time you

log in. 

To generate the web address tap on Setup One Click Login.
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You will see the address in the web address line of the browser you are using. Save this as

a Favorite/Bookmark shortcut using the appropriate method for your device and browser. 

  NOTE: If your GoldMine username or password are changed, the One Click Login will

no longer work. The One Click Login address would need to be generated and saved

again so that the new username/password combination would be encrypted into the

web address.

Saving the One Click Login on an iPhone
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See below for info on Android.

Tap the Share button as highlighted below. 
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Select Add to Home Screen to add the shortcut to the iPhone home screen (or Add

Bookmark to add as a Safari browser bookmark.
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The resulting icon will be placed on the Home Screen.
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Saving a One Click Login on an Android 

On an Android (using Samsung default browser) using the default browser, tap on the

browser menu icon as highlighted in orange below.
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Tap on Add page to.

Then select Add to Home screen.
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Select a name for the shortcut and then tap ADD.
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In the end you should be able to see the icon on your cell phone’s home screen.

Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Calendar Options

  Contact Options

  E-mail Setup

  Side Menu Options

  Contact Set

5.4.27.8 Contact Set

Setting the Current Contact Set

wMobile supports multiple Contact Sets. 
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The Contact Set can be displayed in Home page if you tap on  'Show Contact Set in Home

Page'.

 

To use a different Contact Set, choose from the drop-down list which contains the list of

available Contact Sets.

Select the appropriate Contact Set from the drop-down list and tap the Save button. The

selected Contact Set will become the current Contact Set and will be saved as the default

for future wMobile sessions until it is changed again.

Use the following links to access information on each of the other My Preferences topics:

  Personal Information

  Regional Settings

  Calendar Options

  Contact Options

  E-mail Setup

  Side Menu Options

  Setup One Click Login

5.4.28 Logout

To manually log out of a wMobile session, tap the Logout link available from the user

menu (side menu) on the Home Menu. If you forget to log out of wMobile, the wMobile
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system (on the server) itself will automatically log you out of your session after a set

number of minutes. When and if this occurs and you attempt to work in wMobile, you will

be returned to the login page and must re-enter your login information.

5.4.29 About

The About page displays information for the wMobile system including but not limited to

the version and build of wMobile currently running, license information and copyright

information.

To access this information, tap the About link available from the user menu (side menu)

on the Home Menu.

On the About page is a Client Info link used to display information about the client (mobile

device) wMobile is running on.  

Here you can also find the Version updates info for the update/upgrade information.

The information available on these screens will be primarily used for administrative and

troubleshooting purposes.
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5.5 Contact Options

After locating a specific contact there are a number of options available for you to

perform. You may need to schedule an activity, send an email message, review history

data, create a history record for an unscheduled call you received, etc. wMobile has many
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options for working with the selected contact. Please refer to the View contact

information topic for more details.
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Please use these links for specific information to the hyperlinks available:

  Add Note [This hyperlink may appear as "Add Note" or "View Note (n)" where "n" is the

number of existing notes.]

 Email addresses

  Edit (Contact) [The contact also can be edited from the header details, tap on the pencil

button]

  Add To Local Address Book

  Clone to New Contact

Back to Contact List: This link will return you to the list of contacts found after a search.

Home: This link returns you to the Home Menu.

You will find information on Contacts, Pending, History and Opportunities, etc. for the

selected contact on the LINKED tab shown below. Tapping on the down arrow of a

specific field will provide a list with the relevant records. For each record which has sub-

items, the (x) represents the number of items.
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Please use these links for specific information viewing these items:

  Contacts [View Additional Contacts]

  Opportunities

  Cases
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  Pending Activities

  History Activities

  Details

  Documents

  Custom Fields Screens

  View Groups

Please use the links for specific information detailing adding these new items:

  Add New Additional Contacts

  Schedule New Pending Activity

  Complete Unscheduled Activity

  Add a New Detail

  Add New Group Membership

  Add a New Opportunity

  Add a New Case

5.5.1 View Contact Information

Once a contact has been selected, you will see a variety of information. wMobile Phone

Edition has been designed specifically for use on mobile devices and built so that only

fields that contain data will be displayed. This minimizes the need for users to scroll to

see specific data. If you prefer to see fields that do not contain data, this can be

configured using the wMobile Manager Console by editing the setting: ShowEmptyFields.

Any piece of information that is underlined and highlighted in blue is a hyperlink. These

hyperlinks can be used to instantly make a call to your customer on your mobile phone,

bring up an email message, or view the website.

See the topic below to Edit Contact information.

NOTE: This example shows typical fields but does support displaying non-standard fields.

This information can be customized to show information appropriate to your business

needs.
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Additional information will be displayed on the LINKED Tab. See topics below in the guide

for viewing and adding related information. 



Phone EditionwMobile User Guide 475

Copyright © 2021 SugarCRM All Rights Reserved.

5.5.2 Edit Contact

Users have the ability to edit the displayed contact's information using their mobile device.

After opening a contact that needs to be edited, in the View Contact Page are two ways to

edit it. First tap on the Edit link (shown here) to open the Edit Contact page.
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From within this Edit Contact page you will be able to edit the contact's data. Field names

that have an asterisk (*) next to them are "required" fields that you must enter data into

while all other field entries are optional. Certain fields have a drop-down list or a text box

and will allow you to choose a selection from the drop-down list or type in your own entry

within the text box.

  NOTE: Please refer to the section, General Editing, for details on using drop-down

lists and text boxes.
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At the bottom of the Edit Contact page is a the Save link that you will use to save the

updates you made while editing the record.

Copy Last Contact (contact_name): Using this link will open an Add Contact page and pre-

populate fields with data from the current contact.

Cancel: Returns you to the Contact Detail page without saving any changes made.

Home: Returns you to the Home Menu.

5.5.3 Email addresses

Email addresses can be viewed and updated in wMobile. The primary email will be

displayed on the DETAILS tab.
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From DETAIL tab select Email addresses to edit or add new email addresses.

The contact email addresses will be listed. To edit an email address, use the Edit option.
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Update the address as needed and tap Save to preserve changes. 

To add another one tap on the " + " button.
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Fill in the new email address for the selected contact. Add Merge Codes if needed. Select

whether the new email address should be the primary email address. 

It is also possible to change the Contact if there are primary and secondary contacts on

the record.

On the bottom of the page are commands to Save or Cancel.
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After saving the new email address, it will be displayed in email address list.

Note: Multiple email addresses can be stored for contacts, but only the one marked as the

Primary Email Address will be displayed on the Details tab. 
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5.5.4 Additional Contacts

Additional contacts can exist as secondary contacts and are associated with a primary

contact. An example of this would be having a primary contact record for a company and

the main contact is the owner or president of that company. The additional contacts might

be the individual sales team members (one or many), the receptionist, and the IT

department personnel related to the "primary" contact. You might even use an additional

contact record to store a second physical address for the primary contact (e.g., their home

address or a separate ship to address).

To view an additional contact associated with the main contact, select the LINKED tab and

then tap on Contacts (x) list. This will display a list of the additional contacts. The number

in parentheses indicates the number of additional Contacts. 

From this pop-up you can select a name from the list or tap on the expand button ( ).

This will display the Additional Contacts page. 
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In this example, there are two (2) additional contacts for the primary contact. Select one of

the contacts and Additional Contacts (Details) page will be opened.
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The Additional Contact page will show the selected contact's details. As with the primary

contact, the phone number and email address will be hyperlinks so they can be selected to

have your mobile device dial your phone or create an email message.
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Below the contact information, there are several command hyperlinks:

Edit: This link will take you to a page for editing the additional contact data.

Swap With Primary Contact: This will swap the selected additional contact with the

primary contact record making the primary contact become an additional contact and vice

versa.

Go To Contact: Opens the detail page to display the primary contact.

Back to Contact: This link will return you to the Contact Detail page (and allow user to

move between records found in contact search).

Add To Local Address Book: Adds this contact's data to your device's local address book.

Depending on your device you may be asked to confirm the addition. The Add To Local

Address Book can be restricted by the wMobile administrator.

To add an additional Contact, use the + button. Then select New to add a new (blank)

contact, or select New  - With Primary Data to add a new contact with the same primary

address data. 
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5.5.4.1 Add New Contact (Additional)

To add a new additional contact, or view existing additional contacts, select the LINKED

tab and then tap on Contacts (x) list or on "+" button to add a new contact. 
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The selections available for adding a new additional contact are :

· (New): Use to create a new additional contact starting with all fields blank.

· (New - With Primary Data): Using this will cause wMobile to pull in address data from

the primary contact to be used for the additional contact being created.

· (Manage Contacts): Selecting this option will open a page listing all of the additional

contacts associated with the primary contact.

Enter the additional contact information. Any field that has a lookup list in GoldMine will

have the same lookup list in wMobile.
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 NOTE: When entering data, please note the field(s) with an asterisk (*) as they are

required and must be filled in.

At page bottom:

After all the data has been entered, tap Save to preserver the information entered. 

Tap Cancel if you don't want to save this information. Tap Home to return to the Home

Menu.
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5.5.5 Custom Field Pages

wMobile supports custom field views used to display user-defined fields. This gives you

the potential for greater flexibility and the ability to meet more demanding needs of what

information is available while using your mobile device.

The Fields list displays all of the custom field screens for wMobile. Select the Fields

section and then tap on the name of the screen or tap on the "View" button to view any

screen. In this example, there is one (1) field screen available.

This is a view of the custom detail page displaying the detailed information. Tap the Edit

link if you wish to modify the data. If the Edit link does not appear, this means the custom

field page was configured for read-only access to the data.
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In edit mode, all available fields will be be displayed for update, including empty fields. 

Selecting the arrow button [>] button changes the screen by adding changing the field type

to a text box (allowing free typing) or a drop-down (for selection from a lookup list). Some

fields allow both, based on the field configuration in GoldMine. 

The text box will allow you to type in your entry which will override the drop-down value

after tapping the Save link or vice versa.
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5.5.6 View Opportunities

If the contact has associated Opportunities, then the Opportunities list will be populated

with the contact's opportunities. The number in parentheses indicates the number of

opportunities for the contact. 

To view the contact's Opportunities select the LINKED tab and then tap on the

Opportunities (x) section. The number in parentheses indicates the number of

Opportunities for the contact. 
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From the prompt displayed select a specific opportunity to view its details.

All the details of the opportunity will be displayed. As on the contact screen, if a field does

not contain data, it will not be displayed on the opportunity page to minimize scrolling on

the mobile device. If you prefer to see fields that do not contain data, this can be

configured using the wMobile Manager Console by editing the setting: ShowEmptyFields.
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You may view any Products/Services, Influencers, Tasks, Team members, Issues,

Competitors, Issues, Documents, Pending or History activities. Select the specific

information from LINKED tab.

You may also add new opportunity items such as an Influencer, Product/Service, Task,

Team Member, Issue, or Competitor. Tap on the "+" button on the item line.
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New Pending and New History activities can be created here and will be linked to the

opportunity.
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Notes may be viewed or added by tapping on Notes on the DETAILS tab of the Opportunity.

If Notes is followed by (No), then there are no existing notes linked to the opportunity. If

Notes is followed by (Yes), then there are notes linked to the opportunity. 
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Editing a Notes () link will open the Opportunity Notes page:

Tap on Save to preserve the note.

To Add a new Note, use the + button. 
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The user may navigate back to Opportunity or back to the Home Menu by tapping on

headers buttons.

In DETAILS tab, on the bottom menu you can find additional option for working with the

opportunity.
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Tap on Edit to change opportunity details.

Tap on Win or Lose to the close the Opportunity.

Tap on Delete to remove the Opportunity. This option will depend upon GoldMine

permissions. 

Tap on Back to Contact to return to the Contact screen or Home to return to the Home

menu.

5.5.6.1 New Opportunity Linked To Contact

Use the  " + " button on the Opportunities section of the LINKED tab of the contact to

create a new opportunity linked to this contact.

The company and contact will be filled in automatically. Otherwise, the process is the

same as adding a new Opportunity from the Home Menu. See the section on New

Opportunities for further detail.
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Add opportunity data as needed and tap on Save.

Tap Cancel if you do not wish to save the information or tap Home to return to the Home

Menu.

5.5.7 View Cases

If the contact has associated cases, then the Cases list will be populated with the

contact's cases. To view the contact's Cases select the LINKED tab and then tap on the

Cases (x) section. The number in parentheses indicates the number of cases linked to the

contact. 
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From the list displayed, select a specific case to view its details.
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All the details of the case will be displayed. As on the contact screen, if a field does not

contain data, it will not be displayed on the case page to minimize scrolling on the mobile

device. If you prefer to see fields that do not contain data, this can be configured using the

wMobile Manager Console by editing the setting: ShowEmptyFields.
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In LINKED tab you can view any contacts, team (members), tasks, attachments and

pending or history activities.

You may also add new case items. Tap on the "+" button on the related line.
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New Pending and New History activities can be created here and will be linked to the

case.
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You may view pending or history activities. Select the specific list using the down arrow

and the pending or history pop-up list will be displayed.
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In DETAILS tab, the Notes may be viewed or added by tapping on Notes. 

If Notes is followed by "(No)", this means there are no existing notes linked to the case. If

Notes is followed by (Yes), then there are notes linked to the case.

Tapping on the Notes (Yes) link will open the Case Notes page (shown here with one

note). 
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"+" button (Add Note): Add a new note to the case. This page provides a text area to type

notes into. On the "Case Notes" page there will be Save and Discard commands. The note

can be edited using the Edit link or deleted using the Delete link.

Back To Case: Takes user back to the Case details page.

Home: Returns you to the Home Menu.

Back on the DETAILS tab, there are additional options. 

Resolution Notes - Select to add case resolution notes.

Edit - use to edit any of the fields on the DETAIL tab of the Case. 
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Reassign - use to Reassign the case to another user. 

Escalate - use to Escalate to another users. 

5.5.8 View Pending

Pending activities are tasks that are scheduled to be done at some time in the future. Once

you have selected a contact in wMobile, there is an option to view any or all pending

activities for yourself (the default) or another user you will need to select.

Select the LINKED tab to see Pending activities related to the contact.  Tap on the down

arrow in the Pending section to expand the list. New activities can also be added by

tapping on the " + " button on the Pending line. 

In this example, a list of nine (9) pending activities will be displayed for "All" of the

available activity types. To view pending activities tap on the Pending section and a pop-up

with all types of activities will be opened.
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 The number next to each activity type indicates the number of that type for the current

contact. For example, of the nine (9) Pending Activities show here, two (2) are Sales.

Activity Icon Key:

Icon  Type
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The top of the list displays the filtering you chose (if any) and the record count. Below that

is the list of pending activities. From this list, you may view an activity by selecting its

date/time link (which is displaying the actual date and time the activity is scheduled for).

Select the Edit link to open the activity to be edited or select the Complete link to

complete the activity.
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"+" button (New Pending Activity): This link will allow you to schedule an activity.

Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.

After tapping on a link for a pending activity, the details page will appear. This is an

example of the details page for a pending call.
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Complete: This link will take you to a page for completing the activity.

Edit: This link will take you to a page for editing the activity.

Add To Local Calendar: Adds the pending activity to the local calendar on your handheld

device. The Add To Local Calendar functionality can be restricted by the wMobile

administrator.

Delete: Tap this link to delete the pending activity.

Back to Activity List: This link will return you back to the list of Pending Activities.

Home: Returns you to the Home Menu.

Navigation buttons are available for moving through the list of pending activities if all

cannot fit onto a single screen.

5.5.8.1 Schedule Activity

wMobile allows you to create scheduled activities for tasks you need to do in the future.

This might be a call you need to make, an appointment for a sales meeting, or even a

forecasted sale you would like to track.

Use the  " + " button on the Pending section of the LINKED tab of the contact to add a new

Pending activity. 

Choose the specific type of activity to be scheduled (i.e., Call, Next Action, Appointment,

Other or Event).
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Enter the activity information. If there are primary and additional contacts on the record,

use the down arrow at the end of the Contact field to toggle to a different associated

contact.

After selecting a contact, enter the data for the activity you are scheduling. The Detail and

Users tabs at the top of the page switch between the scheduled activity and a list of users.

You can switch between the activity detail and the user list at any time.
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If you wish to schedule the activity for additional users, tap the Users tab at the top-right

corner of the window. Select any additional users from the list. 

When scheduling activities, certain fields, like Reference and Code will allow you to

choose from a drop-down list or type in your own entry within the text box.
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  NOTE: Please refer to the General Editing topic for general editing instruction

details for using drop-down lists and text boxes.

If you need to schedule this activity for a different user or a different linked contact, select

them from the drop-down lists. Other available fields are Reference, Code, Notes, and

Opportunity/Project or Case.

Set the Date, Time, and Duration entry drop-downs. You may also optionally select a color

for the activity.

You may optionally set an alarm for this activity by placing a tick in the checkbox and

setting a date and time for the alarm to occur. These alarms will occur in GoldMine only

and not on your mobile device, unless Notification Services have been configured to

deliver alarms via email or SMS text.

Tap the Save button on either the Detail or Users tabs to save the activity. This new

activity will appear immediately in wMobile and GoldMine.
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Not shown but also available at bottom of page:

Cancel: Close this page without saving the activity.

Home: Returns you to the Home Menu.

Activities can also be scheduled directly from the calendar. 
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5.5.9 View History

Another option after selecting a contact is to view any or all of the contact's historical

data. This will give you a means for easily reviewing recent history before calling or

visiting a contact. 

Select the LINKED tab to see History activities related to the contact.  Tap on the down

arrow in the History section to expand the list. New activities can also be added by tapping

on the " + " button on the History line.  

In this example a list of seven (7) history activities will be displayed for "All" of the

available activity types. To view history records for one specific activity type, tap on

History list and then tap on the specific record type of activity.
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Activity Icon Key: 

 Icon Type



Phone EditionwMobile User Guide 521

Copyright © 2021 SugarCRM All Rights Reserved.

 

The top of the list displays the filtering you chose (if any) and the record count. Below that

is the list of history records. From this list, you may view the history data by selecting its

date/time link (which is displaying the date and time the activity had taken place) or select

the Edit link to open the activity to be edited. Tap the link for the activity to view to the

activity details page (see below).
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"+" button (New History Activity: This link will allow you to schedule an activity.

Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.

After tapping on a link for a history activity, the details page will appear. This is an

example of the details page for a completed appointment.
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Edit: This link will take you to a page for editing the activity.

Back to Activity List: This link will return you back to the list of Completed Activities.

Delete: Tap this link to delete the Completed Activity. 

Home: Returns you to the Home Menu.
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Navigation buttons are available for moving through the list of history items if all cannot

fit onto a single screen.

5.5.9.1 Complete Unscheduled Activity

There are many instances when you may need to log a historical record of an activity you

have completed that was not previously scheduled. An incoming call from a customer

would be an example. The Complete Unscheduled Activity feature allows you to create a

history record for tasks you have completed without the need for a pre-existing scheduled

activity.

From the History section of the Contact LINKED tab, tap on the " + " button to Complete

Unscheduled Activity. You may choose the specific type of activity to be completed (i.e.,

Call Out, Call In, Next Action, Appointment, Other, Sale, To-Do, or Event).

  NOTE: Please refer to the General Editing topic for general editing instruction

details for using drop-down lists and text boxes.

The page that appears will allow you to enter the data for the activity type you wish to

create a history record for. When completing unscheduled activities, certain fields, like

Reference and Code will allow you to choose from a drop-down list or type in your own

entry within the text box.

If you need to assign this activity to a different user or a different linked contact, select

them from the drop-down lists. Other available fields are Reference, Code, Result, Notes,

Opportunity/Project, or Case.

Set the Date, Time, Duration, and Success entry drop-downs.

You may optionally schedule a follow up activity by placing a tick in the checkbox and

selecting an activity type from the drop-down list. If Schedule Follow Up is ticked, then

immediately after Save is selected, you will be in edit mode to create the follow up activity
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record. Ticking the Schedule Follow Up (Auto) will create a pending activity for you,

scheduled based on the number of days selected without the new record needing to be

edited.

Tap the Save button to save the completed unscheduled activity. This activity will appear

immediately in GoldMine.
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Cancel: Close this page without saving the activity.

Home: Returns you to the Home Menu.

5.5.10 View Details

Details are used in GoldMine to store custom information. They keep track of multiple

pieces of information such as products sold, serial numbers, account numbers, etc.

Details can have up to twelve (12) associated fields in GoldMine Premium Edition. As an

example, a Product Sold custom detail might include the product name, version, model

number of the product, date sold, license number etc.

If the account being viewed has details already associated with it, this section will be seen

on the contact view LINKED tab in wMobile. As previously noted, wMobile was designed

for view on mobile devices, so if no details exist that are linked to the account, this

section will not be displayed.

If the contact has multiple details, they'll be listed with the number of details in

parentheses. In this example, a list of seven (7) Details will be displayed for "All" of the

available Details. To view specific types of Details, tap on the down arrow in the Details

line and a pop-up with all types of Details will be opened. Tap on "View" or tap on detail

type (i.e., the hyperlink) to see the detail records.
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The detail info will be displayed. To see all the associated detail data, tap on the detail

name (i.e., the hyperlink). 
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"+" button: Tap to open a page to add a new detail.

Delete: Place a tick in the checkbox of one or more details and tap on Delete to delete

them (based on GoldMine permissions).

Back to Contact: This link will return you to the Contact Detail page.
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Home: Returns you to the Home Menu.

After selecting a specific detail's hyperlink, the detail's page will open and display the data

associated with that detail. 

Use the [<] and [>] buttons to scroll through details if there are multiple details. 

Edit: This link will take you to a page for editing the detail's data.

Back to Detail List: This link will return you back to the list of Details.

Home: Returns you to the Home Menu.
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Navigation buttons are available for moving through the list of details if all cannot fit onto

a single screen.

5.5.10.1 Add New Detail

To add a new Detail, tap on the "+" button on the Details section of the Contact LINKED

tab. 

Select a detail type from the list. This list will reflect any custom Details created in your

GoldMine software. Example detail types are shown below. 

Enter the detail information as you would in GoldMine. Any field that has a lookup list in

GoldMine will have the same lookup list in wMobile.
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When all the data has been entered tap Save to preserve the information. 

Tap Cancel if you do not wish to save the information or tap Home to return to the Home

Menu.

5.5.11 View Documents

When a contact has linked documents associated with it, the Documents list will be

present on the Contact Detail page, on the LINKED tab. The number in parentheses

indicates the number of Documents linked to the contact. There are 5 in this example.

Many types of documents can be linked to an account. These linked documents can

include: email attachments, quotes, invoices, images, etc. 

 The user can select the Documents section to view the types of documents that are

linked. A prompt will be displayed with all document types linked to the contact.

 After selecting the document "type" (e.g., pdf, docx, jpg etc.), tap the View button or tap on

the document type (i.e., the hyperlink) to open the Linked Documents page.
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Depending on the user's selection, a list will appear like the one below. The user can open

a document by tapping on the document name hyperlink in blue. The user must have an

appropriate application on the device running wMobile in order to open a PDF file, a Word

document, image files, etc.

  CONFIGURATION NOTE: For linked document access to be successful,
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configuration is needed in the wMobile Manager Console for Virtual File Settings.

If there are more than ten (10) use the < and > buttons to scroll through the documents. 

Send as Attachments: Tick the checkbox for one of the documents to send as attachment.

Delete: Tick the checkbox for one of the documents to delete it. 

Back to Contact:This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.
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Related topics:

Send as Attachments 

Link New Document

5.5.11.1 Send as Attachment

To forward a document via email, tick the checkbox for one of the documents in the list

and then tap on the Send as Attachments hyperlink:

The draft email defaults to the current contact.
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To send the document(s) to a different contact, either select that contact from those

listed in the drop-down or select the Lookup Contact entry in the list and tap Select to open

the Lookup Contact page:

Search for the contact to send the email to:

Tap on Add Additional Recipients to add CC'd contacts:
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Either select an additional contact from the list or use Lookup Contact and Add Recipient

to search for a different contact.

Multiple Additional Recipients can be added from the list at the same time as shown in the

example below. Use Add selected to add all selected recipients to the email. 
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When the draft email is completed, tap on Send.
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Send: Sends the email.

Save Draft: Saves the email as a draft to be sent at a later time.

Back To Linked Documents: This link will return you back to the list of linked documents.

Home: Returns you to the Home Menu.

5.5.11.2 Link New Document

It's possible to link new documents from the mobile device such as photos or other files.

On the Contact Detail page, LINKED tab select Documents list. After selecting the

document "type" (e.g., pdf, docx, jpg etc.), tap the View button or tap on the document type

(i.e., the hyperlink) to open the Linked Documents page.
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Select "+" button to link a new Document from the bottom of the records.
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A new screen will be displayed to enter details on the new document and select the file. 

Add a Document Name. Add any desired notes. Checkmark Allow File to Synchronize if

there are remote GoldMine users that use GoldMine's synchronization functionality to

sync data updates to a local GoldMine installation. Select Choose File to browse for the

file on the mobile device.
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Select the appropriate option:

- To take photo, video or recorder select Camera, Camcorder or Voice Recorder

- Select a file from My Files or Files
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Once the file is selected, tap on Save. The document will then be linked to the contact

record and available for any other GoldMine/wMobile users to view (if their record access

permits them to view the record). Documents are listed with the most recent at the top of

the list.
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Configuration settings for where uploaded documents will be stored on the server can be

found in System Settings. 

5.5.12 Referrals

Referrals are used in GoldMine to create a link between two contact records.

If a contact has linked referrals associated with it, you will find them on the Contact Detail

page. Select the LINKED tab. The number in parentheses indicates the number of Referrals
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for the contact. Select the Referrals section.  It will open a pop-up with all referrals linked

on this contact. Tap on the on the expand button ( ). This will display the Referrals

page. 
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From the Referrals list page you can navigate to the referral contact by tapping on the

referral hyperlink in blue or selecting Go To Referral.  Use the Edit option to edit the

referral information. 
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"+" button: Use this button to add a new Referral.

Delete: Place a tick in the checkbox of one or more details and tap on Delete to delete

them.

Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.

After tapping on the Referral Name or the Go to Referral hyperlink, the Contact Detail page

of the referred contact will be opened.

Tap on Edit to update the Referral details.



Phone EditionwMobile User Guide 550

Copyright © 2021 SugarCRM All Rights Reserved.

Tap Save to preserve the information or tap Cancel if you do not wish to save the

information.

Navigation buttons are available for moving through the list of contact if all cannot fit onto

a single screen.

5.5.12.1 New Referral

To add a new Referral, tap on "+" button on the Referrals section of the Contact LINKED

tab. 

Search for the contact for which you're adding a referral and use the Select button when

the contact is found. 

Enter referral information as appropriate. 
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Tap Save to preserve the information or tap Cancel if you do not wish to save the

information.

5.5.13 Relationships

Relationships are used in GoldMine to show relationships between records. In earlier

versions of GoldMine, these were also referred to as Org Charts. 

If a contact has linked Relationships associated with it, you will find them on the Contact

Detail page. Select the LINKED tab. If the contact is part of a Relationship/Org Tree, the

section will be present showing Yes in parentheses. 
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Select the Relationships section.  It will open a pop-up with the option to View Contact

Relationships. Select View Contact Relationships or tap on the on the expand button (

) to display the Relationships page. 
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The Relationship Tree will be displayed from the top level. 

Use the arrow(s) to expand the tree and folders, if present. 

Tap on any section of the Relationship tree and use the hamburger menu (the three

horizontal lines) to access Relationship options. 
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A menu options will be displayed to add a New Section, New Contact, or to Edit or Delete

the Relationship (based on GoldMine permissions). 

Use the "+" button at the bottom of a Relationship tree to add a new Relationship. Once a

Relationship is created, additional sections can be added.
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Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.
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5.5.13.1 New Relationship

 If no Relationship is present on the contact, the Relationships section on the Contact

LINKED tab will be grayed out and (No) will appear to indicate this contact is not currently

a member of a Relationship. Use the + button to add a new Relationship. 

Select Save to create a Relationship. 
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Select View Contact Relationships or tap on the on the expand button ( ) to display

the Relationships page. 
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Use the hamburger menu (the three horizontal lines) to Go to Contact, add a New Section,

New Contact, or to Edit or Delete the Relationship (based on GoldMine permissions). 
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Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.

5.5.13.1.1  New  Section

Use the hamburger menu (the three horizontal lines) to Go to Contact, add a New Section,

New Contact, or to Edit or Delete the Relationship (based on GoldMine permissions). 
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Use the button with two arrows to change the name of the section. 
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Update the section name as desired. 

Select Save to link the new section to the Contact.  

If you forget to update the section name during creation, expand the relationship tree and

use the hamburger menu to select Edit to rename the section. 

Use the same hamburger menu at the level of the new section to add a New Contact.
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Back to Contact: This link will return you to the Contact Detail page.

Home: Returns you to the Home Menu.

5.5.13.1.2  New  Relationship Contact

Use the hamburger menu (the three horizontal lines) at the desired level of any relationship

tree to add a New Section, New Contact, or to Edit or Delete the Relationship (based on

GoldMine permissions). In this example, a new contact will be linked to the Divisions

section of this Relationship tree.
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Use the person icon to search for the contact to link to this Relationship tree. 

Enter the contact name or company name and select Search. Use Select button to select

the appropriate Contact. 

Select Save to add the new contact to the Relationship tree. 
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Expand the tree to see the new Contact added to the section. 
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This step can be repeated to add multiple contacts. 

Back to Contact: This link will return you to the Contact Detail page.
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Home: Returns you to the Home Menu.

5.5.14 View Groups

Groups are used in GoldMine to identify a static group of records. The group might be

used for viewing in a list, for an email or letter merge, scheduling calls, etc. 

If a contact is a member of a GoldMine Group, then this section will appear on the LINKED

tab of the Contact screen. The number in parentheses indicates the number of Groups the

contact is a member of. Select the Groups section.  It will open a pop-up with all Groups

this contact is a member of. 
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If a contact is a member of more than one GoldMine Group, each group will be listed in the

Groups list prompt. The number in parenthesis is the number of members of the group. To

view the other members of within a group, tap on the Group name.
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Select Remove to remove the contact from the Group.

Select Edit to update the Membership Reference. 

As with any contact list in wMobile, any item underlined and in blue is a hyperlink and can

be selected on to view that contact's detailed information, draft an email message, call a

contact, or view Pending or History activities.

The other members of the group will be listed up to a maximum of ten (10) at a time. Use

the [<] and [>] buttons to scroll to the next set of records.
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Select Schedule to create an activity for all members of the group.

Select Edit Group Properties to edit the name or activity code of the Group.

Select Add Contacts from Filter to add members to the group. 

Place a tick in the checkbox of one or more contacts in the list and then tap the Remove

contact(s) from Group link to remove the selected contacts from the group (NOTE: The

contact itself will not be deleted).

Tap Back to Contact to return to the Contact screen or Home to return to the Home Menu.

5.5.14.1 New Group Membership

A contact can be added to a GoldMine Group using the New Group Membership selection.

Regardless of whether a contact is already a member of a group or not, the + sign can be

used to add the contact to an existing group. 

Select the appropriate Group from the drop-down list and tap on its name.
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Add any Membership Reference and then tap on Save.

Tap Cancel if you do not wish to save the information or tap Home to return to the Home

Menu.

5.5.15 Notes (Contact)

Contact notes play an important part of your contact management relationship solution.

With the View Notes (n) link you can open the Contact Notes page to review the notes for

the current contact.

· If there are no notes linked to the contact, the link will read Add Note.

· If there are notes, tapping the View Notes (n) link will open the Contact Notes page and

display the notes. In the parenthesis after View Notes will be a number in parentheses

indicating the number of existing notes for the contact. 

This example shows that there is one (1) note linked to the contact:
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Sample of the Contact Notes page. The notes can be edited in wMobile using the Edit link

or may be deleted using the Delete link (based on GoldMine permissions):

"+" button: Use this link to ad a new note to the contact.

Back to Contact: Returns you to the Contact Detail page.

Home: Returns you to the Home Menu.

5.5.16 Add to Local Address Book

The Add To Local Address Book option appears on the Contact DETAILS tab. Select Add

To Local Address Book to send this contact to your phone's address book. Refer to the

Contact Options in My Preferences to set the method to send contacts to the local

address book.
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When you select to add a contact to your address book from the iPhone, you'll be

prompted for an email address to send to.

  NOTE: In order for this function to work, there is some configuration required. This

option may also be restricted in the wMobile Manager Console by the wMobile

administrator.

5.5.17 Clone To New Contact

Select Clone to New Contact to create a new new contact using the information from the

current contact.
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  NOTE: This option may be restricted in the wMobile Manager Console by the

wMobile administrator.

Update the contact name and any other information as required. Field names that have an

asterisk (*) next to them are "required" fields that you must enter data into while all other

field entries are optional.
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All field information will be copied over from the original contact.

Command links:

When all data has been entered tap the Save link.
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Copy Last Contact (contact_name): Using this link will open an Add Contact page and pre-

populate fields with data from the current contact.

Cancel: Returns you to the Contact Detail page without saving any changes made.

Home: Returns you to the Home Menu.

5.6 Working with Contacts

From your mobile device, you have many tools available to you for maintaining your

contact data.

  Contact Lists

  Contact Detail

  Contact Options

  Editing Pending Activities

  Completing Pending Activities

  General Editing (Drop-down Lists and Text Boxes)

5.6.1 Contact Lists

After using the Lookup Contact search page, a list will display containing any contacts

found that meet the search criteria you have entered. Each contact's name within this list

is displayed as a link that when selected, will display that contact's data in the Contact

Detail page. Another feature of this list is the Pending / History links that will allow you to

view a contact's pending activities  or view recent history.

The following example shows the Lookup Contact page ready to run a search for contact's

that have the Contact field beginning with the text "Susan" (please note that searches are

not case-sensitive). After entering your criteria, select Search to get a list of results.
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The results are shown here in a list. As you can see, only one record was found meeting

the criteria. Note also, the links: Pending / History for quick access to those activities and

history.
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"+" button: Use this button to create a new contact. This opens the Add Contact page.

Back to Lookup Contact: This link will return you to the Lookup Contact page.

Home: Returns you to the Home Menu.

Navigation buttons are available for moving through the list of contact if all cannot fit onto

a single screen.

5.6.2 Contact Detail

The Contact Detail page displays the majority of an individual contact's data.

On the DETAILS tab, all of the basic contact information is displayed. This information

includes the company and contact name, phone numbers, the contact's address, the
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contacts email address, website and the KEY fields from GoldMine. The phone numbers,

email address and website are presented as links. They can be selected to have your

mobile device dial your phone, start an email message or browse to the contact's website.

The positioning of these fields can be modified (up and down) by Customizing the contact

screen in the wMobile Manager Console.

The LINKED tab displays additional information about the contact, such as Pending

activities, History, Contacts (i.e. additional contacts) and more. The number in

parentheses represents the total number of items in the list.
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For example, in the screenshot, we see that there are 3 additional Contacts, 9 Pending

activities, 10 History activities, 5 linked Documents, etc. 

The following table describes which drop-down lists provide what types of information:



Phone EditionwMobile User Guide 581

Copyright © 2021 SugarCRM All Rights Reserved.

Drop-down Description

Contacts Additional contacts linked to the contact record.

Opportunities Opportunities linked to the contact record.

Cases Cases linked to the contact record.

Projects Projects linked to the contact record.

Pending Pending Activities and a breakdown of Pending Activities by type.

History Completed Activities and a breakdown of Completed Activities by type.

Details Details and a breakdown of Details by type, excluding E-mail Addresses

and Web Sites.

Documents Linked Documents and a breakdown of each by file type.

Fields Custom fields screens.

Referrals The contact Referrals.

Relationships The contact Relationship

Groups Groups of contact records this contact is a member of.

The "+" buttons allow the user to Create new contacts (New Contact), Schedule activities

(New Pending), Complete unscheduled activities (New Completed), Create new detail

records (New Detail), and Create new groups of contacts (New Group Membership).
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View Note (n): View and add contact notes. Please see details in the Notes (Contact)

topic.

Edit: This link will take you to a page for editing the contact data.

Add To Local Address Book: Adds this contact's data to your device's local address book.

Depending on your device you may be asked to confirm the addition. The Add To Local

Address Book can be restricted by the wMobile administrator.

Clone to New Contact: Create a new new contact using the information from the current

contact.

Home: Returns you to the Home Menu.

5.7 Working with the Calendar

wMobile's calendar will aid in graphically working with your activities. See activities and

schedule them from the calendar views available.

  Calendar Month

  Calendar Week

  Calendar Day

  Create New Activity

5.7.1 Calendar Month

Below is an example of the calendar displayed in the Month format. To switch from one

view to another view, tap on the Calendar options icon 
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Calendar options: The user menu calendar options will be opened. 

The calendar views: Month  Week or Day.

User: Change the calendar user.

Preferences: This link will take you directly to the Calendar Preferences.

Help

Select Month to view activities by Month.

Use the [<] and [>] links on the calendar to display the previous month and next month

respectively.

Any date on the calendar that has one or more activities scheduled will be displayed in

bold typeface.
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The current day is shown here with a green background (the 19th). This color is controlled

using the Today BackColor setting in the Calendar Preferences and is a user specific

setting.

To create a New Activity, use the " + " button at the bottom of the calendar. For detailed

steps, see: Create New Activity.
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5.7.2 Calendar Week

Below is an example of the calendar displayed in the Week format.  To switch from one

view to another view, tap on the Calendar options icon 

Calendar options: The user menu calendar options will be opened. 

The calendar views: Month  Week or Day.

User: Change the calendar user.

Preferences: This link will take you directly to the Calendar Preferences.

Help

Select Week to view activities by Week. 



Phone EditionwMobile User Guide 586

Copyright © 2021 SugarCRM All Rights Reserved.

Use the [<] and [>] links to display the previous week and next week respectively.

For each day, there are navigation links to quickly take you to a specific day within the

current week being viewed. The days that are not links are not enabled as "Work Days" in 

Calendar Preferences. See Saturday and Sunday in the following example:

Activities that are scheduled for the week currently displayed will appear on the calendar.

Tapping on an activity link will display the activity details.

Time of Day links:

Tapping a "time" link (e.g., 3:30 PM) on the Week or Day calendar view will start the

process for scheduling an activity. See: Create New Activity for details. 

The colors for calendar items are controlled using settings in the Calendar Preferences.
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Events Display

When Events are set to be displayed, they are shown below the date they are scheduled for

and above the time links. On the Day view of the calendar, Events are displayed the same

way.

5.7.3 Calendar Day

Below is an example of the calendar displayed in the Day format. To switch from one view

to another view, tap on the Calendar options icon 



Phone EditionwMobile User Guide 589

Copyright © 2021 SugarCRM All Rights Reserved.

Calendar options: The user menu calendar options will be opened. 

The calendar views: Month  Week or Day.

User: Change the calendar user.

Preferences: This link will take you directly to the Calendar Preferences.

Help

Select Day to view activities by Day. 

Use the [<] and [>] links to display the previous day and next day respectively.

For each day, there are navigation links to quickly take you to a specific day within the

current week being viewed. The days that are not links are not enabled as "Work Days" in 

Calendar Preferences.
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Activities that are scheduled for the day currently displayed will appear on the calendar.

Tapping on an activity link will display the activity details.

Time of Day links:

Tapping a "time" link (e.g., 3:30 PM) on the Week or Day calendar view will start the

process for scheduling an activity. See: Create New Activity for details. 

The colors for calendar items are controlled using settings in the Calendar Preferences.
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5.7.4 Create New Activity

Steps to create a new activity:

Tap on the " + " button from any of the calendar views (Month, Week, or Day), or tapping a

"time" link on the Week or Day view.
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You may choose the specific type of activity to be scheduled (i.e., Call, Next Action,

Appointment, Other or Event).

Next you will be prompted to search for a contact to schedule an activity for. (By default,

in Calendar Preferences the 'Open 'Lookup Contact' on new activities' is set to prompt the

user to search for a contact. Before the pending page is open, a contact must be

selected.)
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After entering search criteria, any contacts found will be listed. Select one of them and

then the Schedule Activity page will be opened. After entering and saving the activity it will

be displayed in the calendar.
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5.8 Working with Activities

The activities in your database can be edited and/or completed using wMobile. You may

need to reschedule an appointment or update the notes for an upcoming meeting or call to

be made. After the meeting or call has been completed, you will want to track what

occurred and store that information in history for future reference. These topics will detail

how to accomplish these tasks.

  Editing Pending Activities

  Completing Pending Activities

  Editing History Activities

5.8.1 Editing Pending Activities

Pending activities can be edited within wMobile. Activities might be accessed from the

Contact record LINKED tab, from the Calendar, from Lookup Pending Activity on the

wMobile home menu, or the Dashboard. 

To edit a pending activity, tap the Edit link when viewing activities displayed on a list page.

This is an example of a pending "call" on the editing page. The drop-down lists and text

boxes are clearly labeled and self-explanatory. After making the necessary modifications

to the activity being edited, tap the Save link to save the changes to the database. 
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Save: Save the edits made to the database.

Cancel: Returns you to the prior page without saving any changes made.

Home: Returns you to the Home Menu.

  NOTE: Other activities are edited in the same manner although the screen contents

may appear slightly different depending on the type of activity being edited.

5.8.2 Completing Pending Activities

Pending activities can be completed within wMobile. Activities might be accessed from

the Contact record LINKED tab, from the Calendar, from Lookup Pending Activity on the

wMobile home menu, or the Dashboard. 

To complete an activity, tap the Complete link when viewing activities displayed on a list

page.

This is an example of a page that would be displayed to complete a pending call. The drop-

down lists and text boxes are clearly labeled and self-explanatory. After making the

necessary modifications to the activity being completed, tap the Save link to create the

history record in the database.
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Save: Save the completed activity to the database.

Cancel: Returns you to the prior page without saving any changes made.

Home: Returns you to the Home Menu.

When an activity is completed, the pending activity record is removed and a history record

is created in its place to serve as an audit trail of your past activities. This is a great place

to store all of your history notes for future reference. Record all the results of the activity

that you are completing.

  NOTE: Other activities are completed in the same manner although the screen

contents may appear slightly different depending on the type of activity being edited.

5.8.3 Editing History Activities

History activities can be edited within wMobile. This is helpful when more detail needs to

be added to an existing history record for future reference. Activities might be accessed

from the Contact record LINKED tab, from the Calendar, from Lookup History Activity on

the wMobile home menu, or the Dashboard. 

Access to edit a history activity is made by tapping the Edit link when viewing history

activities displayed on a list screen.

This is an example of a history Call on the editing page. The drop-down lists and text

boxes are clearly labeled and self-explanatory. After making the necessary modifications

to the activity being edited, select the Save link to save the changes to the database.
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Save: Save the completed activity changes to the database.

Cancel: Returns you to the prior page without saving any changes made.

Home: Returns you to the Home Menu.

  NOTE: Other history activities are edited in the same manner although the screen

contents may appear slightly different depending on the type of activity being edited.

5.8.4 Recurring Activities (Phone)

Creating a Recurring Activity in wMobile Phone

To start, find/select a contact to create a recurring activity for and make that contact

visible on the Contact Detail page,  LINKED tab.

 

From LINKED tab, Pending, tap on the "+" button and then select Call from the opened

'Schedule' menu.
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The Schedule Call page will open. Note there are 3 tabs that can be configured: Detail,

Users, and Recurring.

Here is a screenshot of the Detail tab already populated for this example:
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The call's Reference value is "Conference Call" and the calls are scheduled to start on at

10:00 AM with a duration of 30 minutes. Notes were added to remind us of the meeting's

topics and a Code (PRY) was set. (NOTE: PRY = Priority; you may use any code you wish

from your system.)

Other Options to Set:

You may optionally (as shown on the page above) link the activity to an Opportunity or a

Case, set an Alarm, Notify via Email, Auto-generate RSVP, Mark as Private, and set a Color

value. The Primary User (ADELA in this example) may be changed if you are scheduling

this for a user other than yourself. The Users tab allows you to set the activity for multiple

users. In this example, we left this set only for ADELA as the Primary User.

The Users Tab

When creating recurring activities, more than one user can be added to the activity. This is

accomplished using the Users tab.

Here is a screenshot of the Users tab in wMobile Phone:

NOTE: The (primary) User linked to the activity is set on the Detail tab.
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Other users can be added to the activity by placing a tick in the checkbox next to their

username in the list presented on the Users tab.

Here is a screenshot of the Recurring tab already populated for this example. We want to

meet "Mondays" of every week starting on 6/22/2020, through the end of August 2021.
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Above, the page shows how to setup the calls to be scheduled:
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- Start Date = 6/22/2020; End Date = 8/30/2021 (totaling a year's worth)

- Start time = 10:00 AM (the time to meet; the Duration was set previously)

- Occurs = Weekly

- Every = 1 Week (user for every week; no skipping in this example)

- Monday (we select the day of the week)

Finally, to create the series of recurring calls, tap the Save link. 

On the Contact Pending Calls page, we see they were created (only three shown here):

When the Edit link for one of these recurring activities is selected, wMobile Phone will

display this page:
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The user has the option to edit either the "Edit the current occurrence" or the "Edit the

recurring series" of activities by selecting one of the buttons on the page presented (see

above). Note: The "Edit the current occurrence" is activity that was selected from the

Contact Pending Calls page. After tapping a button, the Edit Pending Call page opens

where edits to the activity can be made and saved (or activities of the entire series).

  IMPORTANT: Editing Recurring Activities (Special Notes for Behavior Based on

GoldMine Versions)

The user has the option to edit either the "Edit the current occurrence" or the "Edit the

recurring series" of activities. However, please note that users running different

versions of GoldMine will have different capabilities:

GoldMine 9.x and higher:

Users running GoldMine 9.x and higher will be able to edit the recurring details (i.e., the

start/end dates/times) as well as the activity details such as reference, activity code

and notes.

GoldMine 8.x, 7.x, and 6.x:

Users running GoldMine 8.x, 7.x, and 6.x will only be able to edit the activity details such

as reference, activity code and notes. The recurring tab will not be displayed for editing

the recurring details (i.e., the start/end dates/times).

5.9 Working with Email

Use wMobile's email capabilities to send and receive email from one or more email

accounts. Configure these accounts to link and file email messages into GoldMine. Use

email templates and more.
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  Email Center

  Email Inbox

  GoldMine Email Inbox

  Opening Email

  Working with Email Drafts

  Sending Email

  Link to Contact

  Email Linking

  Local Email Rules

  Email Settings

5.9.1 Email Center

From the Home Menu, select the Email Center link to take you to the Email Center page.
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  NOTE: The Email Center link on the Home Menu does not display by default. This

needs to be configured in Email Setup preferences (see: Show E-mail Center in Home

Page).

With one or more email accounts configured, the drop-down will contain the names of

those accounts that have already been configured. Use the E-mail Setup selection to

access the Email Accounts Page for adding new accounts or editing existing accounts.

If you have not configured at least one email account, tap on E-mail Setup link to display

the Email Accounts Page where the New Account link can be used to setup an email

account.
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Here is the Email Center page showing an account that has been configured and selected.

Below the drop-down are links to open this account's Email Account Inbox or the logged in

GoldMine user's GoldMine Inbox. If you have more than one email account configured and

you want to view email for a different account, select the email account name from the

drop-down to view it.

The Inbox (n) link opens the selected email account to view and work with email. In the

parenthesis, the "n" value represents the number of unread email messages in the

account's Inbox.

5.9.2 Email Inbox

The Email Inbox displays email that is on your IMAP or POP3 mail server. This is like the

Online Inbox in GoldMine where we see emails that have not yet been retrieved into

GoldMine. 

Below, you will find a screenshot of an Email Inbox page and the descriptions for each

item found within it. For the Email Inbox(es) and for the GoldMine Email Inbox, there are

some specific similarities in the way email is displayed. Those similarities are explained

here:

Unread Email: Unread email is displayed with the sender's name in bold type font. If the

sender's name is not available, the sender's email address will be displayed.
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Read Email: Read email is displayed in light blue and the sender's name in normal font. If

the sender's name is not available, the sender's email address will be displayed.

Envelope Icon:  = Unread email;   = Read email

Date / Time: The Date/Time value displayed in the list is extracted from email message's

date header. The value represents the date/time when the email was sent. If a date is not

displayed, the email was sent on the current day.

Size / Attachment Status (displayed within parentheses): This displays the size of the

email message including any attachment(s). If the paper clip icon is present ( ) the

email has file(s) attached.

Linked Status: If the word "Linked" appears after the Size / Attachment Status values then

the email message was linked to a contact in GoldMine. 

Filed Status: If the word "Filed" appears after the Size / Attachment or Filed Status values

then the email has been filed. wMobile has an option to Auto File received E-mails based

on matching email address.

Email Subject Line: This is the email's subject line and is also a link to open the email to

be read. Tap this link to open the email for reading and further processing. The checkbox

to the left of the subject line is used to select the email message for further actions like

filing, marking as read or unread, deleting, etc.
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Account: At any time, you may change the email account you want to view by tapping on

the account at the top of the page and selecting a different account from the drop down

list.

Checked hh:mm:ss Hours Ago: The value displayed (hh:mm:ss) is the elapsed time since

the email server was last checked for new email. The time is displayed in hours (hh),

minutes (mm), and seconds (ss). NOTE: The duration of time in between wMobile

checking the email server for new email is set in the email account configuration.

Example: Checked 01:15:17 Hours Ago.

Check: Tapping the Check link immediately forces the email server to be checked for new

incoming email messages.

Folder: Choices include the Inbox, Sent Mail, Local Draft, Local Outbox and Local Trash

folders. 
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Select:  Use this icon to display email by status. The select options are: All, None,

Read and Unread. 

View:  Use the filter icon to filter emails by status. Tap one of the following choices

available:

· All: Display all email messages (read and unread).

· Read: Display only email messages marked as read.

· Unread: Display only email messages marked as unread.

Emails : (X-Y of Z): Based on the choice of filtration selected in the View option, the email

message count is displayed on this line as follows: 

· X: Beginning number on the current page.

· Y: Ending number on the current page.

· Z: Total email messages.

Example: Emails : (1 - 4 of 8)

  NOTE: If there are more email messages than can be displayed on a single page,

navigation links and buttons will be available to give you access to the next (or

previous) page of messages. Here are the two types:

Example of the "next" and "prior" page links.

Single or multiple emails can be selected or checkmarked for processing using the

options at the bottom of the page: Mark, File, and Delete.
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Tap on Mark to see marking options.

Mark as Read: This link will cause the selected email message(s) to be marked as if they

have been read.

Mark as Unread: This link will cause the selected email message(s) to be marked as if

they have not been read.

Mark Emails Private: This option will mark the selected email message(s) private so other

GoldMine and wMobile users would not be able to read the email text. (NOTE: A master-

level user in GoldMine can still see emails marked as private.)

Mark Emails Not Private: This option will make the selected email message(s) public.

Other GoldMine and wMobile users would be able to see and read the emails based on

their record access.

Tap on File to see filing options.
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File to History & Delete: This option will store the email message(s) in GoldMine and

create a GoldMine history record. The email will be deleted from the wMobile Inbox.

File to History & Keep in Inbox: This option will store the email message(s) in GoldMine

and create a GoldMine history record. The email will remain in the wMobile Inbox.

Move to GM Inbox: Tapping Move to GM Inbox will store the email message(s) in

GoldMine and create a GoldMine pending activity record. The email will be moved to the

GoldMine Inbox, and it will be removed from the wMobile online Inbox. 

Copy to GM Inbox: Tapping Copy to GM Inbox will store the email message(s) in GoldMine

and create a GoldMine pending activity record. A copy of the email will be placed in the

GoldMine Inbox. The email will remain in the wMobile online Inbox. 
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Delete: Use this link to delete the selected email message(s).

Back To Email Center: Takes user back to Email Center page.

Home: Returns you to the Home Menu.

"+" button: This button is used to begin a new outgoing email message.

5.9.3 GoldMine Inbox

The GoldMine Inbox contains emails that have been previously downloaded and retrieved

into GoldMine. The list of email messages displayed are from "all" of the folders created

in GoldMine as child-folders in the main Inbox folder.

The GoldMine Inbox shares many of the same attributes as the Email Inbox with regard to

the user interface and operation. Please refer to the Email Inbox topic for details.
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Select: The Select options allow selecting email messages based on read status. Options

include All, None, Read, and Unread.

 

View: The View options allow filtering of the displayed email messages. Tap one of the

following choices available to filter the display:

· All: Display all email messages (read and unread). (This is the default.)

· Read: Display only email messages marked as read.

· Unread: Display only email messages marked as unread.
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5.9.4 Opening Email

To open an email message, tap on the subject line of the message you want to read from

the Email Inbox or from the GoldMine Inbox (the email subject lines are displayed as

links). 

This example shows the email body displayed using Simple HTML (i.e., plain text):
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Parts of the email message record shown above:

Email Count: The email count is displayed on the top and the bottom of the email

message. This displays the number of the email message out of the total number of email

messages. In this example, this is the first email of 9.

Navigation buttons ( < and >): Use the navigation buttons to move to the previous [<] or

next [>] message. 

E-mail subject: Just below the e-mail count is e-mail's subject line text. 

E-mail Header: An email header summary is displayed including From, To, and Date

information after tapping on the down-arrow ( ) button.

Attachments: This link will display if the email has one or more attachments. Selecting

this link will open a page containing links to the attached files. From this page the file(s)

can be opened for viewing if your device supports opening the type of file you wish to

view. 

View Full HTML: By default, messages are displayed using simple text for ease of viewing

on a handheld device screen, speed in displaying, and to minimize scrolling. Tap on View

Full HTML to view the email using full HTML. (See the example below displayed in full

HTML.) The default can be changed in the email settings (see the Default E-mail view

setting).
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Message body: This is the text of the e-mail message.

This example shows the email body displayed using Full HTML:

At the bottom of the email page are many links to provide functions for processing the

email that is being viewed:
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Reply: Reply to only the sender. 

Reply to All: Reply to all of the recipients.

Forward: Forwards a message; you will add the recipient(s) to send to.

Tap on Mark record to open the Mark's options:
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Mark as Unread: This link will cause the email message to be marked as if it has not been

read.

Mark as Private: This option will mark the selected email message private so other

GoldMine and wMobile users would not be able to read the email text. (NOTE: A master-

level user in GoldMine can still see emails marked as private.)

Tap on File to open the File's options:

File to History & Delete: This option will store the email message in GoldMine and create

a GoldMine history record. The email will be deleted from the wMobile Inbox and from the

server after filing it. 

File to History & Keep in Inbox: This option will store the email message in GoldMine and

create a GoldMine pending activity record. The email will remain in the wMobile Inbox.

File with Options: This option will store the email message in GoldMine and create a

GoldMine pending activity record. The email will remain in the wMobile Inbox.

File to another Contact: Use this to link the current e-mail message to another existing or

new contact. The Link to Contact page will open.
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Move to GM Inbox: Tapping Move to GM Inbox will store the email message in GoldMine

and create a GoldMine pending activity record. The email will be moved to the GoldMine

Inbox, and it will be removed from the wMobile online Inbox. 

Copy to GM Inbox: Tapping Copy to GM Inbox will store the email message in GoldMine

and create a GoldMine pending activity record. A copy of the email will be placed in the

GoldMine Inbox. The email will remain in the wMobile online Inbox. 

Link to Contact  (or) Go to Contact: The link that displays here depends on whether the

email message being viewed is linked to a GoldMine contact or not.

· Go to Contact: Appears only when the email message is linked to a GoldMine contact.

Use this link to open the associated contact's detail page.

· Link to Contact: Appears only when the email message is not linked to a GoldMine

contact. Use this to link the email message to an existing contact or to create a new

contact and then link the message to the newly created contact. The Link to Contact

page will open for performing these actions.

Delete: Use this link to delete the email message.

Back to E-mail List: Return you back to the list of email messages.

Home: Returns you to the Home Menu.

5.9.5 Meeting Requests (Phone)

Meeting requests are supported in both wMobile Phone and wMobile Desktop versions. 

If an incoming email contains a meeting request, a meeting response or a canceled

meeting, the email will be parsed and the body of the email will be created using

information extracted from the meeting part.

Accepting Meeting Requests

Meeting Cancellations

Using Meeting Requests with Office 365

5.9.5.1 Accepting Meeting Requests (Phone)

When opening an email that contains a meeting request, a new link will be added to the

email header: ‘Respond to meeting request'.
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When tapping on that link, a prompt with meeting response options will be visible (see

picture below). As in the Desktop version, three new buttons will be available (‘Accept,'

‘Tentative,' ‘Decline’), a text box where the user can insert his comments and a checkbox

to choose if he wants to send a reply email to the meeting organizer to notify him whether

or not he will be attending. The response will be sent when the user presses one of the

three options.
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When a user responds to a meeting request the following actions can happen:
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1. A meeting response email would be created.

If the ‘Send reply’ option is checked, a meeting reply email would be created and sent to

the meeting organizer to notify him whether or not the user will be attending.

2. An appointment would be inserted in the user's Calendar

If the user presses ‘Accept’ or ‘Tentative’, a new appointment is created and inserted in his

calendar.

If the user presses ‘Decline’, no appointment is created.

3. After the user responds, the email is deleted and filed to GoldMine. This action happens

regardless of the response.

5.9.5.2 Meeting Cancellations (Phone)

When opening an email that contains a canceled meeting, a new button will be added to

the email action options: ‘Remove from calendar.’

When tapping on that option, the pending activity linked to that email is deleted from

calendar and the email is Filed to GoldMine.
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5.9.6 Working with Email Drafts

If you have started composing an email but are not ready to send it, you have the option of

saving it as a draft. At the bottom of the page, select Save Draft.
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The draft will be saved and closed. To access the draft at a later time, it can be found in

the Local Draft folder. From the Email Center's Inbox, select the Local Draft from the

Folder drop-down list.
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Any drafts that were saved will appear in the list.
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Tap on the draft email's subject line to open it. The email can now be edited or sent using

the options Edit or Send respectively.
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If the draft is edited, there will be an option to Send the email after editing.
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5.9.7 Sending Email

New email messages can be created from the Email Center's Inbox as well as when

viewing contact information. From the Email Center, the message may be sent to an

individual, a filtered set or group of contacts, and optionally allow the inclusion of

additional contacts.

Select an email account to send your email from:

At the top of the page is a drop-down to allow you to change, if desired, the email account

you would like to send the email from. To change this, select the email account from the

drop-down list. 

To send a new outgoing email message from the Email Center, Select an email account,

tap the "+" button from the bottom of the Email Inbox page. This will open the Send Mail

page.

  NOTE: The "From account" drop-down list will initially display the default email

account as specified when configuring email accounts.

Selecting the email recipients:

There are different methods for selecting the recipients for an email message and these

methods may be combined for each email message to give you flexibility. The methods

include: manually entering an address, searching for and selecting an existing contact's

email address, using a filtered set of contacts, using a contact group, or selecting a

GoldMine user.
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To select a recipient, use the drop-down to the right of the TO label. Select an option on

the list and tap Select.

· Manual Edit Address: This option will allow you to manually type an email address into

the TO field. 

· Lookup Contact: Opens the Lookup Contact page. Enter a search value and tap the

Search button. After the results are displayed, tap on the desired email address link to

use it as a recipient.

· Additional Contacts: Lists the additional contact email addresses to select from.

· Users: Below the "Users:" header in the drop-down list is a list of the individual GoldMine

users available to be selected as a recipient. Each of these choices is prefixed with a

hyphen (-).



Phone EditionwMobile User Guide 637

Copyright © 2021 SugarCRM All Rights Reserved.

Tap on the "+" sign to the right of the Additional Recipient to add additional recipients.

Use the drop-down list to select : To (to):, Cc (carbon copy), or Bcc (blind carbon copy)

recipients.
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The same choices will be presented: Manual Edit Addresses, Lookup Contact, Additional

Contacts or Users. See also: Lookup Contact.
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 When using Lookup Contact, use the checkboxes to the left of the email address to to

select multiple recipients.

  NOTE: Tap the Remove link next to any recipients already selected if you wish to

remove them from receiving the email.

Subject: Enter the subject of the email message in this textbox.

- To use an email template tap the envelope " " button next to the Subject field. Please

see the section on Email templates for details.

Email message body is entered in the field below as shown:
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 Add My Signature: Adds the user's signature to the email message.

Add Attachments: This link will open a page  where you can upload files to attach to

email.

Opportunity/Project (Regarding): This option will only appear if an opportunity or project

exists on the contact to whom you are sending the email. Select an opportunity or project

from the drop-down to link the email message to. The default is "(none)".

 File to: When checked, the email will be filed in GoldMine. This is checked by default.

 Private: Marks a message as private.  

Send: Tap the Send button to send the email message. A page will display showing the

status of the email sent and links for Back to Email List and Home.
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Save Draft: Use this to save a draft of the email. The email can be edited again and

emailed at a later time.

Back To Email List: This link will bring you back to the email list for the current email

account you were last viewing.

Home: Returns you to the Home Menu.

Send: Tap Send to send the message. 

Back To Email List: Takes user back to the Email List.

Home: Returns you to the Home Menu.
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5.9.7.1 Lookup Contact

This type of Lookup Contact page appears when searching for email recipients when

sending email. Type in a part of or all of the contact's name or company and tap on

Search.

A list of contacts that meet the criteria will be listed. Tap on the email address hyperlink

to add it as a recipient.

Use Back To Email to cancel the search.

Use Home to return to the Home Menu. The email draft will NOT be saved.
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5.9.7.2 Email Templates

wMobile supports the use of email templates. The templates must be created and

maintained in the GoldMine application prior to using them in wMobile. The list of email

templates added to the drop-down will be those that are owned by the user logged into

wMobile and will also include those that are set as "public" in GoldMine. The publicly

owned templates will be at the top of the drop-down list and are prefixed with

"[public]" (e.g., "[public] wMobile Brochure").

To use a template, tap on the  button next to the Subject line field.



Phone EditionwMobile User Guide 644

Copyright © 2021 SugarCRM All Rights Reserved.

Select a template from the drop-down list.

wMobile will populate the email body textbox with the template's contents. Please note

that the data being merged into the template's merge fields from GoldMine (if any exist)
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will not appear in the textbox; they will display as they do when creating the template. The

data from GoldMine is merged into the template at the time the email is being sent. Also

note that in our example, an attachment was also included (this attachment was added to

the template when it was created in GoldMine).

Proceed to edit the email and send as usual. Details are in the Sending Email topic.

5.9.7.3 Mail Merge

Tap on the Mail Merge tab when composing an email to send the message to a list of

contacts based on a filter or a group.
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After selecting the Mail Merge tab, select the group or filter to use from the drop-down:

· Groups: Below the "Groups:" header in the drop-down list is a list of the individual

contact groups available to be selected from. Each of the choices is prefixed with a

hyphen (-).

· Filters: Below the "Filters:" header in the drop-down list is a list of the individual filters

available to be selected from. Each of the choices is prefixed with a hyphen (-).

  NOTE: The Groups and Filters need to be created in advance so they are available for

use when sending templates. The list of groups and filters added to the drop-down will

be those that are owned by the user logged into wMobile and will also include those

that are set as "public" in GoldMine.
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Tick the checkboxes to send to:

· Primary Contacts: Tick to send to primary contact.

· Additional Contacts: Tick to send to additional contacts. wMobile can merge both

primary and additional contacts.

A mail merge can be limited to email addresses that have been marked with an E-mail

merge code. Select Clear to remove the merge codes.

Add in the text or select an email template. 

By default the user signature file will be included. 

Optionally link the message to an Opportunity or Project.

By default the email will be filed in GoldMine.
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Send: Tap Send to send the message. 

Back To Email List: Takes user back to the Email List.

Home: Returns you to the Home Menu.

5.9.8 Link to Contact

At times an email will be received and there will not be a matching email address or

contact in the database to link it to. In the example below, the second email is Linked

while the unread email is not linked:

On opening an unlinked email, there will be an option to Link to Contact in the list of

actions at the bottom of the email. Tap this to link the email to a contact:

The Link to Contact page is displayed for linking an email message to a contact.
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There are two choices for linking email to a contact: (1) Create a new contact and link to

it; (2) search for an existing contact and link to it.

1.  The Create New Contact link opens the Add Contact page for creating a new contact

that the email will be linked to. On the Add Contact page, enter the appropriate data for

the new contact record and tap the Save link. Now the email will be linked to the newly

created contact record and the email message page will be re-displayed.

2.  Use the Lookup Contact textbox and the Search button to locate the contact to link to.

Enter a search value in the textbox and tap the Search button. From the list of contacts

found, tap the Select link or the New Additional Contact link:

a. The Select link will link the email to the selected contact. Then you are returned to

the email message page.

b. The New Additional Contact link will open the Add Contact page to allow you to

enter a new additional contact and link to it. Then you will be returned to the email

message page.
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Back to Email: Returns you back to the email message.

5.9.9 Email Linking

Email can be linked to an existing Opportunity, Project, or Case when composing or filing

an email. 

When composing an email, tap on the down arrow to the right of Regarding to link the

email to a related Opportunity, Project, or Case. 
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In the next example of an incoming email, use File with Options to access the Regarding

setting.
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Select a case, opportunity or project under 'Regarding' as shown below, on incoming or

sent email.
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  NOTE: The Regarding option will only appear if an opportunity, project, or case is

linked to the contact with whom you are corresponding. The default is "(none)".

5.9.10 Local Email Rules

Local email rules will allow user to create filters for email handling and specify rules for

what should happen to those emails, such as copying email to the GM Inbox or a specific

project folder, marking email as Read, or forwarding email. 

These are ‘Local’ email rules in wMobile, to be distinguished from email rules that users

might have in GoldMine, Outlook, or other email clients. 
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These email rules will allow us to replicate the auto-retrieve and auto-delete email settings

from GoldMine to copy email from the Online Inbox to the GoldMine Inbox and then

remove it from the Online Inbox. 

Email rules can be configured in the Rules tab of Email Account Settings in Preferences.

(Additional information on configuring email accounts can be seen in the Email Settings

topic.)

Select "+" button to add a new Rule.
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The rule condition contains one or more filters, as follows:

Select / Apply for folder

Filter on FROM recipient

Filter on TO recipient

Filter on SUBJECT text

Filter on BODY text



Phone EditionwMobile User Guide 657

Copyright © 2021 SugarCRM All Rights Reserved.

Filter on ATTACHMENTS

Note: Filters on FROM, TO, SUBJECT, BODY are applied with CONTAINS function.

Example: 

If the Filter criteria is SUBJECT='invoice'

Then the Incoming email (Subject='Please send invoice details') will evaluated as

matching because it CONTAINS 'invoice'. 
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A rule can be set for one folder, or all. Rules will only be applied for folders that are visible

in wMobile.

Setting up a rule with no condition (no values in

FROM/TO/SUBJECT/BODY/ATTACHMENTS) will result in processing of ALL incoming

emails from the selected folder. 

The rule action contains one or more sub-actions, as follows:

Copy to GoldMine folder

File to GoldMine

Mark as Read

Delete

Move to Online folder
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These options provide a range of possibilities for processing email. We can archive email

into project folders, delete junk mail based on a specified criteria, forward email to other

email address(es).  

To emulate GoldMine's auto-retrieve and auto-delete functionality, see the example below

to copy email in the Online Inbox into the GoldMine Inbox and remove it from the Online

Inbox. 
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When the desired Filters and Actions have been configured, select OK at the bottom of the

screen to save the rule. 

Multiple rules can be created for different purposes.
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6 Desktop Edition

wMobile Desktop allows you to connect to your live GoldMine data when you're on the

road or in your home office with a laptop (or desktop) computer, iPad, or tablet by using

the device's Internet browser. wMobile Desktop supports any web browser such as

Internet Explorer, Firefox, Google Chrome, Safari, etc. Use the web address provided by

your wMobile administrator and log into wMobile using your GoldMine username and

password. See the topic on setting up a One Click Login for fast and easy access and

Configuring User Profiles/Allow Login for your administrator to allow users to log into

wMobile.

wMobile provides an interface similar to GoldMine, so it's familiar and easy to learn to

use.

6.1 Configuring User Options

wMobile Desktop has a number of User Options that control how the application works for

an individual user. Settings configured by a specific user do not affect other users'

settings.



Desktop EditionwMobile User Guide 663

Copyright © 2021 SugarCRM All Rights Reserved.

To access the User Options, under the user name select User Options from the menu bar.

There are nine groupings of settings. Use the links below to access details on each set of

options. Some option groups, like Contact, have an arrow ">" in the tree view showing that

there are sub-options; tapping the ">" expands the list to select from. 

  Display

  Personal

  Regional

  Contact

  GM+ Browser

  Activity

  Session

  Documents

  Email

6.1.1 Display Options

The User Options settings control the display and behavior of wMobile Desktop. These

settings can be adjusted for the individual user. 

The Display settings control how wMobile Desktop is displayed on your screen.

Theme: Please see: Change Themes for details on themes.

Startup Page: When wMobile Desktop is opened, the page that is initially displayed can be

set to one of the following: Dashboards, Contact Search, Pending Activities, History

Activities, Calendar (Daily, Weekly, or Monthly), Last Visited Contact, Case Manager, Email

Center, Opportunity Manager, or the Report Center. Select the option that will be used

most often when opening wMobile Desktop.
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Show column filters: With this selection checked, the filter bar on Pending, History, and

Additional Contact tabs will be displayed by default, as pictured below. The user can show

or hide the filter bar using the Filter Bar button regardless of the default setting.

  FONT SELECTION NOTE: Font selections here pertain to general display settings

such as activities and opportunities. There are separate settings for the Contact screen

in Contact Options.

Label Font Name: Select a font for the label text. Options include Arial, Times New Roman,

Lucida, Comic Sans MS, and Monospace. 

Label Font Color: A color can be selected for the label text from a color palette. The

default color is black.

Label Font Size: A font size can be set for the label text ranging from 6 to 13. The default

setting is 9.

Label Alignment: This setting controls the alignment of the label text. The options are Left,

Right, and Center.

Value Font Name: Select a font for the value text. Options include Arial, Times New

Roman, Lucida, Comic Sans MS, and Monospace. 

Value Font Color: A color can be selected for the value text from a color palette. The

default color is black.

Value Font Size: A font size can be set for the value text ranging from 6 to 13. The default

setting is 9.

Value Alignment: This setting controls the alignment of the value text. The options are

Left, Right, and Center.

Default Page Size: The default page size can be set to 10, 20, 50, or 100.

Editors New Line Mode: When creating a new line in an editor, choose Paragraph or

BreakLine for when the >Enter> key is pressed.

Tap OK at the bottom of the page to save changes.
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The filter bar is displayed by default with the Show column filters setting checked above.

6.1.1.1 Change Themes

There are different themes available for the display of wMobile Desktop. 

Tablet themes were been added in wMobile start with 3.1 version, for use on iPads and

tablets. These settings will only be used if an iPad or tablet operating system is detected.

To verify, or try other themes, select User Options from the menu bar, under the user name.

Select Display on the left to access display settings.
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Themes for use on full browsers on computers and laptops can be set under Theme.

Expand the Display options node using the arrow ">" sign to locate settings for iPads and

tablets.
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Tap in the Tablet Options node to access the tablet specific settings (see Tablet Display

Options for details).

Tap OK at the bottom of the page to save changes.

6.1.1.2 Tablet Display Options

Expand the Display options node using the arrow ">" sign to locate settings for iPads and

tablets.

When a tablet operating system is detected such as an iPad or Droid tablet, these settings

will be used.

NOTE: The Material theme is the default and recommended theme.

Zoom Level allows control over the general size of the page/components. This may be

needed to adjust the zoom for particular devices.
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Tap OK at the bottom of the page to save changes.

6.1.1.3 Navigation Menu Configuration

The navigation menu can be customized so users have the features they use frequently

easily accessible. Less used features can be accessed from the down arrow at the end of

the menu. This customization can be done by end-users in User Options or administrators

in the wMobile Manager Console. 

End users will access User Options from the user name menu. 

Expand the Display section and select Main Menu Configurator. 

You will see your main menu displayed in a tree view. You can start to reorder using drag &

drop or using the available buttons on the right. If you press on the ‘Built-in Order’ button,

the main menu will be reset to the default order provided by the application.
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After reordering, tap ‘OK’ and the main menu will be reloaded.
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Note: The Logo in the upper left, the Search button and the User Profile menu on the right

cannot be moved. 

6.1.1.3.1  External Menu Items

External menu items (URLs to external pages) can also be added to the navigation bar.

Select the External menu items tab. Enter Caption and URL (web address) and select Build

URL. Examples are shown below.
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This is how they are displayed in the Main Menu. Before these items, a line separator will

be added.

The external menu options will be listed in the Main Menu Configuration list as well and

can be reordered as needed.
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After reordering, tap ‘OK’ and the main menu will be reloaded.
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6.1.2 Personal Options

The Personal Options are displayed in both wMobile Phone Edition and Desktop Edition.

These settings are used in wMobile Phone edition for mapping functions.

Personal settings include mailing and address information used mainly in the Phone

Edition.

Prefix Dial: Set this if your phone requires a dialing prefix.

Email Client: The email client selection options are Builtin or System Default. This setting

controls wMobile's behavior when you tap on an email address hyperlink. Depending on

the setting here, the email will be created using wMobile as the email client (Builtin) or

your device's email client (System Default).

Contact Set: wMobile Desktop supports multiple contact sets. To switch from one

contact set to another, select the appropriate contact set from the drop-down list.
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Tap OK at the bottom of the page to save changes.

6.1.3 Regional Options

Regional settings control display and formatting for time, language, date, currency, and

distance units. NOTE: The settings in this example are appropriate for the US, but can be

adjusted for other countries.

Time Zone: Select the time zone in which you reside.

Language: Set for the appropriate language.

Short Date Format: Select the date format for short dates as you prefer them to be

displayed. The differences are in the order of month, day, and year and whether they are

separated by slashes (/) or dashes (-). 
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Long Date format: Select the date format for long dates.

Time Format: Select the time format you prefer using AM/PM (such as 03:00 PM) or what

is sometimes referred to as military time or 24-hour clock (e.g., 15:00).

Currency: Select the currency for your country, such as USD, EUR, GBP, CAD, etc.

Currency Format: Select the appropriate currency format for your country.

Distance Unit: Select KM or Mile for the distance unit.

Tap OK at the bottom of the page to save changes.

6.1.4 Contact Options

Contact Options include display settings for the Contact screen.

  FONT SELECTION NOTE: Font selections here pertain to the Contact screen

settings. For changing fonts displayed when viewing activities and opportunities, there

are separate settings for the those screen in Display Options.
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Label Font Name: Select a font for the label text. Options include Arial, Times New Roman,

Lucida, Comic Sans MS, and Monospace. As an example, "Contact" is label text in the

screenshot below.

Label Font Color: A color can be selected for the label text from a color palette. The

default color is black.

Label Font Size: A font size can be set for the label text ranging from 6 to 20. The default

setting is 9.

Label Alignment: This setting controls the alignment of the label text. The options are Left,

Right, Center.

Value Font Name: Select a font for the value text. Options include Arial, Times New

Roman, Lucida, Comic Sans MS, and Monospace. As an example, "Susan Smith" is value

text in the screenshot below.

Value Font Color: A color can be selected for the value text from a color palette. The

default color is black.

Value Font Size: A font size can be set for the value text ranging from 6 to 20. The default

setting is 9.

Value Alignment: This setting controls the alignment of the value text. The options are

Left, Right, Center.

Screen Row Size (px): This setting adjusts the space between the rows. The default is 28.

Use the up and down arrows to adjust or type in the value desired.

Screen Column Size (px): This setting adjusts the column size across the screen from left

to right. the default setting is 10.Use the up and down arrows to adjust or type in the value

desired. If increased to the point where the fields extend further to the right than will fit on

the screen, a scroll bar will appear.

Additional Contact: Fax Label: The label text for the additional contact's "Fax" field.

Show Labels as Links: Show the labels as hyperlinks.
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Contact Set: wMobile Desktop supports multiple contact sets. To switch from one

contact set to another, select the appropriate Contact Set from the drop-down list.

Tap OK at the bottom of the page to save changes.

Example of Contact view with the settings as pictured above.
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6.1.4.1 Tabs

The Tabs settings control which tabs are displayed at the bottom of the contact screen.

Place a tick in the checkboxes for the tabs you use and remove the ticks from  any tabs

that you don't use or don't wish to see. Custom tabs can be selected as here as well.
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Tap on the Reorder tab to change the order in which the tabs appear.

Select a tab on the list and use the up and down arrows to change the order of the tabs.

The topmost item on the list will be the first tab displayed (on the left) on the bottom half

of the contact window.
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  IMPORTANT: wMobile administrators can set the access to contact tabs on behalf

of users by using wMobile Manager Console. For details, please see: Managing Contact

Tabs in wMobile Desktop.

6.1.4.2 Google Tab

Select the fields to be used to with Google search.
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6.1.4.3 Quick Search

Select the fields to be used in the Quick Search option in the upper right hand corner of the

wMobile Desktop window. By default, Company Name, Contact Name and City are

selected. 

Checkmark the fields that will be useful for you to search on:
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The fields selected will be used in the Search.

The Quick Search is found near user name. After tapping on the magnifying glass the

Search contact record window is opened: 

Click here for further information on search functionality.
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6.1.4.4 Detail  Tabs

Any custom details created in your GoldMine will be listed on the Tab drop-down list. Once

selected, select the fields to display for that detail. There are now up to 12 associated

fields with Details, but you might not be using all of them.

This is the custom detail "Campaigns" tab with the fields selected as above.
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6.1.5 GM+ Browser Options

If your GoldMine has been customized to include GM+Views, then they will be available for

selection in wMobile Desktop. The Car and Property examples are provided by GoldMine

with a demo installation. Some other common examples are Weather, Google Maps, or

Twitter. Some customers might have customized GM+Views to show other custom data

in a web format such as accounting data, sales, or reports.

The selections that were added will appear in wMobile Desktop on the GMPlus View tab.
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6.1.6 Activity Options

The Activity Options set behavior with scheduling and completing activities in wMobile

Desktop.

Set alarm on new activities: If checked, this will automatically set an alarm on all activities

created in wMobile Desktop.

Carry over completion notes to follow up: If checked, any activity notes will be copied over

to the follow up activity. reducing typing.

Schedule a follow up by default when completing an activity: With this option checked,

when an activity is completed, a new window will come up automatically to schedule a

follow up activity.

Default Pending Sort Order: This option controls the sort order on the Pending tab of the

Contact screen. Ascending will sort the activities in ascending order from oldest at the top

to newest on the bottom of the page. Descending order will sort the activities from newest

on the top to oldest on the bottom of the page.

Default History Sort Order: This option controls the sort order on the History tab of the

Contact screen. Ascending will sort the activities in ascending order from oldest at the top

to newest on the bottom of the page. Descending order will sort the activities from newest

on the top to oldest on the bottom of the page.
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Default Time Picker minutes interval: This option sets the default duration of an activity.

6.1.6.1 Calendar Options

Calendar Options control how the calendar is displayed in wMobile Desktop. Access from

the Activity section in the User Options as shown in the image below.

Calendar Font Size: Select a font size for the calendar activities ranging from 6 to 20. The

default setting is 9.

First Day of the Week: Select the first day of your work week that should be displayed on

the wMobile calendar.

Last Day of the Week: Select the last day of your work week that should be displayed on

the wMobile calendar.
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Start Hour: Select the hour you typically start work. The calendar will be displayed

beginning with this time.

End Hour: Select the hour you typically end work. Activities will be displayed on your

calendar ending at this time.

  NOTE: The calendar will only display the days and time selected in these options. If

an activity is outside the days and times selected in the preferences, it will not be

visible.

Minute Interval: Select the interval for the calendar display. The options are 10, 15, 20, 30

or 60.  The shorter the timeframe, the longer the calendar list will be, but there will be more

room to show activities.

Calendar Font Name:  Select a font for the label text.  Options include Arial, Times New

Roman, Lucida, Comic Sans MS, and Monospace.

Calendar Font Color: Select a color for the text.  The default color is black.

Fields in Calendar: Tick the Company and/or Contact checkbox to display them for

activities on the calendar.

Activity Types Pending: Tick the Activity Types checkboxes to be displayed on the

calendar: Calls, Next Actions, Appointments, Others, and/or Events.

Show history activities: Tick the completed activity typescheckboxes to be displayed on

the calendar: Calls, Next Actions, Appointments, Others, and/or Events. These activities

will be displayed with a line through them to distinguish them from Pending activities.
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6.1.7 Session Options

Keep Me Logged In for: This option controls the timeout setting in wMobile Desktop. If

you are not active in wMobile Desktop, set how long before you are logged out of wMobile

Desktop. The setting ranges from 30 minutes to 1 day.
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6.1.8 Dashboard Options

Font Name: Select a font for the Dashboard text.  Options include Arial, Times New

Roman, Lucida, Comic Sans MS, and Monospace.

Font Size: A font size can be set for the Dashboard text ranging from 6 to 20. The default

setting is 9.

Pending: Select the pending activities to be included in the Dashboard summary.

History: Select the history activities to be included in the Dashboard summary.
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6.1.9 Documents

Default document settings can be made here.
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6.1.10 Configuring Email

In order to use wMobile to send and receive email, an email account must be configured. These

settings are not copied from GoldMine and might be different when accessed outside the network vs.

when GoldMine is accessed on the network.  Email accounts can be configured in wMobile Phone,

wMobile Desktop, or from the wMobile Manager Console.

To configure an email account in wMobile Desktop, select Email > Email Center from the wMobile

Desktop menu.

If an email has already been added, it will appear in the list and the settings can be accessed by

tapping on Edit. Otherwise, tap the + sign as highlighted below to add a new account.
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Add a name for the email account that you’ll recognize, your name and email address. Select Next to

proceed to the next screen.

Add incoming email server information. You should be able to obtain this information from your

Internet Service Provider, your IT Administrator or consultant, or possibly from your GoldMine email

settings. Click Next to proceed to the next screen of settings.
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Add outgoing email settings. Click Next to proceed.

Add Fetching settings if appropriate. wMobile offers auto-file functionality with IMAP type email

accounts, which can automatically file email to GoldMine History based on a matching email address.

This can be managed here, but is usually set by an admin in the Manager Console. If auto-filing Sent
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email, verify the name of the Sent folder in the Sent Items Directory. For example, in Outlook the

folder is labeled ‘Sent Items.’ In GMail, it’s ‘Sent Mail.’

If ‘Disable Auto Checking’ is set, the wMobile fetcher service will not go out to the server or ISP

mailbox to check for new emails. Typically, this is left unchecked so users will see new mail in wMobile. 

If ‘Delete from Server when processed’ is checked, emails will be removed from the server or ISP

mailbox when they are filed and/or deleted. This should be checked to avoid downloading the same

emails repeatedly. However, in some cases, users wish to view emails in multiple email clients such as

wMobile, GoldMine, Outlook, native phone clients, and/or web interfaces. Leave this unchecked if you

wish to be able to access the same emails in multiple email clients, even after they are filed or deleted

in wMobile.

Type in or copy/paste an email signature or use Import GoldMine Signature. 
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The email credentials can be tested using the Test button. Select Done when all configuration is

completed. You will then be able to use wMobile Desktop to send and receive emails using this email

account.

6.1.10.1 Email Settings

Email settings can be accessed from the User Options menu. Select User Options under

user name.

  

Select the Email tab as shown below.
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If 'Show GoldMine Folder' is checked, then the GoldMine inbox will be listed in the wMobile

Desktop Email Center as well as the Online Inbox.

When composing an email, or selecting an email, it is recommended to to select New

Browser Window. You can then send or process email, without having to wait for the email

list to refresh.

Email templates can be selected for new emails, reply emails, and forwarded emails.

6.2 Customizing wMobile Desktop Edition

wMobile Desktop Edition can be customized in a variety of ways:

  wMobile Desktop AddIn Configuration
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This documentation assumes you have some familiarity with GoldMine database structure

and the ability to identify GoldMine field names. If assistance is needed for customization,

please contact your wMobile reseller or wMobile Support.

6.2.1 wMobile Desktop AddIn Configuration

To make adjustments to AddIns for wMobile Desktop, open the wMobile Manager

Console. In the wMobile Explorer window, select the Desktop node and then double-click

the AddIns Configuration icon in the center window. 

The Addins will be listed as shown below. Any of the features listed that are not going to

be used based on your needs can be disabled by unchecking the AddIn item. (NOTE: If you

have a custom AddIn provided by W-Systems, you will see it in this list as well.)

Following is an example of disabling the Cases Addin. If you don't use GoldMine's Service

Center for cases, you might want to disable the Cases AddIn by un-checking it as shown

below. Click Save (shown highlighted in yellow) in the Actions window to preserve this

change.
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A prompt will appear requesting to restart the Desktop component; click OK to proceed. 

NOTE: Restarting the Desktop application will cause users to be forced back to the

wMobile login page.

When a user logs into wMobile after these steps are taken, the items related to Cases in

the Desktop Edition, such as the option to open "Cases" will no longer be displayed.

Further, the option to display the tab (in this example "Cases") will not be available in User

Options. See the following screenshots for examples of before and after disabling the

Cases AddIn:



Desktop EditionwMobile User Guide 699

Copyright © 2021 SugarCRM All Rights Reserved.

Removed from Toolbar:

 

 

Removed from Tabs:

         

Removed from the User Options:
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6.2.2 Setting Default Tabs for Desktop Users

wMobile provides a way to save and use the Desktop edition's tabs configuration as a

default set.  When it is desired that all users have the same set of tabs displayed, this

default can be used to set the tabs for all users at one time.

Following are the steps detailing how to save a default tabs configuration and then apply it

to all users.

  NOTE: The Save as Default button, required in the following steps, is only available

for master-level users. The master-level privilege is set and maintained in GoldMine.
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wMobile obtains this information from the GoldMine API. Users with master-level

privileges can be viewed in the wMobile Manager Console:

Start by selecting User Options, under the user name from menu bar to open the User

Options dialog:

Select the tabs to be displayed, click the Save As Default button, and then the OK button to

close the dialog.
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To apply the default tab selection to all users:

1. Open the wMobile Manager Console and select the Desktop node in the wMobile

Explorer window.

2. In the center window double-click on the Default User Options icon.
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The center window will now display the options available. In the center window, navigate

to Options > Desktop > Contacts and click on the SelectedTabs setting as shown.

Select Apply to all users as shown.

When prompted, select Current setting "Selected Tabs" to apply this setting to all users.
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The next time a user logs in, they will have the their tabs set based on the defaults.

For further information in this manual, see:

  Configuring wMobile Default User Options

Blog post article link: Setting wMobile User Option

https://www.w-systems.com/blog/setting-wmobile-user-options/

6.3 General Editing

This topic covers general editing features that are important to know as they're used

throughout wMobile Desktop's user-interface.

When editing certain field values like "Reference" or "Code" while scheduling or completing

an activity, editing field information, or adding new contacts, wMobile will allow you to

either choose a pre-defined selection entry from a drop-down list or type your own entry.

The pre-defined selections that are available in the drop-down lists are maintained within

GoldMine or wMobile Desktop by an administrator with master rights (i.e., GoldMine's F2

Lookups).

Drop-down List Selection

This field has a restricted drop-down list:

Please take note of the "arrow" sign to select the value from the list. A selection can be

made from the list. Free form text entry is not permitted.

This field allows manual entry or selection from a Lookup list:

https://www.w-systems.com/blog/setting-wmobile-user-options/
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Entries into this type of field can be made by:

· Typing a value directly into the field.

· Clicking the "arrow" sign to allow a selection to be made from a Lookup list that will

display.

Editing Notes (Pending and History Records)

Pending activity notes and history record notes play a key role in keeping solid

relationships with your contacts. Within the notes field for these record types, you can

add, edit, or simply review notes for the current activity.

Notes textbox:

The notes field is a multi-line free-form text box. Enter helpful information here to aid in

upcoming activities (Pending) or meaningful information describing what occurred for an

activity (History). Text is edited in the same way for both pending and history notes.

6.4 Connecting to wMobile

Connecting to wMobile Desktop Edition is very simple. Nothing needs to be installed on

your device before you can use wMobile (i.e., typically referred to as an "app" people today

are familiar with). All you need is an Internet browser, an Internet connection, and the web

address for your company's wMobile Desktop to get connected.

  Logging into wMobile Desktop Edition
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  Using a One Click Login

6.4.1 Logging into wMobile Desktop

Open an Internet browser such as Internet Explorer, Firefox, Google Chrome, or Safari.

Browse to the web site for your company's wMobile Desktop. This should have been

provided to you by your wMobile administrator. Use your GoldMine username and

password to log into wMobile. There is a Remember Me checkbox that can be used if you

are the only user on your computer and don't want to have to enter your username each

time.

6.4.2 One Click Login

wMobile can generate an encrypted web address (URL) that contains your organizations

wMobile server address combined with your username and password. If your administrator

has enabled this feature it will allow you to copy this URL and save it as your wMobile

stored link for easy access without having to type your user name and password. On some

devices, the web page can be associated with a keyboard shortcut to offer the most

convenient wMobile access.

  NOTES: 

· If your GoldMine password is changed after creating a One Click Login, that One Click

Login will no longer work and a new one would need to be created.
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· One Click Login can be restricted if your company's security policy requires users to

log in with their username and password each time.

To generate the web address click on User Options > Setup One Click Login:

A page similar to the following image will appear. Click the Add To Favorites link to save

the One Click Login as a favorite/bookmark (based on your browser preference). For

advanced users, you may also copy and paste the URL as you wish if you familiar with that

process. 

Bookmarking varies based on browsers. Use your browser’s option to save the web address as a

browser favorite or bookmark. Some examples are provided below.

In Chrome and Firefox, you will be prompted to use the Control + D keys on your keyboard to

bookmark.

Chrome:
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You can update the Name as you like, and select an appropriate folder or bookmarks bar. Click

Done to save the bookmark.

Firefox:
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Internet Explorer:
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Using whichever browser, your One Click Login will appear where you saved it. If you saved it into

your browser’s bookmark bar, it will be displayed with the new icon.

You can also save a One Click icon for wMobile Desktop on an iPad or tablet.   In Safari, on an iPad,

the Share icon would be used as highlighted below.

Select to Add to Home Screen. (You could also use Add Bookmark which would save a bookmark in

the browser bookmarks, instead of on the Home Screen.)
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Give the bookmark a name and click Add.

The new wMobile One Click Login will be placed on your home screen and can be moved as

desired.
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6.5 Searching for Contacts

There are 3 fast and easy ways to search for contacts in wMobile Desktop. See each

section below for specific instructions:

  Quick Search

  Contact Search

  Label Search

6.5.1 Quick Search

The Quick Search is located at the top right of the wMobile Desktop Window.

The search includes the company, contact, and city fields by default, but this can be

customized.

Click on magnifying glass from menu bar.

Enter part of a company, contact name or city in Search here... field and click on

magnifying glass.

· You will be presented with a list of potential matches. 

· Any item highlighted in blue and underlined is a hyperlink. Click on it to bring up the

contact details.

· Use the scroll bar on the right to go up and down on the list.
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After clicking on a company or account hyperlink, the record will be displayed on the

Contact window.

6.5.2 Contact Search

The Contact Search can be initiated from the Contacts menu. Select Primary Contact

Search or Additional Contact Search from the menu.

The Contact Search might also be your default when you log into wMobile Desktop.
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Enter your search criteria. 

There are a number of filter comparison options as pictured to the left. The default is

"Starts with" which is most commonly used. 

The default option will be used if you don't make a filter comparison selection and just

click elsewhere on the window. 

The search results will be displayed in a list. 

The fields in the Contact Search can be customized using the Columns button in the

Contact Search menu bar.
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6.5.2.1 Contact Search Menu Bar

There are a number of other options available on the Contact Search Toolbar:
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New: This option takes you to a blank contact form where you can fill in the new contact

information. (NOTE: this option might not be present depending on security settings.

Adding new contacts can be restricted administratively.)

Clone: Select Clone to copy check-marked contact records. 

Edit: This option will open the highlighted contact for editing.

Delete: Click Delete to delete a selected contact. This option is dependent on GoldMine

permissions. Only one contact can be deleted at a time.

Schedule: You can schedule any type of activity from the drop-down list: Call,

Appointment, Other, Next Action, Sale or Event.

Refresh: Use the Refresh button to search again and refresh the list.

Clear: Use Clear to remove any search criteria.

Columns: Select Columns to add or remove columns in the Contact Search as shown

below.

Filter Builder: Click on the Filter Builder to open a filter area at the top of the Contact

Search to enter criteria and save the criteria as a filter. 

Add to Group: Checkmark contacts from the list and click on Add to Group to add them to

an existing GoldMine Group or create a new GoldMine Group.

Export: Click Export to export selected contacts. Options for export include CSV, Excel and

PDF. This option is dependent on GoldMine permissions.

New Email: Click on New Email to start a draft email to selected contacts. 

Additional Contacts: Use the Additional Contact button to switch to searching Additional

Contacts. 

NOTE: When searching for Additional contacts, the button will be displayed as Primary

Contacts.
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The fields in the Contact Search can be customized using the Columns button on the

Contact Search menu bar as highlighted on the left.

Select the field to add to the search criteria and use the >> button to add it as a column in

the Contact Search pane. 

To remove a field, use the << button to return it to the list of available fields.

6.5.3 Label Search

wMobile Desktop supports the same type of label search as GoldMine Premium Edition.

Click on a label such as Company, Contact, Source, State, Acct Manager etc. to bring up a

search on that field. Source is used in the example below.
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Click on the arrow sign to the right of the field to see the lookup list. Enter your search

value(s). If you have a lookup list for the field in GoldMine, it will be available for selection

in wMobile.
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The search results will be listed below the criteria. Select the appropriate company or

contact to bring up contact details. 

Click here for other options available on the Contact Search menu.
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6.6 Working with Contact Details

Once a contact has been selected, the Contact details can be viewed and updated. The top

part of the contact window will display contact information as it does in GoldMine.  The

bottom part of the screen will display tabs such as Additional Contacts, Pending, History,

etc as you see in GoldMine.

wMobile Desktop supports GoldMine Record Typing.
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Click in a field to update the information. 

Any field that has a drop-down list in GoldMine will have the same drop-down list in

wMobile for selection. 

Click on the arrow sign of the right the field, to view the selection list.
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Select the appropriate value from the list to update the field.

See the sections below for editing tab information.
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6.6.1 Selecting Primary Field view

If you use primary field views in GoldMine, these will be available for selection in wMobile

Desktop from the Primary Fields drop-down list pictured here.

You can set a default primary view in the User Options.
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6.6.2 Using the Splitter Bar on the Contact Screen

You might want to adjust the splitter bar between contact information on the top have of

the contact screen and the tab information on the bottom half of the screen. Move your

cursor over the separation bar until you see the up and down arrow as pictured on the left.

Then drag the splitter bar up or down as needed.

6.6.3 Additional Contacts Tab

Secondary or additional contacts can be seen under the Additional Contacts tab of the

contact screen.

Note that the names are underlined and in blue. They are hyperlinks that can be clicked on

to bring up further details.
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Information can be viewed or updated. If changes are made, click on Save to preserve the

changes or Cancel to close the window without preserving any changes.
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There are options on the toolbar at the top of the Additional Contacts tab.

Click New to create a New additional contact. 

Click Edit to edit the highlighted contact.

Click Delete to delete the highlighted contact. 

Swap with Primary: This option swaps the additional contact with Primary.

NOTE: If these options are not present, then your security does not permit it. These

options can be restricted in the wMobile Manager Console.
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Filter bar: Use the filter bar to filter the list of additional contacts by contact name, title,

reference or phone number. The standard list of comparisons is available as pictured to

the right. 

Only additional contacts that meet the criteria will be displayed until the criteria is

removed. 

Clear filter: Clears the filter criteria.

6.6.4 Fields Tab

If you have custom field views in GoldMine, they will be accessible in wMobile Desktop as

well under the Fields tab.
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If you have more than one field view in GoldMine, these can be accessed from the Custom

Screens button. Select the field view from the drop-down list.
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The selected field view will be displayed. A default field view can be selected in User

Options.

6.6.5 Pending Tab

Pending activities will be displayed under the Pending tab. To set the sort order, see

Activity Options.
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Pending toolbar.

· Click Schedule to create a new pending activity. 

· Click Edit to edit the highlighted activity.

· Click Complete to complete the highlighted activity.

· Click Delete to delete the highlighted contact. 

· Click Move Forward to move the activity forward. The selection options include 1 Day, 7

Days, 14 Days, 21 Days, 30 Days, 60 days, 90 Days or select a date from the calendar..

· Click Filter Bar to add the field filtering choices on Type, User, Date, Time, Contact and

Reference.

· Click Clear filter to clear all filter criteria.

NOTE: If these options are not present, then your security does not permit it. Some of

these options can be restricted in the wMobile Manager Console.

Notes display can be toggled on or off using the toggle button at the right of the Pending

tab.
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6.6.5.1 Schedule a Pending Activity

On the Pending tab, highlight the activity to edit and click on the Schedule button on the

toolbar and select the type of activity to schedule: Call, Appointment, Other, Next Action,

To-Do, Sale or Event.

The activity will come up in a separate window. Edit the fields as needed or add activity

notes. Click Save to preserve any changes. Click Cancel to close the activity without

preserving changes. Note the Users tab to select additional users or groups for an activity.

Note the Recurring tab to select Recurring activities.
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6.6.5.2 Editing a Pending Activity

On the Pending tab, highlight the activity to edit and click on the Edit button on the toolbar.
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The activity will come up in a window. Edit the fields as needed or add activity notes. Click

Save to preserve any changes. Click Cancel to close the activity without preserving

changes.
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6.6.5.3 Complete a Pending Activity

On the Pending tab, highlight the activity to complete and click on the Complete button on

the toolbar.
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The activity will come up in a window. Edit the fields as needed or add activity notes. Click

Complete to complete the activity. Click Cancel to close the window without completing

the activity.
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6.6.5.4 Delete Pending Activity

On the Pending tab, highlight the activity to delete and click on the Delete button on the

toolbar. 

NOTE: This option might not be available depending on security settings.

6.6.5.5 Recurring Activities (Desktop)

Creating a Recurring Activity in wMobile Desktop

To start, find/select a contact to create a recurring activity for.

From the toolbar, select: Activities > Schedule > Call

The Schedule Activity dialog opens. Here is a screenshot of the Detail tab already

populated by a user (these values will be used in examples):
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The call's Reference value is "Conference Call" and the calls are scheduled to start on at

9:30 AM with a duration of 15 minutes. In this example we want to meet "Tuesdays" of

every week starting on 10/8/2019. Notes were added to remind users of the meeting's

topics and a Code (PRY) was set. (NOTE: PRY = Priority; you may use any code you wish

from your system.)

Other Options to Set:
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You may optionally (as shown in dialog above) link the activity to an Opportunity or a

Case, set an Alarm, Notify via Email, Notify via SMS, Auto-generate RSVP, Mark as Private,

and set a Color value. The Primary User (ADELA in this example) may be changed if you

are scheduling this for a user other than yourself. The Users tab allows you to set the

activity for multiple users. In this example, we left this set only for ADELA as the Primary

User.

The Schedule Activity dialog's Recurring tab is populated:
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Above, the dialog shows how to setup the calls to be scheduled:

- Start Date = 10/8/2019; End Date = 10/31/2019 (totaling a year's worth)

- Start time = 9:30 AM (the time to meet; the Duration was set previously)

- Occurs = Weekly

- Repeats = Every week (user for every week; no skipping in this example)

- By Day of the Week = Tuesday

Finally, to create the series of recurring calls, click the Schedule button. 

On the Pending tab, we see they were created (only three shown here):

When the Reference link for one of these recurring activities is clicked on, wMobile

Desktop will display this dialog:

The user has the option to edit either the "current occurrence" or the "recurring series" of

activities by selecting one of the radio buttons in the dialog presented (see above). Note:

The "current occurrence" is activity that was clicked within the list. After clicking OK, the

Edit Dialog opens where edits to the activity can be made and saved (or activities of the

entire series).

If an activity is to be deleted the user will be prompted to delete the "current occurrence"

or the "recurring series". The dialog is similar to the one displayed prior to editing.

The Users Tab
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When creating recurring activities, more than one user can be added to the activity. This is

accomplished using the Users tab.

Here is a screenshot of the Users tab in wMobile Desktop:

NOTE: The Primary User linked to the activity is set on the Detail tab:

Other users can be added to the activity by selecting them in the User list and clicking the

arrow pointing to the right (see the following screenshot). Repeat as necessary to add the

users to the activity. The opposite can be performed to remove a user from the list on the

right once it's populated. There are also buttons for adding or removing "all" of the users

at one time from ether list using the >> and << buttons. In wMobile Desktop, a user can

add the members of a User Group by selecting that group from the User Groups List and

using the right arrow.
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  IMPORTANT: Editing Recurring Activities (Special Notes for Behavior Based on

GoldMine Versions)

The user has the option to edit either the "current occurrence" or the "recurring series"

of activities. However, please note that users running different versions of GoldMine

will have different capabilities:

GoldMine 9.x and higher:

Users running GoldMine 9.x and higher will be able to edit the recurring details (i.e., the

start/end dates/times) as well as the activity details such as reference, activity code

and notes.

GoldMine 8.x, 7.x, and 6.x:

Users running GoldMine 8.x, 7.x, and 6.x will only be able to edit the activity details such

as reference, activity code and notes. The recurring tab will not be displayed for editing

the recurring details (i.e., the start/end dates/times).
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6.6.5.6 Move Forward

On the Pending tab, highlight the activity and click on the Move Forward button on the

toolbar. Select the number of days to move the activity forward: 1, 7, 14, 21, 30, 60 or 90

days or select a date from the calendar.

6.6.5.7 Filter Bar

The Filter Bar can be used to filter the displayed activities. Use the drop down lists for

Type, User, Date, and Time or type the value into Contact, Code, or Reference fields to limit

the displayed activities.

The Clear Filter can be used to clear the filter criteria.
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6.6.6 History Tab

History activities will be displayed under the History tab. To set the sort order, see Activity

Options.

History toolbar:

· Click Complete Unscheduled to complete an activity that was not previously scheduled.

· Click Edit to edit the highlighted activity.

· Click Delete to delete the highlighted contact. 

NOTE: If these options are not present, then your security does not permit it. Some of

these options can be restricted in the wMobile Manager Console.
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The Filter Bar can be used to filter the displayed activities. Use the drop down lists for

Type, User, Date, and Time or type the value into Contact, Code, or Reference fields to limit

the displayed activities. The Clear Filter option can be used the clear all filter criteria.

Notes display can be toggled on or off using the toggle button at the right of the History

tab.

6.6.6.1 Complete Unscheduled

Click on Complete Unscheduled and select the type of activity from the drop down list to

complete an activity that was not previously scheduled.
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The activity will come up in a window. Edit the fields as needed or add activity notes. Click

Complete to complete the activity. Click Cancel to close the window without completing

the activity.
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6.6.6.2 Edit History Activity

On the History tab, highlight the activity to edit and click on the Edit button on the toolbar.

The activity will come up in a window. Edit the fields as needed or add activity notes. Click

Save to preserve any changes. Click Cancel to close the activity without preserving

changes.



Desktop EditionwMobile User Guide 749

Copyright © 2021 SugarCRM All Rights Reserved.

6.6.6.3 Delete History Activity

On the History tab, highlight the activity to delete and click on the Delete button on the

toolbar. 

NOTE: This option might not be available depending on security settings.

6.6.6.4 History Fil ter Bar

The Filter Bar can be used to filter the displayed activities. Use the drop down lists for

Type, User, Date, and Time or type the value into Contact, Result Code, or Reference fields

to limit the displayed activities.
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The Clear Filter can be used to clear the filter criteria.

6.6.7 Groups Tab

If a contact is a member of a GoldMine group, the group will be displayed under the Groups

tab.

The menu bar includes the following options:

New, Edit, Delete, Filter Bar, and Clear Filter. 

6.6.7.1 New Group

Use the New button to add the contact to a Group.
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Select the Group from the list. The other settings are inherited from the Group. Select

Save to add the contact to the new Group.

6.6.7.2 Edit Group

Select Edit to edit the Group membership settings.

Update settings such as the Membership Reference. 
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6.6.7.3 Delete Group Membership

Click on Delete to remove the contact from the selected Group. The Group will still exist

with its other members.

6.6.7.4 Group Filter Bar

Select Filter Bar to activate the filter bar. Filtering options include name, members and

user.
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6.6.7.5 Clear Group Filter

Select Clear Filter  to clear any entries in the filter bar. 

6.6.8 Linked Documents Tab

Documents that are linked in GoldMine such as email attachments, merged documents

and manually linked documents can be accessed under the Linked Documents tab. Click

on Edit or double-click on the file name to open a document. Documents uploaded in

wMobile will be in folders with unique folder names. A document can be deleted, if user

permissions permit.

Attach to Email
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Click on the Filter Bar button on the Linked documents toolbar to filter the list of

documents. A user can filter on File Name, File Path, Document or Extension. In the

example below, only linked documents with .pdf extensions are displayed.

See the topic on uploading a linked document.

6.6.8.1 Uploading a Linked Document

To Upload a new linked document, navigate to the Linked Documents tab of the

appropriate GoldMine record. Select the New button on the toolbar.
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The user will enter the document name, add any notes, and browse to the location where

he saved the edited file. click OK to add.

The uploaded document will be accessible to others in wMobile Desktop. As noted

previously, the file path uses an algorithm to ensure a unique folder name.

6.7 Document Merge

It is possible to merge a letter for single GoldMine contact, or to produce a letter for

multiple recipients. See the links below:

  Create a Document Merge Template

  Single Document Merge
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  Multiple Recipient Document Merge

6.7.1 Create Doc Merge Template

Document templates can be created for use in merging letters with a single contact or

multiple contacts.  These templates are separate from any templates created and used in

GoldMine.

Select Documents Templates from the the expanded menu.

Select the "+" sign to create a New document template as highlighted here in yellow. Or

select File and New document as highlighted in green.

Create the document template. A date can be inserted from the Insert menu. Select the

date format of your preference.
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GoldMine fields can be inserted, such as the Name, Title and Address.
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When the letter is completed, select Save Template from the File menu.
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Give the template a descriptive name and click OK. It will then appear on the list of

templates.

 

6.7.2 Single Document Merge

Select your contact and use the Merge button.

Select the template from the list. Give the document a descriptive name. If the user needs

to edit the document, select Docx (or Pdf) as the Output format and select the option to

Check as Linked Document. There’s an optional button to Preview the linked doc. Click

OK.
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The user will be prompted to Open or Save the document.

The saved document will be listed under the Linked Documents tab. The file path uses an

algorithm to ensure a unique folder name as shown below.

The user can open it from the Linked Docs tab. He can either click Edit or double-click on

the file name to open the file.

If the user selects Open at the prompt, it will be opened in Word.
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The user would then need to save the document somewhere he has access on his

computer or the server when done editing. wMobile will NOT automatically save the edited

copy. The updated document would need to be uploaded as any other new document.

See the topic on Uploading a Linked Document.

6.7.3 Multiple Recipient Document Merge

To merge a letter for multiple recipients, a user can select a filter or group from the side

bar.

A user can enter search criteria to locate the desired records.
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In either case, the user can checkmark individual records as shown above, or use the

checkbox in the upper left to select all records.
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Once the selection is made, select Merge Documents from the toolbar.
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Select a template from the Available Templates list. The user should give a descriptive

name for the Output Document Title. The user can select to create the document as "docx"

or "pdf" for the Output Format. If desired, checkmark the Check as Linked Document option

so that a copy will be stored under the Linked Documents tab of each selected account.

The user will be prompted to Open or Save. In either case, a copy will be saved under the

Linked Documents tab, if this option was checked.  In either case, the document will be

linked to each selected record under the Linked Documents tab, if that option was

checkmarked.

6.8 Working with the Calendar

wMobile Desktop provides a view of the user's calendar in Day, Week, Month, Multi-day or

Agenda views. There is an individual user calendar and a Multi Calendar to view several

user's calendars at the same time.

Select from the Calendar menu to view Day View, Week View, Month View, or Peg Board.
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From the calendar, the user can also change the time-frame by clicking on Day, Week,

Month, Multi-day, Agenda as highlighted below.

The user's calendar to be displayed can be selected from the drop-down list as pictured

below. 

NOTE: The ability to view others' calendars will be dependent upon these settings in

GoldMine. If the user does not have the ability to view others' calendars in GoldMine, they

will not be able to do so in wMobile either.
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6.8.1 Multi Calendar

The Multi Calendar can be accessed from the Calendar menu.

 

To view another user, click the arrow sign and select the user from the list. You'll then see

the user's calendars side by side.
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If the administrator wishes to adjust the default number of calendars that can be viewed at

once, that is set in the wMobile Manager Console. Select Default User Options.

In the Desktop section, expand Activities. Select MultiCalendar, then the

MaxCalendarNumber as highlighted below. The default is 4 but can adjusted higher or

lower.
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6.9 Working with SQL Manager

wMobile has some excellent built in searching tools allowing you to get to your data fast.

There are other times we need to sift through data using very specific filtering. You might

want to see if certain data exists; or does not exist. Maybe you need a list of which

customers are in a certain state (or multiple states) and even sort the data how you need

to view it. Building and using SQL queries may be just the solution for you. In wMobile

Desktop, you can use the SQL Manager to create, run, and save your SQL queries. After

running a query, the results may be exported to a CSV (Comma Separated Value) or Excel

file.

A note about SQL:

SQL is pronounced "ess-cue-ell" or "sequel" depending on the source and is the acronym

for: Structured Query Language. There is a lot of great information on the web about SQL

and this might be just the ticket you need to get your data exactly how you want it. In a

nutshell, SQL is a language that includes elements you use to build queries. Once written,

a query is executed against your database and then returns data to you, your way. Your

query can be very simple (listing all the contacts in your database) or very complicated

(returning only contacts in your database created after a specific date you specify, these

contacts do not have a primary email address assigned, and they also must have a
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specific Account Manager). To wrap up what SQL is, it's a way of communicating with the

database. Our query asks for data and then the database gives it to us.

SQL Manager

To configure SQL Queries Manger go to Manger Console > Desktop > SQL Queries

Manager.

The interface for writing and using SQL queries is the SQL Manager. In wMobile Desktop,

from the expanded menu select Tools > SQL Manager:

The SQL Manager interface:
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SQL Manager Tools:

Run - Runs the query contained in the editing area.

Save - Allows you to save (or update) the current query.

Clear - Clears the query editing area.

Export - Allows the results returned from a query to be saved as a CSV or Excel file.

User (drop-down) - List of GoldMine users.

Query (drop-down) - List of saved queries for the user selected in "User" drop-down.

  NOTE: There is also as set of font formatting tools to use as needed but please

note that font formatting has no effect on SQL queries.

To use the SQL Manager, type your query in the editor area and click the Run command.

Your results will display in the area below the query editing area:
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6.10 Working with Email

wMobile can be used to send and receive email. Any email received in wMobile will be

linked in the GoldMine History. Any email sent from wMobile will be displayed in the

GoldMine History.  (This is dependent on there being a matching email address in

GoldMine.)

Multiple accounts can be configured if needed. In the screen shot below, two accounts are

configured (GMail and Outlook 365) and the GoldMine Inbox is also displayed.  Many

GoldMine users auto-retrieve emails from their server or Internet Service Provider (ISP)

mailbox into the GoldMine Inbox. wMobile does not yet have this functionality.  So,

wMobile users should close GoldMine when they leave the office. They'll be able to view

newly received emails on the server or ISP mailbox. They'll access the GoldMine Inbox for

any emails previously retrieved into GoldMine.

Select Email from the wMobile toolbar to navigate to the Email Center.
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6.10.1 Compose Email

Use the Compose button on the toolbar to compose a new email message. Select Regular

Email for a single email. 

A list of most recent recipient email addresses will be listed on the left, available for

selection. Double-click on the email address in the list to select it.
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Click on To and Address Book to search for other email addresses.

Type in the search criteria. Click into another field or use the filter icon to select the

comparison type. The default is Starts With.

Click on a contact name to add to the list. (Note: If you click on the company, that's a

hyperlink that will take you to the company record.)

Use the [X]  as highlighted in yellow to remove a contact.

Click Done when email address selection is completed.

Click on Cancel if you want to cancel out of email address selection.
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Another method to add an email recipient is to type in the recipient name and click on the

Check Names button.

If there are multiple matches, a list will be provided for selection. Click OK when your

selection is made.
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Once selected, the contact email address will be filled in. The paper clip icon indicates the

email will be linked. The Linked To contact will be updated and displayed.
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It is possible to link an email to an existing Case, Opportunity, or Project in the Regarding

field.

Enter the email Subject and email message.
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wMobile also supports applying email templates. Select an existing template from the list

and click on Apply. Learn how to create an email template in wMobile Desktop.
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Select Send when email is completed.

You also have an option to Save Draft.

Or Cancel to cancel out of the email message without sending.
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6.10.2 Save Email Draft

You also have an option to Save Draft.
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If an email draft is saved, it will be located in the Local Draft folder where it can be edited

and/or sent at a later time.
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6.10.3 Email Message Options

Email can be viewed from the Email Center.

When an email is selected, any of the options from the toolbar can be used to Reply, Reply

to All, Forward, Delete, Mark (as Read or Unread), or Print.

Use Go To Contact to view that contact in wMobile.

Link to Contact: This option will appear when an unlinked email is highlighted. When the

Link to Contact button is clicked, it will bring up a Lookup Contact window to search for

the contact to which to link the email message.

NOTE: This option will add the email address to the contact selected.
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Email messages are linked to contacts in GoldMine based on a matching email address.

A linked email will have a chain link icon in the Flags column.

An unlinked email message will not have the chain link icon.

A paper clip icon indicates an email attachment.

ReLink/Unlink: this option is used on linked email to link to another contact.

Under File you will see the following options:
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File to History & Delete: this will file the email  under the contact's History and delete it

from the online Inbox.

File to History and Keep in Inbox: this option will file the email to the contact's History and

keep a copy in the Online inbox.

Copy to GM Inbox: This will copy the email to the GoldMine Inbox and leave a copy in the

Online inbox.

Move to GM Inbox: this option will move the email to the GoldMine Inbox, deleting it from

the Online Inbox.

File to another contact: this option will link the email to another contact. It will not add the

email address to the other contact.

Refresh: this will refresh the items in the Inbox. Sometimes a refresh will be needed to

clear emails that have already been processed.

Check Mail: this option is used to check the server or ISP mailbox for new email

messages. The email fetcher will do this automatically based on how the email account is

configured, but this option can be used if you need to check immediately. The default

interval for checking for new email is 30 minutes, but can be configured in the wMobile

Manager Console.

Column Chooser: Click on this toolbar icon to add different fields to the Email Center

display.
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Clicking on the email subject will open the email, where the same options will appear to

process email messages.

NOTE: the underlined contact name in the Sent By column is a hyperlink and will navigate

to the contact record.

File with Options will file the email (and delete it from the Inbox) with the options to

specify an activity code, result code, Filed folder etc.

6.10.4 Email Templates (Desktop)

wMobile Desktop supports the use of email templates and gives users the tools to create

new email templates and edit existing ones .

Email Templates Access / User Interface

On the wMobile Desktop menu bar, click Email > Email Templates:
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P

The Email Templates window will open and display a template list (red area) with tools

and a template editor (blue area):

Clicking on an existing template within the template list will cause that template to display

in the editor. The Subject and Attachments (if any) will be populated along with the body

text.
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Above the template list is a set of icons/tools:

 

From left to right, the tools are:

New: Create a new email template.

Rename: Rename the "selected" template.

Delete: Delete the "selected" template.

Refresh: Refreshed the email template list.

In the editor is a menu containing tools for filing, editing, and formatting the template:

If a template contains an attachment, the existence of the attachment can be tested. To

do this, click the Test Attachments Paths button:
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Upon success, the button icon will

change to: 

Upon failure, the button icon will change

to: 

Using an Email Template

When composing an email in wMobile Desktop, use the Template drop-down to select a

template:

  NOTE: The list of email templates found in the Template drop-down will be those

that are owned by the user logged into wMobile and those that are set as "public" in

wMobile or GoldMine. The publicly owned templates will be at the top of the drop-down

list and are prefixed with "[public]" (e.g., "[public] wMobile Brochure w/PDF").

For instructions on composing email, please see the topic: Compose Email.
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6.10.5 Email Merge

On composing a new email in wMobile Desktop, there's a choice to compose a Regular

Email or Mail Merge.

• A Regular Email means creating a normal internet message for a set of recipients by

manually adding them.

• A Mail Merge is the option to send the internet message to filter/group of contacts

In the Groups/Filter drop down list, all the user's groups and filters will be listed, including

public groups and filters.

On the right side of this drop down there are three checkboxes for different options:

• Primary Email Address – means the email will be sent to primary email address of each

contact in the selected group or filter

• Additional Email Address – means the email will be sent to all non-primary email

addresses of each contact in the selected group or filter
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• Additional Contacts – means the email will be sent to email addresses of all additional

records for each contact in the selected group or filter.

The email can be limited to a specific E-Mail merge code (in place of, or in addition to, a

group or filter).

An email template can be selected. All the users own and public templates will be

available. After a template is selected, select [Apply].

Attachments can be added.
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Click Select and browse for a file. Double-click on the file name or select Open.

After selecting a file, click on Attach Files.
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If a template is not used, the email body can manually entered. Even if a template is used,

the text can be updated. 

When all options have been entered and the email body is filled in appropriately, select

Send to send off the email merge to the selected filter or group of contacts.

NOTE: It is always recommended to send email blasts to a test group or filter first to

double-check formatting etc.
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6.10.6 Local Email Rules

Local email rules will allow user to create filters for email handling and specify rules for

what should happen to those emails, such as copying email to the GM Inbox or a specific

project folder, marking email as Read, or forwarding email. 

These are ‘Local’ email rules in wMobile, to be distinguished from email rules that users

might have in GoldMine, Outlook, or other email clients. 

These email rules will allow us to replicate the auto-retrieve and auto-delete email settings

from GoldMine to copy email from the Online Inbox to the GoldMine Inbox and then

remove them from the Online Inbox.

There is a Rules tab in Email Settings in wMobile Desktop, where Local Email rules can be

configured. Additional information on configuring email can be seen in Configuring User

Options

New rules can be added to the Rule tab by selecting New Rule as shown here.

The rule condition contains one or more filters, as follows:
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Select / Apply for folder

Filter on FROM recipient

Filter on TO recipient

Filter on SUBJECT text

Filter on BODY text

Filter on ATTACHMENTS

Note: Filters on FROM, TO, SUBJECT, BODY are applied with CONTAINS function.

Example: 

If the Filter criteria is SUBJECT='invoice'

Then the Incoming email (Subject='Please send invoice details') will evaluated as

matching because it CONTAINS 'invoice'.  

A rule can be set for one folder or all. Apply rules only for folders that are visible in

wMobile, otherwise the rule will not be applied. 

Setting up a rule with no condition (no values in

FROM/TO/SUBJECT/BODY/ATTACHMENTS) will result in processing of ALL incoming

emails from the selected folder. 

The rule action contains one or more sub-actions, as follows:
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Copy to GoldMine folder

File to GoldMine

Mark as Read

Delete

Move to Online folder

These options provide a range of possibilities for processing email. We can archive email

into project folders, delete junk mail based on a specified criteria, forward email to other

email address(es).  We can now also emulate GoldMine's auto-retrieve and auto-delete

functionality to copy new email into the GoldMine Inbox and remove it from the Online

Inbox. 
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When the desired Filters and Actions have been configured, select OK to save the rule. 

Multiple rules can be created for different purposes.

.

6.10.7 Meeting Requests

If an incoming email contains a meeting request, a meeting response or a canceled
meeting, the email will be parsed and the body of the email will be created using
information extracted from the meeting part.

See related topics:

Accepting Meeting Requests
Meeting Cancellations
Using Meeting Requests with Office 365
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6.10.7.1 Accepting Meeting Requests (Desktop)

In wMobile Desktop, when the selected email from Email Center contains a meeting

request, three new buttons will be added to the email toolbar: ‘Accept’, ‘Tentative’,

‘Decline’.

When hovering the mouse over one of these buttons a tool tip will be opened where the

user can insert his comments and choose if he wants to send a reply email or not to the

meeting organizer to notify him whether or not he will be attending. The response will be

sent when the user presses one of the three buttons or presses the button inside the tool

tip.
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The same behavior happens when the email is opened separately.

1. A meeting response email would be created:

If the ‘Send reply’ option is checked, a meeting reply email would be created and sent to

the meeting organizer to notify him whether or not the user will be attending.
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When a user responds to a meeting request the following actions can happen:

2. An appointment would be inserted in the user Calendar

If the user presses ‘Accept’ or ‘Tentative’, a new appointment is created and inserted in his

calendar:

If the user presses ‘Decline’, no appointment is created.
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3. After the user responds, the email is deleted and filed to GoldMine. This action happens

regardless of the response.

6.10.7.2 Meeting Cancellations (Desktop)

When opening an email that contains a canceled meeting, a new button will be added to

the email toolbar: ‘Remove from calendar’.

When clicking on that button, the pending activity linked to that email is deleted from

calendar and email is Filed to GM.

.

6.10.7.3 Using Meeting Requests w ith Office 365 (Configuration)

If you're using a Microsoft 0ffice 365 account, some configuration is required.

Go to: https://outlook.office.com/owa/?path=/options/popandimap, and verify if ‘Send

event invitations in iCalendar format’ is checked, as in the image below:
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6.11 Working with Cases

wMobile Desktop supports GoldMine cases in order to view, create, and update Cases.

wMobile customers use Cases for different types of service or support cases. 

See the links below:

View Cases

New Case

Working with Case Tabs

Case Metric Dashboards
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6.11.1 View Cases

To access the Service Center, select View Cases from the wMobile menu.

Click on a case link in the Number or Subject column to bring it up in detail view.

Clicking on the Company hyperlink will navigate back to the main account record.

The case can be edited or activities logged. When ready, click on Back to Case List to

return to the summary list of cases.
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6.11.2 New Case

To create a new Case, select New Case from the Cases menu or use the New button on

the Cases toolbar.

A Case could also be created from the Cases tab on a Contact record. Use the New button

on the Cases tab toolbar.

If this method is used, the Company and primary Contact will be filled in automatically. 
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If a case is created from the Service Center, the user will need to search for the

appropriate company and/or contact record.
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The remaining fields can be filled in as appropriate. A template can be applied if your

company or team uses case templates. 

See Working with Case Tabs.

6.11.3 Working with Case Tabs

The same tabs are available in wMobile Desktop as in GoldMine to track information

related to the Case including Contacts, Resolution, Attachments, Tasks, Team, Notes,

Pending, and History. Actvities created from the Pending or History tab will automatically

be linked to the Case. 



Desktop EditionwMobile User Guide 805

Copyright © 2021 SugarCRM All Rights Reserved.

6.11.4 Case Metric Dashboard

The Case Metric Dashboard was introduced in wMobile 5.0.0.511, in January 2020. These

metrics represent a better way to track, analyze, and summarize all types of cases.

The metric dashboard can be opened from Cases tab -> Metrics:

Cases metrics include 2 big areas: 

· The top part of the dashboard contains bar charts with the cases counts.

· In the bottom half of the dashboard, you will find the donut charts split in 4 quarters,

representing periods of a year.

In the first area, you can make different selections based on time period, User, and Case

Status.

For the counted cases you can select different periods of time, by checking the checkboxes

above the graphs, these can be counted/displayed by ‘Created Date’ and ‘Due Date’. 
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You can choose for which user you want to display the cases graphs (based on user

permissions in GoldMine).

The legend of the colors is detailed on the right side. The case types are displayed or hidden

by clicking on the color specified. 

These graphs can be exported in .pdf format.

Click on a bar in the chart to drill down to a list of the Cases. 

Select the Charts tab to return to the list view. 

In the second area, you can see the donut charts which represent 4 time periods of a year.

The legend color is also detailed on the right side with the same actions as in the Cases

count area.

As above, if you want to see the assigned cases, you simply click on the color assigned to

this type of case in the chart to drill down. The details tab will be opened.

From this tab, you can modify a case, by clicking on its number. It can also be deleted (based

on GoldMine permissions).
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By clicking on the company or contact name the contact page will be opened.

Click on the Charts tab in the top left of the drill down the chart to return to the Chart view.

We hope the Case metric dashboard will help you track the progress of your cases, provide

easy access for updating information, and make sure no Case gets overlooked.

6.12 Working with Filters and Groups

Groups (i.e., contact groups) and Filters that are created using wMobile (and/or defined in

GoldMine) will be displayed on the appropriate tabs at the left of the Desktop windows:

     

By default, the the Groups and Filters of the logged in user are displayed. However, using

the drop-down to select another user will cause that user's groups/filters to be displayed.
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When a tab is clicked, the window opens to display the items and tools appropriate for

that list. The tools for each are described here:

Group / Filter Tools

Before using the Groups or Filters tools, an item must be selected. When selecting a

specific group or filter from the lists, do not click on the link itself as that opens a contact

list containing the results of the selection made. To use the tools, click on the area below

the group/filter name and the selected item will be highlighted when selected as shown

here:

 Groups:                                            Filters:

     

Groups tools:

New - Use to create a new group. After the following dialog is displayed, enter a group

name for the new group and click OK. After the group is created, search for contacts and

add them to the newly created group as desired.
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Clone - Use to clone (i.e., copy) an existing group into a new group having a new name.

After the following dialog is displayed, enter a group name for the new group and click OK.

After the group is cloned, the newly cloned group will be available to display its contacts.

Delete - After selecting a group, use this button to delete the group (contacts in the group

will not be deleted). (WARNING: The user will NOT be prompted before filter is deleted!)

Filters tools:
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New - Use to add a new filter. After the following dialog is displayed, enter a filter name for

the new filter. Enter the filter criteria as desired and then click OK. After the filter is

created, search for contacts meeting the filter's criteria by using its link.

Edit - Use to edit an existing filter. The dialog that appears is similar to the one used to

create a new filter. After making necessary edits to the filter, click OK to save the

changes.

Delete - Deletes the currently selected filter. (WARNING: The user will NOT be prompted

before filter is deleted!)
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Viewing Groups / Filters Results

To view the contacts that are in a group or found using a filter, select the group or filter by

clicking on the group/filter name's "link" from the appropriate list and the results will be

displayed. Below are examples of using each.

Group Results

Select the group link to display its members:

The members of the selected group are displayed:
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Filter Results

Select the filter link to display its members:

The members of the selected filter are displayed:
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6.13 Working with Reports

wMobile Desktop supports running Crystal Reports. The Crystal Reports Runtime engine

must be installed for the Reports functionality to work.

The reports themselves must be written using Crystal Reports tools and then

stored/maintained in GoldMine. Once the reports are accessible for use in GoldMine, they

can then be accessed using the Reports button from the expanded menu list.

To access a specific report, select the appropriate user library and category the report was

filed to.
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Only Crystal Reports will appear on this list.
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To run a report, double-click the report name (for the following example, "WIP Test no

path" was used).

If the report requires any parameters to be selected (Enter GoldMine USER in this example)

the user will be prompted. After the parameters are set, click OK:
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The report will be generated and then displayed. The Crystal Reports Runtime provides the

report navigation tools like paging through the report, zoom level, find, and more:



Desktop EditionwMobile User Guide 817

Copyright © 2021 SugarCRM All Rights Reserved.

6.14 Working with the Opportunity Manager

Using Opportunity Manager in wMobile Desktop

The Opportunity Manager in wMobile is available to help users work with and maintain

opportunities that are simple or complex having many components. As an example, a large

sales potential might involve a few contacts, several appointments to get things

scheduled, several files may be used for reference, and so on. With an opportunity, all of

these components are consolidated into one central location to make the components of

the opportunity easy to find, navigate, review, and update. Opportunities can be assigned

stage values and status values to track progress as well as start and end dates. 

See the links below:

View Opportunities

New Opportunity

Working with Opportunity Tabs

Opportunity Metrics
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6.14.1 View Opportunities

Opportunity menu:

To view existing Opportunities in wMobile, click Opportunities on the toolbar and select

View Opportunities:

wMobile will display the Opportunity List screen and will list the opportunities. Please note

that the opportunities can be filtered by typing into the filter field and pressing enter (the

funnel button allows the user to change the scope of the value searched for within the

field; this is typical for most columns in the Opportunity List):

Other columns in this view display information for Stage, Code, Probability, Forecast, and

more. The displayed columns can be controlled to be visible or hidden, and the order they

appear in, using the Select Columns button.
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The tool buttons allow a user to create a new opportunity, edit an existing one, refresh the

list of opportunities, or select the columns to be displayed. To edit an opportunity, select

the row and click the Edit button.

6.14.2 New Opportunity

Opportunity menu:

Click the New Opportunity button to open the New Opportunity dialog:
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Enter the "main" opportunity information here. This information is displayed in the

Opportunity List. Other components and details that need to be related to the opportunity

are added after the opportunity is created.

Clicking on the arrow icon opens a lookup list to select a pre-defined value from. However,

the user can type directly into the field (free form) if that is desired. The Manager drop-

down field contains a list of users to select from. The three date fields can have their

values set using the calendar button to open a date selector.

After all of the information is entered, click OK to create the opportunity.

In the following examples, the sample opportunity named: wMobile - Opportunity linked to

company "W-Systems" (seen in the Opportunity List above) will be used.



Desktop EditionwMobile User Guide 821

Copyright © 2021 SugarCRM All Rights Reserved.

Once the opportunity is added and appears in the Opportunity List, click on the opportunity

name to view its details (in red frame):

Users can manage the components and details of the opportunity using the tabs (shown

above in the blue frame). Each of the tabbed views contains a toolbar typically containing

the tools: New, Edit, and Delete for working with the data within the specific tab (tools are

shown above in the green frame).

6.14.3 Working with Opportunity Tabs (Desktop)

The same tabs are available in wMobile Desktop as in GoldMine to track information

related to the Opportunity including Influencers, Products/Services, Task, Team, Issues,

Notes, Competitors, Details/Links, Pending, and History. 

Influencers: 

Add one or more influencers that should be associated with the opportunity. These may be

anyone in your database that has a part in the opportunity. Use this to add sales staff, IT

techs, vendors, purchase agents, prospects, etc. If the influencer you want to add does not

exist in your database, it can be added without leaving this tab. To add an influencer to the

opportunity, click the New button to open the New Influencer dialog.
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On the New Influencer dialog, search for a influencer using the Lookup button. In the

Lookup Contact dialog presented, search for the influencer (actually a contact) to add to

the opportunity, or use the Add Contact button to add a new contact to the database and

then to the opportunity.

Products / Services:
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This tab stores products and services that are related to the opportunity. The specific

items can be assigned to specific users. The area below the tabs displays, from left to

right, the tasks:

Tasks:

Schedule actions to take place for the opportunity. The specific tasks can be assigned to

specific users. The area below the tabs displays the list of tasks:

Start Date and End Date, Priority, % Done, and Notes can be set for each task using the

New Task dialog:
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Team:

Create a "Team" for the opportunity on the Team tab. A team can consist of GoldMine

users and/or contacts that are going to be contributing to the opportunity.
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Following is a screenshot of the Edit Team Member dialog (the row was selected and Edit

tool was clicked). The Type field allows the user to select either a GoldMine user or a

contact and set them as a team member (GoldMine user for "Type" is shown here):

Issues:

If there are and issues hampering the success in completing an opportunity, they can be

tracked against an opportunity too. Here is an example of a problem that needs to be

addressed:
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This screenshot of the Edit Issue dialog shows the information entered for the issue at

hand. Here we can store and view notes pertaining to the issue:

Notes:
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Notes are an important part of opportunity management. The Notes tab gives users a

place to store and edit free-form notes. After a note is created, the Author and Date values

are set by wMobile:

To add/edit notes, the Add/Edit Note dialog is used (the top of the Edit Note dialog is

shown here; not shown are the Save/Cancel buttons):

Competitors:

This tab allows a user to enter contacts that could be competition for the opportunity

being tracked. The competitor can be selected from contacts within the database, a

lookup list, or typed in. 
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This screenshot of the Edit Competitor dialog shows the information entered for the

competitor record. Here we can store and view notes pertaining to this competition:

Details/Links:

This tab allows a user to enter very simple details consisting of two fields, Item and

Reference, and the ability to "optionally" link a document to the record. If a file is linked to

a record, the Linked Document path can be clicked on to download the file for use (i.e., if

the device running wMobile supports the file format). 
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Displayed here is the Edit Linked Document dialog. Use the Choose File button to select a

file to be linked to the opportunity. In our example of the Riva Cloud Deployment

opportunity, we've linked a file containing a support document to have handy when needed.

Pending:

In any given opportunity, there are always items that need to get done. When something

needs to be scheduled, the Pending tab is the place. The Schedule drop-down on the

Pending tab allows a user to schedule a Call, Appointment, Other, Next Action, Sale, or

Event. Also available on this tab is: (1) the ability to Complete an activity, (2) filter the

activities being viewed using the Filter Bar, and lastly, (3) a user can move an activity

forward to a different date using the Move Forward drop-down which contains a pre-

defined list of date increments (i.e., various numbers of days) or a date picker to easily set

a specific date:
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Clicking the Edit button with a row selected on the Pending tab opens the Edit Activity

dialog (note the fields available for your information):

History:

Another important aspect of opportunity management is history related to it. We need to

be able to refer to items that have been completed. After a pending activity is completed it

becomes a history record. The History tab displays completed activities for the
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opportunity. Please note that there will be times when an action is taken for an opportunity

that was not previously scheduled (i.e., no pending activity exists). In those cases, users

can use the Complete Unscheduled drop-down to create a history record on-the-fly. The

choices in this drop-down are: Call, Appointment, Other, Next Action, Letter/Memo,

Literature Request, Sale, or Event.

Clicking the Edit button with a row selected on the Pending tab opens the Edit Completed

Activity dialog (note the fields available for your information):
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6.14.4 Opportunity Metrics

In Fall ‘19 a new feature has been added in wMobile for GoldMine (Desktop): the Metric

Dashboards. These metrics dashboards represent interactive data graphs. This

information is presented in bar charts, forecast charts, and donuts charts. In this article,

we’ll describe the metrics on Opportunities.

Keep track of your Opportunities with these new metrics which help you to analyze and

visualize in an easier way the progress of the Opportunity sales on different periods of

time.

The metrics dashboard can be open from the Opportunities tab -> Metrics:

At the top of the Opportunity Count, you can make different selections for choosing what

type of opportunities you want to display. It can be filtered by periods of time,

‘Start/Closed Date’ & ‘Close By’ or even to export one of the charts. 

By permissions set in GoldMine, you can choose for which user you want to display the

opportunities graphs.
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In the first area of metrics you can also find:

· The top part of the dashboard represents the opportunities counts

· In the bottom section, there are three tabs which represent different information

· In the ‘Quarterly’ tab, you will find four donut charts that represent 4 periods of time 

· The ‘Forecast’ tab represents the sum of all types of opportunities. Also, these graphs

can be displayed quarterly

· The ‘Drill Down’ tab will be open when a specific type of opportunity is selected. (For

example, click on a column from the first chart and in the ‘Drill down’ tab the selected

opportunities types will be listed. Select the Charts tab to return to the list view.

The legend of the colors is detailed on the right side. The opportunities types are

displayed or hidden by clicking on the specified color. This behavior is applied for all types

of graphs, in the Opportunities Count, Quarterly and Forecast tabs.
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In the second area, you can see the donut charts which represent 4 time periods of a year.

The legend color is also detailed on the right side with the same actions as in the

Opportunities count area.

As above, if you want to see the active opportunities, you simply click on the color

assigned to this type of opportunity in the chart to drill down. The ‘Drill Down’ tab will be

opened.

From this tab, you can modify an opportunity, by clicking on its name. It can also be

deleted (based on GoldMine permissions). By clicking on the company or contact name

the contact page will be open. Click on the Quarterly tab in the top left of the drill-down

chart to return to the Chart view.

The ‘Forecast’ tab presents the sales opportunities in monthly graphs, split in 4 quarters.

The user can choose the quarter from the drop-down list which is located in the left

corner, under the tabs.  Like in the ‘Quarterly’ tab, if you want to see a type of opportunity,

you click on the assigned color for this type and the ‘Drill Down’ tab will be open.
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We hope the Opportunity metric dashboard will help you to have a clear vision of your

sales progress, easy access for updating information and make sure no Opportunity gets

overlooked.

6.15 Working with the Project Manager

Using Projects in wMobile Desktop

The Project Manager in wMobile is available to help users work with and maintain projects

that are simple or complex having many components. As an example, a wMobile

installation project may potentially involve a few contacts, several appointments to get

things scheduled, several files may be used for reference, and so on. With a project, all of

these components are consolidated into one central location to make the components of

a project easy to find, navigate, review, and update. Projects may be assigned stage values

and status values to track progress as well as start and end dates. As you see what

Projects has to offer, you may find it useful to use.

See the links below:

View Projects

New Project

New Project Template

Working with Project Tabs

6.15.1 View Projects

Project menu:
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To work with existing Projects in wMobile, click Projects on the toolbar and select View

Projects:

wMobile will display the Project List screen and will list the projects. Please note that the

projects can be filtered by typing into the filter field and pressing enter (the funnel button

allows the user to change the scope of the value searched for within the field; this is

typical for most columns in the Project List):

Other columns in this view display information for Start Date, End Date, Age, Status, Stage,

etc.

The tool buttons allow a user to create a new project, edit an existing one, complete the

selected project, refresh the list of projects, or delete one (after selecting a row in the list,

click the appropriate tool button), or to open the Project Templates lists:
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6.15.2 New Project

Project menu:

To Create a New Project, click the New button and select New Project.

 

Enter the "main" project information in the New Project dialog box. This information will

be displayed in the Project List. Other components and details that need to be related to

the project are added after the project is created. 
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Clicking on the arrow icon opens a lookup list to select a pre-defined value from. However,

the user can type directly into the field (free form) if that is desired. The Manager drop-

down field contains a list of users to select from. The three date fields can have their

values set using the calendar button to open a date selector.

After all of the information is entered, click OK to create the project.

Once the project is added and appears in the Project List, click on the project name to

view its details (in red frame):
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Users can manage the components and details of the project using the tabs (shown above

in the blue frame). Each of the tabbed views contains a toolbar typically containing the

tools: New, Edit, and Delete for working with the data within the specific tab (tools are

shown above in the green frame).

See Working with Project Tabs.

6.15.3 New Project Template

To Create a New Project Template

Click the New button and select New Project Template to open the New Project Template

dialog:
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6.15.4 Working with Project Tabs (Desktop)

In the following examples, the sample project named: wMobile Installation/Training linked

to company "Company B" (seen in the Project List above) will be used. 
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Users can manage the components and details of the project using the tabs (shown above

in the blue frame).The same tabs are available in wMobile Desktop as in GoldMine to track

information related to the Opportunity including Contacts, Task, Team, Issues, Notes,

Details/Links,  Pending, and History.  

Each of the tabbed views contains a toolbar typically containing the tools: New, Edit, and

Delete for working with the data within the specific tab (tools are shown above in the

green frame).

Contacts: 

Add one or more contacts that should be associated with the project. These may be

anyone in your database that has a part in the project. Use this to add sales staff, IT techs,

vendors, purchase agents, prospects, etc. If the contact you want to add does not exist in

your database, it can be added without leaving this tab. To add a contact to the project,

click the New button to open the New Contact dialog.

On the New Contact dialog, search for a contact using the Lookup Contact button. In the

Lookup Contact dialog presented, search for the contact to add to the project, or use the

Add Contact button to add a new contact to the database and then to the project.
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Tasks:

Schedule actions to take place for the project. The specific tasks can be assigned to

specific users. The area below the tabs displays, from left to right, the tasks:

... the progress of each task:
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.. and a Gannt chart (all side-by-side across the screen):



Desktop EditionwMobile User Guide 844

Copyright © 2021 SugarCRM All Rights Reserved.

Start Date and End Date, Priority, % Done, Notes and Color can be set for each task using

the New Task dialog:

Team:

Create a "Team" for the project on the Team tab. A team can consist of GoldMine users

and/or contacts that are going to be contributing to the project.
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Following is a screenshot of the Edit Team Member dialog (the row was selected and Edit

tool was clicked). The Type field allows the user to select either a GoldMine user or a

contact and set them as a team member (GoldMine user for "Type" is shown here):
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Issues:

If there are and issues hampering the success in completing a project, they can be tracked

against a project too. Here is an example of a problem that needs to be addressed (there

is also a User column that is not shown in this screenshot):

This screenshot of the Edit Issue dialog shows the information entered for the issue at

hand. Here we can store and view notes pertaining to the issue:
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Notes:

Notes are an important part of project management. The Notes tab gives users a place to

store and edit free-form notes. After a note is created, the Author and Date values are set

by wMobile:
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To add/edit notes, the Add/Edit Note dialog is used (the top of the Edit Note dialog is

shown here; not shown are the OK/Cancel buttons):

Details/Links:

This tab allows a user to enter very simple details consisting of two fields, Item and

Reference, and the ability to "optionally" link a document to the record. If a file is linked to

a record, the Linked Document path can be clicked on to download the file for use (i.e., if

the device running wMobile supports the file format). 
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Displayed here is the Edit Details/Links dialog. Use the Choose File button to select a file

to be linked to the project. In our example of the wMobile Installation/Training project,

we've linked a file containing the license/serial number to have handy when needed during

the installation of wMobile.

Pending:

In any given project, there are always items that need to get done. When something needs

to be scheduled, the Pending tab is the place. The Schedule drop-down on the Pending tab

allows a user to schedule a Call, Appointment, Other, Next Action, Forecasted Sale, or

Event. Also available on this tab is: (1) the ability to Complete an activity, (2) filter the

activities being viewed using the Filter Bar, and lastly, (3) a user can move an activity

forward to a different date using the Move Forward drop-down which contains a pre-

defined list of date increments (i.e., various numbers of days) or a date picker to easily set

a specific date:
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Clicking the Edit button with a row selected on the Pending tab opens the Edit Activity

dialog (note the fields available for your information):
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History:

Another important aspect of project management is history related to it. We need to be

able to refer to items that have been completed. After a pending activity is completed it

becomes a history record. The History tab displays completed activities for the project.

Please note that there will be times when an action is taken for a project that was not

previously scheduled (i.e., no pending activity exists). In those cases, users can use the

Complete Unscheduled drop-down to create a history record on-the-fly. The choices in this
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drop-down are: Call, Appointment, Other, Next Action, Letter/Memo, Literature Request,

Forecasted Sale, or Event.

Clicking the Edit button with a row selected on the Pending tab opens the Edit Completed

Activity dialog (note the fields available for your information):

6.15.5 Project Metrics

The metrics dashboard in wMobile for GoldMine provides interactive data information.

This data is represented in new graphs and charts. The projects can be easier to track,

analyze, and summarize in these metrics.
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The metrics dashboards are found in the ‘Projects’ tab, click on ‘Metrics’ from the

dropdown list:

Project metrics include two significant areas. The first graph represents the Projects

Count, and by default, all types of projects are presented. The legend of the colors is

detailed on the right side. The project types are displayed or hidden by clicking on the

specified color. This same selection method is used for the donut Charts on the bottom

half of the metric dashboard.
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For the counted projects, you can select different periods of time, by clicking the

checkboxes above the graphs. These can be displayed by ‘Start Date’, ‘Closed Date’ and

‘Actual End’.

You can choose for which user you want to display the project graphs. (Note: Access will

be determined by permissions set in GoldMine).

Each chart can be exported in PDF format.

Click on a bar in the chart to drill down to a list of the Projects. The Details tab includes

hyperlinks to navigate to the Project detail record, Company or Contact. Select the Charts

tab to return to the list view.

6.16 Working with Dashboards

wMobile 5.0 introduces the use of new dashboards for user to track Activities, Cases,

Opportunities, and Projects.

Activity Dashboard

Cases Dashboard 

Opportunities Dashboard 

Projects Dashboard 

6.16.1 Activity Dashboard

Starting with Fall '19 in wMobile 5.0.0.334, wMobile Desktop for GoldMine includes a new

functionality on Activities: Metrics. These metrics contain modern graphs and charts

which can be selected on time intervals, for pending activities and history activities.
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wMobile for GoldMine CRM - Pending and History Activity Metrics Dashboard

The metrics are found in the ‘Activities’ tab, click on the dropdown list, choose Metrics >

Pending Activities or History Activities.

wMobile for GoldMine CRM - Access Metrics for Pending or History Activities

Pending Activities metrics include three areas. The first graph represents the Pending

Activities Count and, by default, all types of activities from that day (Today) are displayed.
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The user can choose which period of time they want to include in the graph from the

checkboxes included in the menu above this graph.

If you don't want to view an activity type, you on it to temporarily deselect it.

wMobile for GoldMine CRM - Pending Activities Count

The second area displays the This Year Sales Amount chart. This chart represents the

forecasted sales and their projected amounts, using a month interval.

wMobile for GoldMine CRM - Current Year Sales Chart
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In the last area, we find the donut charts that represent all activity types. These are split

into four Quarters, which represent the four quarters of a year. By default, all types of

activities are displayed. You can also deselect a type by clicking on it. 

For example, if you want to display in the Current Quarter, the appointments and calls, you

can click on Events, Others, Sales and Next actions. These will get disabled and will be

shown in gray.

wMobile for GoldMine CRM - Current Quarter Activities Donut Chart

The legend of colors described on the right side of the donut helps the user identify each

type of activity. If you click on the color assigned to Calls, the Details drilldown tab is

opened with all call activities. In this tab, you can also complete, edit or delete an activity.

After each action, the charts will be reloaded. The Delete action respects GoldMine record

deletion permissions.

wMobile for GoldMine CRM - Activity Metrics Settings
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In the metrics menu from above, we will find 3 more buttons/dropdown lists.

The activities graphs can be filtered by date ( the Activity Date, Created Date and Modified

Date) and these filters affect the graphs for the Pending Activities Count and for donut

charts.

Also, the user can be selected for whom the graphs will be displayed.

wMobile for GoldMine CRM - Activity Metrics Filters

Each chart can be exported in PDF format.

wMobile for GoldMine CRM - Export Activity Metrics Charts as PDF

The History Activities Metrics display the same types of charts with the same

functionalities.
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wMobile for GoldMine CRM - Past Activity Metrics

The only difference is on the This Year Sales Amount chart, where the user finds the

completed sales which include completed and lost sales. The sales type (closed or lost)

can be displayed or disabled by clicking on it.

With the new metrics on activities, the user will have a better view of activities from the

pending and completed lists.
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6.17 Working with the Knowledge Base

Usage

The Knowledge Base provides a resource for maintaining any type of information useful to

an organization or an individual. The Knowledge Base can be accessed from the navigation

menu bar. If this option isn't in the first commonly used menu items, check the down

arrow at the end of the menu bar for more options. 

The Knowledge Base has two components, a public Knowledge Base and a Personal Base.
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 The public base contains general information relevant to staff and clients and can contain

information like company policies, product prices, press releases or any other general

information. The personal base contains information for the individual user and can

contain personal notes, special personal events, or any other type of personal information.

Both bases are structurally the same and operate in the same way. The reading and writing

access are determined by users with master access.

Structure

The graphic interface is structured into two sections, the left side that contains the

Knowledge Base tree functionality and the right side that contains the items content.

6.17.1 New Knowledge Base entries

The Knowledge Base contains books, folders and topics. To add a new entry in the

Knowledge Base, select the area where you wish to add use the Add button on the tree

menu (or right click on the entry in the tree view). Choices will include New Book, New

Folder and New Topic.
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In this example, a new folder will be added. 

Repeat the process to add a New Topic.
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Select the book, folder or topic and select Edit to make changes. Use the Knowledge Base

menu to format text, Add Attachment and Save when the topic is complete.
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7 Troubleshooting

Troubleshooting wMobile:

· wMobile Diagnostics Tool 

· Account is Locked

· Cannot find license file

· Change wMobile Port

· Duplicate Lookup Header Warning

· Internet Service Provider (ISP) Has Changed

· ISAPI Filter Troubleshooting

· Migrating wMobile to a New Server

· No connection could be made because the target machine actively refused it

· SQL Password Changed

· Troubleshooting Email Accounts

· User Cannot Log into wMobile

7.1 wMobile Diagnostics Tool

OVERVIEW:

The wMobile Diagnostics Tool is designed to assist wMobile administrators in identifying

configuration problems. This tool also has the capability to send a diagnostics report and

associated wMobile log files to wMobile Support for review when needed. The wMobile

Diagnostics Tool also has a Repair command which is able to correct some common

issues reported by this tool. 

Running the wMobile Diagnostics Tool

During a wMobile installation or upgrade, the wMobile Diagnostics Installer Wizard

prompts the user to Run wMobile Diagnostics. Running this tool is optional but highly

recommended after an installation/upgrade to check for success. However, this tool can

be started at anytime after an installation by using its shortcut from the Windows Start

menu.

To run the wMobile Diagnostics Tool, select Start > All Programs > W-Systems > wMobile

Diagnostics > wMobile Diagnostics.
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While the wMobile Diagnostics Tool is opening, it runs a set of diagnostics against your

wMobile system and displays a screen containing the results. Following is a key

describing the various status symbols displayed for the results.

 Success: This symbol designates that the item is meets requirements.

 Warning: This symbol designates that error logs exist in the log files.

 Critical: This symbol is identifying a critical issue with an item. This issue will need to

be addressed manually.

 Critical/Repairable: This symbol is identifying a critical issue with an item. This issue

can be fixed using the Repair command.

In the following example, the Remote GoldMine Service is shown as "not started" ( ) and

a connection to a remote server failed ( ):
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Using the wMobile Diagnostics Tool

Create wMobile Diagnostics Report File

Click Copy to create a copy of the report as an HTML file and place it on the server's

Desktop. The resulting file will be named: HtmlDiagnosisReport.html and can be viewed in

a browser by double-clicking it.
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Run the wMobile Diagnostics Tool

Although the wMobile Diagnostics Tool runs the diagnostics when it is started, you may

optionally want to run it again once it's opened after making configuration changes to

wMobile to see if they were successful. Clicking Run will re-run the diagnostics and

display the new results.

Send wMobile Diagnostics Report and wMobile Log Files to wMobile Support

A support technician might request the report and log files using the wMobile Diagnostics

Tool. Clicking Send will email a copy of the report and the wMobile log files to wMobile

Support. 

  IMPORTANT:

If you are not able to submit the diagnostic by using the Send command, this is usually

due the port being blocked on your server.
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When the Send command is unsuccessful, the diagnostic report and logs are

compressed into a file that can be forwarded manually via email to

goldminesupport@sugarcrm.com. If wMobile was installed to the default folders during

installation, the file will be found in the following folder:

C:\Program Files\W-Systems\wDiag\reports

- or -

C:\Program Files (x86)\W-Systems\wDiag\reports (on a 64-bit operating system)

The file name is logs.zip:

If you need further assistance, please contact wMobile Support. Please see our Contact

Information for details.

Viewing Logs

To view log files, click View on the main menu and then click the appropriate log to view.

mailto:goldminesupport@sugarcrm.com
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Filtering the Results Displayed

To filter the components tested and displayed in the wMobile Diagnostics Tool, click on

Options. Next, use the checkboxes to enable/disable the items to be displayed.
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Repairing wMobile

Clicking the Repair command on the main menu will attempt to correct some of the

common issues that are reported by the wMobile Diagnostics Tool. Issues that Repair will

try to correct are designated with the  symbol.

As an example, let's consider that the Remote GoldMine Service was found with a red 

symbol (meaning it is not running). After clicking Repair, the following Checks to Repair

dialog will display listing the items to be fixed:

Click the Repair button (not shown) on the dialog to start the repair process. The dialog

will update after running the repair. Please note the highlighted "Fixed" result indicating the

repair was successful. 

After closing the Checks to Repair dialog, the wMobile Diagnostics Tool will run and

refresh the display.
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7.2 Account is Locked

OVERVIEW:

When a user is logging into wMobile and enters an incorrect password more than a

specified number of times (the default is 3), that user will be locked out of wMobile. This

is a security feature and the access lock for this user needs to be reset before the user

can regain access. This number of attempts allowed can be adjusted in the wMobile

Manager Console.

PROBLEM:

After failing to log in using the maximum number of attempts allowed, the user will receive

a message similar to this:

Login Failed.Account is locked after repeated login failures. Please contact your

wMobile administrator to release the lock.

RESOLUTION:

1.  Log into the wMobile Manager Console.

2.  Open the User settings by selecting the wMobile node in the wMobile Explorer window

and then double-clicking the Users icon.

3.  Remove the check from the Is Locked column for the appropriate GoldMine user you

want to unlock.

4.  In the Actions window, click Save.

5.  Close the wMobile Manager Console.

MORE INFORMATION:



TroubleshootingwMobile User Guide 872

Copyright © 2021 SugarCRM All Rights Reserved.

The maximum number of failed login attempts allowed is configured in the System

Settings using the MaxFailedLogins property.

7.3 aspnet_client is Missing or Not Pointed to the Correct Location

wMobile uses the aspnet_client resources in IIS. If the virtual directory is missing in IIS, or

is not pointed to the correct location, there will be a warning in the wDiagnostic.

If the directory exists, but is not pointed to the correct location, the error would appear as

shown below.

In both cases, an option will be available from the Repair menu. Select the option to Repair

in the bottom of the window.
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When the box shows the result as Fixed, the box can be closed.

7.4 Cannot access Login Page

Our first step when a customer reports they can't reach the login page is to test wMobile

on the server where it's installed. 
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If the login page doesn't come up directly on the server either, then there's a configuration

issue with wMobile. Reach out to your wMobile reseller or run the wDiagnostic tool and

use the SEND option to submit to wMobile Support.

If the login page comes up on the server and wMobile works as expected, then it's

probably an issue with the firewall, such as a blocked port. 

There are a variety of port testing tools available to test whether a port is accessible. In

default wMobile installations, wMobile is installed using port 80 or port 443 (if you're using

an SSL certificate and access wMobile using a https web address). Another port could

have been selected during installation or might be changed after initial implementation.

One such tool is available at www.canyouseeme.org. (Be advised this is a free tool and the

web site contains advertisements.) 

Enter the Port to Check based on the port in use for wMobile at your company and select

Check Port as highlighted in yellow below. The result will be posted as highlighted in

green. Port testing tools are not 100% foolproof based on firewall settings, but it shows a

high probability that the port is blocked and/or the port needs to be mapped to direct

traffic to the wMobile server. Consult with your IT staff or your Internet Service Provider to

have the port opened and mapped accordingly. 

Reasons for external access problems can include needing to open a port or configure a

port mapping to direct traffic to the wMobile server. This might be on initial installation or

after a change such as switching internet service provider, getting a new modem, or after

migrating wMobile to a new server. 

http://www.canyouseeme.org
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7.5 Cannot find license file

PROBLEM:

Errors such as "The GoldMine API failed to load" or "Cannot find the GoldMine license file"

might be seen when launching wMobile Phone, wMobile Desktop, or the wMobile Manager

console. They might be seen in the logs, or possibly on initially installing the Remote

GoldMine Service.

CAUSES:

1. The settings referring to the GoldMine folder might be incorrect.

2. More often, the issue is related to problems accessing UNC or drive mapped paths to

GoldMine.

RESOLUTION:

Open GoldMine. From the main menu, select Help > About GoldMine > System button: 
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QUESTION: Do the GoldMine files (i.e., System Files in the About GoldMine dialog) reside

on the same server with wMobile, or is GoldMine on another server?

If GoldMine is on the same server as wMobile, then the path in the registry should be the

local path such as shown in the example below.

The Remote GoldMine Service will start in the local location and follow pointers in the

gm.ini such as the ones below:

RealIni=G:\GoldMine\gm.ini

SysDir=\\LVM-TRAINING\GoldMine\gm.ini

Any drive mapped or UNC paths must be accommodated in the Virtual File System

Settings. If GoldMine resides on another server, then the Remote GoldMine Service will

need Windows credentials to access GoldMine files across the network. This would be

configured using the Virtual File System Settings within the wMobile Manager Console.

Please see the topic on Virtual File System Settings.

  NOTE:  In new installations, the wMobile Manager Console does not require

GoldMine authentication with a username and password. This allows login to the
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wMobile Manager Console to configure Virtual File System Settings to access

GoldMine files such as the executable, dlls, and license file.

If further assistance is needed, please contact your wMobile reseller or

goldminesupport@sugarcrm.com.

7.6 Change wMobile Port

If it is determined after wMobile is installed, that another port must be used, the port used

should be updated in two places.

1.  The port should be updated in IIS. It will apply to all applications in the website. For

example, if you change the Default Web Site port, it would apply to any web applications

installed into the Default Web Site. (It is also possible to create a separate website for

wMobile. Email wMobile support at goldminesupport@sugarcrm.com for further

information.)

To change the port in IIS, open IIS and select the website in the navigation pane on the left.

Select Bindings in the Actions pane. Select Edit to change the port as needed. Click OK to

save your changes.

2.  The port should be updated in the wMobile Phone and Desktop keys in the Windows

registry.

Open the registry and navigate to:

mailto:goldminesupport@sugarcrm.com
mailto:goldminesupport@sugarcrm.com
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HKEY_LOCAL_MACHINE\SOFTWARE\W-Systems\wMobile

The Phone and Desktop keys have a value for the WebTcpPort entry.

Right click on WebTcpPort entry and select Modify to change the port number. Click OK to

save your changes.

Make this change to the WebTcpPort entry for both the Phone and Desktop keys.

7.7 Considerations When Upgrading GoldMine

When upgrading GoldMine, you must have exclusive access to GoldMine tables. Any

applications that access the GoldMine tables such as GoldSync and the wMobile services

must be closed as well. To stop the wMobile services, select Start > Run. Enter

services.msc in the field and press Enter or click OK.
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There are two (2) wMobile services: Remote GoldMine Service and wMobile Email Fetcher.

Stop these services during your GoldMine upgrade. Restart them after the upgrade has

been completed.

7.8 Duplicate Lookup Header Warning

OVERVIEW:

A warning might appear when logging into the wMobile Manager Console:

"wMobile Manager Console Warning - wMobile identified duplicate lookup headers in your

GoldMine installation. Some features in wMobile may not work properly until the problem

is corrected. Please fix the duplicate lookup headers in the Manager Console"

PROBLEM:

GoldMine has duplicate lookup headers, which were likely caused by synchronization in

the past.

DISCUSSION:

In GoldMine, the F2 lookups can be configured to allow blanks, force valid inputs, etc.

These settings are stored in a header record in the LOOKUP table. If you have duplicate

headers, this means that you have two or more records that indicate what the settings for

a particular F2 lookup should be. Duplicate lookup headers are somewhat normal if you

are installing wMobile on a copy of GoldMine that has been synchronized. It happens when

two users alter or create the F2 lookup settings on two different instances of GoldMine.

Since each system is not aware that the settings have been created on the other, they both

create a header record. When the systems are synchronized together, the server GoldMine

will then contain two (or possibly more) header records. 

wMobile doesn't handle duplicate lookup headers - the result will be that for any F2 lookup

where there are duplicate headers, wMobile will list the values in the drop-down, but not

apply any of the settings.

RESOLUTION:
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wMobile has a tool built into the Manager Console that can remove duplicate headers. 

The Duplicate Lookup Header tool will display a list of fields that have duplicate headers. 

In this case there are 18, as highlighted in the screnshot below. If there's more than a few,

there will be a scroll bar to scroll down the fields. For each entry on the list, select one to

keep.  If there's YN type data in the LookupSupp field as in the example below, it indicates

values have been set for the field such as allowing blank input, requiring input from the

lookup list, etc. Select the value you wish to keep. 

Administrators will be able to check the field settings in GoldMine as in the example

below.
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When the list has been reviewed, select Remove Duplicate Headers in the Action pane to

remove the duplicate headers  (i.e., the headers you have chosen NOT to save). 

The wMobile Manager Console will create delete sync stamps for the header records that

were deleted and an updated sync stamp for the ones you are saving to enforce the

selection on all of the remote, synchronizing GoldMine intances. 

Once you have completed this procedure, you won't see the warning on logging into the

wMobile Manager Console.
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7.9 Increase Logging Level

Each component in wMobile has logs: Phone, Desktop, Email Fetcher, Remote GoldMine

Service, and wMobile Manager Console. Occasionally, we need to increase logging levels

for troubleshooting purposes. Each component can be seen in the wMobile Explorer pane

of the wMobile Manager Console.

Expand the component where additional logging is needed. In the example below, we've

expanded the wMobile component folder, including the Log folder. 

Select Change Logging Level and set the desired level of logging. Info is the default.

Debug is the level used for debugging application errors. 
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Select Save when the selection is complete. 

If a problem is reproducible, try to reproduce the problem in the component where it's

occurring. Afterwards you can examine the logs by selecting Refresh or submitting the

wDiagnostic to send the logs to the wMobile support team at

goldminesupport@sugarcrm.com for review.

Note: A Debug logging level should be left for a short time, maybe up to a few days to try

to capture more logging when an error occurs. It shouldn't be left at this verbose logging

level indefinitely. 

Sometimes additional SQL logging can be helpful. The SQL logging settings can be found

just below Application Logs in the wMobile Explorer pane for each component. Select

Enable SQL Logging. 

mailto:goldminesupport@sugarcrm.com
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To disable SQL logging after the problem has been reproduced and the log is captured,

select Disable SQL Logging.

7.10 Internet Service Provider (ISP) Has Changed

When you change ISPs, you get a new external IP address. You can use a tool such as

www.canyouseeme.org to determine the external IP address you need to use. The wMobile

addresses follow the patterns shown below. You need to replace the "ExternalIP" value in

the pattern with your actual external IP address. No changes need to be made to wMobile

settings on the server, only to the address that is used to access wMobile.

http://ExternalIP/wMobilePhone

http://ExternalIP/wMobileDesktop

If these addresses don't resolve to the login page, try using a tool such as

www.canyouseeme.org to determine whether the wMobile port is open. In a default

installation, port 80 is used (HTTP). If you use HTTPS, then port 443 will most likely be

used. Unless your ISP was notified that you use a particular port, it might have been left

closed by default. The port needs to be open and mapped to your Web server where

wMobile is installed.

http://www.canyouseeme.org
http://www.canyouseeme.org
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It’s also possible that a different port was designated for your wMobile in IIS. You can

check your website binding in IIS.

If you are using a specific non-standard port, your URL will need to have the port added to

it. Add a colon (:) and then the port number as shown in these examples:

http://ExternalIP:8081/wMobilePhone

http://ExternalIP:8081/wMobileDesktop
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When you are in your office, you are typically connected to your internal network and using

the external IP address might fail to get you connected. Using the internal IP address of

the server on your network would be a better option.

See Also:

Logging into wMobile

7.11 ISAPI Filter Troubleshooting

ISAPI filters are required for wMobile. If they are not installed, there will be an error during

the install identifying that the ISAPI filters are missing.

"The installer has detected that none of the ISAPI filters are enabled for the selected web

site. This will prevent correct functioning of the application….

Choose 'Yes' to ignore the error and continue with the installation, 'No' to stop installing

wMobile Phone Edition 5.1 or 'Cancel' to go back and revise your settings."

It is recommended to stop the installation and resolve this issue before continuing.

Check in Roles and Features to confirm that the ISAPI Filters and ISAPI Extensions are

installed.

If the install was completed, but the ISAPI filters were not installed, this will be detected in

the wDiagnostics tool: 
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Use the Repair option from the menu to install missing IIS components. 

  NOTE: You might need to run the wDiagnostics tool using the ‘Run As Administrator’

option to have permissions to install IIS components.
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When completed, the Result status will be listed as Fixed, and the dialog can be closed.

7.12 Migrating wMobile to a New Server

INFORMATION:

wMobile cannot be "moved" to a new server. The application must be reinstalled on the

new server.  The steps below are a guideline.
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If wMobile is to be installed on a new server, please email

goldminesupport@sugarcrm.com for a new license. Be sure to note what version of

wMobile you are running.

If the wMobile version on the existing server is version 3.x, 4.x, or 5.x then wMobile can be

installed on the new server over the existing wMobile (WT_ tables).  If the wMobile version

on the existing server is older than this, then the SQL table structure is different, and will

cause conflicts.  Where possible, we recommend updating wMobile on the original server

before migration.  If this is not possible, and wMobile is an older version (below 3.x), then

uninstalling wMobile is recommended, or removing the WT_ SQL tables before installing

wMobile on the new server. 

 IMPORTANT: SQL Tables from an old install can cause problems with the new

install.

Beginning with wMobile installer version 4.0.0.547, if WT_* tables are detected during

installation, a warning message will be presented with the option to remove the old tables.

Make the appropriate selection based on the information above.

mailto:goldminesupport@sugarcrm.com
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Some additional guidelines are below.

1. If wMobile is being used as an email client for sending/receiving or auto-filing email, it

is recommended to export the email account settings on the existing/old server. This

can be done individually for each account or for all email accounts at one time. Email

accounts can be re-imported on the new server if SQL tables are removed from the

previous installation. Further detail on importing email accounts appears below.

2. It is also recommended that a screenshot is saved of the wMobile registry key and its

entries to be used for reference when reinstalling wMobile on the new server. This registry

key is in the following location:

HKEY_LOCAL_MACHINE\SOFTWARE\W-Systems\wMobile
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3.  Be sure to make sure all prerequisite IIS roles and features are installed on the new

server before installing wMobile.

4.  Reinstall wMobile on the new server.

5. If SQL tables were removed, and Email Accounts don't appear in the Email Accounts list,

import the previously exported Email Account data. Navigate to Email Accounts in the

wMobile Explorer pane as shown below. Select Import Email Account or Import All Email

Accounts in the Actions pane. Locate the email accounts export file from the original

server, which will have a .eax file extension.

  NOTE: Migrating or reinstalling wMobile is not covered under standard maintenance.

Migration and/or reinstallation can be scheduled with wMobile support staff at a flat fee

of $350 USD.
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Contact wMobile Support at goldminesupport@sugarcrm.com  if you have further

questions on this topic.

7.13 No connection could be made

OVERVIEW:

When a user attempts to log into wMobile, they receive a message stating that "No

connection could be made because the target machine actively refused it".

PROBLEM:

One of the following errors, or one similar to these, can be displayed onscreen and/or

appear in the wMobile logs:

mailto:goldminesupport@sugarcrm.com
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CAUSE:

The connection is being refused because the Remote GoldMine Service is not running.
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RESOLUTION:

1.  On the server with the Remote GoldMine Service installed, click Start > Run.

2.  Type services.msc and then click OK. 

3.  In the Services console, scroll down to the Remote GoldMine Service and select it.

4.  Click Start Service button (or right-click on the Remote GoldMine Service entry in the

list and click Start from the context menu).

5.  After the service starts successfully, "Started" will appear in the Status column for the

Remote GoldMine Service.

6.  From the menu, select File > Exit.

7.  Test your login to wMobile.

Services Console:

7.14 SQL Password Changed

PROBLEM:

If the SQL Server user/password credentials changed, the Remote GoldMine Service and

other components that access SQL Server data will not work.

RESOLUTION:

To update wMobile's configuration to use the newer login credentials,  start the wMobile

Manager Console and you will be prompted to set them in the Change SQL Password

dialog:
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This will automatically update the SQL credentials in the registry. 

After clicking OK the wMobile components will need to be restarted. Click OK to restart

the application pools and services used by wMobile.

After the components are restarted, the wMobile Manager Console Login dialog will

appear.

Note: The process above works when all wMobile components are on the server. If the

Remote GoldMine Service resides on a different server, the wMobile Manager Console

won't be able to access the registry on another server. In this case, email wMobile Support
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at goldminesupport@sugarcrm.com for assistance. The registry contains the SQL

password in an encrypted form, so it can't be edited in the registry directly.

7.15 Troubleshooting Email Accounts

A user might report that they are not seeing new emails in wMobile. Or a user might see

that their email account has been disabled, meaning that wMobile is no longer routinely

checking for new email messages on the server or ISP mailbox.

In the Phone Edition, an account will be shown in red when there's a configuration problem

or the account has been disabled due to connectivity issues.

In Desktop Edition, the account will also be shown in red, and will have a Stop sign icon to

indicate a problem.

mailto:goldminesupport@sugarcrm.com
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NOTE: When Auto-Retrieve is disabled, the stop sign is displayed and account name is

shown in red as a visual reference. Hover your mouse over the account name to get more

information.

Email settings can be accessed in either wMobile Phone or Desktop Edition, but the best

place for an admin to troubleshoot these problems is in the wMobile Manager Console

installed on the server.

In the wMobile Explorer window, navigate to: wMobile > Email Fetcher > Email Accounts.
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If auto-retrieve has been disabled, this status will be indicated in red.

Highlight the account and select Edit.

The email account settings will be displayed for review. If you know something has

changed, such as the email password, go ahead and edit the settings.

When Disable Auto Retrieving of new e-mails is checked, the wMobile fetcher will no

longer automatically check the server or ISP mailbox for new emails.

If the email fetcher fails to connect to an account a certain number of times, the auto-

retrieval will be disabled automatically. By default, that's three times. This is done to

prevent server resources from being used repeatedly to check a defunct account. The

number of times that the account is checked and the interval can be adjusted in the Email

Retrieval Settings.
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If settings needed to be updated, use the Test Account button at the bottom of the email

settings to see if the settings are valid. 
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Click on Save and Close when all settings are updated appropriately.
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7.15.1 Troubleshooting GMail Accounts

If a GMail Account doesn't test successfully, there are some settings to check in GMail.

1) If the email account has been configured in wMobile to use the IMAP protocol, verify

that IMAP has been enabled in GMail settings.

Further information on GMail settings can be found in Google Support:

https://support.google.com/mail/answer/7126229?hl=en

2) Verify that GMail's 'less secure app acess' setting is enabled. While wMobile does

include functionality to connect using SSL (Secure Socket Layer) for email, GMail requires

this setting with most email clients (including Outlook).

Log into your Google Account and select Google Account. 

https://support.google.com/mail/answer/7126229?hl=en
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On the Account page, select Security. Scroll down to the Less secure app access setting

and verify it's set to On or select Turn on access. 
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Note: It's possible that you will not be able to adjust this setting if your company has a

corporate GMail account. This would need to be set by the GMail administrator.

Further information on GMail's less secure app setting can be found in Google Support:

https://support.google.com/accounts/answer/6010255?hl=en

7.16 User Cannot Log into wMobile

PROBLEM:

A user cannot log into wMobile. The login failure may occur for several reasons.

CAUSES / RESOLUTIONS:

Wrong username or password

There is a mismatch between your GoldMine login credentials (username and password)

and what you entered for logging into wMobile. Use your GoldMine username and

password credentials exactly as you do for logging into GoldMine.

Access denied

You have entered valid username and password credentials but have not been granted

access to wMobile. To grant access for a user, log into the wMobile Manager Console and

open the Users list by double-clicking the Users icon in the main window. Place a check in

the Allow Login column for the user needing access and then click on the Save button in

the Actions window to save this change. If the user list is not complete, see the section on

Adding or Updating Users in wMobile. 

Multiple incorrect login attempts (Account is Locked)

If a user attempts to log in with the correct username but uses an incorrect password,

after a predetermined number of failed attempts, the user will be locked out of wMobile.

Please see Account is Locked for details and how to re-enable the user's access.

7.17 wSetup.exe installer blocked

OVERVIEW:

The wSetup.exe is clicked on, but nothing happens.  There is no on-screen message, so it’s not clear

what’s happening. We have seen the installer marked as blocked in some Windows environments.

https://support.google.com/accounts/answer/6010255?hl=en
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PROBLEM:

Under some Windows policy settings, installers are marked as blocked. 

RESOLUTION:

There are 2 steps to take to resolve the blocked installer.  

For a one-time, temporary fix, right click on the downloaded installer file (wSetup.exe) and select

Properties. On the general tab, select Unblock as shown below.
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To resolve this for future updates/upgrades as well, the wMobile download page should be added to

Trusted sites.  This can be accessed in Internet Explorer by going into Internet Options.
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Select the Security tab and select Sites. Then add download.w-systems.com to the list of trusted

sites.
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You can also get to this area faster by typing in inetcpl.cpl from the Run option in Windows or a

Command Line.

After this change is made, the installer will run as expected.
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8 Technical Support

For Technical Assistance:

wMobile maintenance is $59/USD per user per year. Maintenance includes all application

updates throughout the maintenance period. The maintenance also includes limited tech

support. (Installation and migration are not included, but any functionality issues,

questions, errors etc are included.) 

If technical support is needed, please feel free to:

· Contact your wMobile partner

· Email goldminesupport@sugarcrm.com. Please include as much information as

possible regarding your issue and supply full contact information so we know who to

contact when we respond. Thank you!

· You may also initiate a support request by submitting a wDiagnostic.

mailto:goldminesupport@sugarcrm.com
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9 Additional Information

9.1 Contact Information

W-Systems merged with SugarCRM in November 2020 after years as a top SugarCRM

reseller. Sugar will continue to serve W-Systems customers using GoldMine by offering

implementation and consulting services. wMobile for GoldMine will continue to operate as

normal. The W-Systems services personnel will not change. Going forward, wMobile

renewal notifications and invoices will come from Sugar.

wMobile questions can be directed to the wMobile team via email at

goldminesupport@sugarcrm.com. 

wMobile maintenance is $59/USD per user per year. Maintenance includes all application

updates throughout the maintenance period. The maintenance also includes limited tech

support. Installation and migration are not included, but any functionality issues,

questions, errors etc are included. Support should be initiated via email to

goldminesupport@sugarcrm.com. This will automatically create a support case. You may

also initiate a support request by submitting a wDiagnostic.

 

9.2 End-User License Agreement (EULA)

wMobile End User License Agreement

IMPORTANT – PLEASE READ CAREFULLY

Before reading the articles below, please note the following preliminary terms, which use
some of the definitions specified in Article 1 below:

Entering into this Agreement: This End User License Agreement constitutes a valid and
binding agreement between W-Systems and You, as a user, for the use of the wMobile
Software. You must enter into this Agreement by clicking on the ACCEPT button in order
to install and use the wMobile Software. You hereby agree and acknowledge that this

mailto:goldminesupport@sugarcrm.com
mailto:goldminesupport@sugarcrm.com
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Agreement covers all Your use of wMobile Software, whether it be from this installation or
from any other terminals where wMobile Software has been installed, by You or by third
parties. Furthermore, by installing and continuing to use the wMobile Software You agree
to be bound by the terms of this Agreement and any new versions hereof.

Electronic Signatures and Agreement(s): You acknowledge and agree that by clicking on
the ACCEPT button or similar buttons or links as may be designated by wMobile to show
Your approval of any foregoing texts and/or to download and install the wMobile Software,
You are entering into a legally binding contract. You hereby agree to the use of electronic
communication in order to enter into contracts, place orders and other records and to the
electronic delivery of notices, policies and records of transactions initiated or completed
through the wMobile Software. Furthermore, You hereby waive any rights or requirements
under any laws or regulations in any jurisdiction which require an original (non-electronic)
signature or delivery or retention of non-electronic records, to the extent permitted under
applicable mandatory law.

Article 1 Definitions

In this Agreement the following capitalized definitions are being used, singular as well as
plural.

1.1 Affiliate: any corporation, company or other entity that directly or indirectly controls, is
controlled by, or is under common control with, wMobile. For the purpose of this
definition, the word "control" shall mean the direct or indirect ownership of more than fifty
percent (50%) of the outstanding voting stock of the corporation, company, or other entity.

1.2 Agreement: this End User License Agreement, as may be renewed, modified and/or
amended from time to time.

1.3 Documentation: any online or otherwise enclosed documentation provided by wMobile.

1.4 Effective Date: the date on which this Agreement is entered into by clicking on the
ACCEPT button as stated above.

1.5 IP Rights: any and all intellectual property rights, including but not limited to
copyrights, trademarks and patents, as well as know how and trade secrets contained in or
relating to the wMobile Software, the Documentation, the wMobile Website or the wMobile
Promotional Materials.

1.6 W-Systems: refers to the company established under the laws of New Jersey, W-
Systems, with its address at 19 Spear Road, Suite 101, Ramsey, NJ 07446.

1.7 wMobile API: application program interface consisting of the set of routines utilized by
the wMobile Software to provide the wMobile Software functionality for a given platform
or operating system, wMobile API being included in or linked to the wMobile Software.

1.8 wMobile Online Material: the wMobile images and documents available for download
on the wMobile Website.

1.9 wMobile Promotional Materials: any and all trademarks, names, signs, logos, banners,
wMobile Online Material and any other materials, in whatever form, owned and/or used by
wMobile for the promotion of its company, its products and activities.
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1.10 wMobile Software: the software distributed by SugarCRM for wireless CRM
applications, including without limitation the wMobile API, UI and Documentation, as well
as any future programming fixes, updates and upgrades thereof. 

1.11 W-Systems Staff: the officers, directors, employees and agents of W-Systems or its
Affiliates, or any other persons hired by W-Systems or its Affiliates. 

1.12 wMobile Website: any and all elements, contents and the 'look and feel' of the
website.

1.13 UI: the user interface of the wMobile Software.

1.14 You: you, the end user of the wMobile Software, also used in the form “Your” where
applicable.

Article 2 License and Restrictions

2.1 License. Subject to the terms of this Agreement, WMobile hereby grants You a limited,,
non-exclusive, non-sublicensable, non-assignable, license to download, install and use the
wMobile Software on Your server, computer, phone or PDA for the sole purpose of
enabling wireless access to a wMobile server and any other applications that may be
explicitly provided by wMobile. 

2.2 No Granting of Rights to Third Parties. You will not sell, assign, rent, lease, distribute,
export, import, act as an intermediary or provider, or otherwise grant rights to third parties
with regard to the wMobile Software or any part thereof.

2.3 No Modifications. You will not undertake, cause, permit or authorize the modification,
creation of derivative works, translation, reverse engineering, decompiling, disassembling
or hacking of the wMobile Software or any part thereof.

2.4 Third Parties. You acknowledge and agree that the wMobile Software may be
incorporated into, and may incorporate itself, software and other technology owned and
controlled by third parties. Any such third party software or technology that is incorporated
in the wMobile Software falls under the scope of this Agreement. Any and all other third
party software or technology that may be distributed together with the wMobile Software
will be subject to you explicitly accepting a license agreement with that third party. You
acknowledge and agree that you will not enter into a contractual relationship with W-
Systems or its Affiliates regarding such third party software or technology and you will
look solely to the applicable third party and not to W-Systems or its Affiliates to enforce
any of your rights. 

2.5 New Versions of the wMobile Software. W-Systems, in its sole discretion, reserves the
right to add additional features or functions, or to provide programming fixes, updates and
upgrades, to the wMobile Software. You acknowledge and agree that W-Systems has no
obligation to make available to You any subsequent versions of the WMobile Software
beyond a 30 day period after initial purchase. You also agree that you may have to enter
into a renewed version of this Agreement, in the event you want to download, install or use
a new version of the wMobile Software. W-Systems will not accept any liability in relation
to the direct or indirect damages caused by the release and/or the absence of release of
new versions of the wMobile Software..
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2.6 Paid Services. This Agreement applies to downloading, installing and using the
wMobile Software. The use of any paid services which may be offered by W-Systems or its
Affiliates, may be subject to the additional Terms of Service.

Article 3 Confidentiality and Privacy

3.1 W-Systems’s Confidential Information. You agree to take all reasonable steps at all
times to protect and maintain any confidential information regarding wMobile, its
Affiliates, the wMobile Staff, the wMobile Software and the IP Rights, strictly confidential.

Article 4 IP Rights and Translations

4.1 Exclusive Ownership. You acknowledge and agree that any and all IP Rights to or
arising from the wMobile Software are and shall remain the exclusive property of W-
Systems and/or its licensors. Nothing in this Agreement intends to transfer any such IP
Rights to, or to vest any such IP Rights in, You. You are only entitled to the limited use of
the IP Rights granted to You in this Agreement. You will not take any action to jeopardize,
limit or interfere with the IP Rights. You acknowledge and agree that any unauthorized use
of the IP Rights is a violation of this Agreement as well as a violation of intellectual
property laws, including without limitation copyright laws and trademark laws. You
acknowledge and understand that all title and IP Rights in and to any third party content
that is not contained in the wMobile Software, but may be accessed through use of the
wMobile Software, is the property of the respective content owners and may be protected
by applicable copyright or other intellectual property laws and treaties.

4.2 No Removal of Notices. You agree that You will not remove, obscure, make illegible or
alter any notices or indications of the IP Rights and/or wMobile’s rights and ownership
thereof, whether such notice or indications are affixed on, contained in or otherwise
connected to such materials.

Article 5 Your Use of the wMobile Software

5.1 No Warranties. Access to a wMobile server is dependent on communications services
provided to You by your communications vendor. W-Systems cannot guarantee that You
will always be able to access your wMobile server, nor can W-Systems guarantee that You
can communicate without disruptions, delays or communication-related flaws. W-Systems
will not be liable for any such disruptions, delays or other omissions in any
communication experienced when using wMobile Software.

Article 6 Term and (Consequences of) Termination

6.1 Term. This Agreement will be effective as of the Effective Date and will remain
effective until terminated by either W-Systems or You as set forth below.

6.2 Termination by W-Systems. Without limiting other remedies, W-Systems may limit,
suspend, or terminate this license and Your use of wMobile Software with immediate
effect, if we think that You are in breach of this Agreement. W-Systems shall effect such
termination by providing notice to You to the email address You have provided.

6.3 Termination by You. You may terminate this Agreement with immediate effect at any
time, with or without cause and without recourse to the courts, provided that You will meet
with the conditions as set forth in Article 6.4 below.
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6.4 Consequences of Termination. Upon termination of this Agreement, You (a)
acknowledge and agree that all licenses and rights to use the wMobile Software shall
terminate, and (b) will cease any and all use of the wMobile Software, and (c) will remove
the wMobile Software from all hard drives, networks and other storage media and destroy
all copies of the wMobile Software in Your possession or under Your control.

6.5 No liability. W-Systems will not be liable in relation to any damage caused by the
termination of this Agreement.

Article 7 Your Representations and Warranties; Indemnification of WMobile

7.1 Representations. You represent and warrant that You are authorized to enter into this
Agreement and comply with its terms. Furthermore, You represent and warrant that You
will at any and all times meet with Your obligations hereunder, as well as any and all laws,
regulations and policies that may apply to the use of the wMobile Software.

7.2 Indemnification. You agree to indemnify, defend and hold W-Systems, Affiliates and the
W-Systems Staff harmless from and against any and all liability and costs, including
reasonable attorneys’ fees incurred by said parties, in connection with or arising out of
Your (a) violation or breach of any term of this Agreement or any applicable law or
regulation, whether or not referenced herein, or (b) violation of any rights of any third party,
or (c) use or misuse of the wMobile Software.

7.3 Export Restrictions.  You acknowledge that the wMobile Software may be subject to
international rules that govern the export of software. You agree to comply with all
applicable international and national laws that apply to the wMobile Software as well as
end-user, end-use and destination restrictions issued by national governments.  

Article 8 Disclaimer of Warranties

8.1 No warranties. THE WMOBILE SOFTWARE IS PROVIDED “AS IS”, WITH NO
WARRANTIES WHATSOEVER; W-SYSTEMS CORP. DOES NOT, EITHER EXPRESSED,
IMPLIED OR STATUTORY, MAKE ANY WARRANTIES, CLAIMS OR REPRESENTATIONS
WITH RESPECT TO THE WMOBILE SOFTWARE, INCLUDING, WITHOUT LIMITATION,
WARRANTIES OF QUALITY, PERFORMANCE, NON-INFRINGEMENT, MERCHANTABILITY,
OR FITNESS FOR USE OR A PARTICULAR PURPOSE. W-SYSTEMS CORP. FURTHER DOES
NOT REPRESENT OR WARRANT THAT THE WMOBILE SOFTWARE WILL ALWAYS BE
AVAILABLE, ACCESSIBLE, UNINTERRUPTED, TIMELY, SECURE, ACCURATE, COMPLETE
AND ERROR-FREE, NOR DOES W-SYSTEMS CORP. WARRANT ANY CONNECTION TO OR
TRANSMISSION FROM THE INTERNET.

8.2 Your own Risk. You acknowledge and agree that the entire risk arising out of the use or
performance of the wMobile Software remains with You, to the maximum extent permitted
by law.

8.3 Jurisdiction’s Limitations. As some jurisdictions do not allow some of the exclusions
or limitations as set forth above, some of these exclusions or limitations may not apply to
You. In such event the liability will be limited as far as legally possible under the applicable
legislation.

Article 9 Limitation of Liability
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9.1 Limitation of Liability. IN NO EVENT SHALL W-SYSTEMS CORP., ITS AFFILIATES OR
THE W-SYSTEMS CORP. STAFF BE LIABLE, WHETHER IN CONTRACT, WARRANTY, TORT
(INCLUDING NEGLIGENCE), PRODUCT LIABILITY OR ANY OTHER FORM OF LIABILITY, FOR
ANY INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING
WITHOUT LIMITATION ANY LOSS OF DATA, INTERRUPTION, COMPUTER FAILURE OR
PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE WMOBILE
SOFTWARE, EVEN IF W-SYSTEMS CORP., ITS AFFILIATES OR THE W-SYSTEMS CORP.
STAFF HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

9.2 Remedy. YOUR ONLY RIGHT OR REMEDY WITH RESPECT TO ANY PROBLEMS OR
DISSATISFACTION WITH THE WMOBILE SOFTWARE IS TO DEINSTALL AND CEASE USE
OF SUCH WMOBILE SOFTWARE.

9.3 Jurisdiction’s Limitations. As some jurisdictions do not allow some of the exclusions
or limitations as set forth above, some of these exclusions or limitations may not apply to
You. In such event the liability will be limited as far as legally possible under the applicable
legislation.

Article 10 General Provisions

10.1 New versions of the Agreement. W-Systems reserves the right to modify this
Agreement at any time by providing such revised Agreement to You or by publishing the
revised Agreement on the W-Systems Website. The revised Agreement shall become
effective within thirty (30) days of such publishing or provision to You, unless You
expressly accept the revised Agreement earlier by clicking on the accept button. The
express acceptance by You, or Your continued use of the wMobile Software after expiry of
the notice period of thirty (30) days, shall constitute Your acceptance to be bound by the
terms and conditions of the revised Agreement. W-Systems reserves the right to make
changes to this Agreement from time to time.

10.2 Entire Agreement. The terms and conditions of this Agreement constitute the entire
agreement between You and W-Systems with respect to the subject matter hereof and will
supersede and replace all prior understandings and agreements, in whatever form,
regarding the subject matter.

10.3 Partial Invalidity. Should any term or provision hereof be deemed invalid, void or
enforceable either in its entirety or in a particular application, the remainder of this
Agreement shall nonetheless remain in full force and effect.

10.4 No waiver. The failure of W-Systems at any time or times to require performance of
any provisions hereof shall in no manner affect its right at a later time to enforce the same
unless the same is explicitly waived in writing and signed by W-Systems.

10.5 No Assignment by You. You are not allowed to assign this Agreement or any rights
hereunder.

10.6 Assignment by W-Systems. wMobile is allowed to at its sole discretion assign this
Agreement or any rights hereunder to any Affiliate, without giving prior notice.

10.7 Applicable Law. This Agreement shall be governed by and construed in accordance
with the laws of New Jersey.
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10.8 Competent Court. Any legal proceedings arising out of or relating to this Agreement
will be subject to the jurisdiction of the courts of the state of New Jersey.

YOU EXPRESSLY ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT AND
UNDERSTAND THE RIGHTS, OBLIGATIONS, TERMS AND CONDITIONS SET FORTH
HEREIN. BY CLICKING ON THE ACCEPT BUTTON AND/OR CONTINUING TO INSTALL THE
WMOBILE SOFTWARE, YOU EXPRESSLY CONSENT TO BE BOUND BY ITS TERMS AND
CONDITIONS AND GRANT TO WMOBILE THE RIGHTS SET FORTH HEREIN.

Last revised: December 2017.

Copyright(c) 2020 W-Systems Corp. All Rights Reserved.
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